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Introduction

1. Introduction
What is Polymath is the software that ESA Elettronica offers its cus-
Polymath? tomers to use to configure all its products that have Win-

dows® CE as their operating system. The principal feature of
the application is that it's so easy to use, thanks to its user-
friendly, intuitive interface.

What does The concept behind Polymath is to be the switching-point be-

Polymath do? tween the customer and the terminal; in fact, it is the tool that
allows the user to transfer his or her own ideas onto the panel
creating projects at different levels of development. It is a uni-
versal software, that is, it can be used to program the behav-
ior of ESA Windows® CE terminals, independent of their
particular features and technical characteristics.
The work performed by Polymath produces a compiled project
containing all the operative details of the package created.
Once the project has been compiled without errors, it can be
uploaded and installed on the panel, which is now ready to
use. Polymath guides the user at every step of the develop-
ment of the project: from its creation to editing, from compi-
lation to its passage to the terminal.

Which "Basic" only allows to program the VT family of products.

POLYMATH

version? "Advanced" with all functionalities and for all families of pro-
ducts:

- VT text, graphic and touch operator terminals.

- IT terminals based on CE windows operational system
- VT CE terminals with CE open operational system

- Industrial PCs

Pass from the "Basic" mode to "Advanced" with the "Premium"
upgrade.

ESAPOLYMATH - User Manual - rev. 2.1
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Note: For a better knowledge of the functions offered by a particular
product, please consult the product’s technical characteristics on
www.esahmi.com

B.—’

What’s new The most striking difference between Polymath and its prede-
compared with cessors is undoubtedly its improved, totally overhauled graph-
VTWIN? ic interface. All operations are made simpler and more
intuitive and can be achieved with just a few clicks.
There is now the possibility of creating projects by means of a
guided procedure (Wizard) that makes it possible to work on
a project just a few seconds after starting the software. In ad-
dition, easy-to-use operations have been included for manag-
ing Recipes and Alarms, automating operations that once
could only be done manually.
Further on in this guide there will be a detailed description of
all the new operative features and information will be supplied
to help you use these in the most efficient way.

The Manual This manual is designed to be a constant guide for ESA’s cus-
tomers, describing and explaining the different features that
the software offers. It is aimed at the average user of ESA
products, guiding both first-time users of ESA products and
those already familiar with previous versions of the configura-
tor.

The principal concepts and the method of use related to each
topic and operative feature will be illustrated using appropri-
ate examples and screenshots.

The information contained in this document is subject to
change without prior notice and do not represent any obliga-
tion on the part of ESA elettronica S.P.A.

All products are trade names registered by their respective
owners.

Conventions To make it easier to consult the manual and make the topics
used in the dealt with simpler to understand, we will use symbols that it
Manual would be useful to learn from the outset.

ESAPOLYMATH - User Manual - rev. 2.1
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The table below lists all the symbols that are used in the fol-
lowing chapters of this manual:

Tabella 1: List of conventions used

Symbol Meaning

Indicates a navigational path; in this
case it means the user should click
File->New consecutively on the File and then New
buttons

Indicates that there is a note; notes
[ 1 are often inserted to provide sugges-
':.'}, tions or clarify common doubt

Indicates particularly important points
to be read with care to avoid falling in-
to difficult situations

Indicates that there is a guide dedicat-
ed to explaining in detail how a partic-
ular operation should be carried out

Indicates that within the description
there are key ideas - ideal for rapid
consultation of the guide in that they
accompany the essential notions

R #*p

ESA In the event of any doubts about the use of POLYMATH or oth-
Elettronica’s er ESA products, contact ESA Elettronica’s Customer Care ser-
Customer Care vice (open Monday to Friday from 8.30 to 12.30 and 14.00 to
service 18.00).

Customer Care telephone number: 0039/031/757400
Fax: 0039/031/751777
E-mail: customer.care@esahmi.com

A | mportant: it is always a good idea to annotate the currently in-
stalled version of POLYMATH and keep it to hand every time you
contact ESA’s Customer Care service. The version of the softwareis
shown in the main menu by clicking on Help->Information

ESAPOLYMATH - User Manual - rev. 2.1
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2. Installation

This chapter supplies information needed to be able to under-
take the first steps towards using POLYMATH: ’installation.
We set out the requirements a machine must have for the ap-
plication to function correctly as well as the crucial steps that
make up the installation phase.

& Note: POLYMATH isaprogramming utility for ESA panels ESA that
use the Windows® CE operating system, but this configuration soft-
ware can be installed on PCs using the Windows® 2000, Win-
dows®XP, Windows® Vista or Windows® 7 operating system.

Minimum Below are set out the minimum requirements necessary for
requirements using POLYMATH on one’s machine:

Tabella 1: Minimum requirements

Type Requirement

Windows® 2000 with Service Pack 4
. Windows® XP with Service Pack 3
Operating
system Windows® Vista
Windows® 7
RAM 1 GB RAM
Processor Pentium 1V or equivalent
Screen. 1024*768
resolution
Space on
Hard Disk 3GB

ESAPOLYMATH - User Manual - rev. 2.1
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Recommended Below are set out the recommended requirements for being
requirements able to run POLYMATH better on one’s machine:
Tabella 2: Recommended Requirements

Type Requirement

Windows® 2000 with Service Pack
4 or better

. Windows® XP with Service Pack 3
Operating

system or better
Windows® Vista
Windows® 7
RAM 2 GB RAM or more
Processor Pentium 1V or better
Screen

. 1024*768 or better
resolution

Space on

Hard Disk 3 GB or more

ESAPOLYMATH - User Manual - rev. 2.1
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Installing Once the presence of the minimum requisites have been che-
POLYMATH cked on your mac-hine, it is possible to start the installation

of POLYMATH.

Close or end any application active on the computer.
Introduce the POLYMATH program DVD-ROM.

The following window is presented automatically :

Italiano ' Espafiol

English Deutsch
Frangais b8

Select your language of choice. This window appears offering
several options:

Polymath Suite
Install Polymath version 2.0 BETA
Install Downloader version 2.2
Install Remote Access version 1.04

Y | Documentation . Utility

Install Software Manual Install Acrobat Reader

Install IT Hardware Manual Install OS Images HMIL

Install VT Hardware Manual Install Startup HMI Software

Read Software Manual Install USB Serial Adapter

Read IT Hardware Manual Driver

Read VT Hardware Manual IT programming cable driver
instructions for Win 7 / Vista

¥ ESA worldwide subsidiaries

A Polymaith

ESAPOLYMATH - User Manual - rev. 2.1
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Select "Install Polymath". This window appears. Select your
language of choice and click "Next":

ESAPOLYMATH - InstallShield Wizard P ] 53

Cinese [semplficato]
Francess [standard

Select "Next :

ESAPOLYMATH - Installshield wizard x|

‘Welcome to the InstallShield Wizard for ESAPOLYMATH 2.0

The InstallShield® Wizard will install ESAPOLYMATH 2.0 on your computer. Ta continue, click
Hext

ESAPOLYMATH - User Manual - rev. 2.1



Chapter 2

Installation

Read and accept the license terms and select "Next” :

ESAPDLYMATH - Install

POLYMATH SOFTWARE LICENSE AGREEMENT j

IMPORTANT: THIS IS A LEGAL AGREEMENT BETWEEN
YOU AND ESA ELETTRONICA SPA. BEFORE CONTINUING
WITH THE INSTALLATION OF THE PROGRAM, YOU MUST
READ, UNDERSTAND AND ACCEPT THE TERMS AND
CONDITIONS OF THE SOFTWARE LICENSE AGREEMENT
(VWHICH FOLLOWS

IMPORTANT
Read This Carefully Before Installing the Software

ITHIS 1S A LEGAL AGREEMENT BETWEEN YOU AND ESAL‘

& | accept the terms of the license agreement “

| do nat accept the terms of the license agreement

Read and accept the license terms and select "Next” :

ESAPOLYMATH - InstallShield Wizard

Ix

POLYMATH SOFTWARE LICENSE AGREEMENT

1. EXPLICIT ACCEPTANCE
Explicit acceptance of the clauses:
6 - Limited gurantee
T - Mo other gurantees
& - Limited library
9- Termination
10 - Miscellaneous

% | accept the tems of the license agreement “

€ 1 da not accept the tems of the license agreement

9

ESAPOLYMATH - User Manual - rev. 2.1



10 | Chapter 2

Installation

Select one of the options and click "Next":

ESAPOLYMATH - InstallShield Wizard x|

Plesse select a setup type.
& Emgiad

@ Al program Festures wil be installed. [Requires the most disk space. ]

 Custom
@ Gelect which pragiam features you want installed. Recormended for advanced

Select "Next” in order not to modify the default folder of the
POLYMATH program (C:\Program Files\ESA elettronica\ESA-
POLYMATH x.xx) or "Change” to modify the pathway :

ESAPDLYMATH - InstallShield Wizard x|

Install ESAPOLYMATH 2.0 to;

C:\ProgrammiVE Sé elettronicabE SAPOLYMATH 2.0 w

&’D Note: asPOLYMATH is a softwarein continuous devel opment, with
frequent issues of new versions, it is useful specify directories diffe-
rent to the default ones (e.g. ESAPOLYMATH_X.XX) in order to al-
low different versions to coexist on the same machine, if this
necessity should arise.

ESAPOLYMATH - User Manual - rev. 2.1
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Introduce the following information regarding the user :

ESAPOLYMATH - Installshield Wizard x|

Flease enler your name. the name of the company for which you work and the product seiial
number.

User Narme
Compary Mame:

License code:

@ I

&9 Note: When Polymath is installed in Demo mode without license, a
temporary "TRIAL" license, lasting thirty days, is activated. At the
end of the thirty days the user is warned through a pop up window
where the field for inserting the actual license appears; if the user
insertsthe correct licensg, it is possible to continue using Polymath,
otherwise, the programwill close and it will no longer be possible
to use Polymath.

Select "Install" :
|

Click Install o begin e installstion,

IF you want to review or change any of your installation setfings, click Back. Click Canelto exit the
wizard

Select "End”, the POLYMATH installation procedure has ended.

ESAPOLYMATH - User Manual - rev. 2.1
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Layout of menus

Before we can confidently operate the numerous features
offered by POLYMATH we need to familiarise ourselves with
the work environment and its various menus.
The layout of the application can be divided into the following
areas:

= main menu

« toolbars

= work area

= a series of anchorable windows
This chapter offers guidelines for making general software
settings and will pay particular attention to the main menu
and the toolbar which are the basic instruments for carrying
out any operations within POLYMATH. We will also refer to the
various anchorable windows which will be dealt with in greater
detail in the course of the following chapters.

Moo Toolbar Working
Area
X allx
n--:n-n—»—_r | 1
Al & 140 d| &b @ @S a
FSP0gaadana=gedteaaeanaalr
e dde

° @
Dockable
Windows
Project Errors/Warnings Viewer  Properties/Events Editor,
Explorer & Librery Explorer
Compiler Qutput &

Task Help

13
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The functions offered by the toolbar can all be accessed via
the main menu.

Main menu The main menu is the tool that permits POLYMATH’s main
project and settings operations to be performed.

|File Edit Script Fields Layout Image View Tools ?|

It is located in the top part of the program window and is a
fixed element that cannot be repositioned within the

framework of the page. There are also various scrollable
submenus each offering different functions as set out in the
paragraphs that follow.

File menu

Icon

Chosm
B S

Save hs...
8 .
a Wakdate: project
s e
@ Compls
D Feum gesort
BB o ot e
D Download

Fait

Chiel

S

=

Crkp

Chrie Shift v

ChrkeshitHC

=
il S FE.
CerkhEteD

Skt

Table 1: Functionsin the File menu

Path Menu

Description of function

File -> New

Creates a new Wizard project
(see chap. 4, “Managing the
project” page 83)

=

File -> Open

Opens an existing project

NAL

File -> Close

Closes the project

[
]

File -> Save

Saves the project

NAL

File -> Save as...

Saves the project with a
different name/path

ESAPOLYMATH - User Manual - rev. 2.1
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Table 1: Functionsin the File menu

Path Menu Description of function

S File -> Print Prints the project

File -> Validate Validates all the project (see
project chap. 8, “Validation” page 461)

File -> Validate Validates the element currently
current selected

Compiles the project (see chap.
File -> Compile 8, “Compiling, Downloading and
Runtime” page 461)

e

Opens the project simulator
(see chap. 8, “Compiling,
Downloading and Runtime”

H

File -> Run project

page 461)
Open the project online simula-
E File -> Perform tor (see chap. 8, “Compiling,
online simulator Downloading and Runtime”
page 461)

Downloads the project onto the
panel (see chap. 8, “Compiling,

&
i
File -> Download Downloading and Runtime”

page 461)
NA® File -> Exit Exits from POLYMATH
1.1con Not Available
Edit menu
o
= ¥ Undo CtHl+Z »
=
C d Fedo ChrIY
Wl Chrl+x
Copy Chrl+C
D Paste Chrl+y
Delete Dl
Table 2: Functions of the Edit menu
Icon Path Menu Description of function
Modify -=> Annul Annuls the previous operation

ESAPOLYMATH - User Manual - rev. 2.1
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Icon

Table 2: Functions of the Edit menu

Path Menu

Description of function

Modify -> Repeat

Repeats the following operation

Edit -> Cut

Cuts the object selected

Edit -> Copy

Copies the object selected

Edit -> Paste

Pastes the object that has been
cut or copied

Edit -> Cancel

Deletes the object selected

Script Menu

Icon

Find

k| 3
<

= =
Vs &

Indent

il

Go ko line

Zamrment

Uncommenk

Cukdent

Table 3: Script menu functions

Path Menu

Description of function

o

Script -> Find

Finds a specific string in the
script

4

Script -> Go to line

Directs to a specific page in the
script

i} . Allows to insert a comment in
Script -=> Comment .
the script
N Script -> Eliminates a comment from the
Uncomment script

Script -> Increase
re-entry

Increases the re-entry of the
text in the script

Script -> Reduce
re-entry

Reduces the re-entry of the text
in the script

ESAPOLYMATH - User Manual - rev. 2.

1




Chapter3 | 17

Layout of menus

Fields menu

Select:

Move editing area
Connect

Move port

Create...

Create 3

Table 4: Functions of the Fields menu

Icon Path Menu Description of function

Selects the object clicked on

Fields -> Select ]
after pressing

Eil

Fields -> Move Moves the Editing area selected
Editing area (e.g. Popup Page)

Enables connection of devices
and terminals (see chap. 4,
“Managing the project”

page 83)

|

Fields -> Connect

Fields -> Move Moves a connection port
Port

<n)
u

Adds a device or a terminal to
the project

+

Fields -> Create

The Create submenu can be reached via the Fields menu and
this submenu can be used to add a large number of elements
to the page (Fields -> Create).

‘ Basic shapes
Yalue fields
Simple controls

Complex controls

The elements that can be added are grouped under the
following headings:

= Simple figures

= Value fields

= Simple Controls

e Complex controls
The tables below give a description of the commands that can
be launched from this submenu. Refer to the appropriate

ESAPOLYMATH - User Manual - rev. 2.1
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chapter for the characteristics peculiar to the elements that
have been added.

Submenu: Simple figures

Rectangle
Ellipse

Arc

Circular sector
Line

Palygon

Polyline

Regular polygon
Label

Complex label

CEEeSNGECEQN

Trend pen

W
[

Image

E

Table 5: Functions of the submenu: Fields -> Create -> Simple figures

Path Menu Description of function

Adds a rectangle to the page

Simple figures -> (see chap. 6, “Simple Figures”

Rectangle page 259)

Simple figures -> Adds an ellipse to the page
Ellipse

’\ Simple figures -> Adds an arc to the page
Arc

Simple figures -> Adds a circular sector to the
Circular sector page

Simple figures -> Adds a line to the page
Line

Simple figures -> Adds a polygon to the page
Polygon

S

Simple figures -> Adds a broken line to the page
Broken line

€

Simple figures -> Adds a regular polygon to the
Regular polygon page

ESAPOLYMATH - User Manual - rev. 2.1



Table 5: Functions of the submenu:

Path Menu

Chapter3 | 19

Layout of menus

Fields -> Create -> Simple figures

Description of function

E

Simple figures ->
Label

Adds a label to the page

>

Simple figures ->
Complex label

Adds a complex label to the
page

Q)

Simple figures ->
Trend pen

Adds a trend pen to the page
indicating the current value of
the buffer

El
.

B

Simple figures ->
image

Adds an image to the page

Submenu: Value fields

A
||
(=
11

Murmeric
Dynarnic
4511
Symbolic
Date time
Bar

Indicator

Table 6: Functions of the submenu: Fields -> Create -> Value fields

Icon Path Menu Description of function
. Adds a numerical field to the
" Value fields -> «
123 Numerical page (see chap. 6, “Value
fields” page 285)
A Value fields -> Adds a dynamic text to the page

Dynamic

Value fields ->
ASCII

Adds an ASCII field to the page

ESAPOLYMATH - User Manual - rev. 2.1
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Table 6: Functions of the submenu: Fields -> Create -> Value fields

Icon Path Menu Description of function
Value fields -> Adds a symbolic field to the
Symbolic page
Value fields -> Adds a field relating to the date
Date Time and time to the page

Value fields -> Bar | Adds a bar to the page

3 ﬁ

Value fields -> Adds an indicator to the page
Indicator

Submenu: Simple Controls

Touch butkon
Touch area

Touch key
Continuous selector
Discrete selector

Continuous knob

CEnO006

Discrete knob

Table 7: Functions of the submenu: Fields -> Create -> Simple Controls

Path Menu Description of function

Adds a touch button to the page
(see chap. 6, “Simple Controls”
page 333)

Simple Controls ->
Touch Button

Simple Controls -> | Adds a touch area to the page
Touch Area

Determines the keys and is
used only during the
configuration of the run time

Simple controls ->
Touch Keyboard
Button

keyboard
Simple Controls -> | Adds a slide potentiometer
Slide (with no predefined values) to
Potentiometer the page

ESAPOLYMATH - User Manual - rev. 2.1
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Table 7: Functions of the submenu: Fields -> Create -> Simple Controls

Path Menu

Description of function

] Simple Controls ->
Slide Selector

Adds a slide selector (with
predefined values) to the page

Simple Controls -> | Adds a knob potentiometer

‘6 Potentiometer (without predefined values) to
Knob the page
(o) Simple Controls -> | Adds a selector knob (with

Selector Knob

predefined values) to the page

Submenu: Complex controls

Push button

Switch button
Frame

Trend

Trendxy

Log viewer

Active alarms viewer
Histaric alarm viewer
Users directory
Recipe directory
Recipe editing
Chronotherm
Schedulers viewer

Holyday group viewer

ROEGHEEECEELOLEE

Table 8: Functions of the submenu: Fields -> Create -> Complex controls

Icon Path Menu Description of function
i Complex controls - | Adds a one-touch push-button
[ > One-touch to the page (see chap. 6,

button

“Complex Controls” page 360)
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Table 8: Functions of the submenu

Path Menu

: Fields -> Create -> Complex controls

Description of function

Complex controls -
> Double-touch
button

Adds a double-touch button to
the page (see chap. 6,
“Complex Controls” page 360)

Complex controls
> Frame

Adds a frame to the page (see
chap. 6, “Complex Controls”
page 360)

Complex controls
> Trend

Adds a trend to the page (see
chap. 6, “Complex Controls”
page 360)

Complex controls
> TrendXY

Inserts a trendXY in the page
(see chap. 6, “Complex
Controls” page 360)

Complex controls -
> Logged on users
displayed

Displays the users logged on
and allows the password to be
changed (see chap. 6,
“Complex Controls” page 360)

El

Complex controls -
> Active alarm
table

Adds a table of active alarms to
the page (see chap. 6,
“Complex Controls” page 360)

El

Complex controls
> Alarm history
table

Adds an alarm history table to
the page (see chap. 6,
“Complex Controls” page 360)

[

Complex controls
> User list

Adds a table with a list of users
to the page (see chap. 6,
“Complex Controls” page 360)

E

Complex controls
> Recipe list

Adds a table with a list of
recipes to the page (see chap.
6, “Complex Controls”

page 360)

2
[ ]

Complex controls
> Recipe editor

Adds a table with a recipe editor
to the page (see chap. 6,
“Complex Controls” page 360)

Complex Inserts a “chronothermostat
1_[,_ controls -> view” in the page (see chap. 6,
- Chronothermostat “Complex Controls” page 360)

Complex Inserts a “scheduler view” in

controls ->
Schedulers

the page (see chap. 6,
“Complex Controls” page 360)
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Table 8: Functions of the submenu: Fields -> Create -> Complex controls

Path Menu

Description of function

Complex
controls ->
Holiday Groups

=

Inserts a “holiday group view”
in the page (see chap. 6,
“Complex Controls” page 360)

Menu: Layout

Show grid

.P Align ka grid

7

zoom

=

Zoar out
100%

m Eroup

Ungraup
align
Distribute

Level

Lock
sk

. ShowfHide kouch grid
@ ShowfHide touch areas

=
Resize with content

Chrl+shift+@

Chrl+5hift+U1

Table 9: Functions of the menu: Layout

Path Menu

Description of function

Layout -> Show
grid

Shows the grid in a page or in a
Hardware configuration (see
chap. 6, “Page properties”
page 257)

Layout -> Align
grid

Aligns the selected element to
the grid

Layout -=> Show/
Hide Touch Grid

Displays / hides the cells to b
selected by the Grill on the
Touch screen

23
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Icon

Table 9: Functions of the menu: Layout

Path Menu

Description of function

Layout -=> Show/
Hide touch-
sensitive areas

Displays / hides the pixels of
the Area on the Touch screen

Layout -> Enlarge

Enlarges the page display

ElE

Layout -> Reduce

Reduces the page display

100% = ‘

Layout -> Zoom

Makes it possible to indicate the
display percentage for the page

-
K

Layout -=> Group

Group two or more elements in
the current selection (see chap.
6, “Grouping of two or more
graphic elements” page 425)

Ed

Layout ->
Separate

Separates the elements of a
group

Layout -> Block

Blocks the objects / pages

wff =

Layout -> Un block

Un blocks the objects / pages

)

Layout -> Re-
dimension with the
control

Re-dimensions the elements
collected, maintaining the as-
pect.

Using the Layout menu you can also access all the functions
for aligning and positioning the elements within the pages.
This is done using the submenus: Align, Arrange and Level
that are illustrated below.
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Submenu: Align

Tap
Bottom
Middle:
Left

Cenker
=

Table 10: Functions of the submenu: Layout -> Align

1 EF S

Icon Path Menu Description of function

Aligns the object in the
selection with the top (see
chap. 6, “Alignment of objects”
page 430)

5

Align -> Top

[l

Aligns the object in the

ign ->
Align Bottom selection with the bottom

= Aligns the object in the
" i - i

Align -> Middle selection with the middle
= Aligns the object in the

Align -> Left selection with the left

Aligns the object in the

i -> . .
Align Centre selection with the centre

Aligns the object in the
selection with the right

B B

Align -> Right
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Submenu: Arrange

|

Horizontally

Right

==

Zenter

Left

==

1 (0 G G

Vertically
Top
Middle

Bottann

Table 11: Functions of the submenu: Layout -> Arrange

Icon Path Menu Description of function
Arranges the object in the

Arrange -> selection horizontally (see
Horizontally chap. 6, “Arrangement of

objects” page 434)

Arranges the object in the
selection to the right

=
=
=

Arrange -> Right

E

Arranges the object in the

-=> N
Arrange Centre selection to the centre

—

Arranges the object in the

-= -
Arrange Left selection to the left

= Arrange -> Arranges the object in the
Vertically selection vertically

——= . .

= Arranges the object in the

- -= "
Arrange Top selection to the top

(— . .

= . Arranges the object in the

-> X -

Arrange Middle selection to the middle

= Arranges the object in the

Arran -> Bottom -
ange otto selection to the bottom
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Submenu: Level

Table 12: Functions of the submenu: Layout -> Level

Path Menu Description of function

Places the object selected into

Level -> the foreground (see chap. 6,
Foreground “Depth order of objects”
page 428)
Level -> Places the object selected onto
Background the background

Raises the object selected by a

Level -> Up level

', L .
owers the object selected by a
o Level -> Down ) Y
level

Menu: Image

Load

Edit

a Reset

Color 3

-

Increase conkrask

Decrease contrast

Increase brightness

¥|o

Decrease brightness
Cut area

Rotate

260

>

Fit to display

3

Keep aspect ratio
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Table 13: Functions of the menu: Image

Path Menu

Description of function

Image -> Load

Load the current image (see
chap. 5, “Operations
performable on an image”
page 201)

Image -> Edit

Allows the image to be edited

HE

Image -> Remove

Remove the image loaded

=)

no

Image -> Colour

Makes it possible to choose the
type of colouring between:
Automatic, Tones of grey, White
and Black

9

Image -> Increase
contrast

Increases the contrast of the
image selected

o

Image ->
Decrease contrast

Decreases the contrast of the
image selected

fm Image -> Increase Increases the brightness of the
brightness image selected
Image -> Decreases the brightness of the
%1 Decrease image selected
brightness

)

Image -> Cut area

Cuts the area selected

'\
F.

Image -> Rotate

Rotates the image selected

»

Image -> Adapt to
screen

Adapts the selection to the
display

>

Image -> Maintain
proportions

Maintains the proportions while
the image size is changed
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Home
Backward
Formard

Show all
e all

Show

Tookars

English (United States) -

Reset window and bars layout

Enter full screen

Alt+Up
AlctLeft »

Ale+Right »

F11

Table 14: Functions of the menu: Display

Path Menu

Description of function

Display -> First
page

Moves to POLYMATH Home
Page

r

Display -> Last

Moves to last work page
displayed

Ca

Display ->
Forward

Moves to next work page
displayed

[English (United States)

Display -> Project
language

Makes it possible to change the
current project language

Display -=> Show
all

Shows all the anchorable
windows (see chap. 3,
“Anchorable windows” page 80)

Display -> Hide all

Hides all the anchorable
windows

and bars position

NAL . Allows to access the anchorable
Display -=> Show -
windows sub-menu
Display -=> Tools Allows to access the tools bar
NAL bar submenu
Display -> Allows to restore the POLYMATH
NAL Restores windows windows and bars with the de-

fault position

Display -> Full
screen

Allows to display the work win-
dow in "Schermo Intero" (Full
Screen) mode

29
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1.Icona Non Disponibile.

Submenu: Show

Project explorer
Library explorer
Log viewer

Properties editar

Events editor

i € €5 By &

Table 15: Functions of the submenu: Display -> Show

Icon Path Menu Description of function

Show -> Explore Shows the Explore Project
roiect window (see chap. 3,

proJ “Anchorable windows” page 80)
Show -> Explore Shows the Explore Library
Library window
Show -> Log List Shows the Log List window
Show -> Shows the Properties Editor
Properties Editor window
Show -> Events Shows the Events Editor win-
Editor dow

Submenu: Toolbar

This submenu lists the twelve groups of icons making up the
toolbar. Using this menu the user can proceed to reintroduce
into the application groups of icons that have been closed and
that no longer appear in the POLYMATH screen. For further
information about the way the toolbar works, please consult
the next paragraph.
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Options
Utilities

Translations »

Tags
Recipes
Alarms

Downloader Utilities »

Dictionary
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Layout of menus

Options Sub-menu

Table 16: Functions of the menu: Tools

Icon Path Menu Description of function

NAL ) Makes it possible to configure
Tools ->Options |\ Aotions of POLYMATH

NA® Tools -= Utility Accesses POLYMATH utilities

NAL Tools -> Manages the Translation of the
Translations project

NA® Tools -=> Tags/ Manages the Tags/Variables of
Variables the project

NAL Tools -> Recipes Manages the project recipes

NAL Tools -> Alarms Manages the project alarms

NAL Tools -> Accesses the Downloader func-
Downloader Utility | tions

NA® Tools -> To access the Dictionary func-
Dictionary tions

1.Icon Not Available

Click on the option Tools -> Options to access the mask for
configuring the Options of POLYMATH.

31
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EECIETTEE——— iz
— Select the language o wie for e ESAPOLYMATH IDE
hn Inghsh -]
Mscetaranus
Eathg

Use the Language menu to choose the language of the
POLYMATH application. Once the language has been selected
the application will need to be restarted to apply the changes.

101x]
Select the viin to use far the ESAPOLYMATH IDE
Laruscs
L] [Bhee =
Missslsneaus
Eaths

From the "Skin" menu, it is possible to select the skin to use
with the POLYMATH interface.

= ESAPOLYMATH Options

[] Draw only field's border while moving

Lanaquage [ Copy&Paste using a new name
in [] Use manual validation of projsct's compansnts

[] Mask passwords editing

[] show page’s fields tosltip

[] Use the panel's picture inta the page editor

[] Show the invert function

[] Show the structure images

[] Use graphics hardware editor

[] Don't ask for the canversion of older projects

[] Use the panel's picture inta the simulator

[] Don't ask ta import Tags from specific DB, if supported by the device
[ Activate Trial Mods

Max open dialogs 10

GUI style |DOUBLE—CLICK ~

A Ask for style at startup
Changes of GUI styls will be available after the restart of the application
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Use the Various menu to proceed to configure the general
Options of the application. The user may decide to view all the
objects during the move or only their outline, to automatically
provide a new name if using the cut/paste function , whether
to validate the project manually (File -> Validate project) or
in ‘real time’ automatically (see chap. 8, “Validation”

page 461), to visualise the edit password screen, view or hide
information on the various fields of the page, whether or not
to view the ESA terminal frame on the page editor, whether to
activate the "Invert" option or not, view or hide the images of
structures, graphically decide if wanting to inherit the
Hardware configuration, decide whether it should show the
message regarding conversation for old programs or not,
display or not display the panel image in the simulator, enable
or disable pop-up window viewing for importing tags,
activating the “Trial” mode or not, to set the maximum
number of windows open at the same time in the POLYMATH
Work area, select between the "ADVANCED" and "DOUBLE-
CLICK" modes and decide whether to offer this choice to the
user when the POLYMATH starts up.

Note: The options Manual validation and viewing only the outline
while the objects are being dragged are advised for configuring
particularly slow performing machines.

Use the "Directories" menu to select a directory in which to sa-
ve the project. Several folders are available by default accor-
ding to the type of panel used.

33
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Utility Sub-menu

Check updates

Project Documentation
Convert panel

Convert device

Remove unused tags
Cross reference

Shared tags

Show Memary

Update operator terminal

Edit{Find/Replace scripts

Table 17: Utility functions menu

Icon Menu path Function description
- Allows to check the presence of
-= .
NAL (L:J;:,:'t?él Updates | oy software issues of the
POLYMATH program
- . Allows a document to be
NA® Utility -> Project created with the specifics of the
documents .
project
NAL Utility -> Panel Allows the conversion of a panel
converts
NA® Utility -> Device Allows the conversion of a de-
converts vice
Utility -> Remove Checks if Tags/Variables not
NAL Tags/Variables used are present in the project
not used
Finds all components used
NA® Utility -> Crossed inside the project.
reference Configured only components ,
are not included in the research
- Displays Tags shared on the
NAL Utility -> Shared network
tags
Utility ->Show Displays the Tags occupied in
NA® Memory the device memory
This function allows you to re-
Utility -> Update store a backup file and execute
NAT operator terminal additional backup before resto-
re.
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Table 17: Utility functions menu

Icon Menu path

Function description

Utility -> Edit/
NA® Find/Replace
scripts

This function allows you to han-
dle (fine, edit and replace)
scripts in a project.

1.Icon Not Available

Update control

The “Update control” option allows verifying if online there are
more updated Polymath versions compared to the one instal-

led:

= Web update

Please check the settings below.

Direct connection

This wizard checks if there are updates available on the update server,

If they are correct, click 'Next' to continue, otherwise, click 'Settings...' to adjust them.

CBX

Settings...

By clicking on “Next” a more recent version of Polymath will
be searched online (on the ESA site) compared to the one in-
stalled on the PC, if a more updated version is not found, the

following image is displayed:
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= Web update

Current version is 2.10.0210
There aren't new updates available

Finish

If there is an updated version, the following mask will appear,
from here, by clicking "Next", a new Polymath version is in-
stalled:

= Web update

Current version is 1,70,1105 m
There is a new updates: 1.70,1106{132185 KB}

Click next to perform the update

< Indietro

Project documentation

The “Project documentation” option allows creating a simple
or complete print report, choosing from “.pdf” “.rtf” and “.ht-
ml” formats.

In the first screen it is possible to choose the “Simple” or
“Complete” option, the first only contains default options:
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= Document Template Creation - Step 1, ... EHEIE|

= [#] TT107W (SP1,ETH1)
S Configuration

[] ScreenShot Pages
PopUpPages
[JImages

[ TextLists
[JimageLists
Alarms
RecipeTypes
[JFrames
[Jreports
[IPipelines

Scripts

[ GlobalScripts

[¥] TrendBuffers

[] schedulers
[]DataLogs

[ TrendBuffersxy
[ remoteNotification
[JweeklyTasks
[JHolidayGroups

1 Mlew ann Ann

while the second one contains all options:

Template Contents

HWConfiguration
= [#] ITLA7W {SP1, ETH1)
SWConfiguration
[v]

Images

Textlists

GlobalScripts
TrendBuffers

TrendBuffersyy
RemoteNatification

[Er YT M S

Pressing the next button opens a window from which it is pos-
sible to choose the desired page layout:
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= Document Template Creation - Step 1, ... E: X

Frontispiece

[ Include Frontispiece {main page far HTML farmat)

Content
O Title:

[ authar:

O Company:

O Project Logo:

O company Logo:

O Document Info:

By enabling the "include title page" check-box, a preview is
automatically opened with all default parameters enabled:

= Document Template Creation - Step 2, ... [’:l@@

Frontispiece

¥l Include Frontispiece (main page for HTML format)

Content Preview

[ Title:
[l Author:
PROJECT DOCUMENTATION

¥l Campany:

[ Project Logo:

¥l Company Logo: Documert irfo

[¥l Document Info:
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Pressing next will open a window from which, by clicking on
"Browse", it is possible to select the name and path where the
file is to be saved:

= Document Template Creation - Step 3, ... [2 |0 [X]

Dacurnent File

File Name

[POF/RTF Page Design ]

Page Format: ad v
Crigntation: ) Portrait O Landscape
Margins () Top: |20 & Left: 20 &
Down: [z0 % Right: |20 &
Header: [0 & Footer: (0 &

[ Document Index

[0 Header:
[ Foater:
Pagition
[ page Mumbers
& Header O Footer
Alignment
®) Left () Center ) Right
\File Options |
¥l ©pen file after creation [ Include Graphics

By clicking on “Create” the project is saved with the desired
file path.

Convert panel

The “Convert panel” option allows converting the panel used
in the project into an HMI with different characteristics, after
choosing the product family, Building (the “Building” group

contains panels used for home ), or Industrial (the “industrial”
group contains panels used for applications that are typically
industrial) systems, open the folders to select the panel type:
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Cestination panel

Convert ta: = B Products
=- il Building

Rotation

Once the panel type and the rotation is chosen (vertical or ho-
rizontal), clicking on “Next” :

Destination panel

Convert to: | IT110T {SP1, PN, ETH1, ETH2) ~

(fiT110T )

| IT110T Pro (SF1, CAM, ETH1, ETHZ

| IT110T Pro (SP1, DF, ETH, ETHZ)

| IT110T Pro (SP1, PN, ETH1, ETHZ)

| IT110T Pro (3P1, SPZ, ETH1, ETHZ)

Bm 1112 E

i IT115 4
| =

[l

Rotation

® 0°
O 900
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The following image, summarising the operation to be carried
out, will appear :

Conversion
Convert from: IT107W {SP1, ETHL)
Convert to: IT1107T (SP1, SP2, ETH1, ETHZ)

[l Adjust fields dimensions

[l Adjust background image

At this point, click on "Next" and wait for the end of the con-
version :

Status

The panel has been successfully converted.
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Convert device

The “Convert device” option allows converting a Device into a

second, during this conversion, only variables with the same
structure are maintained:

The first screen allows choosing the Device group:

Destination device

Convert to: i CANCOPEN

FROFIBUS
PROFIMET

BN THERMOREGULATOR
BN WEB SERVER

Open the folders to choose the Device type:
Once the Device type is chosen, click "Next":
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Convert ta:

BERTHEL
CROUZET
DELTA

Bl EATON MOELLER

B PANASONIC

SALA

SCHNEIDER TELEMECANIQUE

-l SIEMENS

' Helmholz ethernet adapter for 57-300,400
[@ =5 90,95,100,115 up to 944

@ 57 1200 Industrial Ethernet

[@ =7 200 PPI Network 187.5Kb

[ =7 200 PPI Network 9.5/13.2Kb

@l 57 300,400 Industrial Ethernet

>

-

The following image, summarising the operation to be carried

out, will appear:

Conversion

Convert from:

Convert ta:

£7 300,400 Industrial Ethernet

57 300,400

43
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At the end of the conversion a Report is displayed listing the
"non converted tags" and a message is present warring the
user that certain panel/device connections may have been re-
moved, next it recommends recreating new connections:

Status

The device has been successfully converted.

Some device connections have been remaoved, you need to re-create them.

List of the Tags not converted:

0 Tags

Unused Tags Removal

The "unused Tags Removal" option allows verifying if unused
variables are present in the project, and to eliminate them.
The first screen allows selection, by clicking on the correspon-
ding “Unused tags” to be removed.

i

& Note: All variables are selected by default.

Pressing the “Remove” will remove unused Tags:
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Rernowing unused tags

DE_11.DB_NO ~
DB_11.DBB_NO
DB_11.EN_R
DB_11.ERROR
DB_11.LADDR
DB_11.LEN
DB_11.NDR

DB_11.R
DB_11.3FCERR
DB_11.STATUS
HolidayGroup_1_Manth
HolidayGroup_1_Year L9
Scheduler_Start_1
Scheduler_Stop_1
STS_AlarmNothck

| 4

At the end, click on “OK”:

ESAPOLYMATH

-
\y 18 unused tags have been removed

Cross reference

The “Cross reference” option allows searching for unused
components within all projects, from the following window it
is possible to select search criteria:
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CEX

Search for:

) Free Search

2 Find/Replace

) Page Elements

(*) Tags of the project

() Scripts/Functions of the Projsct

Cancel

The search criteria are the following:

 Free search

= Find/Replace

= Page Elements

= Project Tags (with “Check” enabled by default)
= Project Scripts/Functions

Free search

Within “Free search” it is possible to carry out a search by fiel-
ds by editing the “Name Mask” and inserting, for example, the
letter “F”. In the initial page it is also possible to decide if the
search is to be completed for the entire project or only in a
part of it.

Using two keys, it is also possible to save/load filter conditions
in “.XML” format.

Then click “Search”:
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Marne mask : F

Search in &) all Praject

O Only in :

filtering conditions

Load filtering

SN EETTY T

The following mask will display all objects whose name begins

with the letter “F”:

Elernents List

Elernent narne

|
D Friday
D Frames

Friday
Frames

SwitchButtan

Frames

Project\ITLOZW (SP1, ETHLIASW
ProjecthITIOZW (SP1, ETH1)4Pac
ProjecthITIO7YW (SP1, ETH1)4Fra

Find elernent :

In the same page, by using the keys, it is also possible to:

= Export all: Export all objects in the list to an Excel or
CSV file.

= Export selected: Export selected objects in the list to an
Excel or CSV file.
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Modify: After selecting an element from the list, it al-
lows modifying it within the project.

Tree view: Allows modifying how elements are viewed,
from "table" to "tree" type.

Find element: Allows a more detailed search among ele-
ments that have already been searched.

New search: Allows carrying out a new search from the
beginning.

Find/Replace

With the “Find/Replace” option it is possible to find, within the
project, certain elements (for example a Font type) and repla-
ce it with another (for example a different Font type):

earch for:

Replace
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Let us now select the font to be used:

=earch for

Language Source font Replace font

SysternTahoma
SysternCourier
SysternSymbol

e iR

English [United States] | SystemT ahama

rnTimesh

= wRoman k
SystemnWingdings
SysternFangSong ESA

Clicking “Forward”, the following screen is appears:

O ETErence O
Filters
¥l Search By Mame : @ zearch from: |m | o M v
ernent's narme begin with:
O El ' begin with
) Mask:
b Element's category : |NL”T|Er’iCF\E|d 3
b searchin : & all Project
]
O only in:

Save filkering conditions Load filtering conditions

Cancel

Click "End"
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Page Elements

In the “Page Elements” option it is possible to complete a
search for elements within the project, with three different
criteria that can be used both individually and at the same
time:
= “Search by Name” : allows carrying out an alphabetic
search among elements, the "Search by Name" option
is divided into three subgroups:

1) “Search from : to": the filter is set by the user who can de-
fine a search field starting form one letter and finishing with
another one, the following mask will display all objects whose
name is included between “M” and “N”, of the " Numerical
Field" category and belonging to the entire project

Filters

I Search By Mame : @ search from: |m | to: H ~

(2 Element's name begin with:

O Mask:
Il Elemnent's categary @ [MumericField 7
[l Searchin : & &l Project
O only in:

Save filtering conditions Load fitering conditions

2) “Element name begins with”: The filter is set by the user
who defines a search field by selecting the letter at the begin-
ning of the name for the element to be searched

3) “Mask” : The search filter is the same one of the option
“Element name begins with”

= “Element category” : Allows searching within each indi-
vidual category of elements present in the project

= “Search in”: Allows deciding where, within the project,
the search is to be carried out, in the entire project or
only in a portion of it.
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Once the filters for carrying out the search are selected, the
following mask is obtained:

Elernents List

erment name Element type
i MurnericField MurnericField ProjecthIT107W (SP1, ETH1)Pac
D MurnericField_1 MurnericField_1 MurnericField ProjecthIT107W (SP1, ETH1Pac

Export all

Find elernent :

From the previously described mask, using the appropriate
keys, it is possible to complete the following operations:

= Export all: Export all objects in the list to an Excel or
CSV file.

= Export selected: Export selected objects in the list to an
Excel or CSV file.

= Modify: After selecting an element from the list, it al-
lows modifying it within the project.

= Tree view: Allows modifying how elements are viewed,
from "table" to "tree" type.

= Find element: Allows a more detailed search among ele-
ments that have already been searched.

= New search: Allows carrying out a new search from the
beginning.

Projects Tags

In the “Projects Tags” option it is possible to complete a sear-
ch for elements within the project, with two different criteria
that can be used both individually and at the same time:
= “Search by Name” : allows carrying out an alphabetic
search among elements, the "Search by Name" option
is divided into three subgroups:
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1) “Cerca da : a” : Il filtro € impostato dall’utente il quale puo
definire un campo di ricerca iniziando da una lettera e finendo
con un’altra.

“Cerca per Tipo”: Il filtro € impostato dall’'utente il quale puo
definire un campo di ricerca selezionando il tipo di Tag che si
vuole ricercare, verranno evedenziate tutte le Tag apparte-
nenti allo stesso tipo.

2) “Nome dell’elemento inizia con” : Il filtro € impostato
dall’'utente il quale puo definire un campo di ricerca selezio-
nando la lettera di inizio del nome dell’elemento da cercare
3) “Maschera” : Il filtro di ricerca € il medesimo dell’opzione
“Nome dell’elemento inizia con”

Filters

[ Search By Name : | & Searchfrom: ¢ v to: T v

O Elernent's narne begin with:

O Mask:

[# Search By Type : kel System
b Internal
i Recipe Type
b Indexed
M Device & all Devices
O only in

Save fitering conditions Load fitering conditions

Once the filters for carrying out the search are selected, the
following mask is obtained:
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Flernents List

Elerment name Element type

1 MumericField NumericField ProjecthIT107W (SP1, ETH1)Pac
D MurnericField_1 MurnericFisld_1 MurnericFiald ProjecthIT107W (SP1, ETH1MPac

Find elernent :

From the previously described mask, using the appropriate
keys, it is possible to complete the following operations:

= Export all: Export all objects in the list to an Excel or
CSV file.

= Export selected: Export selected objects in the list to an
Excel or CSV file.

= Modify: After selecting an element from the list, it al-
lows modifying it within the project.

= Tree view: Allows modifying how elements are viewed,
from "table" to "tree" type.

= Find element: Allows a more detailed search among ele-
ments that have already been searched.

= New search: Allows carrying out a new search from the
beginning.

Note: The“ Project Tags’” option exclusively searches Tags used in
the project. If a Tag is present within the “ Project Explorer” but it
is not associated with any project element, it will NOT be included
in the search.
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Project Scripts/Functions

In the “Projects Scripts/Functions” option it is possible to com-
plete a search for elements within the project, with two diffe-
rent criteria that can only be used individually:

= Search by Name” : allows carrying out an alphabetic se-

arch among elements, the "Search by Name" option is
divided into three subgroups:

1) “Search from : to": The filter is set by the user who can de-

fine a search field starting form one letter and finishing with

another one.

2) “Element name begins with”: The filter is set by the user

who defines a search field by selecting the letter at the begin-

ning of the name for the element to be searched

3) “Mask” : The search filter is the same one of the option

“Element name begins with”

= “Search by Type”: allows searching within each indivi-
dual category of the "Function" or "Script" present in
the panel project. It is possible to choose between “IT”
and “VT” based on the panel type used in the project.

IT :

By selecting the "Function" option and choosing an item from
the list (e.g. Exit Runtime) the SW will search all “Exit Runti-
me” functions in the project:

= Cross reference

Filters

(O search By Namne Search fram:
Element's name begin with:
Mask:
&) Search By Type T
& Function ExitRuntirne v
] Script

Wt
Function
Internal Comrmand

Macro

Save fitering conditions Load filtering conditions

Cancel
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Once the filters for carrying out the search are selected, the
following mask is obtained:

Elements List
Elernent name Element type
{IT112TProl5P1,CANE YWTPanel

ProgettosIT112TPro(SP1,CANET

Find element :

By selecting the "Script" option and choosing an item from the
list (e.g. ESAStartup) the SW will search all “ESAStartup”

Script in the project:

Cross reference

Filters

) search By Mame Search from:

Elerment's name begin with:

Mask:
(%) Sgarch By Type T
O Function
@ seript ESAStartup v
Ut
Function

Internal Cornrnand

Macro

Load fitering conditions

Save filtering conditions

S ETTS G

Once the filters for carrying out the search are selected, the
following mask is obtained:
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Elements List

[] :ESAStartup

ent name Element type

: ESAStartup Scoript ProgettosIT112TPro(SP1,CANET

Find elernent :

Cancel

From the previously described mask, using the appropriate
keys, it is possible to complete the following operations:

VT :

Export all: Export all objects in the list to an Excel or
CSV file.

Export selected: Export selected objects in the list to an
Excel or CSV file.

Modify: After selecting an element from the list, it al-
lows modifying it within the project.

Tree view: Allows modifying how elements are viewed,
from "table" to "tree" type.

Find element: Allows a more detailed search among ele-
ments that have already been searched.

New search: Allows carrying out a new search from the
beginning.

By selecting the "Function" option it is possible to locate all
functions in the project and choosing an item from the

list (e.g. Direct Command to Value) all “Direct Command to
Value” functions will be displayed:
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oss reference

Filters

(0 search By Name

() search By Type

fitering conditions

Search from:

Element's name begin with:

Mask:
IT
Function
Script
Vt
(=) Function hd
Goto page
7 Internal Command Macmp s A
) Macro Mormnentary reset bit

Momentary set bit
MNane

Permanently reset bit
Permanently set bit

Load fitering conditions

ST T

Once the filters for carrying out the search are selected, the
following mask is obtained:

Elements List

[] iwalue direct commanc Macra OMacro ProjectyUTS0SHYMacrasyMacro

Find element :

ECNET G

By selecting the "Internal Command" and choosing an item of
the list (e.g. Previous Page) the SW will search all "Previous
Page" Internal Commands in the project:
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oss reference

Filters

(0 Search By Name Search from:

Elernent's name begin with:

Mask:
® search By Type T
Function
Script
Wt
O Function

PROJECT - Previous page

(& Intsrnal Command

O Macro

Load fitering condtions

fitering conditions

Once the filters for carrying out the search are selected, the
following mask is obtained:

Elements List

Project\WTS05HWPageshStarthloc

Edit

Find element :

By selecting the “Macro” option and choosing an item of the
list ( e.g. High-level ) the SW will search all the “High-level”

macro used in the project :
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Filters

) Search By Mame

) Search By Type

Save fitering conditions

Search from:

Elernent's name begin with:

Mask:
Im
Function
Script
Wt
O Function

(& Internal Cornmand

& Macro

bﬂm
Macro_ 1

Cancel

Load fitering conditions

Once the filters for carrying out the search are selected, the
following mask is obtained:

Elernents List

Element name Element type

ProjecthWTS05HYPagesiStarthloc

Ewpoit all

Find element :

Cancel

Shared Tags

The “shared Tags” option allows viewing all Tags present in

the project, and

allows the user to choose one or more varia-

bles to be shared on the network with a simple step; in prac-
tice it makes it possible to quickly modify the “Allow tag value
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to be shared via ETH” Check used for network project mana-

gement:

Shared tags

=1

Tag_INT
Tag_IMT_pro
[] DB_10.REQ DB_10.REQ
[] DB_10.LADDR DE_10.LADDR
[] CB_10CB WG DB_10.DB_NO
[] DB_10.DBE_M: DE_10.DBE_MO
D DB_10.LEN DB_10.LEN
[0 DB_10.DOME DE_10.DOKWE
[] DB_10.ERROR DEB_10.ERROR
[ SvS_ETH_Driv Tag
[] DB_10ERROR DB _10.ERROR_1
[ inputz inputz
[] outputz autput?
[ input3 inputa
O inputa inputs
[ float float =
[ textin textll v

All checkboxes are not selected by default,
they are selected by pressing the "Select all" key. This makes

all project variables shared throughout the network:

Shared tags

Tag name

Tag_INT
Tag_INT_pro
DB_10.REQ

E: =d tag name
Tag_INT
Tag_IMT_pro
DB_10.REQ

HEEE

DB_10.LADDR DB_10.LADDR
DB_10.DB WO DB_10.DB_NO
DB_10.DBBE_Mc DB_10.DBB_MC
DB_10.LEN DB_10.LEN
DB_10.0OME  DBE_10.DOKE
DB_10.ERROR DB_10.ERROR
SYS_ETH_Driv: Tag

HEE

DB_10.ERROR.DB_10.ERROR_1
input2 inputz
outputz autput?
input3 input3
inputd inputs
float float =
textll textll v
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or it is possible to choose the variables to be shared by clicking

on the check-box of each individual item :

Shared tags

Tag name Shared tag name
DB_10.REQ DB_10.REQ
DB_10.LADDR DB_10.LADDR
DB_10.DB_NO DB_10.DB_NO
DEB_10.0BBE_M: DB_10.DBB_NC
DB_10.LEN DB_10.LEM
DB_10.DOME  DE_10.DONE
DB_10.ERROR DB_10.ERROR

HEO000

[ SYs_ETH_Drivi Tag

[1 DB_i0.ERROR DB _10.ERRCR_1

[1 symbaoll Symboll

[ inputz inputz

[ outputz autput?

[ inputs inputd

[1 input4 inputd

[1 float float

[1 textio textll

[0 symbols Symbola »

The selected Tags will be shared on the network by pressing
the "End" key.

Memory status

With the “Memory status” option, Polymath makes it possible
to have Device memory occupation state in real time.

Using a graphical interface , the user can immediately identify
the areas that have been allocated or that are free.

If more devices are used, it is possible to choose the one whe-
re "Memory Status" control is to be completed on:
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The "DataArea" is the list of memory Areas that can be confi-

Chaoose the Device and Datafrea

Dievice:

Datadrea: DBw

gured, it is different for each Device and it allows selecting

between Database Area "Types" used to display "Memory Sta-
tus”. After selecting the desired field (e.g. Dbw) press "Next" :

Choaose the Device and Datadrea

Device: 87 300,400 Industrial Ethernet

Datafrea:

Cancel
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Setting a value of "10" in the DB field, a screen opens in the
page showing DBW 10 Memory occupation state.

FreelUsed space

[n]:]

10 Walid range (DEC): 1-65535

EEEEEENEN -
EEEEEENEN -
EEEEEEEN -
EEEEEEEN -
EEEEEEEN -

|

|

|

free used [

(B3

| £

Finish

It is also possible to view the BIT memory occupation,
by selecting “InputBit” in the “Data Area” item:

Choose the Device and Datadrea

Device:

DataArea:

|Input (Bit)
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Clicking “Next”, the following screen appears:

De e tag o patio O
Free/Used space
E 20 Valid range (DEC): 0-16383
Bit
o
o
1
. W
3
4
5
[}
. R
free Used -
Finish

Operator terminal update

The "Operator terminal update” option can be used only with
the "VT" family terminals (regarding the "IT" family terminals,
see chap. 8, “Backup / Restore” page 514) and allows creating
a "backup” file containing the entire project and the VT termi-
nal firmware.

From the “Tools” menu, select the "Operator terminal update”

sub-menu:
Tools | 2
Options | ‘||I-' = -
| Utilities 2 | Check updates
Translations 4 Project Documentation
Tags 2 Corwert panel
Recipes 4 Corwvert device
Alarms 2 Remove unused tags
Downloader Utilities  » Cross reference
Dictionary 2 Shared tags
| Shiow Mernory
g | Update operator terminal R{J
Edit/Find/Replace scripts

«d Tmu
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On the first Screen it is possible to choose between opening
an existing procedure (previously saved), or creating a new
one, the default image is the following :

= Procedure for updating operator terminal

Initial choice

& Open an existing procedure

O Create new procedure

Cancel

New procedure

To create a "New procedure", select the corresponding option
then click "Next" :

= Procedure for updating operator terminal

[nitial choice

(2 Open an existing procedure m

(B Create new procedure

-

Select the operator panel being used in the project and that
needs to be backed up, then click "Next":
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= Procedure for updating operator terminal

Select panel

WT155W PROFIBUS (Portrait’ -~

WTLESW (Portrait)

WT185W ETHERNET

WT185W ETHERMET (Portrait)
WTSOS

WTSOSW CAN

WTSO0SW ETHERMET y
WTS0SW PROFIBUS
WTSL1SW

WTS1SW CAN
WTS1SW ETHERMET
WTS15W PROFIBUS

| <

From the following screen, choose the COM port to be used,
set communication speed, then click "Next":

= Procedure for updating operator terminal

Select communication parameters

Communication port Baudrate

COM1 v

From the following screen, choose the operation to be perfor-
med; either carrying out backup of firmware, the project or
recipes present on the terminal, or downloading the firmware,
the project and one of the previously saved recipes present on
the PC hard disk or on an external support (USB pen drive) to
the terminal:
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= Procedure for updating operator terminal

Select an activity

Backup

[ Firmware and project

[ recipes
Download

[ Firmware and praject Browse
[ Recipes Browse

For example, choose to back-up the firmware and the project
present on the terminal, select the corresponding check-bo-
xes, then click "Next":

rocedure for updating operator terminal

Select an activity

Backup

[l Firmware and project

[ Recipes

Download

O Firmware and project

[ Recipes Browse

From the obtained screen, it is possible to select an existing
folder or to manually insert the path, after the folder is cho-
sen, click "Next" :
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rocedure for updating operator terminal

(Choose output folder

Folder Name C:\Docurnents and SettingsimlanzaiC

A report of the situation of the previous wizards is viewed on
the next page, by pressing "Save Procedure" it is possible to
save the selected folder in the structure :

= Procedure for updating operator terminal

Final Report

Single terminal

UT1ESW

Communication port: COM1
Baud rate: 115200

Activities selected
Backup Firmware and project

Output folder
ChDocuments and SettingsinlanzatDesktopiProg2hESA ElettronicatBatch Executorh21-03-
z011 0216

Finish

Pressing "Save" will save in ".xml" format:
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Saving the procedure file @

Savein: | [ Prog2 v 5 il

it
LY =]

<3

My Recent
Documents

@

Desktop

My Documents

43
My Computer

‘ ‘j File hame: Proge.sml v a
MyNotwolh  Savesstps |Vt updelo prosedure fie v

Pressing the "End" key will create a folder with the files neces-
sary for project Backup.

At this point, open the folder where the procedure has been
saved, or, more precisely, open the path: ESA Elettronica\Ba-
tch Executor\xx-xx-2011 0859\BatchExecutor.bat

Clicking twice on the “BatchExecutor.bat” command a "Dos"
window will open, follow the instructions on video, the backup
file will be saved at the end of the sequence :

:\WINDOWS\system32\cmd.exe - |5

a choice hetween Modem and PC. press on the lable PG.

ENTER to continue, ESC to abort

Check the model of the opelatol panel
Press any key to continue . .

CHEC]( whether there are backup on HD and eventually restore one of them
Mo Restore Executed, Press ENTER to Continue or ESC to EXIT
[BackupFufindProject

[Firmuware and project has heen zaved in
:»Documents and Settingssmlanza“Desktop Prog2-~ESf Elettronica~Batch Executor>2
—03-2811 B216\Backup_210832011_1713
Lio donet?
ClugeCummunlcatlun and end proces

Press any key to continue . . .

69
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'3:3 Note: The panel needs to be set on the transfer page. Open an exi-
sting procedure

To open an existing procedure, select the corresponding op-
tion then click "Browse" :

= Procedure for updating operator terminal IQII:.[Z\

[nitial choice

® Open an existing procedure m

() Create new procedure

Initial choice

) Open an existing procedure

Select a procedure file [E

Lok in; | 55 New Falder 3 Od

I 'E ICIESA Eletironica

My Recent
Dacuments

Desktop

My Documents

My Computer

File name 11Tl | [ openp |

|~ | B Fies of ype: | Select Procedure file " xmi) v| [ Cancel |
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Subsequently it is possible to choose the terminal type, the
default option is the one previously saved:

rocedure for updating operator terminal

Select panel

WTSO Rev.2

WTED CAN

WTED Rev.1

WTo0 Rev.2

WT155W

WT155W (Portrait)
WT1SSW CAN

WT155W CAN (Portrait)
WT155W ETHERNET
WT155W ETHERMNET(Portrait)
WT155W PROFIBUS

WT155W PROFIBUS (Portrait
_ I

|*

From the following screen, choose the COM port to be used,
set communication speed, then click "Next":

= Procedure for updating operator terminal

Select communication parameters

Communication port Baudrate

v| [115200 v

Cancel

For example, choose to Download the firmware and the
project previously saved with the back-up, select the corre-
sponding check-boxes, then click "Browse":

ESAPOLYMATH - User Manual - rev. 2.1



72 | Chapter 3

Layout of menus

= Procedure for updating operator terminal

Select an activity

Backup

O Firmware and project

[ recipes

Download

[ Firmware and project

O Recipes

Pressing “Browse" will open a window where Backup files are
associated in the folder.

i Select Firmware and project file @@
Look in: [ 3 12 5 o2 Er

Y IC)ESA Elettronica
¢ 2) I library

My Recent
Documents

o

1

:

:
(e |

File name: |Backup_22032011_0308 bin v Ope

MyMNetwork | Filesofwps: | Fun and Project fle (“ir) v [ cenee |

bl Firmware and project  C:\Documents and Settings\m Browse

[ Recipes Browse

From the obtained screen, click "Next" :
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= Procedure for updating operator terminal

Choose output folder

Folder Mame Ci\Documents and Settingsimlanzail

A report of the situation of the previous wizards is viewed on
the next page, by pressing "Save Procedure" it is possible to
save the selected folder in the structure :

= Procedure for updating operator terminal

Final Report

Single terminal

VT30

Communication port: COML
Baud rate: 9600

Activities selected
Download Firmware and project

File path: C:\Documents and SettingsimlanzatDesktoph124ESA Elettronicalp atch
Executori21-03-2011 12084Backup_22032011_0908.hin

Output folder
C:h\Docurments and SettingsimlanzahDesktophESA Elettronica\Batch Executor\22-03-2011
0321

Finish

Pressing the "End" key will copy the necessary files to
Download the project.

At this point, open the folder where the procedure has been
saved, or, more precisely, open the path: ESA Elettronica\Ba-
tch Executor\xx-xx-2011 0859\BatchExecutor.bat.

Clicking twice on the “BatchExecutor.bat” command
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will open a "Dos" window, follow the instructions on video, the
previously saved file will be transferred at the end of the se-
quence:

C:\WINDOWS\system32\cmd.exe ﬂ

connect the PC COM to MSP port of the terminal operator
f or PC COM ?pin usze CUCOM111AZ cahle
f or PC COM 25pin use CUCOM2Z5F?H adapter + CUCOM1i11B82 cable.
[ECHO is off.
iGo to TRANS PAGE and then select panel port.
If the panel offers a choice between Modem and PC. presz on the labhle PC.
You are now in transfer page

of f.
NIER to continue. ESC to abort

the model of the operator panel
Press any key to continue . . .

CHECK whether there are bhackup on HD and eventually restore one of them

Mo Restore Executed. Press ENIER to Continue or ESC to EXIT
DounloadFunndPloJect

CloﬂeCommﬁﬁ1cat10n and end proces

Press any key to continue . . . _

Modify/Find/Replace scripts

This function allows to manage (find, modify, replace) the
scripts present in the project.

On the left main window it is possible to modify the search pa-
ge between default Scripts and GlobalScripts set on "ESAStar-

tup”.
= Edit/Find/Replace

= Scripts

*Soript
*Seript_1
GlobalScripts

On the right main window there are five keys that have the
following functions :
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= “Find next”: allows carrying out an alphabetic single se-
arch on the Script name.

= “Replace”:" allows carrying out a single replacement of
a script or of part of it.

= “Replace all”:* allows carrying out a complete alphabe-
tic replacement on the name of the Script (the replace-
ment result is indicated by inserting a "*" next to the
page name).

= "Search all" allows carrying out a complete alphabetic
search (the search result is indicated by inserting a "*"
next to the page name).

= Close : Closes the current screen

On the centre main window there are two fields the mandatory
one is "Find" and the optional one is "Replace with" :

Find what: | -

Replace with:

O Match case lwl Search hidden text
O Match whole ward [ Search in selection
[ Use |Regular Expressians w [ search up

= “Upper case\lower case”: by enabling the check, words
containing upper-case or lower-case characters will be
searched.

= "Whole words only" : by enabling the check only whole
words will be searched.

= "Use Regular Expressions" or "Wildcard characters" :
"Regular Expressions'" are syntaxes used to represent
groups of strings. In computing, a "Wildcard character"
or "jolly" or "wild" character is a character that doesn't
represent itself inside a string, but a group of other cha-
racters or character strings (with the only exception of
special meaning characters like "." and "/™).

= "Search in the hidden text" : Enabled by default, it se-
arches the commented row.

= "Search in the selected text" : Searches inside a se-
lected text and highlights the found part.

= “Search up”: allows reversing search direction.
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Translations Sub-menu

Expart

Irnport

Table 18: Trandlations menu functions

Icon Menu path Function description
NA® Translations -> Exports Translations
Export
NAT Translations -> Imports Translations
Import

1.Icon Not Available

Translations are converted in CSV. format easily transferable
and convertible from each software.

Tags Sub-menu

Export

Impart

Table 19: Tags/Variables menu functions

Icon Menu path Function description

NAL Tags/Variables -> | Exports Tags/Variables
Export

NA® Tags/Variables -> Imports Tags/Variables
Import

1.Icon Not Available

Recipes Sub-menu

Export
Imnport

Recipes editar
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Table 20: Recipe menu functions

Icon Menu path Function description
NA® Recipes -> Export Exports Recipes
NA® Recipes -=> Import | Imports Recipes
NA® Recipes -> Allows to manage the recipes

Recipe Editor

1.Icon Not Available

Alarms Sub-menu

Export
Irnpork

Table 21: Alarms menu functions

Icon Menu path Function description
NA® Alarms -> Export Exports Alarms
NAL Alarms -> Import Imports Alarms

1.Icon Not Available

Downloader Utility Sub-menu

Online kools

Backup/Restore

BackupfRestore YT

BackupfRestore YT with Modem
Upload ©fS image for IT panels
Bootloader For IT and XT

Bootloader For WTwxeoW in DIRECT mode
Bootloader For WTwxeoxW in ASSISTED mode
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Table 22; Utility downloader functions menu

Icon Menu path Function description
After having connected to the
ESA panel, it allows to carry out
the following operations: To
transfer the project, to explore
- the panel, to compare the me-
NAlL Utlllty.downloader mory used with that which can
-=>0Online Tools .
be used, to compare the files
which make up the project to be
transferred with those already
present on the ESA terminal, to
fill in the project.
- Perform backup or restore the
1 Utility downloader .
NA ->Backup/Restore project for CE / IT products
Utility downloader Perform backup or restore the
NAT ->Backup/Restore | project for VTxxx products
VTxXXX
Utility downloader Perform backup or restore the
NA® ->Backup/Restore | project for VTxxx products by
VTxxxW with means of the modem
modem
Sends O/S image Updates the image of the
NA® for the Windows IT | operating system for IT
panels panels only
Utility downloader Updates the boot Windows CE
NAL ->Update Boot for IT and XT panels
Windows CE for IT
and XT
Utility downloader Updates the boot of the VTxxx
NA® ->Boot loader terminal without the help of
directly for WTxxx help messages
Utility downloader Updates the boot of the VTxxx
NAlL ->Boot loader for terminal with the help of help

WTxxX in assisted
mode

messages
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? Menu
Register
about
Help F1
Table 23: ? menu functions
Icon Menu path Function description
NA® Allows the user to register the

?-> i i
Register installed polymath product

Allows the information
NA® ? -=> Information regarding the version of the
program to be seen

NAL 5 Allows to access the POLY-
? -> Help .
MATH guide

1. Icon Not Available

The Toolbar The Toolbar consists of buttons allowing the user to access all
POLYMATH operations.

0oodoaaasoo 800a@ vuui:-ad d dec0agcuadad
d EQN00E0Ea 6 ede0eaaa0 ssQa
10-0ddddddd 8asaea~ -J ) goae

When the mouse is placed on one of the icons, its meaning is
displayed, see below:

(o —
acda

Open Project. .,

D
[~ &L

1 I"I

o |
b =S

2,

Note: The Toolbar offers a shortcut to the same Functions that you
can access from the main menu. To find out what a given icon
means, consult the Table of Functions in the main menu (see chap.
3, “Main menu” page 14).

&
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Editing the Toolbar

The Toolbar is organized into groups of icons, each of which
can be managed individually.

To move or delete a group of objects, just drag up from the
bar towards any area of the application. To start the drag,
click on the left edge of the group.

Once you have clicked, the mouse pointer will change into the
dragging cursor typical of Windows. It is now possible to
insert the group wherever you want.

acan.s

Release the mouse key to apply the move. The group can be
left in any position on the screen or closed by clicking on the
related ‘ g - Closed groups can be reinserted into the toolbar
by clicking on the corresponding name in the main menu
(Display->toolbar). The changes to the layout of the toolbar
are saved for the next time POLYMATH is used.

Anchorable Besides the menu and the icons, the other fundamental
windows component of POLYMATH is the Anchorable window.
Anchorable windows are:
= Project explorer (see chap. 5, “Project Explorer”
page 107)
= Properties editor (see chap. 6, “Properties Editor”
page 241)
= Events editor (see chap. 6, “Properties Editor”
page 241)
e Library explorer (see chap. 7, “POLYMATH Libraries”
page 441)
= “Errors Viewer” (see chap. 7, “Errors Viewer” page 458)
e “Compiler Output” (see chap. 7, “Compiler Output”
page 459)
The Anchorable windows are described in detail in the
following chapters together with their respective function. In
this section we will simply explain how Anchorable windows
are positioned and managed.

ESAPOLYMATH - User Manual - rev. 2.1



l.‘ir/.

Chapter 3

Layout of menus

Displaying Anchorable windows

When the program is started up, all the Anchorable windows
are displayed in the layout of the application, though the
software layout can be changed to suit the user.

Each of these windows can be closed at any moment using the
Ed button and hidden using the ﬂ button. Hidden windows
remain on the sides of the screen in the form of clickable
folders. To make a window appear again in its fixed position,
click on the icon El-

Note: The Hidefunction isrecommended where the resolution of the
screen is poor and space needs to be reserved for the Work area.

Once Anchorable windows have been closed, they can be re-
introduced by clicking on the respective icon in the Tools menu
or using the submenu: Display -> Show. Alternatively they
can be re-introduced using the menu that appears after
clicking with the right-hand key inside the toolbar (first
activate the corresponding check).

By clicking on the icon ﬁ (Display -> Show All) all the_
Anchorable windows are re-introduced, while the icon
(Display -> Hide all) deletes them all without distinction.

Moving Anchorable windows

Anchorable windows can be moved within the POLYMATH as
the user thinks fit. To move an Anchorable window, select it
by clicking on the title bar of the window in question. See
below:

Project Explorer

DE@lagaae

POLYMATH is organized into four virtual areas inside of which
a window can be anchored. These virtual areas are situated
respectively to the left, to the right, below and above the Work
area.

81
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To select which of the four areas to move the window to, use
the mouse to place the grab (see picture) on one of the four
arrows of the directional pointer (see picture) in the middle
of the screen. When the mouse key is released, the window
assumes its new position immediately, keeping it until the
next operation. Each time the mouse reaches an area of the
directional pointer, the corresponding destination area is
highlighted.

If the window is dragged within another Anchorable window,
a new directional pointer containing a fifth, central button
appears. When the grab is dragged onto one of the arrows of
the directional pointer and the mouse key is released, the
window is simply set next to the existing one in the
appropriate direction. While if it is dragged onto the “fifth”
button of the pointer, the window is incorporated as a
clickable folder as indicated in the figure below :

The windows that are in the form of a clickable folder can be
moved by merely dragging the folder to a new position.

The changes made to the program layout are saved for all
future use of the software.
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4. Managing the project

The user can completely program the behavior of the terminal
by using POLYMATH which will produce at the end a project
file.

The user can create a project file, edit it as he or she pleases
(using the functions we will describe later on), save it and lat-
er reopen it for any further editing.

The aim of this chapter is precisely to furnish the information
needed to create and manage the POLYMATH project files cor-

rectly.
Choice of When the Polymath starts up, in the case of version 2.0 or
interface above, you are offered a choice of graphical interface: "DOU-

BLE CLICK" or "EXTENDED". The initial page is shown below :

x|
o Cidosat |
g
; =
= DOUENCRICT
= e
O
0O
b (Clicktostart |
™,
T T

EBXSIENDEBD

EXTENDERE

O Use this style as the predefined one and don't ask the next start

Click one of the two options to activate the required interface.
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Double Click

Interface TR e
00ACaaLQEON 4.8 00 38l EECIEED U8

.

The main feature of the "DOUBLE CLICK" interface is that with
a few and simple steps it is possible to edit any object proper-
ties.

In this mode in the right part of the development environment
the graphical libraries are in the foreground.

To use a library object simply select one of the present objects
and drag it on the page to then edit it and configure it at will.
Using this type of interface is recommended to those users
who are familiar with the use of Popup pages for the configu-
ration or the editing of objects :

|
#Oupt
-

When you have inserted an object you can double-click it to
edit its properties straight away :
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Extended The main feature of the "EXTENDED" interface is its net divi-
Interface sion between the graphical characteristics of the object that is
being edited and the object events.
In this mode, on the right part of the development environ-
ment the Property Editor object is in the foreground, it is pos-
sible to select the Events assigned to the object being edited
at that time in the bottom section.
To use a library object simply select one of the present objects
and drag it on the page to then edit it and configure it at will.
Using this type of interface is recommended for all those users
who prefer a structured interface :

(184,175,193)

Hessun Lampeggio

(255,255,255)
oo
v

s

@ ¥ a - v
)
7= Biamap MNessuno
i =Y Etichetta Messuno

SystemTahoma

Hessun Lampaggio
Weeo
Centro

Centra

Editor Propric A Editor Event
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Changing the You can swap between the "DOUBLE CLICK" or "EXTENDED"
type of interfaces at any time :
interface

EL

Feucibsion Pdsarhaztoramenis] (030]

To change interface, click Tools and select Options :

IDD|S| 2

| qtions |
Utilities 3
Translations »
Tags 3
Recipes 4
alarms »
Downloader Utilities  »
Dictionary 3

Select VARIOUS :

= ESAPOLYMATH Options

[ Draw only field's border while moving

Language [l Copy&Paste using a new narme
Kin [] Use manual validation of project's components

— [] Mask passwords editing

[ Show page's fields tooltip

[ Use the panel's picture into the page editar
[/] Show the invert function

[] Show the structure images

Hax open dialogs 10

GUI style EXTENDED v
EXTENDED

Changes of GUI style will be available after the restart of the application
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Select the interface from the drop-down menu :

= ESAPOLYMATH Options EEX

[ Draw only field's border while moving

[] Capy&Paste using a new name

[] Use manual validation of project's companents
[] Mask passwords editing

[ Sheow page's fields taokip

[] Use the panel's picture into the page editor
Shaw the invert function

Show the structurs images

Language

Skin

Wax open dialogs 10

GUI style

bl Ask far style at startup

Changes of GUI style will be available after the restart of the application

Check the "Choose style at start-up" box if you wish to have
the choice of interfaces when the Polymath starts up.

Leave the checkbox void if you prefer to set your current choi-
ce of interface for next time.

Creating a The first step using POLYMATH is to create a brand-new
project in project. The user is offered two ways of creating a new
Wizard mode project: one guided (the Wizard) and one completely manual.

Opening the Wizard

Wizard mode will guide you in creating your projects and in or-
ganizing the various hardware components.
There are three ways of activating the Wizard :

= Click on

= File->New from the main menu

e Click on to enter the Home Page of the program and
Click on ‘Open Wizard to create a project’ to start up the
guided project creation.

Using the Wizard

To create a project in “Wizard” mode 5 operations need to be
carried out : choosing the “Type of project”, choosing the
“Panel”, choosing the “Device”, “Project information” and
“Confirmation of the choices”. While in any given window of
the Wizard it will be possible to review the preceding step sim-
ply by clicking on the ‘Preceding’ key.
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As soon as the guided project creation starts up, the Wizard
welcomes you.

S=ES |

Welcome

This wizard will guide you through the crastion of & project for
ESAPOLTMATH.

Click Next > to continus

To start creating the project just click on the ‘Forward’ button
as highlighted in the figure.

[Screatenem e 1ol

Freject Type
Chese the typm of propect that you mant to create
o W &

EXDEED et o Mot o
deces e

Dascription

The first choice to make relates to the type of project to be
created; the options available are Simple Project, Network of
Devices or Network of Panels.

Once the choice has been made, click on ‘Continue’ to pro-
ceed.
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[Screatenempraet =lcix
Panel
Choose the panel to use
= T
+mmCE
L
i PG
4 W Visualyser
OF Rl

Now state which ESA panel is to be used; once this choice has
been made, click on ‘Continue’ to proceed.

g e
ITROST (5F1, 592, ETH1)
OF  Raplic
# mm ITL0T
+ 1110
i omm Tz
+ W T
P
= Visualyser =l
Retation
@ o
O war

If a panel in the "IT" family is selected (excluding panels in the
"IT105K" family), it is possible to have both the horizontal
(0°) or vertical (90°) display options.
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=100
Deevice
Choose the device to use
. CODESTS
< . LG
« W MOTION CONTROL
= W MOTOR DRIVE
o OTHERS
-
< M THLRMOREGULATOR
3 M WEB SERVER

The device to be connected must be selected; different cate-
gories are supplied for the selection. For each category, the
devices are divided by Manufacturer's. Once the selection has
been made, click on "Avanti" (Next) to continue.

& Note: the categories proposed in the window differ according to the
type of panel previously selected.

& Note: When auser chooses a devicethat allowsthevariablesimport
from database to owner, the mask described below will appear and
it will be possible to decide whether to import the variables at this
stage of the project or to postpone the operation : :

The device 57 300,400 supports importing from DB, Do You want to import tags now 7

—

[ Don't ask again

All the data required for the project has now been inserted.
POLYMATH will configure the hardware for the project. You will
then be able to edit the project accordingly.
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Changing At any given moment it is possible to add, change or cancel

elements elements and connections which are part of project’s Hard-

within a project  ware configuration; all you need to do is double-click on the
option ‘Hardware Configuration’ in the ‘Explore project’ win-
dow (see chap. 5, “Project Explorer” page 107); the Hardware
Configuration window will now appear and, using this, it will
be possible to carry out the operations described below.

ProgettosHW Configuration R

E;l] Progetto

= | IT107T(SP1,5P2,ETHL)

. ) .
=2 SwConfiguration

?;' Tags
+ 0 Languages and fonts

= g Pages

% Inizio
m PopUp pages
E Frames
m Alarms
QF‘ Recipe types
';8 Users and passwords
fj Drata archive
{ } Scripts
{3} Global script
D Lists
R Images
+ _% Advanced

i

i

i

i

A window appears in which all project hardware elements are
present :

There are three options for adding new devices to the project :
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= Use the right mouse key to click inside the white confi-
guration page and select "Aggiungi Nuovo Oggetto"
(Add New Object) from the menu

Zaoam In
Zoam Ouk
#dd Mew Chijeck

= Click on the q- key present in the tools bar

= Select Fields -> Create...from the main menu
A dialogue window will open from where it is possible to select
ESA devices and panels :

I 1)

Aidd New Obinet

Category

VTWIN panels =]

IT Panels
Visustysar Pansls
Cavicns

Now the introduction procedure of the object selected, results
identical to that described previously in the "Wizard".

Modification an nnection of th roj mponen

Once all of the useful elements for the realisation of the
project have been introduced, they must be connected and
the connection modes must be specified.

The "ConfigurazioneHW" (HW Configuration) window displays
the VTs and previously-inserted devices. The ports available
are indicated for every element (MSP,ASP,COM, etc..).

Moving a VT or device

To move a VT or a device to the inside of the Configuration
Window just click on and then on the element to be
moved. At this point the element has been selected and you
need only drag it (keeping the left mouse key pressed down)
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till it reaches the desired position; when the left mouse key is
released the element will remain in the new position unless it
is again moved. If elements containing connections are
moved, POLYMATH will automatically update the position and
the connections showing in the window.

Moving a port

To move a port, click on ; at this point the icons represent-
ing the ports can be selected, as in the following example.

IT110T(SP1.5F2.ETH1.E

| RTU Master {fast pe
4 ETHI SP1 I » 3
4 ETHZ SPZ [P

4 com

Lol

After clicking on the port to be moved just drag it (keeping the
left mouse key pressed down) till it reaches the desired posi-
tion; when the left mouse key is released the port will remain
in the new position unless it is again moved.

IT110T(EP1.6P2.ETH1.E

—

4 ETHL 3
4 ETHz sPZ B

SP1 ’_|_‘ e6E

RTU Master (fast pe

Lol

If ports that are references to existing connections are moved,
POLYMATH will automatically update the position and the con-
nections showing in the window without altering their nature.
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Connecting two elements

If the page contains at least one ESA panel and one device you
will be able to specify the mode of the connection between
them. If you want to add a connection you have first to click
on and then go on to click inside a free port (one that is
not already a reference to another connection). When the
pointer nears an available port, a small rectangle will appear
next to the pointer containing a connection thread as shown
in the figure.

IT110T(SP1.5F2.ETH1.E

| RTU Master ffast pe

[P

a
a

4 ETH1
4 ETHZ SEZ »

SP1 k

4 comMm

Without releasing the left mouse key, you can proceed to
specify the connection path (a horizontal line appears).

IT110T(SP1.5F2ETH1.E

| ATU Master fast ps

. |

4 ETH1
4 ETHZ SP2 4
spl P

a
a

B oM
%

To establish the second terminal of the connection release the
mouse as soon as the black line reaches the port you wish to
include in the connection. When the pointer nears an available
port, a small rectangle will appear next to the pointer contain-
ing a connection thread.

ESAPOLYMATH - User Manual - rev. 2.1



Chapter4 | 95
Managing the project

IT110T(5P1.5P2 ETH1 E

ATU Master fast ps

ol
4 ETHL g
4 ETHZ =PZ B

sSP1 ’_|_‘ com

The connection will appear as a broken blue line between the
two reference ports.

| mportant note: In Simple Project mode it is not possible to create
connections between two panels or between two devices; were such
a need to arise, it would be necessary to create a network project.

Operations on VTs and devices

To change a VT or a device in the Hardware Configuration win-
dow you need first to select it: click on and then on the el-
ement itself.

Once the object has been selected, just click with the right-
hand key on the same to be able to access the following edit-
ing menu :

Edit
Duplicate

Delete

Zoom In
Zoom Cuk
Add MNew Object

Convert device
Show Memory

Using the ‘Edit’ option you can make changes to the properties
of the object; ‘Duplicate’ creates within the Configuration Win-
dow an identical copy of the object that has been selected (all
the properties of the first are copied into the second). The
‘Cancel’ option eliminates the element from the project, while
the ‘Cut’, ‘Copy’ and ‘Paste’ keys have their usual functions,
typical when operating in Windows. Besides these there are
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the Zoom options which allow you to edit the dimensions of
the display of the objects, “Show memory” displays the Tags
occupied in the device memory.

Eliminating a VT or device

To eliminate a VT or a device from the Hardware Configuration
window just click on and then on the element to be elimi-
nated. To eliminate it, once the object has been selected,
press the ‘Canc’ key of the keyboard or alternatively click with
the right-hand key of the mouse on the element, then, using
the drop-down menu that appears click on ‘Cancel’.

Eliminating a connection

To eliminate a connection from the Hardware Configuration
window just click on and then on the connection (line) to
be eliminated. To eliminate it, once the connection has been
selected, press the ‘Canc’ key of the keyboard or alternatively
click with the right-hand key of the mouse on the element,
then, using the drop-down menu that appears click on ‘Can-

cel’.
Changing a Changes to the general data of a project can be made at any
project’s data moment throughout the project editing process (over and
above changes to its components as seen in the last para-
graph).

To access the editing menu of a project, double-click the
‘Project’ option within the ‘Explore project’ menu (see chap. 5,
“Project Explorer” page 107). There are three editing masks:
User Information, File Information and Components

User Information

Information

Name Project

Comment

Authar LMASK
Company

Version

Created

Modified
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Using the User Information mask you can edit general data re-
lating to the project, such as Name, Comment (optional), Au-
thor, Company and Version. The data relating to the creation
and editing of the project are not editable.

File Information

[ sﬂﬂ TE]
Wisr wiformation Comeenents

Information
File Mame.
Fil Eath

Fila Creatad

File Modified

The File Information mask contains the data relating to the
current file in which the project is saved; such data contains
information regarding the name of the file, the remote path in
which the file is saved and the creation and editing dates of
the file.

Note: The name of the project and the name of the file are two quite
distinct things: the name of the project is a project identifier used
only within POLYMATH software while the name of the file serves
to distinguish the file within the File System of the user’s PC.

Components

HW Configuratior,

User infarmation  File information  Kefifafadal =i

Compuonents

HWConfiguration
IT110T{SP1,5P2,ETH1 ETHZ
RTU Master (fast peripherals

The Components mask lists all the devices and ESA panels in-
volved in the current project and added in the course of the
creation of the project. By clicking on each element in the list
you can access the corresponding editing mask.
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Saving a At any point throughout the process of editing the project the
project user can save his or her work onto hard disk or a removable
support.

There are three options for saving the project into a file:
- File -> Save from the main menu

- Press CTRL+S on the keyboard together

- Click on

When the project file is overwritten, POLYMATH automatically
creates a backup file with the extension *.vtprj.bak saving it
into the folder the user is working in. In this way there is al-
ways a reserve copy of the original project; to use and edit the
backup copy just rename the extension, changing it from *.vt-
prj.bak to *.vtprj and reopen the project in POLYMATH.

A | mportant note: When the Save command described above is used
the currently open file is overwritten (or written onto a new filein
the case of a new project); to maintain the original file you must
choose File->’ Save as...” from the main menu and supply a name or
a different path.

Opening a When the application is launched or in the course of the work
project on POLYMATH you can proceed to work on a project previously
saved onto Hard Disk or onto a removable support.
There are three options for opening a new file:
- click on
- File -=> Open from the main menu
- click on to go to the Home Page of the program. Then
click on ‘Open existing project’
In all these cases an exploration window opens that allows you
to select project files (*.vtprj) from within your resources.

Note: When you enter the Home page of the program by means of a

B/
click on a list of recently opened files ordered chronologically
according to their last editing date. This procedureissimplest and
quickest if you often work with the same files.
Network The network project makes it possible for several terminals to
project communicate, share and manage data simultaneously.

One's own project is present on each terminal, where Tags are
shared and can be monitored by all of the network partici-
pants.
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Creation of a The sequence of operations to be carried out to create a
network "Network Project" will be shown in the following images.
project

To create a new project, having opened the "Wizard" mode,
select the option "Panel network™ and then press "Forward".

= Create New Project P ] 7|
Progect Type
Choose the type of project that you want to creste

Simple Project  Hetwork of
devicet

Chaote & name and, optionally, & description for the propect

Name Fraject

Descriptsn

Click "Add" to download the projects that make up the
network, one at a time :

s 5

Metwork Project - List of project

Selnct ESAPCLYMATH projects b mchadn m restwork projact,

Once the projects have been downloaded click "Forward™ (in
this example we will put two projects on the network,
"Server_IT107.vtprj" and "PC Client.vtprj") then click "End" :
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Netwark Project - List of project

Select ESAFOLTHATH projects to include in netwark praject.

We will now examine the individual projects which make up
the network project, in particular the part of the project refer-
ring to the shared variables.

ServerlT107 From "Explore project" double-click the voice "Tag" from the
Project "Tags" option :

ProgettodIT107W(SP1,SP2,ETH1) Tags A

’:?__:L Progetta

L HWConfiguration

= | IT107W(SPL,SP2,ETHL)
ﬁ‘ SwConfiguration
= ?; Tags

/@

u Languages and fonts

=295
g] Inizio
m PopUp pages
E Frames
m Alarms
QF‘ Recipe types
';n Users and passwords
E Data archive
{ } Scripts
{3} Global script
|:| Lists
f"? Images
i3 Advanced

Tag

Progetto\IT107W{SP1,5P2,ETH1\Tags4 Tag
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From the editing area, the features of the tag to be shared can
be observed on the "General™ mask. In our example, the tag
will be "Internal™ :

Select the ("Share Tag") option and assign a name (in this ca-
se "Server_Tag") so that it can be seen by the other partici-

pants.
PC Client From "Explore project” double-click the voice "Tag" from the
Project "Tags" option

Daooaoe

ProjecthPCClient_(ETH1MWTags i

l:_i] Project
[k HwcConfiguration
=1 | PCClient_{ETH1)
‘-":‘ SwCaonfiguration
= 5‘} Taags
7

k&) Languages and fonts

g Pages

m PopUp pages
= Frames

m alarms

% Recipe types
L @ Users and passwords
Ej Data archive
[ } Scripts

{3} Global script
D Lists

/v? Images

E3 } Advanced

+

=

=

)

=

Tag

Project\PCClient_{ETH1}\Tags\Tag
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From the editing area, the features of the tag to be monitored
can be observed on the "General" mask. The tag must be the
"Network" type :

Tres st =

[ Altgw the tag's vakse ta ba shared through the intranet/ otaerat
Network We will now examine the previously created network project
Project which contains the two sub-projects just shown :

MetProject\ ITLOSS(SP1,SP2 ETH1\etworkTags |
E;l] MetProject
= | IT107T(SP1,5P2,ETHL)
EH MetworkTags
= | IT1055(5F1,5P2,ETHL)
= EH MetworkTags

#

Tag

MetProjecthITL0SS(SP1,5P2,ETHLWNetworkTags4Tag

From "Explore project”, double-clicking the voice "Tag" from
the "Network Tags" option, the editing area is accessed.

On the "Link" mask, the features of the tag to be monitored
can be determined :
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Link

Type node INatworkTag d
Mode IITIU?T(SPIJSPZ,ETHI) |
Tag name ISEFVEYﬁTaI] j

The tag must have the following features :

« It must be the "Network" type.

» The node must be indicated. The node is the point whe-
re the tag is shared (in our example the shared tag is in
the IT107T terminal).

= The name of the tag to be monitored must be determi-
ned (in our example the name of the tag to be monito-
red is Server_Tag).

Compilation of The compilation and the download of the projects that make
the network up the network project must be carried out inside of the
project network project.

Click on the icon to fill out the project :

<= ESAPOLYMATH - NetProject [...etProject\NetProject.vipri]

File EdR Sergt Fekds Lwout Image View Took 7

000cgdeuo-Cconla @a-a

Qb =@z @dE@dIdl A8 CddaddldudsSE | deE
e bl D e 2 Y b ] Lo -l - B3-S - D WD (S =

|ropcteeeee 2] mw«u NetmerkTag Tes | ITIOSSISPLERLETHY ‘0%
Coooe [

WatProje.

o ¥cirenct | Information
r b me

The following mask will appear from which one can choose to
fill out all the projects that make up the network or, if only one
project has been varied, to fill out only the modified one :
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Wizard download network project - New Wizard Page x|

Choose network panel to download/compile

Comple | Name |
FC_Client
1T107T(SP1 SP2ETHT]

- =R

Click "forward".

At the end of the compilation, the following mask will appear :

‘Wizard download network project - New Wizard Page x|
Status

Binary compiler:

pages:

page Inizia

alarm signal AlarmSignal
alarn signal Alaraignal L
alarn signal Alaraignal Z
alarm signal AlarmSignal 3
frames:

fraue sienal Alarmfignal
frame sigmal AlarmSignal 1
frame sigmal AlarmSignal 2
fraue signal Alarafignal 3

Done

[ -

At this point, by clicking "end", the projects that make up the
network are ready to be transferred to their respective termi-
nals.
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Click on the icon ﬂ to transmit the projects to their respec-
tive terminals :

ESAPOLYMATH - NetProject [...etP

NetProject.viprj]

00adauie-CeD0a @a-a-
G0 28R Canr@ AR ODNBOBAEE0DESC
SR8 HAG-B-8-0-00@! =

progetiper ¢ = | WetmariTazs | Tap | riGSS(sELSEATIE) |

oGo0De T T

[Metproject

& [ ILoTTiseL ez ETHI} Hame Hathrogect
Fetwark Tags =
= 1] Mmnssise, SeL T
S tetmarkTags
T T
Author Eza
Campany
Wersion
cresed
Madfied

The following mask will appear from which one can choose to
transfer all the projects that make up the network or, if only

one project has been varied, to transfer only the modified
one :

= wizard download network project - New Wizard Page x|
Choose network panel ta download/compile

Download

Compie [Name ]
PL_Client
IT107TISP1.5P2ETHI]

Click "End" when the transfer is complete :
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rd download network project - New Wizard Page:

Status

Binary compiler

pages:
page Inizie
alarm signal
alarm signal
alaru signal
alaru signal
frames:

frame signal
frame signal
frame signal
frame signal

Alarnsignal
Alarnfignal 1
Alarufignal 2
Alarufignal 3

AlarnSignal
AlarmSignal 1
Alarmsigal 2
Alarnsigal 3
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Project Explorer

The principal anchorable window in POLYMATH is the Project
Explorer window from which the structure and operations of
the project can be controlled. In this chapter we describe in
detail all the characteristics that can be configured using
Project Explorer.

Project Explarer

caooae

Progetto w
E_‘l] Progetto
1k HwConfiguration
= J IT110T({SP1,5P2 ETH1,ETH2)
?’;‘ SWConfiguration

+

i; Tags

¥

U Languages and fonts

g Pages
m PopUp pages

= Frames

m alarms
"\12‘ Recipe types
l Users and passwords
ﬁ Data archive
{ } Scripts
{3} Global seript
-1 uists
+ R Images
= _% Advanced
?; Fipelines
& Q Reports
& [~ Remote notification
w5 keyboards
!‘Q‘ Weekly tasks

n

¥

m

Progetto

The Project Explorer window contains all the editable objects
arranged as a tree diagram in which the parent element is
always the project to which the Hardware configuration is
anchored, the ESA terminals (with their attributable
properties) and the connected devices (with their related
settings).

Note: A single click on an element in the tree selected it, while a
double click allows you to edit.
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If Project Explorer should fail to appear on the screen because
it has previously been closed, it can be brought back to the
screen by clicking on the icon "r;ﬁl of the toolbar or using the
main menu by clicking on Display->Show->Project Explorer.
Like all anchorable windows, Project Explorer, too, can be
moved, reduced to an icon or closed (see chap. 3, “Moving
Anchorable windows” page 81).

There are six buttons present in the upper part of the window :

e The button is used to add one element to the
category selected in the tree chart. If the entire project
is selected, this key can be used to insert new VTs or
devices.

e The button is used to enter editing mode for the
element selected in the tree chart.

e The button is used to shift an element upwards.

e The button is used to shift an element downwards.

« The B! button is used to put the objects in order.

- The B button is used to put the page numbers in order.

[~

-

ProjectsHW Configuration
Project IT110T (SP1, SP2, ETHL, ETHZ) (I
ProjectiIT110T (SP1, SP2, ETHL, ETHZRSWCan'
Project\ITL110T (SP1, SP2, ETHL, ETHZMTags
ProjecthIT110T (SP1, SP2, ETHL, ETHZWPages
ProjectiIT110T (SP1, P2, ETH1, ETHZPoplUpP
Projecth\ITL110T (SP1, SP2, ETHL, ETHZMImages ™

There is also a drop-down menu from which any of the
categories making up the menu can be selected.

Hw' Configuration

ProjectsHWConfiguration

Project Explorer; Library Explorer

Information relating to the element selected is displayed in
the lower section of the window. Here you will find the name,
the comment and the path of those objects chosen when
creating the project.
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There is a series of cumulative functions applicable to all the
categories or elements of the Project Explorer window
irrespective of their nature. These functions are contained in
a menu called up by clicking with the right-hand key on the
object in question as illustrated in the figure

Project Explorer

Cdooaa

ProjecthIT107T(SP1,5P2 ETH1 4\ Tags
% Project
I Hw Configuration
= || ITLO7T(SP1,5P2,ETHL)
‘;:‘ SwiConfiguration
H ‘?E_Edit

! Add New

4 add New ard Edit
- hgW Le
= Z P
| Create Falder
& -
= ' copy CTRL4C
4 o CTRL+Y
* QF. ® Paste as child
fa [}
e ﬁ o Import
o { } z|  Export
{8} ¢ Configuration columns

The functions that can be selected are:

Edit, to enter editing mode

Add new, to add an element to a category

Add new and Edit, to add an element to a category and
directly access the editing page (in the Work area)
Rename, to change the name of the object selected
Duplicate, to create an exact copy of the element
selected; the properties that must remain unique within
the project (e.g. Name, ldentifying Number,
Description) are not copied but are automatically
assigned a valid value

Delete, to delete the element selected

Create folder, for organization reasons, it is possible to
split all the components of a project in different folders;
You can :

- Create new folders.
- Rename the folders.
- Cut/Copy/Paste the objects in the folder
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- Delete the objects and the folders.
- Move the objects among the folders

= Cut, to eliminate the element selected and copy it into
the clipboard

= Copy, to copy the element selected into the clipboard

= Paste, to paste in the element contained in the clipboard

= Paste as Child, to paste in the element contained in the
clipboard as Child of the element selected

= Import texts from : to import texts inside of the project
in the ".xIs" or ".csv" format

= "Export texts to": exports project elements (texts,
alarms, pages etc.) onto the Hard Disk or the USB
storage device

= "Translations": displays all the project texts on a table
simultaneously, to be able to edit/translate them to the
desired languages at the same time

= "Unused Tags/Variables Removal": to remove the Tags
and Variables not used in the project

= "Convert panel": to convert the panel with another

= "Convert device": to convert the device with another
changing the communication protocol

e "VT Simulator”: to simulate VT terminal project pages

e "Runtime Simulator": to simulate the IT terminal "real-
time" operation

= "Crossed reference": to search for/verify the existence
of a certain variable/page/script/function inside the
project

Elements of Project Explorer

The tree-type structure of Project Explorer allows the user to
access the configurator of all the components of a POLYMATH
project (with the exception of the graphic elements that are
configured by the Editor property); the Project (see chap. 4,
“Changing a project’s data” page 96) and Hardware
configuration editor (see chap. 4, “Managing the project”
page 83) have already been described in the previous chapter
while the other objects will be described in this chapter.

To access the editor of an element just double-click on it in
Project Explorer; the corresponding editing window will
appear in the work area.

We will start by describing the elements that can be
associated with ESA terminals and then we will illustrate the
settings of devices connected to these terminals.
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Setting the When the Project Explorer icon corresponding to the panel
panel added to the project is double-clicked, the user is able to edit
its characteristics.

Editing the panel is organized via 6 work windows: General,
Communication ports, Main window, Configuration Boot,
Exchange areas and Components. The user can move from
one window to another at any time without losing any of the
changes made.

General

Harr ET110T(5P1, 587 E T ETHT}

Comment

Model: IT110T (891, 892, ETHL, ETHZ)
Creation Dake: 15/M6/2010 84543
Hedéy Date: 02/09%/2040 10.47.16
Compiling Date: 15/06/2040 10.08.11

IT Remote access
O Activate IT Remsts Accois

Usarnad

Erabln Bassthrough

0 spy O sp2

The work window ‘General’ is used to change the name of the
panel in question and add comments within it to make it
distinguishable in the programming phase with POLYMATH.
The bottom of the window shows information on the date of
creation, editing and compilation of the project.
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Communication ports

ETHL

The port is not connected

9600 bits

RONE

Eight

00

1 timoout (msec) (DEC): 500-5000
Idle chars before TX (DECH: 0-100
Retry time (sec.) (DEC): 1-60

LTHE

Tha post is 1

52

The pert is net connected

In this window it is possible to configure the communication
method between the panel and the device; the parameters
can be configured in function of the connected panel and
device.

The bottom of the window shows the range allowed by the
protocol for each value inserted

MSP/ASP/SP1/SP2

Baudrate 9600 bitfs

Parity NOME.
Data Bt Eight
o Bit one
Protocel timeout (msec) 500
Tdle chars befere TH 5

Retry time (£8c.) 1

The first four parameters are always available in the
configuration whilst the others vary according to the protocol
used on the gate.

CAN

Syne. time (meec)

Crdde (msec)
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DP

l

100

5 (enly for tarminals wi 0

ETH1/ETH2

COM O

For this communication gate, no parameters are foreseen
because it can be set via script.

Main window

General Communication ports JAFIMWMMGERY EBoot configuration Exchange areas Components

Editing page default grid size

Width 10
Height 10
Options
O Show focus [ show mouse cursar
[ Use SIP keyboards [ Beep on key press
[ Hide Taskbar b4 Show confirmation rmessages

W Use default dialogs size

Dialogs size
Persistent-Data Flush Interval fmin) 3 v
Edit mode idle timeout [sec) 10

Help pages fant SystermTahoma(Tahoma) '

The Work window of the main window shows the dimensions
in pixels of the page displayed on the panel; in general these
dimensions are unchangeable and depend on the features of the
panel hardware. On a PC, for example this one, character can
be configured because it is not possible to determine the
resolution of the screen. Nevertheless, it is possible to change
the grid for arranging objects in the page (see chap. 6,
“Managing a page” page 254); the default values for these
dimensions are set at 10 pixels for the width and 10 pixels for
the length. By reducing these values you have more freedom
to add and reposition elements within the page (the grids in
the work area will be denser); similarly, by increasing these
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values, the lines will become less dense and there will be less
freedom to introduce objects.

Then, providing the operating system of the panel allows this
(if not, they will appear disabled), a series of configurable
options are available regarding the display of pages on the
terminal; the "Show focus" option can be selected (100%
zoom), the user can decider whether to display the title bar,
the ‘Reduce to icon’ button, the window focus (practically
speaking, the focus highlights the currently selected object or
button), the on-screen keyboard for entering data and
whether to hide the applications bar, whether the confirmation
message is to be shown, whether to show the confirmation
message, whether to use the default size of the dialogues.
The last three options allow the user to set the time-out in the
edit phase, the font for the Help pages and the password level
for accessing the system pages (see chap. 5, “Password
configuration” page 184).

Dialog Box
General Communication ports [EETMESEEEN Boot configuration Exchange areas Components
Editing page default grid size
Width 10
Height 10
Options
O shaw focus O sShaw mouse cursor
[l Use S1P keyboards [ Beep on key press
[ Hide Taskbar [¥l Show confirmation messages
[l Use default dialogs size
Dialogs size
Persistent-Data Flush Interval {min} 3 "
Edit mode idle timeout (sec) 10
Help pages font SystemTahoma(Tahoma) °

From the main window (previous image) it is possible to change
the "Dialog Boxes" size disabling the check-box “Use default dia-
logs size”. Once disabling such option, the user will be able to con-
figure the new sizes :
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General Communication ports Mthonﬂuuratlon Exchange areas Components

Editing page default grid size

Width 10
Height 10
COptions
O Show facus O Show mause cursor
¥ Use SIP keyboards [ Beep on key press
[ Hide Taskhar [/ Show confirmation messages

[0 Use default dialogs size

Dialogs size

Persistent-Drata Flush Interval {min) 3 -
Edit mode idle timeout (sec) 10
Help pages font SystemTahorma(Tahoma) .

This value is unique for all the dialog-boxes and can not be chan-
ged at Runtime level.

The events which use the new "Dialog Box" are the "User login"
and all the related to "Recipes" functions (see chap. 6, “Events re-
lated to Recipes” page 251).

Configuring the Boot

This mask allows the user to set the page to be displayed
when the project is opened. By clicking on the 1 icon a new
page can be added, while thelid icon opens the editor of the
page selected.

In addition, the Runtime refresh frequency of the
DateAndTime system Tag (see “Appendix A - System
Variables” page 693) can be defined; a refresh of once a
second or once a minute can be set.
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Exchange areas

ORI GEIS TS

ESA panels communicate with the field devices to which they
are connected; to make this information exchange possible
the panel and the device in question share memory areas from
which data can be taken and into which it can be written. In
reality, an exchange area is a tag-area (of one or more words)
located in the field device.

The two main categories of exchange areas are the status
areas and the command areas. The former are for the panel
to write information regarding the working of the device
connected while the second are read by the VT which then
answers by running particular operations in relation the value
read (in practice the device uses the command areas to send
automatic commands to the VT). From this mask it is possible
to proceed to add (using the ‘Add’ key), delete (using the
‘Delete’ key) or duplicate (using the ‘Duplicate’ key) both
exchange areas and command areas. Once an exchange area
is added, an area-type variable must be assigned to it (see
chap. 5, “Value” page 126) for reference. In the case of
command areas it is also necessary to introduce a response
tag (variable) to which the data relating to the outcome of the
operation indicated is written.

This variable can also be newly created and edited by clicking
on the adjacent icon; this can then naturally also be used
inside the project or accessed using Scripts.

To be able to see in detail the list of activities that can be run
using the status area and the command area, the reader is
advised to consult the appropriate appendices (see “Appendix
C - Status area” page 715 e see “Appendix D - Command
area” page 719).
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Components

Cormponents

SwConfiguration
Tags

Pages
PoplUpPages
Images
Textlists
Imagelists
Alarms
RecipeTypes
Frames
Reports

Pipelines
Scripts
GlobalScripts
TrendBuffers

Datalogs
TrendBuffers®y
RernoteMotification
WeeklyTasks

This page offers only a summary of the components that can
be assigned to ESA panels; by clicking on each of these the
appropriate main editing page can be accessed.

The first option you find on the menu of the panel in Project
Explorer is the one relating to the configuration Software. To
this area there belong the setting windows for the following
elements:

= SystemAlarms

e SystemMessages

e Timers
e Timers Events
* F Keys

To access the general editor of each option just double-click
on the appropriate name in Project Explorer. The following
paragraphs will carry detailed information on the features that
can be configured for each element.

SystemAlarms

The system alarms are alarms that are displayed to the
operator whenever certain conditions of anomaly occur.

In this section it is possible to access a table containing all the
system alarms that are displayed by the panel in particular
situations. Alarm messages are displayed for each project
language entered. Some messages are unchangeable by the
programmer while others are contained in editable fields. In
any event, it is always possible to delete the changes made to
the translation by clicking on the appropriate button (‘Clear
Translation’). Use the Project language button to access the
editable list of languages already described in this paragraph
(see chap. 5, “Languages” page 152).
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A Warning: when editing the texts of the systemalarms (and
messages), be careful not to introduce special characters reserved
for the system (e.g. ‘%’).

SystemMessages

System messages are messages displayed to the operator at
various points when the panel is in use.

In this section it is possible to access a table containing all the
system messages that are displayed. Messages are displayed
for each project language entered. Some messages are
unchangeable by the programmer while others are contained
in editable fields. When editing these strings, be careful not to
introduce special characters reserved for the system
(e.g.'%’). In any event, it is always possible to delete the
changes made to the translation by clicking on the appropriate
button (‘Clear Translation’).

Use the Project language button to access the editable list of
languages already described in this paragraph (see chap. 5,
“Languages” page 152).

&~ Note: In ESA terminology, system messages differ fromalarmsin as
much as the former are simple messages set into Dialog Boxes or
masks for entering information, while the latter are connected to
events correlated to system variables (e.g. flat battery, insufficient
space on disk, etc...).

Timers

Timers are tools put at the operator’s disposal for
programming the execution of certain activities in line with
temporal variables calculated directly by the terminal.

The Timers can be used in accordance with the needs of the
project, simply by entrusting functions or Scripts to their
start, suspend or end count events (see chap. 6, “Events
related to Timers” page 253).
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Using the general table relating to the Timers you can
introduce, delete and duplicate Timers. In relation to each
element you can specify the operational mode, the duration
and the direction of the count.

There are different modes of operation:

= One-run: the timer starts, allows a certain period of
time to elapse, then goes off and stops (one run)

= Normal: the timer works periodically, that is, when it
goes off it resets itself and then another cycle starts,
indefinitely (continuous run)

« Single alarm: the timer goes off at the date and time
specified and then stops

= Alarm time: the timer goes off at the specified time then
resets and another cycle starts (continuous run)

Warning: Irrespective of the type of Timer used, it is always
necessary for the Timer to be activated in runtime by the related
Start function called up by the button or Script (see “ Appendix B -
Predefined functions” page 701 and see chap. 9, “ The object
ESATIMER” page 530), otherwise the related count or control will
not be initialised.

The duration attribute also takes on various meanings
depending on the operational mode specified:

If the Mode is One-run or Normal: it represents the trigger
time in tenths of a second (O disables the Timer)

If the Mode is Single alarm: it represents the date-trigger time
in ANSI-C format: number of seconds from time 0:0:0 of the
1-January-1970 (the data can be selected in POLYMATH using
an convenient calendar window).

If the Mode is alarm time: it represents the trigger time in
seconds after midnight; assigning a inadmissible value
disables the Timer and is flagged to the operator by means of
an error dialog box.

The value of direction, indicates the counting mode of the
Timer; this may be arrived at by increasing the count variable
or decreasing it (this choice has no operative consequences on
the working of the Timer but merely on the internal count
value).

Warning: These types of Timer are software timers, soitis
preferable to avoid using them as clocks.
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Timer Events

You can associate an event (function or script) to a particular
condition of any timer you have created. These conditions can
be :

= OnSuspend: the event is activated when the timer is
temporarily suspended

e OnTimerFired: the event is activated when the timer na-
turally stops counting

= OnTimerStart: the event is activated when the timer
starts counting

= OnTimerStop: the event is activated when the timer is-
stopped

Component  [Tiener =l

onSuspend

F Keys (Global

This mask allows the user to define a global mode of
behaviour for all F keys (of a virtual or physical keyboard) :

Svstem alarms  System messages limers Timers cvents TOOREN

Keys defined in this panel
Global Function
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Note: By global mode of behaviour we mean that the key will make
it possible to effect the configured function independently of the
page being displayed on the panel, while by local mode of behaviour
we mean the execution of the function only in the context of the
current page (see chap. 5, “ F keys (Local)” page 158).

A predefined function or a user Script can be associated with
any key simply by double-clicking on the table in the
corresponding row or by selecting and clicking on ‘Put’; should
you wish to delete an already existing association, click on
‘Remove’ after having made the selection. If you choose to
introduce an association with a key, the following dialog
window opens :

Bl Eveni o/ Furvctiona BORSH ~lolx

Functions/Senpts associated o this event

F10 m (e _ Delete 'f Up 'A Down
Fi1

e Parameters of the selected function/sangt

F14 ] Store the return valus into

To add a function just click on ‘Add Function’ and choose the
function required from the list which appears, by clicking on
the line just created three times or on the E key, similarly by
clicking on ‘Add Script’ the Script to be associated can be
chosen. Up to 2 functions/Scripts can be introduced for each
key and these will be executed in the order indicated; to
change the order of the functions just move them with the
‘Move Up‘ and ‘Move Down’ keys. To delete a function just
select it and click on the ‘Delete’ button

Should a predefined function be chosen to associate with the
global key, the lower part of the window can be used to
indicate the data related to a correct execution of this (e.g. file
name, name of objects, etc..).
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Should a Script be chosen to associate with the global key, it
will be possible to choose to save the value returned by this
Script (if the Script is set to return a value) in a variable.
For details regarding the functions that can be associated and
regarding Scripts the reader is advised to consult the sections
of the manual devoted to these topics (see “Appendix B -
Predefined functions” page 701 e see chap. 9, “Scripts”
page 509).

Variables Variables are fundamental elements for creating a POLYMATH
project ; they allow the programmer to store and arrange data
to permit dialog between panel and device. An indefinite
number of variables can be created, the limits depending on
the memory available on the device.

List

List

Nane

Tag L RTU Master {Fast per Address Address=0 Integer  Class_0_5: 508 msee  Meme

Tag_t U Maszar (fast pe

cm) Addresem0 Integer  Clecs_0_S: SO0 e Moee
Tag_3d RTU Master {fast per Address=0  Addressed Integer  Class_0_5: 500 msec Mone Mone
Ir..u 4 RTU Mastnr {fast por ddress=0  Address=0 Integer  Class_0_5: 500 msee  Monn

al J |

RIS CHINS GRS TN

After double-clicking on Project Explorer, you access a table
of variables, whose list and classes of update (described in the
next subsection) can be managed. Using the list, you can not
only introduce new variables, delete them and duplicate them
but also edit certain properties (name, memory and Type; the
meaning of these properties will be described in the next
section). The "Tools" key allows modifying at will the columns
structure, importing or exporting Tags (see chap. 5,
“Variables Export /Import” page 143).

One alternative method of creating a variable is to click Add in
the menu arising from right clicking on Tags in Project
Explorer or clicking on E% in all those properties to which a
variable can be associated. Once a variable is created, it (with
its valid name assigned by POLYMATH) will appear under the
Tags option of the tree-form diagram; to enter edit mode for
this just double-click on it.

If you wish to get to know the list and the meaning of the
events that can be associated to a variable, you are advised
to consult the next chapter (see chap. 6, “Events related to
variables” page 249).
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Note: By dragging a variable from Project Explorer onto a pagein
the work area, POLYMATH automatically creates a data field
(numerical or ASCII) associated to the variable within that page.

Note: The duplication of a variable provokes the creation of a new
variable with a new Memory Address with the same value (address)
as the Memory Address of the original variable.

RefreshGroups

m Groups/Taqgs

List

I

Class_0: as fast as possible 0 sec
Class_0_S: 500 msec 0.5 sec
Class_S: § sec S sec

lCIass_lU: 10 sec 10 sec

& add Duplicate

The second window in the "Tags" menu allows to specify the
"Gruppi di Rinfresco" (Refresh Groups) present in the project.
These classes allow to distinguish the updating frequency of
the values of the relative tags. This function is useful when
different degrees of mutability are envisioned for field tags.
It is possible to introduce, eliminate and duplicate update
classes. An identification name and a refresh value indicated
in seconds can be inserted for each of these. The "Tools" key
allows to modify the structure of the columns at will.
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Tags in the groups

P [T ress | ddross Group m " m
Taa L FTU Master (fast por Address=0  Integer  Class_0_5: 500 msec  Hone Tag
Tag_t ETU Master (fast par Addrasemi  Enbeger  Class_O_S: 500 mese  None Tag
Tag 3 RTU Master (fast per Address=0  Integer  Class_0_5: 500 msec  None Tag
lr.,_a BTU Mastar (fast par Addrasemi  Enbeger  Class_O_S: SO0 mese  None Tag
o | 2

This window shows the list of project tags and it is possible to
modify the relative class associated. It is possible to filter the
display of the elements, limiting it just to the tags of the class
selected. The distinctive features are supplied for every tag in

the list.
Under "Tags" in the tree chart, find the tags just created.
Double click on these to enter the editing window of the
individual tag.

General

| Yalue Device Limits Conversion Threshalds oot Adcrecc Events

Identification

Name Tag
Comment
address |
Type Device =
Tag sharing

[ allow the tag's value to be shared through the intranet/internet.
Name Tag
Comment

Network identifier 0
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The editable elements in the General mask are the identifying
properties of the variable like name and comment; the name
of a variable must be unique, that is other variables cannot
exist bearing the same name, again, the maximum number of
chars you can give to the tag’s name is 60.

The comment is a string that is displayed only within
POLYMATH and it identifies the variable.

It is necessary to specify the type of variable you are editing;
the variables are divided into: device, internal system,
indexed and networks variables.

The device variables are shared with the connected equipment
and constitute the two-way data exchange medium; the
internal variables, by contrast, are used as a deposit for local
data or results of operations or Scripts and their value is not
read by the device; in this case, it is possible to specify
whether the value should be retentive by activating the option
appearing in the page when the variable is internal (‘Save the
value in a persistent memory. Tags are retentive’). If the
variable is retentive, the value is conserved when the terminal
is switched off.

The system variables (whose names begin obligatorily with
the prefix ‘SYS_’) are variables predefined by POLYMATH that
contain special information relating to the working of the
project and of the system. They are not editable by the
operator but can be displayed and used by the panel. The type
of system variable can be selected from the options on a drop-
down menu; the characteristics of each variable appear in the
lower part of the mask and are also illustrated in the related
appendix of this manual (see “Appendix A - System Variables”
page 693).

"Indexed" tags allow you to view the data of each variable in
a single field; the "Index Variable" determines the choice of
Tag the value of which is displayed by the "Indexed Variable"
(see “Indirect Addresses” page 140).

The network tags are variables that can be used by all the
terminals that make up the network, in the case of a "panel
network™" project.
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Value

General REMEY Device Limits Conversion Threshalds o0 coct Addrecc Events

Tag Type

Type Integer =l
Char N
Byte

Boolean

Unsigned Integer —
ng

Unsigned Long
Real

The mask relating to value can be used to configure the type
of data that the variable is supposed to contain. The types of
data possible are those represented in the following table:

Tabella 1: Types of variable

Type Description Range
Char 8-bit signed integer -127 to 128
Byte 8-bit unsigned integer 0 to 255
Boolean Single bit True (1) or False(0)
Integer 16-bit signed integer -32.768 to 32.767
Unsigned 16-bit unsigned integer 0 to OXFFFF
Integer
Lon 32-bit signed integer -2,147,483,648 to
g 2,147,483,647
Unsigned | 32-bit unsigned integer 0 to OXFFFFFFFF
Long
Floating point IEEE 32- -3.402823E38 to -
bit single precision 1.401298E-45 for
Real negative values;
1.401298E-45 to
3.402823E38 for
positive values
Floating point IEEE 64- -1.7976931348623E308
bit double precision to -4.9406564584124E-
324 for negative values;
Double 4.9406564584124E-324
to
1.7976931348623E308
for positive values
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Tabella 1: Types of variable

Type Description Range

ASCII string ASCII String (maximum
String length OX7FFF

characters)

Array of Whole value string 1 to 1024
Unsigned | without sign
Integer
(WORD)
Array of Whole value string with 1 to 1024
Integer sign
(WORD)

Array of Floating point 32 bit va- 1 to 1024
Real lue string

For each variable you can introduce an initialization value that
is assumed at the start of the project. In the case of a String-
type of data, its maximum length can also be indicated.

General REMA Device Ltz Conversion Thresholds  Indirect Address  Events

Tag Type

Type Array of Unsigned Integer{WORD) |

Length z

If the variable is a device variable, Array-type data will also
be present; this in substance is a data area whose dimensions
can be set by POLYMATH; as indicated in the figure, a table
will also appear which enables you to introduce the
initialization values of each portion of the area.
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Device
General Walue Limits Conversion Thresholds [odircct Address Events
Memory Address
Marnory Address [RTU Master (fast peripherals) |
Refresh group [Class_n_5: 500 msec j
& Update Device enabled
O Update always, even when a tag isn't used by any field
[ Read only
Dats Area
[FC 03-16: read/urite registers x| e Jword |
[ signed O eco
Address
Address [1}
valid range: =]

Address (HEX): 0-FFFF

-]

In the case of device variables it is necessary to proceed to
specify the destination memory areas for the values.
POLYMATH guides the user by furnishing indications regarding
the valid memory ranges calculating them automatically in
relation to the device chosen in the project.

First of all it is necessary to introduce the destination device,
the related memory addresses and the update class (see
chap. 5, “RefreshGroups” page 123). If these last two
components are lacking or incorrect, they can be introduced
again by clicking on the icon or they can be edited by
clicking on .

In addition, you can decide whether to enable the updated or
not.

Even when a tag is not being used by any field, the option
‘Keep updating’, indicates, if it is activated, that the variable
will be updated even when its value is not shown in the page
currently being displayed on the panel; this option is
indispensable whenever, you want, for example, to access the
value of this variable via Script. In the event that the variable
is part of Alarms, Pipelines, Trends or Recipes this setting is
ignored and the variable is monitored all the same.

In conclusion, a one-shot read can be requested when the
variable is used in a data field.

It is also necessary to indicate the type of memory to reserve,
whether Bit, Byte, Word, DWord or String; if it is not String,
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you can indicate whether the memory is to be considered as
Signed (for relative values) or BCD.

Note: Binary-coded decimal (BCD) is a commonly used format for
representing the decimal digits in binary code. In this format each
digit of a number is represented by a 4-bit binary code, whose value
is between 0 (0000) and 9 (1001). For example the number 127 is
represented in BCD as 0001, 0010, 0111.

If the type of area is String, you can define the length, the
type and the gap characters. The types of gap characters
available are left, right or none. It is also possible to define the
gap character by entering the appropriate ASCII code or
choosing an option from the drop-down menu. In both cases,
the right-hand side of the mask will display a preview of the
gaps.

You can use the lower part of the mask to introduce the
destination memory addresses; the values entered must be
coherent with the range displayed at the foot of the mask.

Limits

Validity ranges can be defined for the tag just created (if this
restriction has sense in relation to the type of data). It is
possible to assign these limits to the values of the tag and/or
to the device. If limits are assigned to the Tag (i.e. on the tags
of the terminal) the limit will have effect in the editing phase:
if, for example, a maximum limit is at 100 and the operator
inserts a higher value in an editing field, the field will
automatically be taken to 100 (maximum limit). However, this
limit does not prevent a greater value being written in the
device memory by a device side process.

If this is not the case, by assigning device limits a value will
be read on the terminal within the range set also when the tag
on the device assumes values outside of the interval.

Once the relative box has been enabled, it is possible to
manually insert the limit values or assign them dynamically by
combining them with those of tags. This last option can be
performed by clicking on and selecting the tag from the
drop-down menu that will'Occur as a consequence. It will
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always be possible to access the creation-modification of the
tags directly from this mask :

General Value Device Conversion Thresholds -t id .- Events

Input limits on Tag value

[ Enable
Win
Max
O Advice in case of wrang input
Type [Camplete Page for bath limits =l
Complete Page (0K + CANCEL) for bath limits
Input limits on device value
[ Enable

Another option that can be found in the "Limits” option is the
possibility that the user is warned when an incorrect value is
attributed to the Tag. This option is activated

by selecting the “Warn if the value introduced is incorrect”
box. When the option is activated, a warning will appear under
the form of a "Popup" page every time that the value attribut-
ed to the Tag is greater or smaller than the previously-set lim-
its.

After having enabled and set the minimum and maximum limit
and having selected the "Warn if the value introduced is incor-
rect” option (see following image):

General Value Device Conversion Thresholds -t id .- Events

Input limits on Tag value

[ Enable
Min 1n
Max 1nn

[ Advice in case of wrang input

Type [camplete Page for both limits =l

Complete Page (OK + CANCEL) for both limits

from (Project Explore) click twice on the main page and then
use the mouse to drag the Tag inside the page :
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At this point click on the "Esegui Progetto” (Perform Project)
icon u ; the following image will appear :

[~ ]

By clicking on the Tag the editing keyboard will appear, from
where a value can be assigned to the tag itself :
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For example, by entering "150" on the editing keyboard and
confirming using "Enter" also on the editing keyboard, a warn-
ing will automatically appear under the form of a "Popup"
page, where the user is warned of the fact that the value being
introduced is a higher value that the maximum limit set
(which remember is 100) :

I alzlad

‘You are writing a vakue higher than
limit. Do you wart to continee?

[ | Loma ||

At this point the user can decide whether to continue (by click-
ing on the "OK" key, or to annul the introduction of the data,
which must be re-set.

If the user decides to continue by clicking "OK" as just seen,
Polymath will automatically attribute the maximum limit value
(100).

The same will occur when trying to insert a value below the
minimum set, e.g. if a value equal to "5" is set when the min-
imum limit is "10", a warning message will appear under the
form of a "Popup" page, as shown below :
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Yiou are writing a vahue lower than
limit. Do you want 1o continue?

Cancel

Also in this case, the user can decide whether to continue (by
clicking on the "OK" key, or to annul the introduction of the
data, which must be re-set).

If the user decides to continue by clicking "OK" as just seen,
Polymath will automatically attribute the minimum limit value
(10).

Conversion

The value of the numerical external variable is always
calculated by the system based on the rough value.

Often, apart from the standard conversions, it is necessary to
carry out a calculation, because the units of measurement in
which the rough value is expressed are different from those
required for the value of the variable.

For example, it occurs very frequently that the rough value is
expressed as an integer value within the range of a digital-
analog converter, while the value of the variable is expressed
in engineering units.

Using this mask you can determine the type of conversion to
be adopted for the variable; the conversions that can be
selected are: none, linear, quadratic or defined by the user.
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General Value Device Limitc TeTTINRINN Thresholds Indrect Addreee  Events

Type of conversion Preview
Troe T - |

Parameters

Test

Insert a value in one of the box below; the other will be
calculated automatically

% s

v s

Linear conversion implies the definition of two pairs of values,
each formed of the value of the variable and the
corresponding rough value:

P1 (x1, y1)

P2 (x2, y2)

where xn are rough values and yn the corresponding
‘engineering’.

The rough value x and the corresponding value y of the
variable in the conversion are related by the following
equation :

General Walie Doviee Limic: TerimRRee) focsholds 0 0 Eeert
Type of conversion Preview

T -

vpe [sauare Root | v
Parameters

"1 59

et

w2 75
Yz 135
Test

Insert a value in one of the box below: the ather will be
calculated automatically

® 59

s o 1
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The quadratic conversion needs the same values with the
exception of Y1; in the quadratic transformation the equation
that connects the rough value x and the y value of the variable
is as follows :

In both cases the window situated in the left part of the mask
furnishes a graphic representation of how the conversion of
the values will take place.

In addition you can carry out an immediate test of the
conversion after entering the necessary values; a value can be
entered in the appropriate fields and POLYMATH displays its
conversion instantly.

The conversion defined by the user envisages the association
of a Script with the events that can be associated to the
variable (see chap. 6, “Events related to variables” page 249).

Thresholds

General Malue Device Limits Conversion l‘H@M@! Indirect Address Events

Thresholds

TR [None =l

Inhibit

Parameters

The developer can enable the generation of various types of
event associated to a numerical variable. The events are
generated when the variable assumes particular values (or
when there is a rapid change in the value itself), called
threshold values or simply thresholds. The user can make use
of the defined thresholds by assigning a function or a Script to
the threshold events that can then be associated to a variable
(see chap. 6, “Events related to variables” page 249).

There are three types of thresholds: level thresholds,
deviation thresholds and variation speed thresholds.

In this mask, select the type of threshold required and decide
whether to value activating the event should be dynamic or
not (Boolean).

The type of threshold is represented graphically to the right of
the mask.
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Tyoe [Lever = Heri

i Ve

The first type of threshold is the Level type. Up to eight Level

thresholds can be defined, each of which can be enabled

independently of the others.

For each of the above mentioned thresholds the developer

wants to enable, he/she must specify whether the threshold is

a maximum or minimum, independently of which event is

generated: thus, if all eight of the possible Level events are

generated, eight different thresholds need to be specified. It

is also necessary to specify a dead zone value (indicated as a

percentage of the reference value), to be used exclusively to

check the re-entry of the event (hysteresis). The dead zone

indicates a time interval within which the event must not be

raised so as to be able to make the slight value oscillations

negligible.

Alternatively, the Dead zone and Value attributes can be

assigned to another tag simply by clicking on inside the

field in question.

The functioning of the Level thresholds can be summed up as

follows:

= minimum thresholds: if the value of the variable is
falling, the event is activated the moment the variable
falls below the reference value; if the value of the
variable is rising, the event is activated the moment the
variable rises above the reference value increased by
the value of the dead zone.
= maximum thresholds: if the value of the variable is

falling, the event is activated the moment the variable
falls below the reference value diminished by the value
of the dead zone; if the value of the variable is rising,
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the event is activated the moment the variable rises

above the reference value.
Let us consider the example in which we put a reference value
of 30 without a dead zone. In this case, if the threshold is
defined as a minimum threshold, the events will be activated
as soon as the value arrives at the value 30 (when the value
is rising) and as soon as it goes below (when the value is
falling). If the threshold is defined as a maximum threshold,
the events will be activated as soon as the value exceeds the
value 30 (when the value is rising) and as soon as it returns
to a value equal to or less than 30 (when falling).
If we add to our example a dead zone equal to 10% of the
reference value (10% of 30 = 3) the behaviour will be:
if the threshold is defined as a minimum threshold, the events
will be activated as soon as the value arrives at the value 30
(when the value is rising) and as soon as it goes below the
value 33 (when the value is falling). If the threshold is defined
as a maximum threshold, the events will be activated as soon
as the value exceeds the value 30 (when the value is rising)
and as soon as it returns to a value equal to or less than 27
(when falling).

Thrasholds Praviaw
Type [Deviation =] W Yoo
Inhibit Tag -
Parameters
Reference Value
v > B oa
aw
O Enatied
Vahae (%)
Onadtiand (%) @
High
[ Enabled
Value (%) 9
Deadbard (%) E
Wi Vake

The second type of threshold the Deviation threshold; there
are two types of this threshold and these can be enabled
separately:

= DLO= lower deviation

= DHI= higher deviation
Deviation thresholds are relative to a reference value and
indicate how much can be deviated from this value.
For each of the above mentioned thresholds the developer
wants to enable, he/she must specify the deviation value
(expressed as a percentage of the reference value),
independently of which event is generated: thus, if both
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possible events are enabled, two thresholds different from one
another must be defined. The values can be fixed or can refer
to other tags. There must be a dead zone value for each
threshold, expressed as a percentage value of the level
referred to; the attributes dead zone and value can be
associated to another tag.
Let us now seek to clarify how deviation thresholds work by
using an example. To make it easier to understand we will
avoid using the dead zone the concept of which has already
been expressed in the course of the explanation of the Level
threshold concept.
Let us set 30 as a reference value. We shall activate (by
clicking on the appropriate box) the low Level threshold,
assigning 10% as the value. This means that the event
onThdDevLo (see chap. 6, “Events related to variables”
page 249) is launched each time there is a breach (whether
rising or falling) of the value given by:

« reference value - % low threshold value
In our case, 30 - (10% of 30)= 30 - 3 = 27 thus the event will
be activated when the value 27 is crossed.
We operate in the same way to define a high deviation
threshold; by clicking on the appropriate box we activate the
high-level threshold, assigning 50% as the value. This means
that the event onThdDevHi (see chap. 6, “Events related to
variables” page 249) is launched each time there is a breach
(whether going up or down) of the value given by:

= reference value + % high threshold value
In our case, 30 + (50% of 30)= 30 + 15 = 45 thus the event
will be activated when the value 45 is crossed.

Gonoral Malus Deote Liouls Cenvoreon ROGSTODRY (o000 o0 Exants

Thresholds Preview

Tree |rate of changs =1 o Vi

Inbatet T —
Baraen
Reference Yal

! e

hrs min sec

Enspned Ten 0 ] 1
Low

[ Ensbled

walue (%) a

Dreadbarsd (%)
High

O Enabled

walus () G

Deadband (%) Fference Value. T

The third group of thresholds is the Variation speed group; the
idea is to be able to carry out checks on variation times used
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by a variable. It may, for example, be useful to manage a

situation in which a temperature plunges or soars too rapidly.

We can define two Variation speed thresholds that can be
enabled independently of each other:

e RLO= low variation (decrease in the value)

= RHI= high variation (increase in the value)
The Variation speed thresholds are relative to a reference
value. It is necessary to specify the time in seconds below
which the variation in value should take place such that the
event is launched relative to the threshold. Return from the
threshold occurs when there is an increase/decrease lower
than the value specified within the threshold period.
There must also be a dead zone value for each threshold,
expressed as a percentage value of the level referred to; the
attributes dead zone and value can be associated to another
variable.
Let us now seek to clarify how Variation speed thresholds work
by using an example. To make it easier to understand we will
avoid using the dead zone, the concept of which has already
been expressed in the course of the explanation of the Level
threshold concept.
Let us set 30 as a reference value and 5 seconds as the
checking time. Clicking on the appropriate box we shall
activate the low Level threshold, assigning 10% as the value.
This means that the event onThdDevLo (see chap. 6, “Events
related to variables” page 249) is launched each time there is
a decrease of at least 3 (10% of 30) in an interval of less than
5 seconds. In the same way, the event returns to rest when
there is a decrease of less than 3 seconds in a time interval of
less than 5 seconds.
Similarly if we set a high threshold: we will leave the reference
values unchanged (30) and the checking time remains 5
seconds.
Clicking on the appropriate box we shall activate the high
Level threshold, assigning 50% as the value. This means that
the event onThdDevHi (see chap. 6, “Events related to
variables” page 249) is launched each time the value of the
variable increases by at least 15 (50% of 30) in an interval of
less than 5 seconds. In the same way, the event returns to
rest when there is an increase of less than 15 seconds in an
interval of 5 seconds.
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Indirect Addresses

The "Indirect Addresses" option is enabled only when an "In-
dexed" Tag has been inserted. In the "General” window, select
the "Indexed" Tag option :

[eENEEl Malue Device  Limibs  Conversion  Thresholds  Indirect Address  Events

Identification

Name Indirect_a

Comment

Address

Type Indexed =
Device
Internal
Sy stern

Netwark

The "Indirect Addresses" option is now enabled. Select it with
the mouse :

JeENEEIl Value Cevice Linits  Conversion Thresholds  Indirect Address Events

This window appears :

General ¥alue Dcviee Linite Comversion Ihrechclo: PENetaRreed Eeeot

Index tag and values

Tag [tndex_a j

o
l1 a2

F  add

The "Index_A" variable is called "Index Tag" and is an "Inte-
ger" type of "Device" Tag.

"al" and "a2" are two "Integer" type "Device" variables (of the
same type as the "Index" varia-

ble™).

"Indexed variables" are particularly useful when you have a
project involving a high number of Tags (a complex project
can involve literally thousands of varia-

bles). In the interest of
simplicity, POLYMATH offers the user a new function called
"Indexed Variables" that allows you to associate ("map") any
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number of tags to a single variable (the "Indexed variable"),
without having to create many "fields" containing as many va-
riables, saving you time and facilitating your work in the bar-
gain.

The indexed variable allows you to view the value of each va-
riable in a single field; the "Index Variable" determines the
choice of Tag the value of which is displayed by the "Indexed
Variable".

Attention: the Tags must all be of the same type, while the "Index"
Tag must be the "Integer” type.

Below is an example illustrating this :

ESA RunTime Simulation

INDEX TAG
(Index_A)

10

20

e a4 INDEXED TAG
|

&0

evoe | wahist | mestus = I T |

[ @ Semistion s stopped

The above image shows the "Run-time" of a simple project
where we have created 7 "Uinteger" Tags called "al, a2, a3,
a4, ab, a6 and a7" to which we assigned values (0, 10, 20, 30,
40, 50, 60 and 70); we then created an "Index" tag (an "Uin-
teger" tag called "Index_A", the values of which can be betwe-
en 0 and 6 (in this example there are 7 tags, assigned the
values 0-6). By attributing value "0" or "3" to the "Index" tag,
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the "Indexed" tag displays the value of Tag "al" (in this case,
uou) and na4|| (||30n) I’eSpeCtively -

10 a2

INDEX TAG
) (Index_A)
20 a3

£54 RunTime Simulation

pdevake | wotchion | et o] =|m]=]

Events

The "Events" option is visible in "DOUBLE CLICK" mode and
comes under "Editor Events" in "Extended" mode.

You can associate each Variable with an event (function or
script) by clicking the "Browse" button on the right :

General Yalue Device Limits Conversion Thresholds Indieect Addrec: [SHE0E

List
onlnitialization
onoffLine

onoffSean
ononLine
ononScan

OnRawvalueChange
onvalSent
onvalueChange

Onlnitialization

The event is activated according to the condition of the
Variable. The conditions are listed in the table "Events
associated with variables" (see chap. 6, “Events related to
variables” page 249).
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Variables Export /Import

It is possible to export or import a series of previously created
variables by clicking "Tools" then "Tags" from the main menu :

Tools | 2

| J ooome co@
Utilities > =~y =

4 Translations » -ﬂ l‘—d ﬂ ¢

|| Tags L\;‘J Export

i Recipes Impart
Alarms v [mfe Conversi

p Downloader Utilities »

4 Dictionary 3

Export Tags

Tools | 2

oo
Utilities ' B 0 W
Translations 4 ‘ﬂ LIJ uj ¢

|| Tags >| Export QJ
Recipes 4 Import
Alarms Y Limits Convers

Downloader Utilities »

Dictionary 3

By clicking on the sub-menu “Export” the following screen is
obtained:

ags Export

Chooss the tags to sxport

Filter ‘ v‘

Tags to be exported:
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By clicking on the pull-down menu the "filter" options that can
be selected by the user are shown, select, for example "All Ta-
gs" option :

Chaoose the tags to export

Filter -

all Tags of all Devices

all Tags of a Device

All Tags with name starting with
all Tags of an Alarm

all Tags of all alarms

All Systemn Tags

All Internal Ta;is

Tags to be exported;

all Tags types present in the project will be shown and subse-
quently exported :

Choase the tags to export

Filter

Tags to be exported:
Scheduler_Start
Scheduler_Stop
HolidayGroup_Month
HolidayGroup_Year
Tag_INT
HolidayGroup_1_Month
HolidayGroup_1_Year
Scheduler_Start_1
Scheduler_Stop_1
SYS_AlarmMotack
SYS_AUD_MSG_LINEQUT
Tag_PLC
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Clicking the "Next" key will open the following page from whi-
ch the user can choose where the file to be exported is saved
by clicking the "Browse" key.

iZhoose the filename and extension to export tags

Save As

My Recent
Documents

L
Desktop

L.-‘

My Diocuments

My Computer

<

=
fy Metwork,

File Name

Save in: | H’J My Diocuments

- |[EICERT Simulation [10]

() Customer Project 2004
() Custamer Project 2005
() Customer Project 2006
() Customer Project 2007
() Custamer Project 2003
(3 Customer Project 2009

¥ 03 e E
(0 _Mew_test_report (3)0emo PRI x Customer
() _TEST IMPORT [)Demo_Fiera
() AB DeviceMst [CIDESTOP REMOTO
()Backup_Test () 0riverInfo
() Biticing POF for micheling []==1)
[CICamtasia Studio [CIESA elettronica
(L2CAM &nalizer [LDESAPOLYMATH
@cc e

¢ Favorites

\ﬂmee personalizzate
() Gavazzi

Ehedit

[CIHMI D16 spl

[CIHMI D16 5p2

[ HmiDesigner_%17_SP1

&

File name: |TEST|xIs

Vl [ Save l

Save a3 type |M\clusuﬂ Excel [".xls]

vl [ Cancel l

Note: The file to be exported can be saved with extension ".xIs" or

" .CSV"

By clicking on the "Separate addresses" check box, the varia-
bles list is shown, in the table created, in separate fields :
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Tags Export

Choose the filename and extension to export tags

¥l Separate addresses

By clicking on the “Export” key the following screen is obtai-
ned:

ags Expo E|E|®

Fils Export

Start expaort: 03/03/2011 9.35.00

Exporting Tags in fils pp.xls...

Tag exported: Scheduler_Start

Tag exported: Schedulsr_Stop

Tag exported: HolidayGroup_Maonth
Tag exportsd: HolidayGroup_vsar
Tag exported: Tag_INT

Tag exported: HolidayGroup_1_Month
Tag exported: HolidayGroup_1_rear
Tag exportsd: Schedulsr_Start_1
Tag exported: Scheduler_Stop_1

Tag exportsd: SYS_Alarmiotack

Tag exported: SYS_AUD_MSG_LINEOUT
Tag exported: Tag_PLC

Finish expart: 03/03/2011 9.35.00

Open Export
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Tools | 2

Downloader Utilities

Dictionary

Optre QD@
Utilities > -
Translations » |§_H l‘—‘—i ij &
Tags 3 Export
Recipes 4 Import
Alarmns ¥ [Omits Conversi

»

»

By clicking on the sub-menu "Import” the following screen is

obtained:

= Tags Import

Choose type of import

= Excel format

3 PLC Format

Cancel

It is possible to select the format type with which to import va-

riables :

e Excel Format : standard Excel format

= PLC Format : previously exported variables are impor-

ted automatically by using the PLC application in use.

147
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Excel Format :

Tags Import EI@@

Zhoose type of import

(# Excel format

) PLC Format

After clicking "Next" and selecting the file to be imported, the
following screen is obtained:

Tags Import

Choose the tags to import

Starting importing from raw 4 A

N =cheduler_stz INTERNAL ~

Scheduler_Stc INTERNAL
HolidayGroup_ INTERNAL
HolidayGroup INTERMAL
Tag_INT INTERNAL
HolidayGroup, IMTERNAL
HolidayGroup, IMTERNAL
Scheduler_Stz: INTERNAL
Scheduler_Stc INTERNAL
STYS_AlarmNo SYSTEM 37 SYS_AlarmNor

< >

1oooooooog

O overwrite existing var,

O stop importing if sncounter 1 errors

Impart
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From the previous screen, it is possible to choose between the
following options by acting on the keys and by selecting the
various present check-boxes :

= From what row of the list the variables import should be
started

« Select the individual variables to be imported

= Select all variables to be imported by clicking the "Se-
lect all" key

= Uncheck all variables to be imported by clicking the "Un-
check all" key

= Overwrite the already present variables inside the
project or not

= After how many errors the variables import is stopped

After having made the selection, the following screen is obtai-
ned by clicking on the "Import" key :

= Tags Import

Choose the tags to import

Starting importing from row 4

4

N =cheduler_St: INTERNAL ~

Scheduler_Stc INTERMAL
HolidayGroup. INTERNAL
HolidayGroup, IMTERNAL
Tag_INT INTERNAL
HolidayGroup_ IMTERNAL
HolidayGroup_ IMTERNAL
Scheduler_Stz: INTERNAL
Scheduler_Stc INTERMAL
SYS_AlarmMNo SYSTEM 37 SYE_AlarmNo

ooooooood

< .

[ overwrite existing var,

[ Stop importing if encounter 1 Brrors

Import

If everything is done correctly there are no error reports.
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PLC Format :

Tags Import

Choose type of import

O Excel format

& PLC Format

L)

After clicking "Next" and selecting the file to be imported, the
following screen is obtained:

[ [: DB 101, StorePrintData Tat DEW wiord 101 A
[ ok 101.StorePrintData FOE DB W Bvte 101.2
[ ok 101.alarmsCtrl ResetP| DBW Biyte 101.4
[] oB 101.alarmsCtrl AlarmS DBW Byte 101.4
[ OB 101.AlarmsCrl Alarmd DEW Byte 101.4
|:| DB 101.CommunicationCtr DEW Byte 101.6
|:| DB 101.CommunicationCtr DEW Byte 101.6
[1 DB 101 WeekEndCtrl ISOS DRYW BEvte 101.8
[ ok 101.WeekEndCtrl FOLL DB W Bvte 101.8
D DB 101 WeekEndCtrl.POLZ DBW Byte 101.8
D DB 101 WeekEndCtrlISOS DBW Byte 101.6
[] OB 101.WeekEndCtrl.ISOS DRW Byte 101.8
[ OB 101.WeekEndtrl.POLL DEW Byte 101.8
[1 OB 101 WeekEndCtrl POLL DEYW Byte 101.8
[1 DB 101 ¥eekEndCtrl POLE DEYW BEvte 101.8
[ ok 101.WeekEndCtrl FOLE DB W Bvte 101.9
D DB 101 weekEndCtrlMinut DBW Byte 101.9
D DB 101.0iUnitCtrl, StartSte DBW Byte 101.10
[ OB 101.0ilUnitChrl . Motorfe DEW Byte 10110
[0 add CPU name as prefix
[ overwrite existing var,
Impart
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From the previous screen, it is possible to choose between the
following options by acting on the keys and by selecting the
various present check-boxes :

e Select the individual variables to be imported

= Select all variables to be imported by clicking the "Se-
lect all" key

= Uncheck all variables to be imported by clicking the "Un-
check all" key

= Add as prefix to the individual variables name, the CPU
name from which they were previously exported

= Overwrite the already present variables inside the
project or not

After having made the selection, the following screen is obtai-
ned by clicking on the "Import" key :

OK tag DB 101.CutputRatioCtrl ISOMinus ~
OK tag DB 101, CutputRatioCtrl POLLPIus

OK tag DB 101.0utputRatioCtrl POLLMInUs

OK tag DB 101.0utputRatioCtrl .POLZPlus

OK tag DB 101.CutputRatioCtrl POLZMinus

OK tag DB 101.0utputRatioCtrl.OutlAl

OK tag DB 101.CutputRatioCtrl.Qutz Al

OK tag DB 101.QutputRatioCtrl Ratiolal

OK tag DB 101.CutputRatioCtrl RatioZAl

OK tag DB 101.0utputRatioCtrl Trasduceral

OK tag DB 101.0utputRatioCtrl.OutputInRangel
OK tag DB 101,QutputRatioCtrl.QutputIinRange2
OK tag DB 101.0utputRatioCtrl.RatiolnRangel
OK tag DB 101.0utputRatioCtrl.RatioInRange2
OK tag DB 101.QutputRatioCtrl IS OPulseMem
OK tag DB 101.0utputRatioCtrl POLLPulseMem
OK tag DB 101.0utputRatioCtrl POL2PulseMem
OK tag DB 101.WeightCtrl.weight1lalack

OK tag DB 101.WeightCtrl weightzalack

OK tag DB 101.WeightCtrl . weight1al

OK tag DB 101.WeightCtrl.weightzal

OK tag DB 101.WeightCtrl PrintDataMemn

Finish import: 03/03/2011 11.37 48
Imported 518 Tags

Open Export Falder

If everything is done correctly there are no error reports
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Languages and Languages
Fonts

Languages wiad into this panel

English {United States) . 5 English USA SystemTahoma

RIS G G

Startup Language

[English (unitad Statac) 2|

bl Use last language

The configuration window for Languages allows the user to
manage the project languages that can be displayed on the
panel. Up to eight languages can be introduced at the
programming level and at least one language always needs to
be present. To introduce a new language to the project just
click on ‘Add’.

For each language added a decimal and group needs to be
indicated as well as a system language and a Font for the
related system messages. Naturally you can delete languages
present in the project (by pressing ‘Delete’), duplicate (by
clicking on ‘Duplicate’) or change the settings of the existing
ones (by clicking on the corresponding fields in the list table);
in this window you can also indicate the language to be used
when the project starts up on the terminal.

The "Tools" key allows to access two windows :

= Translations; if a multilanguage project is created, ev-
ery time a text is introduced, the possibility of translat-
ing it into all languages is given. In this way a Wizard
will start that will guide the user through the translation
process.

= Columns configuration for modifying the structures of
the columns at will.
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JSIETES]
Choese the languages

& [ Project Languages
[ English (United States)
M ttalian (Italy)

Select the desired languages and select “Next”.

Swere P
Choose the elemnents to export

+ Elements
Systern Messages
System Alarms
[ Text Lists
[ Recipe Headers
[F Touch Buttans
B Alarms
[ Mlarm Headers

-~ [ PopUp Pages
[ Labels

Select the elements to be exported and click on the Create ta-
ble.

[Ereendeeniae i ]
T =
= [r—

[ e

i wrvar Erreen arvaeniae

pr—

o o

anent Conimte

" "

e "

Tas tom byend o Corrms v, Lirets sparmarm mushars.

nsr atrnsdy parins. Cperames 3b

] Sepanilae revida e Frbmsthi s sparatars.

€ anran shangs cumrarm et Srpantue meddcare (o stins s

Lot o e et 814 shak e riars

e T Imseanbly carcabare foomaicrs rvdefnds

annct ihange gaurmoed. Imostntie cambowrs In pasrmere

B4 vt of the Faremard (e S0 3-14 char)  Lunghasza s por i Bassmard (dess sasare 344 caratien)

e 21 Camiwn

o0t Patsmerd it par—t

wrka trver Errors i weritrs

e adar wraasie Ratton starme desortie =
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Once the texts have been added just click on OK to save the
changes made or on Delete to delete them. There is no default
translation but POLYMATH furnishes the same text (the one
introduced for the main language) for all the languages.

& Note: Thereisno particular limit for the translation of secondary
languages; their length may exceed that of the reference language.

&~ Note: While programming with POLYMATH, the display language
for the project elements (e.g. labels and buttons) can be changed
simply by selecting the required language from the Display> project
language menu or the option from the tools menu (if the field has
been set to be present); in both cases the changes will be immediate
and all the objects will be displayed in the required language.

Character fonts

Marne

SysternTimesiewRoman  §Times New Roman

Systemwingdings “wingdings

System Font

SystemFangSong_ESA FangSong_ESA System Font

SystemTahoma Tahoma System Font

SystemCourisr Courier Naw System Font

o o o o o o

SystemSymbol Symbol System Font

& add Duplicate

The window related to the fonts allows the user to manage
(introduce, delete and edit the name or property) of all the
character fonts used in the project. There is a series of default
fonts present in the project (that cannot be cancelled), but
new ones can be added by choosing from those installed on
your PC. It is also possible to associate a comment to each
font added to be displayed only within POLYMATH; for each
font there is also the indication of the memory that to be
occupied by installing the font in question.
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It is possible to use up to 32 "Fonts" during the programming
phase (eight are by default and the user can choose between the
other twenty-four).

Pages are fundamental for the creation of a project; they are
the real interface between operator and terminal. The editing
of pages must be based on information accessible to the user
and the access policy (restrictions on users) and navigation
procedures (links between the pages).

An enormous quantity of objects that can be selected from a
list furnished by POLYMATH - which will be described in detail
in the next chapter - can be introduced into these pages.
After double-clicking the Pages icon of Project Explorer, the
work area will display a list of the pages introduced into the
project. Using this list you can introduce new pages and
duplicate or delete existing ones. In addition, certain
attributes like Page number, Description and Comment can be
edited simply by clicking inside the appropriate fields of the
table and new texts can be introduced.

Once a page has been created (using Project Explorer or the
list), double-clicking on it in the tree-diagram makes it
possible to edit it in the work area. The page editor is
organized in the following sections: Fields, General, Help page
and F keys. The subsections below offer a description for each
mask.

The properties and the events that can be assigned to the
Page will be dealt with in the next chapter; we advise readers
to consult the relevant section for a list of them and their
meanings (see chap. 6, “Page properties” page 257 and see
chap. 6, “Events related to Pages” page 257).

Fields

General Help page Keys Events Page Properties Mouse pointer (456,0)
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The Fields mask shows graphically how the page will appear
once the project has been installed in the terminal. To
introduce an object simply click on the relevant icon and
immediately afterwards draw the outline of the area that will
contain it in the page in the desired position.

The next chapter will illustrate all the procedures for
introducing graphic objects and the relevant meanings and
tools (see chap. 6, “Managing a page” page 254).

General

Fields [EEREIE Help page FKevs

Identification

Name Start

Comment

Page nurnber 1

Description Start .
4] | 2]

Runtirne parameters

[ 3ump auternatically at the next input fisld

Editing
[ override default grid size
width 10
Height 10

Using this mask you can introduce the identifying attributes of
the Page like Name, Comment, Number and Description. The
Name, the Number and the Description of the page are unique
properties within the project that is there cannot be other
different pages that have one of these attributes in common.
For this reason, whenever a page is pasted in or duplicated
POLYMATH sees to it that these properties are edited so that
they satisfy the requirement of uniqueness.

The page number can be a whole number greater than 0O, its
maximum value depending on the capacity of the terminal’s
memory; the Comment is a Unicode string and it is visible only
within POLYMATH.

Warning: when entering the Description string, be very careful not
to introduce control or punctuation characters. Control characters
are those between 0x0000 and 0x001F (inclusive) that can be
introduced using a keyboard by pressing the sequences ALT+000 up
to ALT+031. Thisrule appliesin general for all the objects
containing the property Description.
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This mask can also be used to furnish operational settings for
the page; you can decide have the cursor jump automatically
to the next input field in runtime. If this option is activated,
each time the operator enters a value into a numeric field and
presses the Enter key, the focus of the application (that is, the
selection) moves to the next field (the order of the selection
passage between fields is defined by the Tablndex attribute to
be assigned to the page objects, (see chap. 6, “Properties of
the Numerical Field” page 302, for example).

It is also possible to overwrite the default grid dimensions for
the current page by specifying the desired dimensions. This
option is useful when a different degree of precision is
required during the editing phase of the page. When low
values are entered the grid becomes denser and there is
greater freedom in positioning objects within the page; by
entering a high value, the grid becomes less dense and the
freedom in positioning objects in the page becomes more
limited.

Hel ages

Figlds  Ggmeral Hews Events Page Progerter
Help page

[C[Enable’

Freview

A each project page can have a Help page assigned to it,
giving information relating to the working of the mother page.
The Help page is essentially a window into which a text to
guide the operator can be introduced. Apart from the text
displayed, other properties like the position and the
dimensions of the page can be defined. At the bottom of the
mask you are offered a preview of how and where the Help
page will appear in runtime. It is also possible to define the
font and the dimension of the text of the Help pages during
the phase of defining the general properties of the panel (see
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chap. 5, “Main window” page 113). This page only becomes
visible to the operator when it is expressly called (using the
button assigned to this function introduced into a mother
page, via the command area and function keys).

F keys (Local)

The last mask available for editing the page is the one relating
to the F keys; it is possible to edit the behaviour of a particular
function button within the page. Unlike the global keys, the
functions set in this page are only effective when they are in
the current page.

A Warning: Thetable present in this mask already indicates the gl obal
functions (see chap. 5, “ Keyboards” page 215), so as to make any
overwriting evident. Infact, if they were assigned to the same global
and local key functions, only the local ones would carried out in
runtime in the context of the page in question.

The functions or Scripts that can be associated to the local
buttons are introduced in exactly the same way as already
seen for the global keys, thus the same procedure should be
followed (see chap. 5, “Keyboards” page 215).

Events

The "Events" option is visible in "DOUBLE CLICK" mode and
comes under "Editor Events" in "Extended" mode.
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You can associate an event (function or script) to each Page
you have created.

The event is activated in the two different conditions of the Pa-
ge :

= OnPageClose : the event is activated when the page clo-
ses (for instance when moving from one page to the
next)

= OnPageOpen : the event is activated when the page

opens (for instance when moving from one page to the
next)

Fields General Help page Keys |SEWEN Page Properties

List

onPageClose

OnPageOpen

onPageOpen

To attribute an event to the page, simply select a condition by
clicking the browse button and, in the window that appears,

using the necessary buttons to associate a function or script
to the page :

Tl Gensrdl Helo chgs Heve TEPRTY Ehgs fropsre:
List
SnPageciose
onPagedEen Q
LB et Pt bl =10

Functions/Scripts associsted to this event

Oragacpen
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Page Properties

The "Page Properties"” option is visible in "DOUBLE CLICK mo-
de" and comes under "Properties Editor"” in "Extended" mode.
The "Page Properties” window is in two parts: "Appearance"
and "Advanced" :

Fields General Help page Keys Events [T

Appearance

Boslarum el u255 95 255 =l
Border visibility o
Border size 1
Border color .n 0,0 [|
Border style [sotid E
Border 30 [Fiat &
Advanced
Use background image =]
Backaround image [ j
Image representation ngs\tigmng j
Image horizontal position |c3ntered ﬂ
Image vertical position ICer\tered =l

The “Appearance” section allows you to edit the following op-
tions :

= Background colour
= Border visibility

= Border size

= Border colour

= Border style

e 3D border

The “Advanced” section allows you to edit the following op-
tions :

= Use background image

= Background image

= Image Representation

= Horizontal Position of Image
= Vertical Position of Image

Popup pages Popup pages are pages that are only displayed following the
occurrence of particular situations (these can be called using
the command area and the button with an assigned function).
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After double-clicking the Popup pages icon in Project Explorer,
a list of the pages introduced into the project will appear in the
work area. This list can be used to add new Popup pages,
duplicate them or delete existing ones. In addition, some
attributes like the Page number, Description and Comment
can be edited simply by clicking inside the fields relating to the
table and new texts can be introduced.

Once the Popup page has been created (using Project Explorer
or the list), you can double-click on it in the tree diagram to
begin editing it in the work area. The page editor is organized
in the following sections: Fields, General, Help page and F
keys as described in the paragraphs below.

For information regarding the properties and events that can
be assigned to the Popup pages the reader is advised to read
the relevant section in the next chapter (see chap. 6,
“Properties of Popup pages” page 257 and see chap. 6,
“Events related to Popup pages” page 258).

Fields

TN Generale Pogino dihelp Tasti Eventi PopupPage Properties Puntatore mouse:(800,465)

The Fields mask for the Popup pages is similar to that relating
to the traditional pages (see chap. 5, “Fields” page 155).
The sole difference between the two masks consists in the
dimensions of the Popup page. Naturally the Popup page is
meant to be smaller than a standard page; it may be
positioned in any part of the screen.

To change the dimensions of a Popup page, select it after
pressing the key; at this point just take the cursor onto
the edges of the page (red outline) to enlarge or reduce its
dimensions.
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To move a Popup page, select it after pressing the key;
then simply drag it to the position you want it to appear in
runtime.

The next chapter illustrates all the procedures for introducing
graphic objects and their related meanings and tools (see
chap. 6, “Managing a page” page 254).

General

The General mask for the Popup pages is identical to that
relating to the traditional pages; thus, readers are advised to
consult the paragraph dealing with these (see chap. 5,
“General” page 156) for details of the properties.

The sole difference consists in the possibility of expressing a
preference in runtime: you can choose whether to display the
page title bar or whether the Popup page should always
appear in the foreground.

Help page

The Help page mask for the Popup pages is identical to that
relating to the traditional pages; thus, readers are advised to
consult the paragraph dealing with these (see chap. 5, “Help
pages” page 157) for details of the properties.

F keys

The F keys mask for the Popup pages is identical to that
relating to the traditional pages; thus, readers are advised to
consult the paragraph dealing with these (see chap. 5, “F keys
(Local)” page 158) for details of the properties.

Events

The "Events" option is visible in "DOUBLE CLICK mode" and
comes under "Events Editor"” in "Extended" mode.

The "Events" window on popup pages is the same as the one
for traditional pages, so refer to the same section (see chap.
5, “Events” page 158).

Popup Page Properties

The “Popup Page Properties” option is visible in "DOUBLE CLI-
CK mode" and comes under "Properties Editor" in "Extended"
mode.

The “Popup Page Properties” window is the same as the one

for traditional pages, so refer to the same section (see chap.
5, “Page Properties” page 160).
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The purpose of the Frames is to edit synoptic diagrams parts
to be used in more than one page. For example, if the project
is supposed to contain twenty pages and ten of these have the
same group of element (e.g. two numeric fields with a
button), then simply define this portion once inside a frame
and fetch it onto each page. Once a frame has been defined it
can be introduced into a page simply by dragging it there
(from Project Explorer to the page in the work area).

To learn more about the List and the meaning of the
properties that can be assigned to the Frames, the reader is
advised to consult the relevant part of the next chapter (see
chap. 6, “Properties of Frames” page 258).

List

Double-clicking on the Frames option from within Project
Explorer gives access to the list of Frames present in the
project; this mask contains the name and the comment
relating to each Frame and it is possible to introduce new
Frames or delete or duplicate existing ones.

Cross references

The mask relating to cross references allows you to see how
the frames are used within the project; you can set the mask
for displaying the list of pages using at least one frame or, as
an alternative, the frames used by the pages. In both cases
the results are displayed in a tree-diagram.

When the ‘Update’ key is pressed, POLYMATH recalculates the
references to the Frames in real time.

Creating and managing Frames

A Frame can be created either by using the appropriate list
(see chap. 5, “List” page 163) or directly by using Project
Explorer (press right key on Frames, then Add).

Once a Frame has been added by double-clicking on it in
Project Explorer Work area, in you access the editor
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subdivided into three pages: Fields, General and Cross
References which will be dealt with in the following sections.

Fields

@R General Cross reference

Using this mask you can edit the way a Frame will actually
appear in the pages into which it is called; it is edited just like
that for normal pages with various objects being introduced
and properties being set (see chap. 6, “Managing a page”
page 254).

To introduce an object simply click on the respective icon and
immediately after draw where in the page you wish the outline
of the area to contain it to be placed.

The next chapter describes all the procedures for introducing
the graphic objects together with their related meanings and
tools.

Using this mask you can, however, set the dimensions of the
Frame: click on the icon to select it and then move the
cursor to one of the red corners by dragging it in line with the
dimensions required. (This operation can also be performed
by the General mask as set out in the next section).

You cannot use this mask to move the Frame, in that its final
position is defined periodically in the destination page.
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General

Fields Cross reference

dentification
Mame Frame

Camrent

Bize

Width 320

HH

Height 240
Editing

[ Override default grid size
Width 10

=
Height 1n B

This mask can be used to introduce the identifying attributes
of the alarm like Name and Comment. The name is a unique
property within any given project that is other different
frames with the same name cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.

As an alternative to the drawing of the dimensions as seen in
the previous section, you can also manually set the width and
height of the frame.

You can also overwrite the default dimensions of the grid by
introducing new measurements.

Cross references

;

The mask relating to cross references offers the possibility of
displaying the list of all the pages using the frame in question.
This function is very useful for cataloguing the pages that are
influenced by the changes made to the frame.

[
Type of crass rafarance Fages that uses & Frame - |
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Properties
Fields General Cross reference |aeTToaden
Appearance
Use transparent color
Backaround color 255 55, 285 =l
Border visibility O
Border size 1
Border color .U 0.0 =
Border styls [5eia =
Border 3D [Frat =
Advanced
Use background image O
Background image [ j

The “Properties” window allows you to determine the graphi-
cal properties of the frames.

The “Properties” window of the “Frames” option is visible in
"DOUBLE CLICK" mode and comes under "Events Editor" in
"Extended" mode.

The window is in two parts, "Appearance” and "Advanced" :

The “Appearance” section allows you to edit the following op-
tions :

= Use transparent colour
= Background colour

= Border visibility

= Border size

= Border colour

= Border style

= 3D border

The “Use transparent colour” and “Background colour” options
also allow you to attribute a variable and "threshold" manage-
ment (see chap. 6, “Thresholds option functioning”

page 286).

In the "Advanced" you can choose whether to use a back-
ground image and attributes this to a variable
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Alarms Alarms are events that need immediate attention on the part
of the operator; they are connected to signal anomalous
conditions with respect to the plant or the terminal. The
alarms usually have associated to them particular events of
the following type :

& Raised

RN

Acquisition & & Return to rest

= raised: the alarm condition is signalled on the device

« return to rest: refers to the end of the alarm state on
the device

= acquisition: (often also identified as ‘ack’ -
acknowledgement) an operator has recognized the
alarm condition.

Using Project Explorer, double-click on Alarms to access the
general setting windows of all the alarms. The masks available
in this area are :

e List

= Memory resources
= Behaviour

= Fields

* Priority

= Alarm groups

= User signals

The next subsections will give a detailed account of the
features accessible via each mask.

For a more thorough knowledge of the list and the meaning of
the events that can be associated to an alarm the reader is
advised to consult the next chapter (see chap. 6, “Events
related to alarms” page 250) where there are also illustrations
of the complex fields for displaying and managing alarms (see
chap. 6, “Complex Controls” page 360).
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List

T Memor resources Behavior Fields Prioriies  Alarms groups  User Sianals  Events

List

lmarm Tag AlarmPriority Error  None Descrizione Allarme

Priority

Description Ussr data 1

] 0

The Alarm list allows you to manage the table of alarms and
their related properties; a summary of all the standard
properties in editable fields is supplied. This mask is useful for
giving an overall vision of all the alarms present in the project.
New alarms can be added, or cancelled and those existing
edited by means of the relevant buttons at the bottom of the
mask.

Memory resources

A Behavior Fields Priorities  Alarms groups  User Signals

Nurnber of alarms

Histaric 512 Active 256 =

Size 10240 ==

Use the Memory resources mask to define how much memory
to reserve in the terminal for the management of the alarms;
it is necessary to specify how many alarms can be managed
by the history and how many active alarms to consider.

The "Dimension" field indicates the file dimension expressed
in bytes.
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Behaviour

List Memory resources JONICTIEA Eields Friorities Alarms oroups User Signals Events

Buffer records management
@) Discard the oldest records when the buffer is full (FIFO)

) 1anore the new record when the buffer is full. To empty the buffer, use seripts

The historic buffer can hold 512 alarm's records

Murnber of records that set the SystermTag 'SYS_HistoryWarning' 75 ==
il £}
File to use to store records
Fils Name AlarmHistory Log
The file will be saved in the FLASH of the terminal. If the logs are too frequent,
the FLASH could be damaged
Automnatic change to page
O change page autamatically when priority is greater than
Hin priarity
Page to show in automnatic

Use the Behaviour mask to indicate the filling and emptying
policy of the buffer when it has reached its maximum value.
You can choose to substitute the least recent element (FIFO
buffer) or ignore the new elements when the buffer is full.
(The buffer can be emptied in runtime using a Script, a button
or a command area.) You can also decide on the limit of
alarms present in the history above which the system variable
‘SYS_HistoryWarning* will be activated (see “Appendix A -
System Variables” page 693).

The name of the file in which the Alarm History is to be saved
must be entered into the text field in the mask; the log file is
saved in the folder \log (see chap. 8, “Transferring data”
page 474).

Warning: When entering file names, care must be taken that they are
admissible names for a Windows environment. A file name, to be
admissible, cannot contain the following characters\/: * ?2“ < > |

Note: Thelogfileisafile used by the systemto permanently save the
datato berepresented in the Alarm History. Being ableto chooseits
name using POLYMATH is useful in that it allows the user to
manage this file (e.g. copy or delete in the event that it is too big).
Should you want to re-arrange the data in an Alarm History,
however, it will have to be exported using a predefined function or
Script (see “ Appendix B - Predefined functions” page 701 and see
chap. 9, “ Scripts” page 509).
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If you decide that a Page should change automatically when
an alarm is raised that is of higher priority than a threshold
(specified using a drop-down menu) (see chap. 5, “Priorities”
page 171), indicate which Page to display when the alarm is
raised.

Fields

Use the Fields mask to define the character and the colours of
the display tables of the alarms (see chap. 6, “Active Alarm
View” page 389 and see chap. 6, “Alarm History View”

page 394). You can specify the character of the rows, the
colours of the cells selected, the characters and colours of the
column headers. The way the editing fields relating to the
fonts and colours work is identical to what has already been
set out for the user table (see chap. 5, “Fields grid” page 188).
The programmer can also make a choice in relation to labels
to be assigned to the table headings. Each column can have
associated to it a multilingual label; to access mutilingual
editing just click on the . icon adjacent to the editable text
field (see chap. 5, “Languages” page 152).

Toons that identifiss an alarm
Raised IconlarmRaised [~ A
acknowledged W i

il
Terminated W A
Simple Icongimplealarm - 0
Simple Terminated lm Q
Disgnostic [Feortemetonam Q@

There is also the option of selecting the images to be
associated to the state of the alarm; already at the project
creation stage POLYMATH furnishes a set of default images
that can be confirmed or substituted with an image added to
the project (see chap. 5, “Add an image” page 199).
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The alarm states to which an image should be attributed are:
Active, Recognised, Returned, Simple and Diagnostic.

Priorities

The Priorities mask gives you the possibility of managing the
set of properties that can be assigned to an alarm. As default
POLYMATH offers three priority levels to each of which there
is a corresponding value: Advice (200), Error (100) and Fatal
Error (0). The ‘Add’ and ‘Delete’ keys respectively allow you
to add priority levels to and remove them from the list; the
three initial levels predefined by POLYMATH cannot be
removed. When a new priority is added, it has to be assigned
a priority value that permits it to be classified relative to the
other already existing levels. For example, if you wish to
introduce a priority of a level lower than the three predefined
ones, we will need to assign a value of 201 or above; if you
wish to introduce a high priority, give a value between 1 and
99 (the predefined Fatal Error level is always the one with the
highest priority).

You can distinguish the priority of the alarms in runtime by
assigning them different colours in the Table of active alarms
or in the history (see chap. 6, “Active Alarm View” page 389
and see chap. 6, “Alarm History View” page 394). Use this
mask to indicate the background colour (with the RGB code or
a palette) and text of the non-selected options in the table
(otherwise the colours are those in the Fields mask).

Alarmgroups

List Memery resources Behavier [

Defined groups

POLYMATH offers the possibility of organizing the alarms of a
given project into Alarm groups; this could be useful where a
considerable quantity of alarms is envisaged and the
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programmer wants to have at his/her disposal a cataloguing
tool (for example, to speed up the acquisition of many a
alarms at the same time). Using this mask new groups can be
created by clicking on ‘Add’ or existing ones deleted by
clicking on ‘Delete’); in addition, for each group a comment
with a purely identificatory purpose for the programmer can
be introduced that will be visible only within POLYMATH.

Usersignals

Signals oad 1o inforen the oparator
Enable & signal and move i to the desired position
B nsizad Mlarms
B Massnge
A Disgreostic Alarm
=

Buzeer soltngs

kel Enable Buzzer

Minirurm priority that will trigger the buzzer AarmPriority Error ﬂ

Use this mask to set the alarm signals that appear to the
operator. The types of alarm messages displayed are:

= Raised alarms

= Simple messages

= Diagnostic alarms

= Banners
Once the type of alarm message has been selected (by
clicking on the appropriate box), it is displayed in the preview
page in the right-hand section of the mask. After clicking on
the element introduced, it can be moved to the position you
want the message to appear in.
For the first three types of messages the following must be
defined for the appropriate icon to be displayed: a minimum
level of priority; a destination page when the icon itself is
pressed; and the image to be presented on screen (which can
be selected from among those in the project).
If, on the other hand, the type of message is Banner, a
background and text colour need to be defined as well as a
rotation time expressed in seconds in case there should be
more than one alarm/message.
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The reproduction of a warning sound ("Enable buzzer /audio™)
can be enabled at the back of the mask :

Configurazione cicaline/audic
M abilita cicalino/audio

Priorita minima che avvia il cicalinodaudio [Alarmpriority Ervar O

Tipo di buzzerfaudio [Buzzer =l

Fileudio [Wessuno j

When this function is enabled, it is also necessary to indicate
a minimum priority alarm level so as to cause the sound re-
production: (see chap. 5, “Priorities” page 171) :

IAIarmPriority Erraor m

AlarmPriority Fatal Error
sAlarmPriority Error j
AlarmPriority Warning

It is also possible to assign the alarm to the buzzer or to an
audio file: (see chap. 5, “Audio Files” page 234) :

IAIarmPriority Erraor j

| audicFile
Mone

Buzzer

Note: Audio files can only be reproduced on the I T110TxxxX,
I T112Txxxx, I TL15Txxxx terminals.

Events

The "Events" option is visible in "DOUBLE CLICK mode" and
comes under "Events Editor" in "Extended" mode.

It is possible to associate an event (script) to each alarm you
have created.

The event is activated in the two different conditions of the
Alarm :

= OnHistoryFull : Ithe event is activated when the alarm
log memory reaches 100% capacity (memory full)
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= OnHistoryWarning : the event is activated when the
alarm log memory reaches the set value; by default, the
warning is issued after 75 records (out of the 512 that
can be stored on the memory)

List Memory resources Behavior Fields Priorities  Alarms qroups  User Signals JRbined
List

QnHistoryFull

QnHistoryWarning

OnHistoryFull

To attribute an event to the alarm, simply select a condition
by clicking the browse button and, in the window that appe-
ars, using the necessary buttons to associate a script to the

alarm :

List HMemory sesources Behawior Fields Bopoties Alarms groues  User Signals Sukions

Setihas
List Lights.
GnbistaryFul [ |
CnHistory Warning ks

=

OnHigtaryFull

— G CEITED CEIES RN

seleeted funchionyserst

Creating and changing an alarm

Once the general characteristics of the alarms have been
defined within the project, you can begin to define the way the
individual alarms should work. An alarm can be created
directly from the alarm list (see chap. 5, “List” page 168) or
using Project Explorer (click with the right-hand key on Alarms
and then on Add).

In the editing phase, two masks, General and Property - that
we shall go on to describe in detail below - are presented for
each alarm in the project.
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General

TP Eronecies Eveons

Igentfizanen

Camment

Event of the TAG that raises the slarm

Tag [Tau e
Activalion Typn [Vatar |

Aetivation Valus

The General mask can be used to set the identifying properties
of the alarm like Name and Comment. The name is a unique
attribute within any given project that is other different alarms
with the same name cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.

A variable must be assigned on which the checks relating to
the alarm will be carried out; depending on the type of
variable (see chap. 5, “Value” page 126) there will be different
modes of checking which may be orientated to the bit or value
of the variable. The text box asks you to enter the reference
value which when reached will generate the alarm (absolute
value or bit number).

Properties
General [JNTHl Events
Information
Priarity [AlarmPriarity Error j
s 7]
Description Alarm Description '
User Data 1 '
User Data 2 '
Tree Alarm 154 =

The specific characteristics of the individual alarm are defined
in the Property mask.

First of all the programmer is asked to enter a membership
group for the alarm (see chap. 5, “Alarmgroups” page 171)
and a description representing the actual text that the
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operator will read on the panel when the alarm is triggered.
The description is a multilingual Unicode string (see chap. 5,
“Languages” page 152) that cannot contain punctuation or
control characters (da Alt+000 a Alt+031) and which cannot
exceed 255 characters in length.

The attributes Datiuser 1 and Datiuser 2 are optional
attributes indicating identifying multilingual strings of the
alarm. The user can choose whether to employ them for
personal purposes or to leave them unused. When they are
used they appear in runtime within the alarm views if the
appropriate column is present in the attribute Columns (see
chap. 6, “Properties of the Active Alarm Grid” page 392 and
see chap. 6, “Properties of the Alarm History Grid” page 396).

Note: For the current value of a variable (for example one assigned
to an alarm) to appear in the Description, Datiuser1 or Datiuser2
stringsjust put into the string the name of the variablein a sequence
having the form %{<name of the TAG>#<format>}%. the format
follows ANSI-C specifications. For example, a Description
containing the string “ excessive temperature:
%{TFORNO#%03d}%°C” ; if the variable TFORNO has a value of
150, it will be displayed as: “ excessive temperature: 150°C” .

&

The Property mask also asks you to specify the type of alarm;
the following table explains the types of alarm available.

Tabella2: Types of alarm

Event type Description

simple event; this is not an
Simple event alarm but an information
message

alarm event (requires
acknowledgement on the part
of an operator — triggers an ISA
sequence)

ISA alarm
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The lower part of the mask is used to set a series of
parameters relating to the behaviour of the alarm.
It is possible to decide:

to permit acknowledgement via global
(cumulative)acquisition

to include the alarm in the Alarm History

to attribute a lag (in seconds) before the alarm is
signalled to the user (in the tables or by means of
messages). If the alarm is terminated within this
interval it is not signalled.

that acknowledgement of an alarm instance should
provoke the acquisition of all the instances of this type
of alarm

to enable external acquisition via a project variable If
so, it will be necessary to define a reference variable
and the bit value to be checked. You can choose to have
the bit reset automatically after its remote acquisition
to assign to a page; if this preference is enabled, it will
be necessary to define a reference page be assigned. To
be able to exploit this function you will need to introduce
the ‘Shows page’ button in the Alarm display tables (see
chap. 6, “Active Alarm View” page 389 and see chap. 6,
“Alarm History View” page 394).

Events

The "Events" option is visible in "DOUBLE CLICK mode" and
comes under "Events Editor" in "Extended" mode.

It is possible to associate an event (script) to each alarm you
have created.

The event is activated in the different conditions of the Alarm :

OnAlarmAck : the event is activated when the alarm is
stopped

OnAlarmOff : the event is activated when the alarm en-
ds
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e OnAlarmOn : the event is activated when the alarm en-
ters "Activated" mode

General Properties |8

List

onalarmack
onalarmoff

onalarmon

To attribute an event to the alarm, simply select a condition
by clicking the browse button and, in the window that appe-
ars, using the necessary buttons to associate a script to the
alarm :

Buttons

General Properties JSiEne

Switches

Lights

List

Onalarmécl Fipes and Valves
onilarmoff -
anlarmon % r—
[ Events/Functions Editor i =1
o Functions/Scripts associated to this event |
!
|
T Up
[Parameters of the selected function/script
[ Store the return walus inta
Recipes Types Recipes are a means of creating the setup of the plant or part

of it) to carry out a given process.

This result can be obtained by writing appropriate values into
a certain number of variables, typically set-points or
regulating parameters and PLC memory cells.
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POLYMATH allows you to define a number of types of recipes,
that is, general data structures whose instances the operator
will proceed to furnish in line with his needs; there are no
limits to the number of types of recipes that the programmer
can define using POLYMATH. The only limits my depend on the
Hardware characteristics of the terminal.

Warning: POLYMATH makes it possible to define types of recipes,
that is, different structures identified by name and by the related
variables; the recipes are created and managed in runtime and
saved into the retentive memory of the panel. The types of recipes
describe only the structure which all the recipes belonging to that
type have.

For further information regarding the list and the meanings of
the events that can be associated to a Recipe type, the reader
is advised to consult the next chapter (see chap. 6, “Events
related to Recipes” page 251) where there is also a
description of the display modes of the recipes using complex
controls (see chap. 6, “Complex Controls” page 360) as well
as the meanings of the transfer operations between the VT
and the devices (see chap. 6, “Operations for transferring
Recipes” page 403).

Recipe list

After double-clicking on the Recipe element of Project
Explorer, you access the list of types of recipes present in the
project :

mCa_mm

Lista

lfRempeType

o =l
& Aggiungi @ modifica < Cancella & Strumenti

ESAPOLYMATH - User Manual - rev. 2.1



180 | Chapter 5
Project Explorer

Use this list to add new types (by clicking on the ‘Add’ key),
duplicate (with the ‘Duplicate’ key) or delete (with ‘Delete’)
existing ones.

For each recipe type the summary of the related
characteristics is shown in editable fields. This mask is useful
for gaining a complete view of all the recipes present in the
project.

Modes of compatibility

Options

[ Use compatibility made for the follawing recips type
Recips type j

[ Export headers

[ Use an export language
Export language |Enghsh (United States) =l

Using the Recipe list mask you can specify for which type of
recipe present in the project the mode of compatibility should
be enabled (this option is applicable to one and only one
Recipe type). By compatibility we mean a use of the exchange
areas identical to the Mode of functioning of VTWIN-
programmable ESA terminals . A compatible structure uses
the command area of the project (see chap. 5, “Exchange
areas” page 116) and accepts commands from the PLC only
with a Recipe name not over 4 characters. On the other hand,
a non compatible structure uses dedicated exchange areas (in
this case the recipe can have a longer name).
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Fields
Rows
Font SystermTahoma(Tahoma) .
Selectsd cell
Background Color e =
Column headers
— systernTahoma(Tahoma) .
e o
Type Mame Nome Tipo
Type Id 1d Tipo
Recipe Mame Nome Ricetta
Recipe Id 1d Ricetta
Last Change Time Data Ultima Modifica
lCUmmEnt Commento

The Fields mask is used to define the character and colours of
the Recipe display tables (see chap. 6, “” page 398 and see
chap. 6, “Recipe Editing Table” page 401). Here you can
specify the character of the rows, the colours of the selected
cells, the characters and the colours of the column headings.
The way the editing fields relating to the font and the colours
is identical to what has already been indicated for the User
table (see chap. 5, “Fields grid” page 188).

It is up to the programmer to choose which labels to assign to
the Table headings. Each column can have a multilingual label
assigned to it. To access Multilanguage editing just click on
the ° icon adjacent to the editable text field (active only if
more than one language coexists in the project).

Creating and changing a Recipe type

Once the general characteristics of the recipes in the project
have been established, you can start defining the actual
characteristics of each Recipe type. A Recipe type can be
created directly from the list of Recipe types (see chap. 5,
“Recipe list” page 179) or using Project Explorer (click with
right key on Recipes types and then on Add).

For each Recipe in the project, there are two editing masks,
"General", "Fields", "Recipes" and "Events" (the "Events" op-
tion is visible in "DOUBLE CLICK mode" and comes under
"Events Editor" in Extended mode), which we shall describe in
detail below.
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General

[ELEIEIl Fields Recipes Events

Identification

Name RecipeType

Comment

Exchange arsas

[ Enable exchange areas

S 100
Status areas I j

The General mask is used to define the identifying properties
of a Recipe Type. The Recipe Type ID is an identifying number
within the data structure of the project; it is a whole number
greater than zero.

The Recipe type name and ID are unique attributes within the
project that is other different Recipe types with the same
name cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.

If the recipe being edited is not defined in a compatible mode,
you can use the bottom of the mask to choose whether to
enable the dedicated exchange areas for the recipe in
question. If this option is activated it will also be necessary to
indicate the command and status areas linked to the recipe
(see chap. 5, “Exchange areas” page 116).

If, on the other hand, the recipe has been defined in a
compatible mode, it will be possible to define the status area
used (see chap. 5, “Exchange areas” page 116).

Recipe type fields

General Recipes Events

List

Marne Mong Morne Ricetta

1d Mong 1d Ricetta

lCnmment Mone Commento

F  add Duplicate & Tools

ESAPOLYMATH - User Manual - rev. 2.1



Chapter 5

Project Explorer

The real structure of the Recipe type must be indicated in the
Fields mask. Each recipe in the terminal must have the fields
Name, ID and Comment while other fields can be introduced
by the programmer. It is precisely the fields introduced by the
operator that are the distinctive elements of each Recipe type.
By clicking on the ‘Add’ key it is possible to introduce a new
field to the Recipe type. After having clicked on the key,
variables already present in the project or new variables can
be assigned to the new field using the column relating to the
variable by clicking on the field introduced. It is also possible
to access the editor of the variable selected after clicking on

o remove a field in the Recipe type, simply select it and click
on ‘Delete’.

Recipes

General Fields

LTy Events

List

& add Duplicate

The "Recipes" option allows you to view all the recipes in a
project. There are also buttons for adding new recipes and
cancelling and duplicating existing ones.

Events

The "Events" option is visible in "DOUBLE CLICK mode" and
comes under "Events Editor" in Extended mode.

It is possible to associate an event (script) to each Recipe you
have created by clicking the "Browse" button on the right :
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General Fields Recipes [EE05 Buttons

)
= @
onDownloadComplets b

onDownloadError Access  Accest

OnRecipsCreate % m
(= IS

OnRecipeDelets
[ Events, Functions Editor _ (ol x|

OnRecipeLoad

Functions/Scripts associated to this ewent

onUploadComplets
onUploadErrar

Fararneters of the selected function/script

O store the return value into

The event is activated according to the condition of the recipe.
The conditions are listed in the table "Events associated with
recipes” (see chap. 6, “Events related to Recipes” page 251).

Users and Password configuration
Passwords

Within a project you can define authentication levels to
maintain control of access to specific areas. The purpose of
this feature is to distinguish and control the level of
operational freedom for each user in the course of their work
session. Using POLYMATH the programmer can proceed to
establish access policies for particular features (e.g. access to
buttons, pages, recipe management, etc.) thereby stopping
operators without the proper credentials from accessing or
editing data in an improper manner. Each operator, when
using the panel, must be recognised by the system by
entering an identifying name and a password for the
appropriate level of access (logon operation). It is envisaged
that only one operator can be logged on and use the panel at
any given moment; each operator can logout at any time.
Up to ten access levels can be defined and the lowest level
(typically level 1) is the one with the highest degree of
operational freedom. Each user who has not gone through the
login procedure will be treated by the system as a level 10
user (the lowest degree of freedom) and can access only the
features available to that level. To run an operation of a level
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lower than ten, you will be asked to login again using a special
Popup page predefined by the system.

Use POLYMATH to define the initial users’ levels, that is the
levels of those present at the start-up of the project. You can
also add or edit users directly in runtime. To do this you can
introduce into their pages a predefined check called User List
(see chap. 6, “User List Table” page 396).

For security reasons each operator with access to the pages
for changing User Passwords (using the User List check) can
display and change the access credentials (name-password)
only of users with the same or higher-numbered levels than
his/her own (e.g. an operator on level 5 can see and change
the password of levels 5,6,7,8,9 and 10).

The password configuration of the access levels is made up of
three edit masks: General, Users and Fields grid.

By means of the "Mask Password edit" it is possible to determine
if the password is to be displayed or hidden with asterixes during
configuration.

General

PNl Users Users events Fields
General parameters

[ Logout autematically when panel is idle

Idle timeout (sec) &0
[ After a user's logout, show always a particular page
Page to show Pages j| j 32
[ Login using password enly
Log users activity
[ Enable logging of users login/logout
Log to file User.lag
The file will be saved in the FLASH of the terminal, If the logs
are tao frequent, the FLASH could be damaged.
Timestamp format DO-MM-T7Y, hhimm 24h |
M Erase logs after 3 = pays

The General mask is used to configure the panel such that it
executes the logout automatically after a certain period of
inactivity; you can also define which page to go to see once a
user has completed the logout.

This window can also be used to set the procedures for
recording the user login/logout operations; this function is
particularly useful where it is important to be able to maintain
a history file of accesses. The files in which the data is saved
(avalid file name must be given when working in a Windows)
are editable, as is the format of the date-time and whether to
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program the logs after a certain period of time. The log file is
saved in text format in the folder \log (see chap. 8,
“Transferring data” page 474).

Users

General JUEEIE] Users events Fields

Users defined

Lewel 1:
Lewel 2:
Lewel 3:
Level 4:
Lewel 5:
Level 6:
Lewel 7:
Lewvel &:
Lewel 9:
= Level 10:
DefaultUser (Mo Password)

& Create New < Description

The Users window is the one used to show the participating
users and the corresponding passwords. Up to 19
participating users can be introduced. To create a new
participant, just click the appropriate level and then Create
new; for each participant created it is essential to indicate a
user name and a password (minimum 6 alphanumeric
characters, maximum 14).

In addition, each level can be supplied with a comment visible
only within POLYMATH in the programming phase. To
introduce a comment just click on the level (not the user) and
enter the text in the corresponding field.

Once a participation has been registered and selected using
the and icons it can be transferred to a lower or higher
level as required. If, however, ‘Delete’ is pressed, the selected
participation is cancelled.

Events

The "Events" option is visible in "DOUBLE CLICK mode" and
comes under "Events Editor" in Extended mode.

It is possible to associate events (functions or scripts) to the
actions executed by each use (for instance, log-in) by clicking
the "Browse" button on the right :
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Componerts  [Defassmser =

anegin Q
Oniaginlirar

anLagout [t dveeiionsiond =lalx
| T ————"_

antegin

The event is activated in the various conditions listed in the
table "Password Events" (see chap. 6, “” page 252).

Polymath 2.0 now also allows you to export with a new prede-

fined function, the CSV user log.

Previous versions of the Polymath used Script.
The "User Log Export" function controls access to password

protected objects.

The new “Export User Log” function can be associated by the
Events / Functions Editor. The event is activated in the various
conditions listed in the table "Password Events" (see chap. 6,

“” page 252):

en 1ons

Functions/Scripts associated to this event

1) | ExportUserLoa()

Exportactivealarms()
& PasswordandUser
UserLoging)
UserLogout(}
ChangelserPassword(}

= Recipe
i LoadRecipel)

O DownloadRecipeBuffer()
DownloadRecipe()
SaveRecipeBuffer()
ClearRecipeBuffer()
Mod DeleteRecipe()
UploadBufferRecipe()
ExportRecipe()
ImportRecipes()
ExportRecipeTypel)
ExporiRecipeal Trpes()
StopRecipeTransfer()
StopallRecipeTransfers()
= Page
ShowNextPage()
ShowPreviousPage(}
hawPaneblameth
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The "FileName" field in the window below allows you to select
the directory and the name of the file in which to save the Log:

Events/Functions Editor
Functions/Scripts associated to this event
00 ExportUserLoal)

Parameters of the sslected function/script

[ Stere the return value into

Lo Hard Disk/test.csv
Made sV

Opening the xxxxx.csv file with Excel displays the following
records and allows you to check who has accessed password-
protected objects :

A
16-07-2010;08:44:09;P4:login
16-07-2010;08:45:11;P4:logout
16-07-2010;09:16:07;P8:login
16-07-2010;09:19:33;P8:logout
16-07-2010;10:08:03;P8:login
16-07-2010;10:16:14:P8:logout

oOOEs WK —

Fields grid

General Users Users cvent: TORH

|Rows |

Font SysternTahomalTahoma) °
|selected cell ]
Text Color lzss , 255, 255 ﬂ
Background color .n ,0,0 =]
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The Fields grid window is used to set the graphic properties of
the cells of the user list table (see chap. 6, “User List Table”
page 396). The Font choice box allows you to decide to assign
a font to the user list table; by clicking on the ' icon a
window appears for specifying the font and using this each
project language can have a font assigned to it. In addition,
this window can be used to define various properties of the
font for the table like dimensions and graphic effects.

In addition you can specify a background and text colour for
the cell selected currently. The colour can be selected using
RGB values or the colour palette obtainable by clicking on the
rectangle of the colour [[] or on the selection arrow [-]; the
classic Windows colour selection window appears and using
this even customized colours can be defined.

The "Data Archive" object comprises all the Polymath func-
tions able to store data :

e Time trend
e XY trend
= Data log

Trend Buffer

In runtime the system supplies the support for the acquisition
and accumulation of numerical values and for their graphic
presentation in the form of a “trend curve”.

The accumulated data can be presented in real time or saved
into the permanent memory and recalled to the screen at a
later point.

By double-clicking on the Trend Buffers element in Project
Explorer, the list of Trends held in the project can be accessed.
This list also offers a summary of the principal characteristics
of the Trends in editable fields :

List

List

lTrendBuffer 1

Using this list you can create new Trend buffers and duplicate
or delete existing ones.

189
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For more information on the table and the meaning of the
events that can be associated to a Trend buffer, readers are
advised to consult the next chapter (see chap. 6, “”

page 253).

Once a new Trend has been created double-click on it in
Project Explorer to be able to edit it. For this there are two
pages General and Buffer as indicated in the following
sections. Project Explorer is used only to define the operation
of each Trend Buffer, while the way it is drawn is dealt with in
the next chapter (see chap. 6, “Trend View” page 367).

General

(NIl Buffer Events

Identification
Mame TrendBuffer

Comment

Using the General mask you can set the identifying properties
of the Trends. The ID of the Trend is an identifying number of
the data structure within the project; it is a whole number
greater than zero.

The name and ID of a Trend are unique attributes within the
project that is other different Trends with the same name and
number cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.

Buffer

[T i [T

Diata acquisition

Source (sample) [Tes l!
Strobe type |r_.,, Twner L!
EEDEA | Tumer L!
Management
Size (samples) puii] ==
(tame) 0 hri0 min: S0 sec0 deec ==
Warning lavel (%] s B
[ Log to file

&4 Enabied at start up
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In this mask enter the operating characteristics of the Trend
and of the related memory buffer.

First of all, a source variable to the object of the monitoring of
the Trend must be specified.

You also need to indicate a sampling mode for the values. The
types of sampling available are summed up in the following
table:

Tabella 3: Types of Trend sampling

Sampling mode Description

Time based the sampling is done at regular intervals

the sampling is done when the reference
On Strobe Raise | variable changes the value from FALSE to
TRUE

the sampling is done when the reference
On Strobe Fall variable changes the value from TRUE to
FALSE

the sampling is done on receipt of a command

n mman - -
On Co and from a Script, function or command area

If the type of sampling is Time-based it will be necessary to
enter a reference to a Timer specially configured so as to
acquire sampling of the TrendBuffer (see chap. 5,
“RefreshGroups” page 123), while if the type of sampling is
On Strobe Raise or On Strobe Fall it will be necessary to
specify a Boolean variable (see chap. 5, “Value” page 126).
Setting the TrendBuffer also requires its dimension be
indicated: the maximum number of samples to be saved can
be defined, or, if the sampling frequency refers to a timer, the
maximum duration of the buffer (in tenths of a second).

The system can manage the buffer either on a FIFO (first in
first out: the least recent element is eliminated) or an ARRAY
basis (when the buffer is full the new values are disregarded).
You can also set a Warning value, expressed as a percentage,
beyond which the user must be advised that the Buffer is
nearly full (this triggers an OnWarningLevel event).

The option ‘Save to File’ at the bottom of the mask indicates
whether the elements of the TrendBuffer must be saved to file
so as to be kept after the terminal is switched off (otherwise
they are retained in the volatile memory). If this option is
activated, a storage file name (containing characters
supported by a Windows environment) will also have to be
specified. The log file is memorized in the \log folder (see
chap. 8, “Transferring data” page 474).
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B/

TrendBuffersXY

The last option relates to the possibility of enabling the Trend
at the start-up of the project; if the Buffer is associated to a
Timer, it will still be necessary to start the Timer (see chap. 6,
“Properties of the Password Grid” page 398) to begin the
acquisition.

Note: Thelog fileis a file the system uses to permanently save the
data to be represented in the TrendView. The fact that its name can
be chosen using POLYMATH is useful in that this allows the user to
manage the file (e.g. copy or delete if dimensions are too great). If,
however, you want to manipulate the data of a TrendBuffer it will
have to be exported using either a predefined function or Script (see
“ Appendix B - Predefined functions’ page 701 and see chap. 9,

“ Seripts” page 509).

The display graphic of the "TrendBufferXY" property is the re-
presentation of two distinct variables, and not like in the
"TrendBuffer" of a variable depending on time. Therefore, as
shown in the following image, in the assignment phase, the
variables must both be determined (Source X and Source Y).

LT
T (M LTS TN MO

Clicking "Modify" the "General", "Buffer" and "Events" (only in
"DOUBLE CLICK" mode) masks can be accessed.

General

el Buffer Events

Identification
Marme TrendBufferxy

Cormnment

The identification properties of "TrendXY" can be set on the
"General" mask. The"ID" of "TrendXY" is an identification
number of the data structure inside of the project; it is a whole
number greater than zero.
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The "Name" and"ID" of a "TrendXY" are alone attributes inside
of the project. Distinct "TrendXY"'s having the same name or
ID number cannot exist.

The comment is a Unicode string visible only inside of POLY-
MATH.

Data scauisition
Source ¥ {sample) [Ta0 ;[
Source T (sample) [rasa ;[
Strobe type [on Tiear 5|
Strobe [Fmer 1 100
Management
sizn (smmples) 100 =
(time) 0 hr:0 min:50 sec:d dsec =
Warning bwval (%) 5 =
DO Log e file
B Enabled st start up

The functional features of the TrendXY and the relative me-
mory buffer are indicated on this mask.

First of all, as can be seen, two distinct tag sources must be
indicated (and not only one, as in "Trend", since the second
variable was the time) which will be the object of "TrendXY"
monitoring.

As in the "Trend" function, a value sampling mode must be in-
dicated. The available sampling types and their properties are
identical to those on "Table 4" and in the successive descrip-
tions previously shown.

Events

The "Events" option is visible in "DOUBLE CLICK" mode and
comes under "Editor Events" in "Extended" mode.

You can associate events (scripts) to the various conditions of
the trendbufferXY (for example when the trendbufferXY is full)
by clicking the "Browse" button on the right :
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General Buffer [N

List |
OnBufferClear

OnBufferFull
OnBufferove ==

£ Events,/Functions Editor (=l
onsampls =10l
Functions/Scripts associated to this event

Ontarningle

[Parameters of the selected function/script

O store the return value into

The event is activated in the various conditions of the trend-
bufferXY. The conditions are listed in the table "Trendbuffer
Events" (see chap. 6, “” page 253).

Datalog The "DatalLog" is a property similar to the "TrendBuffer". The
biggest difference is that while the "TrendBuffer" is data
displayed on a graphic, the "DatalLog" is data displayed on a
table.

e
el

Scripts Scripts are an element enabling writing of functions to be
customized, which is useful in that the predefined functions
are not always sufficient for the user’s needs. They can be
written with true programming languages and be executed
directly in runtime. For more information on writing Script
codes readers are advised to consult the chapter dealing with
these (see chap. 9, “Scripts” page 509).

In this section we shall limit ourselves to describing the how
the Scripts are managed at the project level .

By double-clicking on the Script option in Project Explorer, the
list of Scripts in the project (with their related comments) can
be accessed. Using this list mask you can add new Scripts to
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the project (using the ‘Add’ key) or duplicate them (using
‘Duplicate’) and delete existing ones (using ‘Delete’) :

List

List

lESAStartup

2 Edit % Delete Duplicate

To be able to enter the actual edit mode for a Script, double-
click on it in Project Explorer; there are two masks for editing
Scripts: General and Scripts. These are described in the next
subsections.

For more information on the table and the meaning of the
events that can be associated to a Script, readers are advised
to consult the next chapter (see chap. 6, “Events related to
Pipelines” page 252).

General
g coneral|
|1dentification
Harne Seript
Comment
‘ParamEtErs
Return walue type: |Nm,E
F  add Duplicate

Using the General mask you can set the identifying properties
of the Script. The Name is a unique attribute within the project
that is, other different Scripts with the same name cannot
exist.

The Comment is a Unicode string and is visible only within
POLYMATH.
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It is also necessary to define whether the Script must return
a value to the application and what type of value this must be
(Number, String or Variant).

Use the table at the bottom of the mask to specify the input
parameters to the function with their related Names, Types
(Number, String or Variant) and Comments (visible only in
POLYMATH).

Scripts

fefealng General

Scoript
Sub ESAStartup()

1; 'ESAStartup sScript

=
A 15

The Script mask contains only one text input window, inside
of which you enter the code relating to the functions the Script
will have. For more information regarding the uses of Scripts
we advise the reader to consult the relevant part of the
manual (see chap. 9, “Scripts” page 509).

GlobalScripts GlobalScripts function in the same way as the Scripts
described in the preceding paragraph; the real difference is
that these types of Script cannot be associated to an event or
a key but are activated with the start up of the Runtime.
They work and are edited in the same way as standard Scripts,
the only difference consists in the non configurability of the
input parameters and the return values for these functions (as
they cannot be called up inside the project).

Text list In POLYMATH there are objects whose purpose it is to be text
containers useful for creating value fields (see chap. 6, “Value
fields” page 285). Each text list can contain an indefinite
number of texts; the sole limits are those deriving from the
Hardware configuration of the panel.

When you double-click on the Text list icon in Project Explorer
the causes the table of text lists to appear in the work area;
this list can be used to introduce, duplicate and delete the text
lists or simply introduce or edit a related comment.

Once a Text list has been created, it can be double-clicked in
Project Explorer to access the corresponding editing mask
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The upper part of the mask can be used to change the
identifying properties of the list. The Name of a list is a unique
attribute within any given project that is other different lists
with the same name cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.

The lower part of the mask can be used to edit the text list
itself; new texts can be added or existing ones deleted. To
move a text just select it and click on the Up or Down keys
according to the operation to be performed.

If there is more than one language in a project (see chap. 5,
“Languages” page 152), you can go on to define the
translation for each text in the list as shown in the following
figure :

=1o| x|

Language Text

alish (Unitec
Italian (Italy

The machine is now on

The E key allows to insert symbols into the description.

Image list In POLYMATH there are objects whose purpose it is to be text
containers useful for creating value fields (see chap. 6, “Value
fields” page 285). Each Image list can contain an indefinite
number of texts; the sole limits are those deriving from the
Hardware configuration of the panel.
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When you double-click on the Image list icon in Project
Explorer the causes the table of Image lists to appear in the
work area; this list can be used to introduce, duplicate and
delete the text lists or simply introduce or edit a related
comment.

Once an Image list has been created, it can be double-clicked
in Project Explorer to access the corresponding editing mask.

The upper part of the mask can be used to change the
identifying properties of the list. The Name is a unique
attribute within any given project that is other different lists
with the same name cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.

The lower part of the mask can be used to edit the Image list
itself; new images can be added or existing ones deleted. Add
an image already in the project (see chap. 5, “Add an image”
page 199) by using the relevant drop-down menu Image
column. A preview and a comment can be displayed for each
image belonging to the list.

To move an image just select it and click on the Up or Down
keys according to the operation to be performed.

Images POLYMATH offers the possibility of importing into the project
images that are in the programmer’s PC; images in all the
more common graphic formats can be introduced.

By double-clicking on the Images icon in Project Explorer, the
list of images uploaded into the project can be accessed. Using
this list you can see a preview of the figures, add them,
duplicate and delete them. In addition this window makes
information available regarding the dimensions (in pixels) of
the image, its format and quality; it is also possible to edit the
Comment relating to each figure :
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2402220 Ipeg Best Quality

2402220 Ipeg Best Quality
6002407 Ipeg Best Quality

6002407 Ipeg Best Quality

Bk_Ext_Low_Fg_7_10_Hor

6002407 Ipeg Best Quality

Bk_Ext_Low_Bg_7_10_Hor

6002407 Ipeg Best Quality

Bk_Ascii_Up_Fo_4_5_7_10 2402220 Ipeg Best Quality

Bk_Ascii_Up_Bg_4_5_7_10

2402220 Ipeg Best Quality
2402220 Ipeg Best Quality

2402220 Ipeg Best Quality

Bl | L]

?  Edit K Delete

Duplicate

When a new project is created POLYMATH introduces some
images intended for specific uses as a default (display of
alarms, Trend Pen, etc.). These can also be used inside for
other purposes.

For the description of how to introduce and change images
within a page you are advised to read the following chapter
(see chap. 6, “Image Field” page 282). Below we describe the
procedure for adding an image to a project.

Add an image

To add an image in POLYMATH you can operate directly on the
image object (by clicking on Add) or using Project Explorer (by
right-clicking on Images, then Add).

In both cases the Image mask is accessed (described in the
next section); to browse the contents of your PC just click low
down on the mask (‘press here to upload a file’). At this point
a window appears and this is used to add one of the personal
images that can be edited with the normal commands
contained in the Image and General masks that we are about
to describe in detail.

It is possible to insert images with extension type DWG or DXF
type even if they are not available in the files list.

To insert such images in the project, select the image, select
the type of file such as All files and open it.

Polymath will automatically convert the image in BPM, ready
then to be used in the project.
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Image mask
General
Imags Faramsters
Width 28 Height: 72 Resize |Nwma| j
Dithering  [one =
Format [16eg =] Qualiy [ormat =l
Image

This mask is used to edit the parameters of the image. Each
time one of the properties of the image is changed, the
changes made are immediately visible in the preview box at
the foot of the mask.

Firstly, you can set the dimensions in pixels (width and height)
of the image contained in the project. Should the original
dimensions of the imported image be varied it will also be
necessary to define how POLYMATH will have to effect the
change in size (calculating the addition or removal of pixels).
The options available are :

= Normal

= Resample (also called Bilinear), a faster and less precise
algorithm recommended for reducing images

* Bicubic, a more precise algorithm recommended for
enlarging images

in addition you can define the type of filter for the images that
contain colours not supported by the panel thanks to the
dithering technique (substitution of pixels with colours not
available with the interpolation method); you can choose from
a list of the more common types of dithering algorithm the one
you wish to use :

e None

= FloydStenberg
e Stucki

e Burkes

e Sierra

e StevensonArce
e Jarvis

e Ordered

e Clustered
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.
Note: For more details regarding the special characteristics of each
dithering algorithm, the reader is advised to consult manuals

specializing in digital graphics.

Finally you have to specify the format in which the image is to
be saved within the project (Bitmap or Jpeg); if the Jpeg
format is chosen, the level of quality-compression desired will
also have to be defined by choosing between the levels
offered:

= Excellent quality

= Good quality

= Normal

e String compression
= High compression

Operations performable on an image

When you are inside Image mask of an image, POLYMATH
activates a series of icons for graphic purposes that are
applicable to the image in question. These features are
accessible via the toolbar or the image submenu of the main
menu. To edit it is possible to use the image editor of the
window. Below we set out a list of POLYMATH utilities related
to images :

e Load image: reached viaicon E‘! or main menu (Image-
>Load image). Allows a new image present in your PC
to be loaded (you can introduce images in the more
common formats)

= “Modify”: can be reached via the icon or by main menu
(Image->Modify). Allows the image to be modified.

= Restore image: reached via icon or main menu
(Image->Restore image). Undoes all changes made to
the base image.

= Colour: reached via icon @ or main menu (Image-
>Colour). Allows the type of image colour to be selected
from the following 3 types, namely Automatic, Grey
tones or Black and white.

* Increase contrast: reached via icon or main menu
(Image->Increase contrast). Increases the contrast of
the image being edited.

= Decrease contrast: reached via icon @ or main menu
(Image->Decrease contrast). Reduces the contrast of
the image being edited.
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= Increase brightness: reached via icon or main menu
(Image->Increase brightness). Increases the
brightness of the image being edited.

« Decrease brightness: reached via icon %l or main
menu (Image->Decrease brightness). Reduces the
brightness of the image being edited.

= Cut Area: reached via icon or main menu (Image-
>Cut Area). If this icon is pressed it will be possible to
cut (and make visible) a portion of the imported image.

= Rotate: reached via icon E or main menu (Image-
>Rotate). This function makes it possible to rotate the
image anticlockwise; with each rotation POLYMATH
automatically updates the Height and Width dimensions
inverting them.

e Adapt to screen: reached via icon ¥ or main menu
(Image->Adapt to screen). If this |con is pressed the
image is adapted so that it occupies the work screen
completely (in practice its dimensions coincide with the
maximum screen dimensions of the VT).

= Maintain proportions: reached via icon iﬂ or main menu
(Image->Maintain proportions). If this icon is pressed
the proportions of the original image are maintained,
that is, to change the Height of the image, POLYMATH
updates the Width and vice versa.

F-

General

[eTTEl Events
Identification

Name Fipeline

Comment

Parameters

Source |Tag-1 ﬂ
Destination [Tag_2 ﬂ
Mode [Foting =

Activation | ﬂ

The General mask can be used to set the identifying properties
of the image. The Name of an image is a unique attribute
within any given project that is other different images with the
same name cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.
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Advanced The following objects come under the heading of "Advanced" :

* Pipelines

= Print

= Remote messages
= Keyboards

* Weekly tasks

= Schedulers

e Groups
= Audio files (only when panels IT11x are used in the
project)
Pipelines Pipelines are the active objects that update the value of one

variable on the basis of the value of another variable. The
most common application of Pipelines is for copying the value
of one variable into another; this function is convenient for
having the panel work as a bridge between two devices. The
Pipelines created with POLYMATH are already activated at the
start of the Runtime together with their particular functioning.
By double-clicking on the object Pipelines in Project Explorer,
the list of Pipelines in the project can be accessed. The
principal characteristics of each Pipeline are entered in
editable fields. Using this mask you can add new Pipelines,
edit or delete existing ones. A new Pipeline can be edited after
double-clicking on its Name in Project Explorer, thereby
accessing the General mask described in the next section.
For more information on the table and the meaning of the
events that can be associated to a Pipeline, readers are
advised to consult the next chapter (see chap. 6, “Events
related to Pipelines” page 252).

General

[eTTEl Events
Identification

Name Fipeline

Comment

Parameters

Source [Tag_t ﬂ
Destination [Tag_2 ﬂ
Made [Foting [

Activation | ﬂ
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Using the General mask you can set the identifying properties
of the Pipeline. The ID of the Pipeline is an identifying number
of the data structure within the project; it is a whole number
greater than zero.

The Pipeline name and ID are unique attributes within the
project that is other different Pipelines with the same name
and the same ID cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.

At the bottom of the mask you can enter the working
characteristics that describe the Pipeline. First of all, it is
necessary to indicate a source and destination variable.

The related sliding menu is used to select the Pipeline
operating mode and this is chosen from those listed in the
following table :

Tabella 4: Pipeline modes

Mode Description

Each time a new value is read from the source
variable, this value is assigned to the
Polling destination variable. The acquisition rhythm
is governed by the refresh parameters of the
source variable

Similar to ‘polling’, only that the values
acquired from the source variable are
Copy by Change | assigned to the destination variable only
when the value of the source variable is
changed

The value is copied by command, that is, in
line with the transition from FALSE to TRUE of
the value of the auxiliary variable that can be
entered into the next field (activation, must
be Boolean)

Copy by
Command

In the boxes for choosing variables you will also find the icons
for adding variables and editing them.

Events

The "Events" option is visible in "DOUBLE CLICK" mode and
comes under "Editor Events" in "Extended" mode.

You can associate an event (function or script) to each condi-
tion of the Pipeline by clicking the "Browse" button on the ri-
ght:
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General [RI0H

List
OnDestDown

OnSourceDown

onstop

onStart

The event is activated by associating it to one of the conditions
listed in the table "Events associated to the Pipeline"” (see
chap. 6, “Events related to Pipelines” page 252).

Print reports are objects that make it possible to set out on
paper information relating to the Runtime procedures. In
POLYMATH different types of Report can be defined, each
having an undefined number of pages. Each Report page can
in turn contain all the objects found in a Page. The
arrangement of these objects is independent and fixed.

in runtime, printing can be launched by pressing buttons to
which predefined functions are associated or via User Script
(see “Functions relating to printing” page 712 and see chap.
9, “ESAPAGEMGR methods accessible with Scripts”

page 537). Naturally a compatible printer needs to be
connected to the panel.

Using the Report element of Project Explorer you can define
any number of Report types, Headers and Footers. Different
pages, even ones belonging to the same Report, can have
Different and customized Headers and Footers.

Report List

Double-clicking the Report element of Project Explorer
accesses the List of Reports in the project. Using this list you
can introduce Report Types by clicking on ‘Add’, duplicate
existing ones by clicking on ‘Duplicate’ or delete them by
clicking on ‘Delete’. In addition, existing ones can be edited by
clicking on ‘Edit’.

205
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For each type of Report the summary of its characteristics is
shown in editable fields (Name, ID and Comment). This mask
is useful for gaining a complete view of all the recipes present
in the project.

Definition of a Print Report

There are two ways of creating a Print Report :

e click on ‘Add’ in the Report list

e click on ‘Add’ or ‘Add and change’ on the menu
appearing after clicking with the right key of the Reports
element in the Project Editor

In both cases, the Report is edited by means of three tabs:
General, Pages and Headers/Footers page.

General

The upper part of the General mask can be used to introduce
the general properties of the Report.

The Report ID is an identifying number of the Report within
the project; it is a whole number greater than zero.

The name and ID are unique attributes within the project that
is other different Reports with the same name or the same ID
number cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.

Fage TFraview

Size m

Layout T

Default background calor [Jsees 5
Marging and grid

units [Contmeters =]

Left 3
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The lower part of the General mask can be used to define the
common layout of each page belonging to the Report currently
being edited. All the pages belonging to the same Report thus
have the same layout.

Using the left side of the mask you can define the page
settings while the right side shows you an updated preview of
how the printed page will look.

You can define a format for the page (options are A4, A3, B5,
Legal or Letter), an orientation (Portrait or Landscape) and a
default Colour for the pages belonging to the Report.

Finally, after specifying a unit of measurement as a reference
(options are: centimetres, pixel, inches or millimetres), you
can proceed to define the margins between which to print the
Report pages. You can define the left, right, top and bottom
page margins. You can also define default values for the
editing grid of all the pages belonging to the Report (then, if
required, the grid can be edited for each individual page in the
related General table).

Report page list

Reportiage First page of the Report

Eeporthage_1
ReportPage_1

ReportPage_3

The Report pages mask displays the list of the pages
belonging to the Report. Use this list to add new types (by
clicking on the ‘Add’ key), or duplicate (use the ‘Duplicate’
key) or delete (by using the ‘Delete’ key) the existent ones. In
addition, existing ones can be edited by clicking on ‘Edit’.
For each type of Report the summary of its characteristics is
shown in editable fields (Name and Comment). This mask is
useful for gaining a complete view of all the Report pages.

Headers and Footers page

DefaultFooter
Defaultiteader
Defaultfoster

Cefaultrieader
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This Headers and Footers mask allows you to associate a
Header or a Footer page (or both) to each Report page.

Just assign a Header/Footer object to the Report page ID and
specify whether this is to be placed in the upper part
(Headers) or the lower part (Footer).

In the following sections we will illustrate how personalized
Headers and Footers can be defined.

Definition of a Report page

There are two ways of creating a Report page:
= click on ‘Add’ in the Report list of pages related to
reports
= click on ‘Add’ or ‘Add and change’ on the menu
appearing after clicking with the right key of the Reports
element in the Project Editor
In both cases, the Report pages are edited by means of two
tabs: Fields and General.

Fields

Using this mask you can define the way a Report page in
question will actually appear; it is edited just like that for
normal pages with various objects being introduced and
properties being set (see chap. 6, “Managing a page”

page 254).

The properties of the Report pages are the same as those of
the Project pages (see chap. 6, “Page properties” page 257).
To introduce an object simply click on the respective icon and,
immediately after, draw the outline of the area to contain it
wherever you wish in the page .

The next chapter describes all the procedures for introducing
the graphic objects together with their related meanings and
tools.

ESAPOLYMATH - User Manual - rev. 2.1



Chapter 5

Project Explorer

General

Page [Preview
size

Layout

Oafauh background color

Marging and grid

Uinits [Centimaters -

Laft 3
Right 1

Top

Bobtorn
Grid wadth 1

Girid haight 1

The General mask can be used to set the identifying properties
of the Report page. The name is a unique attribute within the
project that is other different Report pages with the same
name cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.

In the "Parameters” sub mask it is possible to determine the
number of pages to be printed.

Programmers can use the bottom of the mask to define their
preferences regarding the editing of the page; by ticking the
option required you can define whether to overwrite the
default dimensions (established in the General mask of the
Report) of the grid .

Definition of Header and Footer

In POLYMATH you can use, the default Headers and Footers
after editing them or create an unlimited quantity of new
ones. Editing for Headers/Footers is the same both for the
default elements and for those introduced by the user.

After clicking on the ‘Edit’ option of the Headers/Footers list or
on a Header or Footer in Project Explorer, you can proceed to
the actual editing the object which is subdivided into two
masks: Fields and General.
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Note: In this phase the objects are defined without distinguishing
between Headers and Footers; thus these are created and edited in
the same way and only at the moment of their being used within a
Report isit specified whether they are to be placed at the top or the
bottom of the page.

Header/Footer list

List

Name Camment

DefaultHeader

DefaultFooter

Headerl

HeaderFooter

By clicking twice on the object Headers/Footers you can
access the Headers/Footers list defined in the project for the
Reports. As a default POLYMATH already contains two objects:
Default Header and DefaultFooter; to edit these objects just
click on the ‘Edit’ button. Itis also possible to add new objects
by clicking on ‘Add’, duplicate by clicking on ‘Duplicate’, or
delete ones already present by clicking on ‘Delete’.

Fields

Using this mask you can edit the way the Header/Footer will
actually appear in the pages into which it is called; it is edited
just like in the case of normal pages with various objects being
introduced and properties being set (see chap. 6, “Managing
a page” page 254).

The properties of the Header/Footer are the same as for
Frames (see chap. 6, “Properties of Frames” page 258).

To introduce an object simply click on the respective icon and
immediately after draw where in the page you wish the outline
of the area to contain it to be placed.

The next chapter describes all the procedures for introducing
the graphic objects together with their related meanings and
tools.

Using this mask you can, however, set the dimensions of the
Frame. Click on the 'ﬁ icon to select it and then move the
cursor to one of the red corners by dragging it in line with the
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desired dimensions (this operation can also be performed by
the General mask as set out in the next section).

You cannot use this mask to move the object, in that its
position could be at the top of the page (if used as a Header)
or at the bottom (if used as a Footer).

General

[Ldentification
Name Header1

Comment

[Size

Wil Fixels
Width 200
Height 200
Grid width o

Grid height ]

GE B B (] 1

The General is used to set identifying properties of the
Header/Footer page. The name is a unique attribute within the
project, that is, other different Headers/Footers with the same
name cannot exist.

The Comment is a Unicode string and is visible only within
POLYMATH.

At the bottom of the mask, you can define your preferences
regarding editing the Headers/Footers. You can also specify a
unit of measurement as a reference (options are: centimetres,
pixel, inches or millimetres) and the height and breadth
values of the part of the page occupied and the depth value of
the grid for the edging phase.

Points relating to print formats: XML and Hardcopy

When the Print function is called using a predefined command
or a Script you can decide to print the Report onto paper or
onto file (or both). In the case of printing onto file, the Report
specified by POLYMATH is saved onto a physical support of the
panel in XML format so as to be able to be displayed on a
browser and be in any case kept in a reconstructable digital
format.

For more information on how to carry out this operation, the
reader is advised to read the chapters illustrating this function
(see “Functions relating to printing” page 712 and see chap.
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9, “ESAPAGEMGR methods accessible with Scripts”
page 537).
Hardcopy printout is an alternative mode for printing the
Reports created in POLYMATH. With this you can print the
entire content of the page displayed by the panel at the
moment of the print command (adapting it to sheet format).
There are two types of Hardcopy printout:
= Hardcopy page : print the current page excluding any
popup
= Fullscreen hardcopy : print exactly what appears on the
screen

Note: Thereis also the possibility of managing the text print and
values on rows in runtime exploiting the Scripting functions
contained POLYMATH. Readers are advised to consult the section
in this manual dealing with the Scripts to discover the potential of
these functions (see chap. 9, “ object ESAPRN” page 595).

Remote The "Remote Notifications" function allows to send notification

Notifications messages by e-mail to a previously created user list.
Associating the notification message to a given alarm present
in the project, a message can be sent to one or more users,
for example.
The message can be associated to one (or more than one) of
the three alarm states: "Raised", "Acknowledged”, "Acquired".
From "Explore Project", double-clicking "Remote Notifica-
tions", the editing area is accessed.

General

The text which will make up the message in the desired lan-
guage can be typed on the "General" mask.

Alarm messages

Alarm ON message oN

Alarmn ACK message ACK

Alarm OFF message OFF

Email

From the "Email" mask it is possible to determine the settings
required to send the "Notifiche Remote" (Remote Notifica-
tions) via E-mails.
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General SME  Proxy

Ernail

Sender's name
Email's subject
SMTP server

SMTP username

SMTP password

SMS

Part 80

From the "SMS" mask it is possible to determine the settings
required to send the "Notifiche Remote"” (Remote Notifica-

tions) via SMS service.

General Emall [SEN Proxy

SME

Sender's nams
SMS gatsway
SMS gatsway username

SMS gatsway password

Type of SMS

User tag

Password tag

Gateway URL extension
User Id

Identifier tag
Destination tag
Message tag

Unicode tag

O Replace Massage tag

Spacs Replacemant

Proxy

Port &0 E

From the "Proxy" mask it is possible to determine the settings
required to send the "Notifiche Remote" (Remote Notifica-

tions) via Proxy service.
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Notification Users

From "Explore Project"”, double-clicking "Notification Users",
the user list is accessed.

Clicking "Add", an unlimited number of different users can be
added.

The name, e-mail address (needed to notify the message) and
the language can be specified for each user.

These parameters can be edited modifying the corresponding
fields :

Notification Groups

All users previously created can be put into one or more
groups.

From "Explore Project", double-clicking "NotificationGroups",
the group list is accessed.

Clicking "Add", one or more groups can be added :

Clicking "Modify", the "General" and "User" masks are acces-
sed.

General

eUle| Users

Identification

Name NotificationGroupl

Cornment

Parameters

O send an email to all the users of the group

[ 5end an SMS to all the users of the group

[ The natification is dispatched when the slarm is trigasrad

[ The netification is dispatched when the alarm is acknowledged

[ The natification is dispatched when the alarm goes off
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From the "General" mask, an e-mail can be sent to all the
users in the group, choosing from the options of the "Parame-
ter" voice.

The notification can be sent when the alarm is "Raised" or
"Acknowledged" or when the alarm "Ends".

Users

From the "Users" mask, clicking "Add", the users created pre-
viously can be added one at a time.

Double-clicking "None", the users on the list can be chosen.
To add other users to the same group, repeat the operation,
clicking "Add" again, until the desired number of users is rea-
ched.

Keyboards Keyboards can be customized to enter data having the desired
form, colour and content, so that they can be used for projects
in any language (using Cyrillic, Greek, German, American and
Asian characters). Keyboards can be created and saved in the
library to be used in further projects.

You can associate a customized default keyboard to any
language.

List

Double-click on keyboard to access the list of keyboards
entered by default :
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List

List

Bk_Ascil_Low_4_5_7_10

Bk_Mumeric_4_5_7_10

Bk_Ext_Low_7_10_Hor

l Bk_Ext_Up_7_10_Hor

The "List" menu allows you, by pressing the respective but-
tons, to :

< Add one or more keyboards

= Edit one or more keyboards in the list

= Cancel one or more keyboards in the list

« Duplicate one or more keyboards in the list

Fields

Double-click one of the keyboards in "Explore Resources":

E| 3_} Advanced

?‘i Pipelines

[]--Q Reports

[#-[~ Remote notification

Bk_Asci_Low_4_5_7_10

Bk_Ext_Up_7_10_Hor
'iw Keyboard
!‘P‘ weekly tasks

K

The "Fields" window opens :
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In the "Fields" window you can double-click each button of the
keyboard and customize its settings and properties :

Mouge poater:(36,56)

Kayboardkny_ia

Keybosrdid [ane 30
KeyCode a1 .
Functonkey [Hone |
PressedHode [Reverie Backaraund H
ToggleMads [roting =
| ———— ]
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General

Fielss [N Fropertes

Idsntification
Name Blk_Numeric_4_5_7_10
Comment

Size
Width 240
Height z20

Editing

O override default grid size

width 10
Height 10

The "General™ window allows you to do the following :

e Attribute a name and insert any comments on the key-
board

= Define the size of the keyboard

= Edit the default size of the grid

Properties
Fields General [20H)
Position
Width 240
Height 220
Appearance
Backaraund imags [ek Numeric_Fa_s_s_7_10 j
Foreground image [Bl_numeric_Ba_4_s_7_10 j
Advanced
Show display =

Show in foreground mode =

The "Properties"” option is visible in "DOUBLE CLICK mode"
and comes under "Properties Editor" in "Extended" mode.

The "Properties” window allows you to do the following :
= Assign a position in the page to the keyboard

= Define the appearance of the keyboard by selecting a
background and foreground picture
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= Choose whether to show or hide the content in the key-
board display

= Choose whether to show the keyboard in "foreground”
mode

Weekly Tasks The Weekly Tasks allow to set all functions that are necessary
to create and edit a "Chronothermostat".
After double clicking on the "TaskSettimanali" (Weekly Tasks)
in the "Project Explorer”, a list of "WeeklyTasks" inserted
within the project will appear in the work area :

Lista

Tag manuale Tempo inizio Tempo fine

1l | L]

2 modifica % Cancella & Strumenti

From this list it is possible to insert new, duplicate or eliminate
existing. The "Tools" key allows to modify the structure of the
columns at will.

Once a "WeeklyTask" has been created (from the "Project Ex-
plorer” or list, by double clicking on it in the tree chart, it can
be edited in the work area.

The properties and events that can be associated to the
"WeeklyTask" object will be treated in the next chapter. It is
therefore recommended to consult the relative section for the
list and meaning (see chap. 6, “Chronothermostat”

page 405).
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General

1dnniificaticn

Hame. WaaklyTask

Commenk

14 1

|Activatian

Status tag [ees jm
Task tag I BT 7]
Hanual tag [ B+ 7]
OFF tag = BT 7]

Start time. 5

End time

Intervals [heur =]
O use defauk value

Dot vahse I =

The "General" mask shows the data relative to the "Chrono-
thermostat” settings. It is possible to introduce the identifica-
tion attributes of the page, such as "Name", "Comment" and

"1d".

The different editing fields listed below can be found in the
"Activation" section:

"State tag" : it can be associated to a Boolean variable
that indicates the switch-on state (1) or switch-off state
(0) of the "Chronothermostat" scheduling

"Tag task": indicates the current temperature value
"Manual tag" :is the variable that memorises the tem-
perature value that can be set in "Manual” mode.

"Tag OFF": it can be associated to a Boolean variable
that indicates the switch-on state (1) or switch-off state
(0) of the "Chronothermostat"

"Start time" : indicates the minimum value relative to
the time scale in the "Chronothermostat" graphics
"End time" : indicates the maximum value relative to
the time scale in the "Chronothermostat"” graphics
"Intervals" : allows to set the time intervals in the
graphics between "hour" and "half-hour"

"Default value" : indicates the desired temperature val-
ue that can be activated by pressing the "Default" key
in the "Chronothermostat”. The system exits the "Auto-
matic" mode and passes to "Manual” mode with the De-
fault value.
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Script

[WM

Bergt
[l s ONOFF seript
Sengk tag [Hione ;I
Type of chronoterm | ;‘
Commutation tag [ jm
Wt 100
Cald tag [ ;I
Offsat tag [hene jm
Current temperature tag | B+ 7]

The "Scripts" that can be activated in this page, allow to define
the behaviour of the "Chronothermostat” in the "Riscaldamen-
to" (Heating) or "Cooling” modes or both.

"Tag script” is a service variable that memorises the activation
state (1) or not (0O) of the "Script" itself.

The "Type of Chronothermostat" indicates which mode to
make active in the system :

= "Heating only" : the system questions the values set
and changes the values of the "Hot tag"

= "Cooling only" : the system questions the values set and
changes the values of the "Tag freddo" (Cold tag)

= "Riscaldamento e Raffreddamento” (Heating and Cool-
ing): the system questions the values set and changes
the values of the "Tag caldo" (Hot tag) or "Tag freddo"
(Cold tag) according to the system active. The passage
of activation from one system to another is activated by
the "Estate" (Summer) or "Inverno" (Winter) control
present in the "Chronothermostat"

The "Tag di commutazione" (Switch-over tag) indicates the
active state (1) or off state (0) of the "Riscaldamento e Raf-
freddamento" (Heating and Cooling) system

Differently, the "Tag caldo" (Hot tag) and "Tag Freddo" (Cold
tag) indicate the temperature reference values for activation
of the system.

The "Tag offset” can be used to set the offset value referring
to the "Chronothermostat"” working temperature in a variable.
The actual temperature value is memorised in the "Tag tem-
peratura corrente" (Current temperature tag).

ESAPOLYMATH - User Manual - rev. 2.1



222 | Chapter5

Project Explorer

Values

General Script

Task values

Temperature

The "Values" table contains the data relative to the tempera-
ture and corresponding tag values. It can be useful to assign
a different tag value with respect to the temperature when the
device, used in the realisation of the project, requires conver-
sion of the data according to its programming features. The
"Tools" key allows to modify the structure of the columns at
will.

Schedulers Through the "Schedulers" function, Polymath allows program-
ming the execution of organised events in daily and weekly ti-
me periods, even combining them with customised calendars.

List

After having double clicked on the "Schedulers" icon in the
"Explore Project", inside the work area the "List" mask contai-
ning a list of the schedulers inserted inside the project will ap-
pear:

List

I Scheduler

From this list it is possible to insert new ones (by clicking the
"Add" key), to duplicate or to eliminate the existing ones (by
clicking the "Duplicate" and the "Delete" keys), the "Tools"
key allows modifying the columns structure at will, while the
"Modify" key allows entering the "General” property editing
mask:
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Identification

Marne Scheduler
Comrment
I
Properties
Task type [startend ~]
Start Tag [ scheduler_start b
End Tag | schaduler_stop v elkd
Holiday
Policy Hone ~]
Fields
Weekly type Days vl

The "General" mask consists of the following sub masks:

 ldentification
= Properties

< Holiday
e Fields
Identification

Identification

Marne

Comment

This sub mask makes it possible to assign a name and a com-

Scheduler

ment to the scheduler.
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Properties
|Prupemes
Task type | startEnd v
Start Tag [ seheduter_start b
End Tag [ seheduter_stop n

The "Properties” sub mask shows data relating to the "Sche-
duler"” settings. It is possible to insert page identification at-

tributes:
e Task Type
e Start Tag
= End Tag

The "Task Type" section makes it possible to choose among
the following options:

= "Single": only the beginning time is shown (that is only
a start event will be associated, it will not have any
event or end time:

Properties |

Task type

Start Tag Scheduler_Start -
Scheduler_Stop

e “StartEnd”: both start time and end time are shown
(that is there will be two events associated to start and

end):
ties
type | startend v
Single
Start Tag _
End Tag |Schedu|er_8top v B3k

By default the scheduler has two Tags associated to it:

e Start Tag
= End Tag
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It is possible to change Tags adding new ones that have to be
of the same type (Internal) and value (Unsigned Long) of the
default ones:

Properties

Task type | startend v

Start Tag Tag v [v]
Scheduler_Start
End Tag Scheduler_Stoj

Holiday
Policy None ]

Clicking on the "Modify" key will edit parameters of the
just created Tag:

|Tag Type |

Type Unsigned Long ¥ | O array
Char

Byte

Boolean

Integer
Unsigned Integer
Lan

S Eg@ﬁlm
Initialization Couble :I

String
Holiday
|HOIiday |
Policy Mone v|

The "Holiday" sub mask allows regulating the just created
scheduler, based on a time period (Holiday) in which the user
needs to change the activity functions set on scheduler, for
example if user is away for the whole month of August, it is
possible to appropriately set Holiday option to disable schedu-
ler for the necessary time period.

On the "Regulate" sub mask it is possible to choose among the
following options:
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= None
= Do not perform during Holiday
= Separate Scheduling

Choosing the "None" option, set by default, the scheduler is
repeated every day without interruptions

|HOIiday |

Policy INone j
Graup MoRunHoliday Fm
SeparateScheduling

Choosing the "Do not Perform during Holiday" option the sche-
duler is disabled for a time period set by the user:

|HOIida5r

Palicy MoRunHaliday v
M
Group il
SeparateScheduling

Choosing the "separate Scheduling" option it is possible to se-
parately manage scheduler activities (main) and "Holiday" ac-
tivities option:

|HOIiday |

Policy None v

In both last 2 cases it is necessary to create a "Holiday
Group":

|HOIiday

Palicy |SeparateScheduIing v|

Group |HOIidayGroup R m

On the "Group" sub mask it is possible to choose among the
following options:
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Fields

The "Fields" option allows viewing buttons on "Scheduler
View" that make it possible to set scheduler activities custo-
mising them at will.

User can choose among following options:

e "None"
- "[)ii)/S'
P IlWeekll
[Fields
weekly type Mane v

Cays
ek

Choosing the "None" option, only two fields indicating hours
and minutes for scheduling beginning and end will appear on
the configured page:

By using the specific decrease and increase keys it is possible
to indicate scheduled time hours and minutes.
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Fields

Weekly type |Days v|
Mone
Week [\!\

By choosing the “Days” option, the configured page will show
seven keys for weekly programming along with the two hour
and minute fields:

Fields |

Weekly type Days v

None

Dais

By choosing the "Week" option, the configured page will show
two keys for choosing between week day programming or
week end only along with the two hour and minute fields :
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By double-clicking on "Scheduler View" in both cases the page
opens configuration menu for editing all present objects (see
chap. 6, “Editing Scheduler View” page 414).

Events

The "Events" option is only present on "DOUBLE CLICK Mode",
while it is present in "Events Editor" on the "Extended" mode.
It is possible to match an event (function or script) to each
previously created Scheduler.

The event is activated on the two different Page conditions :

= OnStart: The event is activated by the "start tag" assi-
gned value present in the "properties” sub mask (see
chap. 5, “Properties” page 224).

= OnStop: The event is activated by the "end tag" assi-
gned value present in the "properties" sub mask. (see
chap. 5, “Properties” page 224).
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General

List

OnStart |
anStop

Onstart

To assign an event to the page, click on the selected condition
and on the browse key, the following screen is displayed which
allows user to match a function or a script to the page by using
the appropriate keys :

General JRLLE

List

OnStart
OnStop ’

- 0 dito O

Functions/Scripts associated to this event

S Add Function & Add Seript < Delete 7w

Parameters of the selected function/script

[ stare the return value into

Holiday Group The "Holiday Groups" function, already found in the "Chrono-
thermostat" option (see chap. 6, “Chronothermostat”
page 405)allows activities planning, usually matched to the
"Scheduler” function, and managing them over a user-defina-
ble time period. (see chap. 5, “Holiday” page 225).
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After having double clicked on the "Holiday Groups" icon in the
"Explore Project", inside the work area the "List" mask contai-
ning a list of Holiday Groups inserted inside the project will ap-
pear :

List

IHn\idameup SpecificYears Haliday Group_Manth HolidayGroup_Year

<

From this list it is possible to insert new ones (by clicking the
"Add" key), to duplicate or to eliminate the existing ones (by
clicking the "Duplicate” and the "Delete" keys), the "Tools"

key allows modifying the columns structure at will, while the

"Modify" key allows entering the "General” property editing
mask :

General

Identification

Name HolidayGroup
Comment
Properties
Holiday type Specifictears bt

Maonth HolidayGroup_Month v
Tear HaolidayGroup_Tear b
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The "General" mask consists of the following sub masks :

« ldentification
= Properties

Identification

atification

dame HolidayGroup

Zomment

This sub mask makes it possible to assign a name and a com-
ment to the "Holiday Group".

Properties

Properties

Holiday type Specificrears b

Month HolidayGroup_Manth v
Year HolidayGroup_vear v

The "Properties"” sub mask shows data relating to the "Holiday
Group" settings. It is possible to insert page identification at-
tributes :

= Holiday Type
e Month
e Year

The "Holiday Type" section makes it possible to choose among
the following options :

= "Specific Year": Determines month and year during whi-
ch Group is active
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Froperties

Holiday type

|SpecificYears

Month

Tear

|Schedu|er_Stop

"Every year": With this option, holiday group is active
during a specific month of every year :

|Proper‘ties

Holiday type

|Eveerear5 “ |

|HOIidayGr0up_Month w

Month

Two Tags are assigned to Holiday Type by default :

e Start Tag
- End Tag

It is possible to change Tags adding new ones that have to be

of the same type (Internal) and value (Unsigned Long) of the
default ones :

Identification

Mame HolidayGroup
Comrnent
< l >
Properties
Holiday type Specificrears e
Manth Tag e
Scheduler_Start
Tear

Scheduler_Stop
HolidayGroup_Month

HulidaiGrDui Year

Clicking on the "Modify" key will edit parameters of the
just created "Holiday group" :
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General KEIMEY Device Limits Conversion Thresholds Indirect Address
|TagType
Type Unsigned Long ‘7\% O array
Char
Byte
Boolean
Integer

Unsigned Integer

Lan
< M 4

. Real
Initialization Double
String
Walue i}
Audio Files The "Audio Files" option is present only when a panel IT110,

IT112 o IT115 has been used :

ooae

|Pr’DJe:t\ITl1DT(SPI,SPZJETHl,ETHZ)\AlaI’ms A
':?:] Project
b HwConfiguration
= u IT110T(SP1,5PZ,ETH1,ETHZ)
Q":‘ SWConfiguration
?;- Tags
@ Languages and fonts
E\] Pages
m PopUp pages

= Frames
=] Alarms
Alarmn
%;‘_ Recipe types
L @ Users and passwords
@ Data archive
{ } Scripts
{3} Global script
[7] uists
‘6 Images
=] ‘_} Advanced
Fi Pipelines
g-_';) Reports
[ Remaote notification
"= Keyboards
!-I,‘,!- Weekly tasks

u__J Schedulers

@ HolidayGroups

- b [

User can use the "Audio Files" function to assign an audio file
(both“.MP3” and “.Wav”) to an alarm report.
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Note: Only MP3 files can be downloaded to panel during project
download; Polymath converts Wave files in MP3 format before
downloading.

After having double clicked on the "Audio Files" icon in the
"Explore Project”, inside the work area the "List" mask contai-
ning a list of the "Audio Files" inserted inside the project will
appear :

List
l Embedded Resources Comment
l False

4  add 7 Edit . Delete Duplicate

From this list it is possible to insert new ones (by clicking the
"Add" key), to duplicate or to eliminate the existing ones (by
clicking the "Duplicate” and the "Delete" keys), the "Tools"
key allows modifying the columns structure at will, while the
"Modify" key allows entering the "General” property editing
mask, by clicking on the "Including Resources" editing area
the "Include as a resource inside project" check-box will also
appear, by setting "True" the file just downloaded will be avai-
lable inside the project :
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List
List
I; T True

< 4

?  Edit < Delete Duplicate Tools

General

&Il Properties
Identification

Name Alarm

Comment

In the "General" sub mask the "Audio File" name and com-
ment can be edited.

Properties

T proge e |

Properties
File Name  C:\Documnents and SettingsimlanzaiDesktophalarm.mp3
Format mp3

[ Embed as resource in project

Play/Stop

The "Properties” sub mask shows data relating to the "Audio
Files" settings.
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= Properties
= Listen / Stop

In the "Properties” section the "Audio File" can be loaded.
can be associated to Alarm.

Select file to be loaded by clicking on the "Load" key and by
choosing desired file path.

Audio File

Laak in: |@ Desklop v y F £ M-

Y BMy Documents
(< 4§ My Cornputer
My Recent D12
Documents 232
?\_ [C)Documents and Settings

[Project 310 slave

[C)Project selection

[CIProject selection310
N larm, mpa

&
ICE

(Chedit
Deskiop

|

My Documents

o7

hy Computer

File name: ‘AIarm.mpB hd | Open

My Net‘work Files of type: ‘ mp3 [*.mp3] 2 | [ Cancel ]

The "Include as a resource inside project” check-box is also
present, by enabling it the file just loaded inside the project
will be available.

In the "Listen /Stop" section it is possible to listen on PC the
selected "Audio File"

It is possible to define a set of properties and working cha-
racteristics for each device in the project;

Double-click "HW Configuration” in "Explore Project" to open
the editing page :
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IT110T(EF1.6P2.ETH1.E

—

4 ETH1 SF1 L4
4 sP2

BT Mafer tfast pB

™
a %4.
o A | | [RTU Master (fast peripherals)
4 com
a a a

Select the device you wish to edit. Double-click it to edit its
settings in the "General" and "Communication Ports" win-
dows.

General

el Wl Communication ports
Identification

Name RTU Master (fast peripherals)

Comment DEVICE

Model: RTU Master (fast peripherals), DEVICE
Creation Date: 14/05/2010 18.20.31

Modify Date: 15/07/2010 15.07.35

Compiling Date: 15/07/2010 11.43.08

Parameters

[ use swap inte protecal Type of addressing Default -

This window allows you to insert the identification attributes
of the devices such as the "Name" and "Comment". Each na-
me in the project must be different - no two devices should
have the same name, even if they are of the same type, brand
and model. The comment is a unicode string that can only be
viewed in the POLYMATH.

"Parameters" subwindow :
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Parameters

[ Use swap inta protacol Type of addressing

The "Parameters"” subwindow allows you to configure the fol-
lowing options :

= Use swap in the protocol: Check the box to invert the
order of the bytes in the complex data.

= Type of addressing: Allows you to establish the format
of the register device address; the "Default” option as-
sociates the format of the chosen driver to the register.

Communication Ports

[EEEEEN Porte di col

10M

IT110T{SP1,5P2,FTH1,ETHZ

Baudrate 9600 bit/'s

Parits NONE

Bit Dati Otto

Bit di Stop Uno

Device address 1

Device address (DEC): 1-255

In this window you can configure communication between the
panel and device. You can configure all the ports on the devi-
ce. In general, it is possible to configure on the terminal the
communication speed (baudrate) and general settings of the
communication protocol (including parity of the bits, data bits
and stop bits), while the address of the device is configured
on the device itself. At the bottom of the window are the ran-
ges permitted by the protocol for each value inserted.
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6. Properties Editor

The purpose of this chapter is to describe all those functions
offered by POLYMATH for editing the graphics and the acces-
sibility of the project applications. Our starting point is the
concept that each executable operation, each visible data
(modifiable or not), each link between the pages, each func-
tion button must appear to the operator inside a page dis-
played on the VT.

We shall start out giving some indications of the general orga-
nization of the pages and go on to give more detailed informa-
tion on all the elements that can be introduced together with
their characteristics. For each graphic element that can be in-
troduced in a page (and for the pages themselves) a series of
properties can be defined that determine the aspect that the
object will assume in Runtime.

Furthermore, in the case of many objects, functions or scripts
are applicable when particular events are triggered.

The reference windows for managing the properties and
events are the Properties Editor and the Events Editor respec-
tively.

Properties
Editor

BackgrimageEnabled [RES
BackgroundImageld (Empty walue)
FrameBCaolor (255,255,255)

FrameBColorTransp  FALSE
FageBorderiDEffect Flat
PageBarderCalor .(U,U,U)
FageBarderEnabled  FALSE
PageBorderSize 1
PageBorderStyle Solid

Properties Editor £ Events Editor £ Task Help

Please note the "Properties Editor"” is only visible in "EXTEN-
DED" mode (see chap. 4, “Choice of interface” page 83).
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&~ Note: Asof “DOUBLE CLICK”, all the objects properties are visi-
ble and editable in the popup-window which appears after “ double
click” over any object. Following is an example using in the project
a “ Touch Button":

By using the “DOUBLE CLICK” interface (see chap. 4, “Double
Click Interface” page 84), let's insert a touch-button in a page
of the project (see chap. 6, “Touch Button” page 333), and
let's “double click” over it to edit its properties (by using the
“EXTENDED” interface such properties of the object are placed
in a table, (see chap. 6, “Properties of the Touch button”
page 334) will appear the following image :

= Edit TouchButton

Cll Appearance Textproperties Behaviour List of Texts Label Image Events

Identification

Hame TouchButton

Comment

O Lock

Data

Bitmap

Mone -
Image
Image list id
Image Tag id
Caption Mone 3

Text .
Text list id
Text Tag id

From the previous window, by clicking on the “Aspect” option
we get into the following window, from which it's possible to
edit the following properties :
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= Edit TouchButton

appearance

FantFinld .
ares color pressed u 0,0 L
Area color released ajm 175,193 -
arna visibility Bz

Barder blink an Blink 5

pardor cole prossed (G Jose, 255, 255 -

Border calor released

Barder visihility
Barder size
Barder styls

Button 30

By clicking on the “Text Property” option we can get into the
following window, from which it's possible to edit the following
properties :

= Edit TouchButton
Generyl  Appearance I

154 Bohaviour Listot Tosts Loboel Image Ewonts

[ Text properties
Toxt Bk
Text Calor
Teat H fgn

Tzt U Abgn
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By clicking on the “Fuctioning” option we can get into the fol-
lowing window, from which it's possible to edit the following
properties :

= Edit TouchButton

Bnhaviour

Disahle e—]

Haelee
Password level w

Tab mdex

=

By clicking on the option “Text List” we can get into the fol-
lowing window, from which it's possible to edit the following
properties :

= Edit TouchButton

List of teuts

Text list value .

Teut list type
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By clicking on the “Label” option we can get into the following
window, from which it's possible to edit the following proper-

ties :

= Edit TouchButton

Texk max lan

Teexk transhate disable

Text multi line

By clicking on the “Image” option we can get into the fol-
lowing window, from which it's possible to edit the following

properties

= Edit TouchButton

Irnage sutosize

lmnage N align

Tmage keep aspece ratin
Image transparent color
Image transparent
Image ¥ align

Tmage st value

Image list type
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By clicking on the “Events” option we can get into the fol-
lowing window, from which it's possible to associate an event
(function or script) to the object (see chap. 6, “Properties of
the Touch button” page 334) :

= Edit TouchButton

CnPressed

OnRelessed

OnPressed

Let's go back to the explanation of “Properties Editor” which is
composed by a list of properties and related editable values.
If the value fields are not editable it means that the current
configuration of the element does not permit any change in its
value; in these cases, editing the fields in question is only pos-
sible when the correlated attributes allow it.

Changes in the graphic properties of an object cause an im-
mediate redrawing of the object on the page which is notice-
able to the programmer.

If the Properties Editor does not appear on the screen because
it has already been closed, it can be recalled to the screen by
clicking on the icon in the toolbar or, using the Main menu,
by clicking on Display->Show->Properties Editor. Like all an-
chorable windows, the Properties Editor too can be moved, re-
duced to an icon or closed (see chap. 3, “Moving Anchorable
windows” page 81).

Over the next paragraphs we will show the editable properties
of each object and the meanings of these properties.

Dynamic assigning of values to the properties

Some properties can have a variable assigned to them rather
than having a constant value. The value of the properties can
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change in Runtime in line with the changes of the variables as-
signed to them.
To pass from the assigning-a-constant mode to assigning-a-
variable mode, just click on the icon present on the left of the
editable field. If in assigning-a-constant mode, the icon will be
and pressing on it will take you to assigning-a-variable
mode. If in assigning-a-variable mode, the icon will be % and
pressing on it will take you to assigning-a-constant mode.
The type of variable assigned must, naturally, be compatible
with the values requested by the properties; for example:
= for the properties True/False, the variable must assume
Boolean values
= for the properties DateAndTime, the variable must as-
sume Long values
= for properties defining colors (e.g. BorderColor, Area-
Color, etc.), the variable must assume admissible RGB
(Long) values as indicated in the following table:

Table 1:
Color RGB Hexadecimal value
Red 255,0,0 00 00 00 FF
Green 0,255,0 00 00 FF 00
Blue 0,0,255 00 FF 00 00
Events Editor The "Events Editor", like the "Properties Editor", is only visible
in "EXTENDED" mode. (see chap. 4, “Choice of interface”

page 83).
The Events Editor is composed of a list of events that can be
assigned to the element in question.

| start

OnPageClose

Properties Editor\E\.'ents Editor £ Task Help

If the Events Editor does not appear on the screen because it
has already been closed, it can be recalled to the screen by

clicking on the icon [& on the toolbar or, using the Main menu,
by clicking on Display->Show->Events Editor. Like all anchor-
able windows, the Events Editor too can be moved, reduced to
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an icon or closed (see chap. 3, “Moving Anchorable windows”
page 81).

Over the next paragraphs we will show, in relation to each ob-
ject, the events to which functions and scripts can be as-
signed.

For further details relating to the functions and scripts, the
reader is advised to consult the appropriate sections of this
manual (see chap. Appendix B - Predefined functions”

page 701 and see chap. 9, “Scripts” page 509).

& Note When POLYMATH isfirst started (in EXTENDED mode), the
Events Editor isincorporated as a clickable icon for the Properties
Editor. To accessit just click in the corresponding area at the bot-

tom Of the Wi ndOW Properties Editor M Events Editor /

Use this window to assign a predefined function or a user
script to each event simply by double-clicking on the corre-
sponding row in the table and then on the . key.

Functions/Scripts associsted to this event

raramaters of the selncted function/script

e the retimn value into

The resulting mask will allow you to make all the settings nec-
essary; to add a function just click on ‘Add Function’ and
choose the function you want from the list that appears. Sim-
ilarly, by clicking on ‘Add Script’ you can choose the Script to
be assigned. For objects like touch buttons, Function keys and
Switchbuttons up to 2 functions/scripts per corresponding
event can be introduced; for the events of other objects gen-
erally only one function or script can be assigned. To change
the order in which the functions must be executed just move
them using the ‘Move up’ and ‘Move down’ keys. To eliminate
a function you just need to select it and click on the ‘Delete’
button.
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Warning: Where two functions can be assigned to the same event

the user must take care to furnish an order which islogical for con-
secutive functions: there would be no sense, for example, in having
afunction referring to an old page follow a function of Change page.

If you choose to assign a predefined function to an event, the
lower part of the window can be used to enter its parameters
(e.g. file name, name of objects, etc.).

If you choose to assign a script to an event, you can choose

to save the value returned by that script (if the script is set to
return a value) in a variable.

For further details relating to the assignable functions and the
scripts, the reader is advised to consult the appropriate chap-
ters of this manual (see chap.“ “Appendix B - Predefined func-
tions” page 701 e see chap. 9, “Scripts” page 509).

Note: If you wish to assign more than one function to a key, it is bet-
ter to use a user script containing those functions.

We set out below a description of the events that can be as-
signed to some of the elements already seen in Project Explor-
er. The list of events in the case of graphic elements will by
contrast be dealt with case by case.

Events related to variables

Table 2: Events assignable to variables

Event Description

Activated immediately after initializa-
Onlnizialization tion of the variable, that is, at the star-
tup of Runtime

Activated when the variable goes Off
Line, that is, when it becomes unavail-
able following a break in communica-
tion

OnOffLine

Activated when the update of the vari-
able field is disabled; this happens via
OnOffScan a script setting the attribute OffScan at
True (see chap. 5, “Device” page 128)
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Table 2: Events assignable to variables

Event Description

Activated when the variable goes On
Line, that is, when it becomes avail-

OnOnLine able again after a break in communica-
tion
Activated when the update of the vari-
ononsScan able field is enabled; this happens via

a script setting the attribute OffScan at
False (see chap. 5, “Device” page 128)

Activated when the peripheral device
assigns a new rough value to the vari-
able (therefore also at the startup of
OnRawValueChange the project and when the connection
with the device is re-established). The
event is always generated before the
value itself is transferred

Activated when the rough value has

OnvalSent been correctly sent to the field device

Activated when a new value is as-
signed to the variable (thus also at the
startup of the project and when the
connection with the device is re-estab-
lished). The event is always generated
before the value itself is transferred

OnValueChange

Events related to alarms

Table 3: Events associated with the Alarms Log

Event Description

OnHistoryFull Activated when the alarm log is full

Activated when the alarm log memory
reaches the set value; by default, the
OnHistoryWarning warning is issued after 75 records (out
of the 512 that can be stored on the
memory).
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Table 4: Events assignable to Alarms

Event Description

Activated when the alarm has been ac-
knowledged

OnAlarmAck

OnAlarmOff Activated when the alarm ends

Launched when the alarm enters the
active stat; the script or the function
are run after the instance of the alarm
event in the table of active alarms

OnAlarmOn

Events related to Recipes

Table 5: Events assignable to Recipes

Event Description

OnDownload Activated when the download from the
Complete VT to the device is completed

Activated when errors occur in the

OnDownloadError download from the VT to the device

OnRecipeCreate Activated when the Recipe is created

Activated when the Recipe is about to
be deleted from the archive. The event
is generated immediately before the
effective deletion of the Recipe

OnRecipeDelete

Activated when the recipe is about to
be loaded in the archive. The event is
generated just before the recipe is ef-
fectively loaded.

OnRecipelLoad

Activated when the upload from the VT

OnUploadComplete to the device is completed

Activated when errors occur in the up-

OnUploadError load from the VT to the device
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Script Events key

Table 6: Events that can be associated to the Scripts

Evento Descrizione

Activated when errors appear during
execution of the Script

OnScriptError

Events related to Pipelines

Table 7: Events assignable to Pipelines

Event Description

When anomalies in the destination
OnDestDown variable stop the Pipeline working cor-
rectly

When anomalies in the source variable
stop the Pipeline working correctly
(break in the connection with the de-
vice, invalid value assignment etc.)

OnSourceDown

The event is activated following the
startup of the Pipeline; that is, it oc-
OnStart curs at the start of Runtime, or after a
break in the connection between the
variables is restored

OnStop When a Pipeline stop is requested

Events related to Passwords

The events relating to the Passwords can be edited by the
Events editor by keeping the User table for Password configu-
ration selected (see chap. 5, “Users and Passwords”

page 184).

Table 8: Events assignable to Passwords

Event Description

. Activated following a successful Login
OnLogin .
operation
OnLogout Actlvat_ed following a successful Logout
operation
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Table 8: Events assignable to Passwords

Event Description

Activated when wrong Login data is
emitted

OnLoginError

Activated following a change in pass-
word for a user via the user grid (see
chap. 6, “Properties of the Password

Grid” page 398)

OnPasswordChanged

Events related to Timers

The events relating to the Timers can be edited by the Events
editor by keeping the reference Timer in the related list select-
ed.

Table 9: Events assignable to Timers

Event Description

Activated when the Timer is suspended
by means of a stop command

OnSuspend

Activated following the completion of

OnTimerFired the Timer count

Activated when the Timer count is

nTimer r
OnTimerStart started

Activated following a stop command to

OnTimerStop the Timer

Events related to Trend Buffers

Table 10: Events assignable to Trend buffers

Event Description

Activated when the buffer has been
emptied

OnBufferClear

Activated following the admission of a
OnBufferFull new sample if, after the reading, the
buffer becomes full

Activated when the buffer is full and a

OnBufferOverflow .
new sample has arrived
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Table 10: Events assignable to Trend buffers

Event Description

A new sample has been admitted. Not
OnSample generated for the trend buffers as-
signed to a tag array

Activated following the admission of a
new sample and the filling of the buffer
has reached the warning level (see
chap. 5, “Buffer” page 190)

OnWarningLevel

Scheduler Events

Events regarding Schedulers can be edited by "Events Editor"
(EXTENDED mode) or by the "Events" option in the DOUBLE
CLICK mode. (see chap. 5, “Events” page 142).

Table 11: Scheduler Events

Event Description

Activated by "Start Tag" assigned va-
lue present in the "Properties" sub
mask (see chap. 5, “Properties”

page 175)

OnStart

Activated by "End Tag" assigned value
OnStop present in the "Properties" sub mask
(see chap. 5, “Properties” page 175)

Managing a To set graphic and visual characteristics of a project special
page attention must be paid its the base element, the Page. Each
graphic element, navigation or function button, command and
Data viewing/editing field must be positioned in a Page for it
to be visible to the operator in Runtime.
To create and manage the pages in a project the reader is ad-
vised to consult the preceding chapter (see chap. 5, “Pages”
page 155).
When you enter a page’s Fields mask, the work area will show
a preview of how the page will be displayed on the VT.
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Emmm

During the editing of a page a series of programming com-
mands are made available. Use buttons , and
of the toolbar (accessible also via Layout menu ->Zoom) to
change the display dimensions of a page, defining these with
the Zoom (the same operation can be performed by clicking
the right-hand mouse key when the pointer is on the page and
choosing the required function from the menu that appears).
By clicking on the icon of the toolbar (Layout -> Show
Grid) you can decide whether to show or hide the editing grid
in the page preview. The grid is very useful for bringing ob-
jects in alignment very quickly when they are being arranged
on the page. The grid dimensions can also be edited using
Project Explorer in the VT options (see chap. 5, “Main window”
page 113).

By clicking on the [f@l icon of the toolbar (Layout -> Align Grid)
you can decide whether to align the objects to the grid once
they have been introduced or whether to have them intro-
duced freely.

With alignment to the grid is activated, the element can only
be introduced within the limits delineated by the grid.

Text
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While if the alignment function is deactivated the elements
can be freely introduced into the page as shown in the figure
below

Text

o
Note: You are recommended to activate the alignment to the grid
function to be sure to have a well-ordered and coherent arrange-

ment of objects on the page.

Should you be creating a multilanguage project (see chap. 5,
“Languages” page 152), the elements in the page and the re-
lated texts can be displayed in a particular project language.
To do this just select the required language from the drop-
down menu containing all the languages added to
the project (this command can be accessed also via the Main
menu using the sequence Display->Project language). Each
time a language is chosen the display of the page changes in-
stantly.

To introduce an object into the page click on the related icon
in the toolbar (or use the Main menu) and draw the outline in
the position desired on the page preview. Once an element is
added it will appear in the page and can be selected simply by
clicking on it. For each object selected there will appear in the
Properties and Events Editor all the options the user can set,
while by clicking with the right key on an object selected you
can access a menu with standard functions like Edit, Dupli-
cate, Delete, Cut, Copy and Zoom.
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Table 12: Page properties

Properties Description

PageBColor

Background page color; editable using
RGB code or a palette of colors

PageBorder3DEffect

Defines the effects of the Border: Flat,
Relief or Sunken

PageBorderColor

Color of the Border

PageBorderEnabled

Defining whether to display the Border
of the Page

PageBorderSize

Dimensions of the Border

PageBorderStyle

Style of the Border, Solid or Broken

Backgroundlmage
Enabled

Defines whether the page must have a
background image

Backgroundlmageld

Chooses the background image (from
the list of images introduced)

ImageHPosition

Horizontal positioning of the image
(Centered, Right or Left)

ImageReprMode

Mode of representation of the image:
can be Cut, Stretched, Stretched
maintaining the proportions and Posi-
tion

ImageVPosition

Vertical positioning of the image (Cen-
tered, Top or Bottom)

Events related to Pages

Table 13: Events related to Page

Event Description

OnPageOpen

Activated after a Page is shown

OnPageClose

Activated when a Page is about to be
closed

Properties of Popup pages

257

The properties of the Popup page editor are exactly the same
as those of the standard pages (see chap. 6, “Page properties”
page 257).
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Events related to Popup pages

The Editor events that can be assigned to the Popup pages are
exactly the same as those of the standard pages (see chap. 6,
“Events related to Pages” page 257).

Properties of Frames

Table 14: Frame properties

Properties Meaning

FrameBColor Defines whether the background of the
Transparent Frame must be transparent

Background color of the frame; edit-
FrameBColor able using RGB code or palette of col-
ors

Permits the 3-D effect that can be as-

PageBorder3DEffect signed to the Border

Indicates the color of the Border; edit-
PageBorderColor able using RGB code or palette of col-
ors

Defines whether the page must have a

PageBorderEnabled Border

PageBorderSize Indicates the dimensions of the Border

Permits the style of the Border to be

PageBorderStyle chosen

Determines the use of a background

BackgrimageEnabled .
image

BackgroundlmagelD Determines the background image in

the frame
Predefined POLYMATH has a set of predefined graphic elements that can
graphic be added to a page. These elements can have simple graphic
elements functions, navigation functions and display and edit data func-

tions. The icons relating to these objects can be found in the
toolbar and the Main menu using Fields->Create.
All the graphic elements have been grouped, depending on
their function, in four groups:

= Simple Figures

= Value Fields

= Simple Controls

e Complex Controls
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The next paragraphs contain a list of all the graphic elements
predefined by POLYMATH which can be introduced into a page.
For each property we shall indicate in a schematic way the re-
lated editable properties and the events that can be assigned
to them.

A Warning: When planning your project you need to bear in mind that
when two buttons on the Touch Screen panel are pressed at the same
timethisisinterpreted as having pressed halfway between these but-
tons. So you are advised to avoid settings that involve this situation.

Simple Figures The first group of graphic elements to be considered is that of
the Simple Figures; these can be useful for creating more or
less complex drawings or for assigning special effects to the
pages.

Rectangle

A rectangle can be introduced into a page by clicking on the
icon [® or using the Main Menu (Fields->Create->Simple fig-
ures->Rectangle) and drawing its dimensions directly in the
page. This procedure enables you also to introduce rectangles
with rounded outlines (see TypeOfBox properties).

The characteristics of the Rectangle must be set in the Prop-
erties Editor as indicated in the following section.

Properties of the Rectangle

Table 15: Properties of the Rectangle

Properties Description

Identifying name of the Rectangle.
Name Must be unique among the graphic el-
ements
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Table 15: Properties of the Rectangle

Properties Description

Comment Identifying comment within POLYMATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension
Determines the color of the Area that
can be selected using the RGB code or
AreaColor color palettes. The value can be as-

signed to a whole variable or it can be
managed with thresholds

AreaVisibility

Determines whether the Rectangle
should have a background or if it must
be transparent; a Boolean variable can
be assigned to this value or it can be
managed with thresholds

Border3D

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderBlink

Determines the flashing of the Border,
which can be No blinking, Slow blinking
or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderColor

Determines the color of the Border,
which can be selected using the RGB
code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

BorderVisibility

Determines whether there will be a
Border to the Rectangle or not; a Bool-
ean variable can be assigned to this
value

BorderSize

Determines the size of the Border,
which must be a number to which a
whole variable could be assigned if de-
sired or it can be managed with thresh-
olds
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Table 15: Properties of the Rectangle

Properties Description

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Determines whether the Rectangle

TypeOfBox must be normal or rounded

Editable if the Rectangle is rounded;
corresponds to the horizontal distance
RoundX between the position of the corner and
the point at which the curve joins the
horizontal side of the Rectangle

Editable if the Rectangle is rounded;
corresponds to the vertical distance
RoundY between the position of the corner and
the point at which the curve joins the
vertical side of the Rectangle

Determines whether the object is ini-
tially visible. It is also possible to as-

Hide sign a Boolean variable (for changes in
Runtime) or it can be managed with
thresholds
Determines if the object can move or

Lock

not

Determines whether to make a partial
PartialFill color infill. The value can be assigned
to a whole variable

Determines the color of the Border in-
fill that can be selected using the RGB
code or color palette. The value can be
assigned to a whole variable

FillColor

Determines the direction of the Border
infill. The infill can happen From Low to
FillDir High, From High to Low, From Right to
Left or From Left to Right. The value
can be assigned to a whole variable

Indicates the percentage of the infill.
FillPercent The value can be assigned to a whole
variable
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Table 15: Properties of the Rectangle

Properties Description

Identifies the movement associated to

TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

. A i T he Dir move-

TagDirectMovement ssociates a Tag to the ect move
ment

TagX Horizontal movement tag

TagyY Vertical movement tag

Steps Movement intervals

FinalX Horizontal co-ordinate

FinalY Vertical co-ordinate

Ellipse

An ellipse can be introduced into a page by clicking on the icon
or using the Main Menu (Fields->Create->Simple figures-
>Ellipse) and drawing its dimensions directly in the page.
To define the characteristics of the Ellipse, they must be set in
the Properties Editor as indicated in the following section.

Properties of the Ellipse

Table 16: Properties of the Ellipse

Properties Description

Identifying name of the Ellipse. Must
be unique among the graphic elements

Name
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Table 16: Properties of the Ellipse

Properties Description

Comment Identifying comment within POLYMATH
Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

Determines the color of the Area that
can be selected using the RGB code or
AreaColor color palette. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines whether the Sector has a
background area or should be trans-
AreaVisibility parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines the color of the Ellipse out-
line that can be selected using the RGB
LineColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

Determines whether the object is ini-
tially visible; it is also possible to as-
Hide sign a Boolean variable (dynamic in
Runtime) or it can be managed with
thresholds

Determines if the object can move or

Lock
not

Determines the 3D effect of the Ellipse,
which can be Flat, Bump or Etched.

The value can be associated with Tag
or it can be managed with thresholds

Ellipse3D

Determines whether to make a partial
PartialFill color infill. The value can be assigned
to a whole variable

Determines the color of the Ellipse infill
which can be selected using the RGB
code or color palette. The value can be
assigned to a whole variable

FillColor
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Table 16: Properties of the Ellipse

Properties Description

Determines the direction of the Ellipse
infill. The infill can happen From Low to
FillDir High, From High to Low, From Right to
Left or From Left to Right. The value
can be assigned to a whole variable

Indicates the percentage of the infill.
FillPercent The value can be assigned to a whole
variable

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

. A i T he Dir m -
TagDirectMovement ssociates a Tag to the Direct move

ment
TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Arc

An Arc can be introduced into a page by clicking on the icon
or using the Main Menu (Fields->Create->Simple figures-
>Arc) and drawing its dimensions directly in the page.

To define the characteristics of the Arc they must be set in the
Properties Editor as indicated in the following section.
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Properties of the Arc

Table 17: Properties of the Arc

Properties Description

Identifying name of the Arc. Must be

Name unique among the graphic elements
Comment Identifying comment within POLYMATH
Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

Determines the color of the Arc outline
which can be selected using the RGB
LineColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

Determines whether the object is ini-
tial visible; it is also possible to assign

Hide a Boolean variable (dynamic in Runt-
ime) or it can be managed with thresh-
olds
Determines if the object can move or

Lock

not

Determines the Arc starting position

StartAngle (given as an angle)

Determines the angle (in degrees) of

SweepAngle the opening of the Arc

Sector

A Sector can be introduced into a page by clicking on the icon
or using the Main Menu (Fields->Create->Simple figures-
>Sector) and drawing its dimensions directly in the page.
To define the characteristics of the Sector they must be set in
the Properties Editor as indicated in the following section.
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Properties of the Sector

Table 18: Properties of the Sector

Properties

Description

Name

Identifying name of the Sector. Must
be unique among the graphic elements

Comment

ldentifying comment within POLYMATH

Top

Vertical position coordinate

Left

Horizontal position coordinate

Width

Width dimension

Height

Height dimension

AreaColor

Determines the color of the Area,
which can be selected using the RGB
code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

AreaVisibility

Determines whether the Sector has a
background area or should be trans-
parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

LineColor

Determines the color of the Sector out-
line, which can be selected using the
RGB code or color palette. The value
can be assigned to a whole variable or
it can be managed with thresholds
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Table 18: Properties of the Sector

Properties Description

Determines whether the object is ini-
tially visible; it is also possible to as-

Hide sign a Boolean variable (dynamic in
Runtime) or it can be managed with
thresholds
Determines if the object can move or

Lock
not

StartAngle Determines the Sector starting posi-

tion (given as an angle)

SweepAngle

Determines the angle (in degrees) in-
ternal to the Sector

CircularSectorType

Determines the type of Sector. If True,
the line closing the sector does not
pass through the center (forming a
convex figure); otherwise, if False, the
line passes through the center (con-
cave figure)

PartialFill

Determines whether to make a partial
color infill. The value can be assigned
to a whole variable

FillColor

Determines the color of the Sector in-
fill, which can be selected using the
RGB code or color palette. The value
can be assigned to a whole variable

FillDir

Determines the direction of the Sector
infill. The infill can happen From Low to
High, From High to Low, From Right to
Left or From Left to Right. The value
can be assigned to a whole variable

FillPercent

Indicates the percentage of the infill.
The value can be assigned to a whole
variable

TypeOfMovement

Identifies the movement associated to
the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement

Associates a Tag to the Direct move-
ment

TagX

Horizontal movement tag
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Table 18: Properties of the Sector

Properties Description

TagyY Vertical movement tag

Steps Movement intervals

FinalX Horizontal co-ordinate

FinalY Vertical co-ordinate
Line

Line can be introduced into a page by clicking on the icon
or using the Main Menu (Fields->Create->Simple figures-
>Line) and drawing its dimensions directly in the page.

To define the characteristics of the Line they must be set in
the Properties Editor as indicated in the following section.

Properties of the Line

Table 19: Properties of the Line

Properties Description

Identifying name of the Line. Must be
Name - -

unique among the graphic elements
Comment Identifying comment within POLYMATH
X1 Horizontal coordinate of starting point
X2 Horizontal coordinate of destination

point
Y1 Vertical coordinate of starting point
Y2 Vertical coordinate of destination point
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Table 19: Properties of the Line

Properties Description

Determines the 3D effect to be applied
to the image: Flat, Relief, Recessed,
Effect3D Tube in Relief or Recessed Tube. Can
be assigned to a whole variable or it
can be managed with thresholds
Determines the color of the infill, which
can be selected using the RGB code or
LineColor color palette. The value can be as-
signed to a whole variable or it can be
managed with thresholds
Determines the thickness of the line.
. . The value can be assigned to a whole
LineSize . . .
variable or it can be managed with
thresholds
Determines whether the object is ini-
tial visible; it is also possible to assign
Hide a Boolean variable (dynamic in Runt-
ime) or it can be managed with thresh-
olds
Determines if the object can move or
Lock
not
Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical
TagDirectMovement Associates a Tag to the Direct move-
ment
TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate
Polygon

A Polygon can be introduced into a page by clicking on the icon
E or using the Main Menu (Fields->Create->Simple figures-
>Polygon). After clicking on the icon, click on the page at the
points that you want the vertices of the Polygon to appear in.
POLYMATH will show the preview of the Polygon as soon as the
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mouse is moved. Every click made will produce a new vertex.
The introduction of the Polygon is confirmed by just double-
clicking it (thereby ending its edit).

Once a Polygon has been introduced, its structure (that is, its
vertices) can be edited: after selecting the Polygon and then
moving one of its vertices the lines (sides) adjacent to this
vertex are automatically removed by POLYMATH.

Using this function, an irregular Polygon can be created, that
is one having angles and sides with dimensions chosen at will.
Regular polygons can also be introduced using the appropriate
POLYMATH tool (see chap. 6, “Regular polygon” page 274).
To define the characteristics of the Polygon they must be set
in the Properties Editor as indicated in the following section.

Properties of the Polygon

Table 20:

Properties Description

Identifying name of the Polygon. Must
Name - g

be unique among the graphic elements
Comment ldentifying comment within POLYMATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension
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Table 20:

Properties Description

Determines the color of the Polygon,
which that can be selected using the
AreaColor RGB code or color palette. The value
can be assigned to a whole variable or
it can be managed with thresholds

Determines whether the Sector has a
background area or should be trans-
AreaVisibility parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines the color of the Polygon
outline, which can be selected using
LineColor the RGB code or color palette. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

Determines the thickness of the out-
line of the Polygon. The value can be
assigned to a whole variable or it can
be managed with thresholds

LineSize

Determines whether the object is ini-
tially visible; it is also possible to as-
Hide sign a Boolean variable (dynamic in
Runtime) or it can be managed with
thresholds

Determines if the object can move or

Lock
not

Determines whether to make a partial
PartialFill color infill. The value can be assigned
to a whole variable

Determines the color of the Polygon in-
fill using the RGB code or the color pal-

FillColor ette. The value can be assigned to a
whole variable
Determines the direction of the Poly-
gon infill. The infill can happen From
FillDir Low to High, From High to Low, From

Right to Left or From Left to Right. The
value can be assigned to a whole vari-
able
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Table 20:

Properties Description

Indicates the percentage of the infill.
FillPercent The value can be assigned to a whole
variable

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement Associates a Tag to the Direct move-

ment
TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Irregular line

A Irregular line can be introduced into a page by clicking on
the icon m or using the Main Menu (Fields->Create->Simple
figures-=>Irregular line). After clicking on the icon, click on the
page at the points that you want the vertices of the figure to
appear (in practice, the beginning and the end of the various
line sections). POLYMATH will show the preview of the line as
soon as the mouse is moved. Every click made will produce a
new line sections. The introduction of the Irregular line is con-
firmed by just double-clicking it (thereby ending its edit).
Once an Irregular line has been introduced, its structure (that
is, its vertices) can be edited: after selecting the Line and then
moving one of its lines, those adjacent to this vertex are au-
tomatically removed by POLYMATH.

Using this function, an open line can be created, that differs
from an irregular Polygon in that it is not necessarily closed to
form a closed geometric figure.

To define the characteristics of the Irregular line they must be
set in the Properties Editor as indicated in the following sec-
tion.
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Properties of the Irregular line

Table 21: Properties of the Irregular line

properties Description

Identifying name of the Irregular line.

Name Must be unique among the graphic el-
ements

Comment ldentifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

Determines the color of the Line, which
can be selected using the RGB code or
LineColor color palette. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the thickness of the out-
line of the Line. The value can be as-

LineSize signed to a whole variable or it can be
managed with thresholds
Indicates the number of sides assigned
NPoints to the Irregular Line in the drawing

phase
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Table 21: Properties of the Irregular line

properties Description

Determines whether the object is ini-
tially visible; it is also possible to as-
Hide sign a Boolean variable (dynamic in
Runtime) or it can be managed with
thresholds

Determines if the object can move or

Lock not

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement Associates a Tag to the Direct move-

ment
TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Regular polygon

A Regular polygon can be introduced into a page by clicking
on the icon or using the Main Menu (Fields->Create->Sim-
ple figures->Regular polygon). After clicking on the icon, use
the mouse to indicate the area in the page where POLYMATH
should draw the Polygon.

The default setting is that a pentagon (5 sides) is drawn; to
change the number of sides (vertices) just edit the properties
Number of Points using the Properties Editor (see the follow-
ing section).

This function allows the creation only of regular polygons, that
is, one with all the angles and sides equal. Irregular Polygons
can also be introduced by using the appropriate POLYMATH
tool (see chap. 6, “Polygon” page 269).

To define the characteristics of the Regular Polygon they must
be set in the Properties Editor as indicated in the following
section.
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Properties of the Regular Polygon

The properties of the Regular polygon are identical to those of
the Irregular polygon(see chap. 6, “Properties of the Polygon”
page 270).

Label

A Label can be introduced into a page by clicking on the icon
or using the Main Menu (Fields->Create->Simple figures-
>Label). After clicking on the icon, use the mouse to indicate
the area in the page where POLYMATH should draw the Poly-
gon. A Label is a text field (may be multilanguage) into which
you can introduce text strings that will not change in Runtime.
To define the characteristics of the Label they must be set in
the Properties Editor as indicated in the following section.

This is a Label

Properties of the Label

Table 22: Properties of the Label

Properties Description

Identifying name of the Label. Must be
unique among the graphic elements

Name
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Table 22: Properties of the Label

Properties Description

Comment Identifying comment within POLYMATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension
Determines the color of the Label,
which can be selected using the RGB
AreaColor code or color palette. The value can be

assigned to a whole variable or it can
be managed with thresholds

AreaVisibility

Determines whether the Sector has a
background area or should be trans-
parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Border3D

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderBlink

Determines the flashing of the Border,
which can be No blinking, Slow blinking
or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderColor

Determines the color of the Border us-
ing the RGB code or color palette. The
value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

BorderVisibility

Determines whether there will be a
Border to the Label or not; a Boolean
variable can be assigned to this value

BorderSize

Determines the size of the Border
which must be a number to which a
whole variable can be assigned, if
wished, or it can be managed with
thresholds
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Table 22: Properties of the Label

Properties Description

BorderStyle

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

FontField

Font related to the text shown in the
field; by clicking on . you can edit
multilanguage Fonts (see chap. 5,
“Languages” page 152)

Text

Text shown in the Label; by clicking on
° you can edit multilanguage texts
and their related Fonts (see chap. 5,
“Languages” page 152)

TextBlink

Determines the flashing of the text;
the possibilities are No Blinking, Slow
blinking or Rapid Blinking. The value
can be assigned to a whole variable or
it can be managed with thresholds

TextColor

Determines the color of the Label text,
which can be selected using the RGB

code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

TextHAlign

Allows you to specify the horizontal
centering of the text within the Label.
The value can be assigned to a whole
variable or it can be managed with
thresholds

TextVAlign

Allows you to specify the vertical cen-
tering of the text within the Label. The
value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Hide

Determines whether the object is ini-
tially visible. It is also possible to as-
sign a Boolean variable (for changes in
Runtime) or it can be managed with
thresholds

Lock

Determines if the object can move or
not

TextMaxLen

Determines the maximum value in re-
lation to the length of the text string
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Table 22: Properties of the Label

Properties Description

Determines whether the Label text can
start a new line

TextMultiLine

Determines whether the translation of

TextTranslateDisable | " ohel text must be disabled

Determines whether automatically to
distribute the text uniformly within the
TextAutoAdjust Label; this causes a resizing of the La-
bel in relation to the text contained in
Runtime

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement Associates a Tag to the Direct move-

ment
TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Complex label

A Complex label can be introduced into a page by clicking on
the icon or using the Main Menu (Fields->Create->Simple
figures->Complex label). This icon (or Menu option) is active
only if it is within a Complex Control editor (see chap. 6,
“Complex Controls” page 360).

After clicking on the icon, use the mouse to indicate the area
in the page where POLYMATH should draw the Label. A Label
is a text field (may be multilanguage) into which you can in-
troduce text strings that will not change in Runtime.

To define the other characteristics of the Label they must be
set in the Properties Editor as indicated in the following sec-
tion.
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Properties of the Complex Label

The properties of the Complex label are identical to those of

the Label. The reader is, therefore, advised to consult the ap-
propriate part of the previous section (see chap. 6, “Properties
of the Label” page 275).

Trend Pen

A Trend Pen can be introduced into a page by clicking on the
icon or using the Main Menu (Fields->Create->Simple fig-
ures->Trend pen). This icon (or Menu option) is active only if
it is within a Trend editor (see chap. 6, “Editing a TrendView”
page 370). In practice, the Trend Pen makes it possible to
view the current value next to the Pen selected, in such a way
as to couple a numeric indication with the graphic display of
the Trend.

After clicking on the icon, use the mouse to indicate the area
in the page where POLYMATH should draw the Trend Pen.
For the characteristics of the Trend Pen to be defined, they
must be set in the Properties Editor as indicated in the follow-
ing section.
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Properties of the Trend Pen

Table 23: Properties of the Trend Pen

Properties Description

Identifying name of the Trend Pen.

Name Must be unique among the graphic el-
ements

Comment ldentifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

Determines the color of the Trend Pen,
which can be selected using the RGB
code or color palette. The value can be
assigned to a whole variable

AreaColor

Determines whether the Sector has a
background area or should be trans-
parent; a Boolean variable can be as-
signed to this value

AreaVisibility

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,

Bordersb Bump or Etched. The value can be as-
signed to a whole variable
Determines the flashing of the Border,

BorderBlink which can be No blinking, Slow blinking

or Rapid blinking. The value can be as-
signed to a whole variable

Determines the color of the Border us-
ing the RGB code or color palette. The
value can be assigned to a whole vari-
able

BorderColor

Determines whether there will be a
BorderVisibility Border to the Field or not; a Boolean
variable can be assigned to this value

Determines the size of the Border
which must be a number to which a
whole variable can be assigned, if
wished

BorderSize
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Table 23: Properties of the Trend Pen

Properties Description

BorderStyle

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable

FontField

Font related to the text shown in the
field; by clicking on @ you can edit
multilanguage Fonts (see chap. 5,
“Languages” page 152)

TextBlink

Determines the flashing of the text;
the possibilities are No Blinking, Slow
blinking or Rapid Blinking. The value
can be associated with Tag or it can be
managed with thresholds

TextColor

Determines the color of the Field text,
which can be selected using the RGB
code or color palette. The value can be
assigned to a whole variable

TextHAlign

Determines the type of horizontal text
alignment, which can be Centered, Left
or Right

TextVAlign

Determines the type of vertical text
alignment, which can be Centered, Top
or Bottom

Lock

Determines if the object can move or
not

PasswordLevel

Determines the authorization level re-
quired to access the field (see chap. 5,
“Password configuration” page 184)

Tablndex

Makes it possible to control the focus
movement when using movement keys
of the cursor within a page. It also con-
trols the order in which data is intro-
duced in several fields when the
automatic setting of the next field of
the page is enabled (see chap. 5,
“General” page 124)

AsciiLen

Determines the maximum length of
the string represented in the Field

PenValue

Allows you to select the type of Pen to
which to assign the field
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Image Field

An Image field can be introduced into a page by clicking on the
icon or using the Main Menu (Fields->Create->Simple fig-
ures->Image). After clicking on the icon, use the mouse to in-
dicate the area in the page where POLYMATH should draw the
Image. The area created in this way will contain one of the im-
ages added to the project (see chap. 5, “Frames” page 163).
To define the characteristics of the Image they must be set in
the Properties Editor as indicated in the following section.

&,

Note: An image can also be added to a page by simply dragging it
from Project Explorer into the work area to the page position re-
quired. With this procedure POLYMATH automatically creates an
Image field relating to the dragged image.

¢

Properties of the Image field

Table 24: Properties of the Image Field

Properties Description

Identifying name of the Image field.
Name Must be unique among the graphic el-
ements
Comment ldentifying comment within POLYMATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension
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Table 24: Properties of the Image Field

Properties Description

Determines the color of the Image
field, which can be selected using the
AreaColor RGB code or color palette. The value
can be assigned to a whole variable or
it can be managed with thresholds

Determines whether the Sector has a
background area or should be trans-
AreaVisibility parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the flashing of the Border,
which can be No blinking, Slow blinking
BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines whether there will be a
Border to the Image Field or not; a
Boolean variable can be assigned to
this value

BorderVisibility

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Reference to the image that must be

Image contained within the Field
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Table 24: Properties of the Image Field

Properties Description

Determines whether the object is ini-
tially visible. It is also possible to as-
Hide sign a Boolean variable (for changes in
Runtime) or it can be managed with
thresholds

Determines if the object can move or

Lock not

Indicates whether the image should
ImageAutoSize automatically sized to fit the dimen-
sions of the Field

Indicates the type of horizontal align-
ment of the image within the Field,

ImageHAlign which can be Central, Leftward or
Rightward
Indicates whether the image should
ImageKeepAspect - . .
Ratio maintain the proportions of the source

image

Indicates the color, selectable using
the RGB code or the color palette, for
which the transparency filter should be
applied

ImageTransColor

Indicates whether a transparency filter

ImageTransparent should be applied to the image

Indicates the type of vertical alignment
ImageVAlign of the image within the Field, which
can be Central, Top or Bottom

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement Associates a Tag to the Direct move-

ment
TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate
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Value fields Value fields are objects (graphic) that can be inserted into a
page in order to show the operator the value of an item of data
(variable) or a representation of it. Some of these fields can
also have their value edited by the operator. In this section we
will analyze each Value field indicating its functional charac-
teristics, its particular properties (that can be configured by
the Properties Editor) and its Events (Events Editor).

Invert Function A general property of all graphic objects (buttons, value fields,
Option numerical fields etc.) that can be inserted in a project page is
called the "Invert Function" option.
The "Invert Function" option can be associated to variables
that have a Boolean behaviour (true/false) and can be used
only if activated as shown hereafter.
Select the "Tools" menu and then the "Options" sub-menu :

File Edt Script Fields Layout Image ‘iew | Tools | 2
BLRLEEETED
J J fJ ."J Utilities R
o 09 oA 1 - WD L ed) |

Translations »

TagsiVariables 3

Recipes

Alarms

Downloader Utiities — »

clicking on "Various" the following image will appear :

almi=l

Selecting the "Show the invert function” box, the option will
be activated.

Invert Function  Select the "Invert"” option in "Editor Properties”, using it as an

option example with a numerical field associated to a "Tag" :
operation
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Thresholds
option
functioning

_'

INumericFie\d [MurnericField] [0003] -

Name MumericField

Comment (Empty value}

Top 169
Left 123

width 46
Height 3z

= Appearance

AreaColor
AreaVisibility
Border3D
BorderBlink
BorderColor
Borderwisibility
BorderSize
BorderStyle
Digits
FontFisld syl Invert

Keyboardld (Ernpty value]

The behaviour associated to the "Tag" is inverted. For exam-
ple, if a "Tag" enables the display of the background colour of
the numerical field when its value is "1", selecting the "Invert"
option, the numerical field background will be visible even
when the value of the "Tag" is "0" and not "1".

Thresholds Management Function

A new functionality is present inside POLYMATH (starting from
version 1.7).

The new POLYMATH function, called Thresholds is present in-
side the Editor Properties and as been created as an additional
option in order to manage the colour change, the flashing, hi-
de, disable and other properties of the various objects.

To explain functioning of the Thresholds option, the AreaCo-
lourPressed property of a Touch-sensitive Button will be taken
as an example :
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ITouchButton [TouchButton] [0000] -
= Design -
Marne TouchButton
Comment (Emnpty value)
= Position
Top 10
Left 10
Wwidth 70
Height 70
(0,0,0)
AreaColorReleased (164,175,193}
Areaisibility TRUE
BarderBlink Na Blink
BorderColorPressed (255,255,255)

BorderColorReleased .(U;U;U)

Marne TouchButton

Comment (Emnpty value)
= Position

Top 10

Left 10

Wwidth 70

Height 70

= Appear.

AreaColorPressed

AreaColorReleased (164,175,193}
Areaisibility TRUE
BarderBlink Mo Blink
BorderColorPressed (255,255,255)

BorderColorReleased .(U;U;U)

On the first click, access the immediate colour selection :

With the second click, access the direct assignment to Tag :
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= Design
Marme TouchButton
Comment (Emnpty value)

width 70
Height 70

AreaColorPressed

AreaColorReleased (164,175,193}
Areaisibility TRUE
BarderBlink Mo Blink
BorderColorPressed (255,255,255)

BorderColorReleased .(U;U;U)

With the third click, access the new "Soglie" (Thresholds)
item:

= Design
Marne TouchButton
Comment (Empty value)

= Position
Top 10
Left 10
Wwidth 70
Height 70
AreaColarPressed [1:]] Value: 3
AreaColorReleased (164,175,193}
Areaisibility TRUE
BarderBlink Mo Blink
BorderColorPressed (255,255,255)

BorderColorReleased .(U;U;U)

The following editing mask will appear by clicking on the
icon :
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e
Tigm [valore =l

| BB ,0,0)
.1 (255,255,255)

% Agaiungi

From the previous mask, select the type of thresholds mana-
gement to be performed, whether with "Valore" (Values) or
"Bits". Moreover, the "ColoreAreaPremuta”™ (AreaColourPres-
sed) property of the "PulsanteSfioramento"” (Touch-sensitive
Button) must be associated to a "Tag". In our example we ha-
ve selected the "Valore" type of management. In this case the
user can add all of the values he wants without any limits :

= Threshalds - ol x|

F  add Duplicate
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The first threshold is assigned with the value "10", associating

it to green :
I xd
Tipa [valore =
Tag [Tag j
| =2 ,0,0)
.10 (128,255,128)

A second threshold is now added by clicking on the "Aggiungi"
(Add) button :

-lolx
Tz [value =l
Tag [Tea j

B (128,255,0)

.1 (255,255,255)

F  add Duplicate

The second threshold is assigned with the value "20", associa-
ting it to blue :
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o
Tz [value =l
Tag [T2a ﬂ

{0.0,0)
(128,255,0)

.(010,255)

T add Duplicate

Clicking on the button to end editing.

If the user should select the "Bits" type management, the sa-
me amount of values must be introduced as there are Bits de-
fined to which the desired settings are to be associated.
Practically, the user can assign a different colour to every Bit,
for example when the second Bit is at 1, the object will be yel-
low. When the third Bit is at 1, the object will be blue, when
the fourth Bit is at 1, the object will be red and so on.

If there are more Bits at 1, the lowest one will be considered.

=1o|x|
T [Bits =l
Tag [Tao ﬂ

(0,0,0)
(255,255,128)

.(010,255)
.(255Jn,n)

% agaiungi
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The Bits that the user addresses may not be adjoining.

The most insignificant Bit must be Bit "1" while the most si-
gnificant Bit will depend on the length of the type of Tag as-
sociated, e.q. if the Tag is at 16 Bit, the user can insert the
Bits from 1 to 16.

Objects to The new Thresholds Management functionality is supported by
which the the following objects, with properties described below :
Thresholds

functionality Rectangle

can be applied

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style
Hidden

Ellipse

Area Colour
Area Visibility
Line Colour
Hidden

3D Ellipse

Arc

Line Colour
Hidden

ircular r

Area Colour
Area Visibility
Line Colour
Hidden

Line

3D effect
Line Colour
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Line Size
Hidden

Polygon

Area Colour
Area Visibility
Line Colour
Line Size
Hidden

Polyline

Line Colour
Line Size
Hidden

Regular Polygon

Area Colour
Area Visibility
Line Colour
Line Size
Hidden

Label
Area Colour

Area Visibility
3D Border

Border Flashing

Border Colour

Border Thickness

Border Style
Text Flashing
Text Colour

Text Horizontal Alignment
Text Vertical Alignment

Hidden
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Image

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style
Hidden

Numerical Fiel

Area Colour

Area Visibility

3D Border

Border Flashing

Border Colour

Border Thickness
Border Style

Text Flashing

Text Colour

Text Horizontal Alignment
Text Vertical Alignment
Rejected Characters
Disabled

Hidden

Mile Separator

Dynamic Text

Area Colour

Area Visibility

3D Border

Border Flashing

Border Colour

Border Thickness
Border Style

Text Flashing

Text Colour

Text Horizontal Alignment
Text Vertical Alignment
Disabled

Hidden
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Ascii Field

Area Colour

Area Visibility

3D Border

Border Flashing

Border Colour

Border Thickness
Border Style

Text Flashing

Text Colour

Text Horizontal Alignment
Text Vertical Alignment
Disabled

Hidden

Symbol Field

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style
Disabled

Hidden

Date Time Field

Area Colour

Area Visibility

3D Border

Border Flashing

Border Colour

Border Thickness
Border Style

Text Flashing

Text Colour

Text Horizontal Alignment
Text Vertical Alignment
Disabled

Hidden
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Bar Field

Area Colour

Area Visibility

3D Border

Border Flashing

Border Colour

Border Thickness

Bar Background Colour
Disabled

Hidden

Indi r

Area Visibility
Border Style
Hidden

Touch-sensitive Button

Area Colour Pressed

Area Colour Released
Area Visibility

Border Flashing

Border Colour Pressed
Border Colour Released
Border Thickness

3D Button

Text Flashing

Text Colour

Text Horizontal Alignment
Text Vertical Alignment
Image Horizontal Alignment
Image Vertical Alignment
Disabled

Hidden

Tactile Area

Disabled
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lide Potentiometer

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Disabled

Hidden

li l r

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Disabled

Kn ntiom r

Area Visibility
Border Style
Disabled
Hidden

Kn | r

Area Visibility
Border Style
Disabled
Hidden

Mon le B n

Area Colour Pressed
Area Visibility Pressed
Area Colour Released
Area Visibility Released
Disabled

Hidden

Chapter 6

Properties Editor
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Bi le B n

Area Colour Key Off
State Area Off Present
Area Colour State On
State Area On Present
Disabled

Hidden

Erame

Background Frame Colour
Transparent Background Frame Colour
Page Edge Colour

Page Border Thickness

Page Border Style

Trend Buffer View

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style
Hidden

Trend Buffer Graphi

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style

Trend Buffer X-Y View
Area Colour

Area Visibility
3D Border
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Border Flashing
Border Colour
Border Thickness
Border Style
Hidden

Trend X-Y Graphi

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style

Data L og View

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style
Hidden

. | .

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style

Historic Alarms View

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
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Border Style
Hidden

User List

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style
Hidden

: .

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style
Hidden

. it

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style
Hidden

Recipe Type Name Text

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
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Border Thickness

Border Style

Text Flashing

Text Colour

Text Horizontal Alignment
Text Vertical Alignment
Disabled

Hidden

Recipe Comment

Area Colour

Area Visibility

3D Border

Border Flashing

Border Colour

Border Thickness
Border Style

Text Flashing

Text Colour

Text Horizontal Alignment
Text Vertical Alignment
Disabled

Hidden

Chronothermostat View

Area Colour
Area Visibility
3D Border
Border Flashing
Border Colour
Border Thickness
Border Style
Hidden

hronotherm ri

Area Colour
Area Visibility
3D Border
Border Colour
Border Thickness
Border Flashing
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Vertical Scale Label Colour

Keyboard Display
Area Colour

Border Colour
Text Colour

Numerical Field

A Numerical Field can be introduced into a page by clicking on
the icon or using the Main Menu (Fields->Create->Value
Fields->Numerical field). After clicking on the icon, use the
mouse to indicate the area in the page where POLYMATH
should draw the Field.

The purpose of the Numerical Field is to show the operator the
updated value of a particular variable. These fields can be also
be edited to become Edit value fields.

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a Numerical Field. In POLYMATH, the value of
the Numerical Field is represented by a series of hash charac-
ters which in Runtime are substituted by the effective value.

SR

2,

Note: an alternative method of creating a Numerical Fieldistodrag
a numerical variable from the Project Explorer directly onto the
destination page in the work area.

¢

Properties of the Numerical Field

Properties Description

Identifying name of the Numerical
Name field. Must be unique among the
graphic elements

Comment ldentifying comment within POLYMATH
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Properties Description

Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension

Height Height dimension

Determines the color of the Numeric
Field, which can be selected using the
AreaColor RGB code or color palette. The value
can be assigned to a whole variable or
it can be managed with thresholds

Determines whether the numerical
field must have the background area
AreaVisibility or if it must be transparent. A Boolean
variable can be associated to this value
or it can be managed with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the flashing of the Border,
which can be No blinking, Slow blinking
BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines whether the Border of the
Numeric Field is present or not; a Bool-
ean variable can be assigned to this
value

BorderVisibility

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds
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Properties Description

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Defines the maximum number of char-
Digits acters visible in the field representing
the value

Font related to the text shown in the
field; by clicking on . you can edit

FontField multilanguage Fonts (see chap. 5,
“Languages” page 152)
Keyboardld Enabling this option allows you to se-

lect the keyboard to use for editing

Indicates the value representation for-
mat, which will be either Decimal with
or without a Sign, Hexadecimal, Bina-
ry, Floating or Fixed Point

Representation

Reference variable for the value to be
displayed. This is a numerical variable.
Tagld Using the appropriate keys you can
create a new variable or edit an exist-
ing one

Determines the flashing of the text;
the possibilities are No Blinking, Slow
TextBlink blinking or Rapid Blinking. The value
can be associated with Tag or it can be
managed with thresholds

Determines the color of the Field text
which can be selected using the RGB

TextColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

Determines the type of horizontal
TextHAIlign alignment of the text; this can be Cen-
ter, Left or Right

Determines the type of horizontal
TextVAlign alignment of the text; this can be Cen-
ter, Top or Bottom
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Properties Description

Indicates the number of digits to be
truncated when finally representing
the field; the digits are truncated start-
TruncationDigits ing from the right (e.g. 1456 when
truncation = 2 is 14). The value can be
associated with Tag or it can be man-
aged with thresholds

Indicates whether the field should be

Disable disabled

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Indicates if zeroes should be set before
the significant digits; e.g. if True
000541 will be displayed, otherwise it
will simply be 541

LeadingZeroes

Determines if the object can move or

Lock not

Determines the authorization level re-
quired to be able to edit the field (see
PasswordLevel chap. 5, “Password configuration”
page 184). This property is ignored if
the field is Read Only

Makes it possible to control the focus
movement when using movement keys
of the cursor within a page. It also con-
trols the order in which data is intro-
duced in several fields when the
automatic setting of the next field of
the page is enabled (see chap. 5,
“General” page 124)

Tablndex

Indicates whether to show “thousand
separators” or not. The value can be

associated with Tag or it can be man-
aged with thresholds

Thousep

ESAPOLYMATH - User Manual - rev. 2.1



306 | Chapter6

Properties Editor

Properties Description

Allows you to use a general numerical
field and view, during insertion of its
data, the character attributed to the
"Password Character" property. For
PasswordChar example, if you attribute the "*" cha-
racter to the "Password Character"
property, a line of asterisks "*****"
will appear when inserting the data
(e.g. "12345").

Indicates the layout of the representa-
tion of the numerical value; for exam-
Picture ple, if the value is 35403 and if the
picture is ##!#:## the field displayed
will be 3514:03

Indicates the number of decimal digits
DecimalDigits to display if the representation format
is Fixed Point

Indicates the string that will appear to

NegativelLeftText the left when the value is negative

Indicates the string that will appear to

PositivelLeftT . .
ositiveleftText the left when the value is positive

Indicates the string that will appear to

NegativeRightText the right when the value is negative

Indicates the string that will appear to

PositiveRightText the right when the value is positive

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement Associates a Tag to the Direct move-

ment
TagX Horizontal movement tag
TagY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate
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Numerical Field events

Table 25: Numerical Field events

Event Description

Activated when data input operation is
ended

OnAbortlnput

Activated when data input using the

OnBeginlnput keyboard starts

Activated when the value of the Field is

OnvalueChange changed using the keyboard

Dynamic Text

A Dynamic text can be introduced into a page by clicking on
the icon or using the Main Menu (Fields->Create->Value
Fields->Dynamic text). After clicking on the icon, use the
mouse to indicate the area in the page where POLYMATH
should draw the Field.

The purpose of a Dynamic text is to show the operator a given
string as the function of the value of a variable. Which string
contained in a Text List is displayed depends on the value of
the variable, (see chap. 5, “Text list” page 196). For example
the words “On” or “Off” can be shown as a function of a Bool-
ean variable.

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a Dynamic text. In POLYMATH, the value of a
Dynamic text is represented by the first value of the text list
which in Runtime is substituted by the correct value.

Properties of the Dynamic Text

Table 26: Properties of the Dynamic Text

Properties Description

Identifying name of the Dynamic text.
Name Must be unique among the graphic el-
ements
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Table 26: Properties of the Dynamic Text

Properties Description

Comment Identifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension
Determines the color of the Dynamic
text, which can be selected using the
RGB code or color palette. The value

AreaColor

can be assigned to a whole variable .
The value can be associated with Tag
or it can be managed with thresholds

AreaVisibility

Determines whether the Sector has a
background area or should be trans-
parent; a Boolean variable can be as-
signed to this value . The value can be
associated with Tag or it can be man-
aged with thresholds

Border3D

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderBlink

Determines the flashing of the Border,
which can be No blinking, Slow blinking
or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderColor

Determines the color of the Border us-
ing the RGB code or color palette. The
value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

BorderVisibility

Determines whether there will be a
Border to the Dynamic text or not; a
Boolean variable can be assigned to
this value
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Table 26: Properties of the Dynamic Text

Properties Description

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Font related to the text shown in the
field; by clicking on @ you can edit
multilanguage Fonts (see chap. 5,

“Password configuration” page 184)

FontField

Reference variable for the value to be
displayed. This is a numerical variable.
Tagld Using the appropriate keys you can
create a new variable or edit an exist-
ing one

Indicates the blinking mode of the text
TextBlink displayed; can be No Blinking, Slow
Blinking or Rapid Blinking

Determines the color of the Field text,
which can be selected using the RGB

TextColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

Determines the type of horizontal
alignment of the text; this can be Cen-
TextHAlign ter, Left or Right. The value can be as-
sociated with Tag or it can be managed
with thresholds

Determines the type of horizontal
alignment of the text; this can be Cen-
TextVAlign ter, Top or Bottom. The value can be
associated with Tag or it can be man-
aged with thresholds
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Table 26: Properties of the Dynamic Text

Properties Description

Active if the type of control is value-
orientated; the values on which to ap-
ply the list strings must be indicated.
By clicking on @ you can access the
mask associating values and elements
of the text list

Value

Indicates the type of control to exer-
cise over the control variable; this can
be value-oriented, single-bit orientat-
ed or bit-group-oriented.

ControlType

Indicates whether the field should be
disabled. The value can be associated
with Tag or it can be managed with
thresholds

Disable

Active if the type of control is single-bit
orientated or bit-group-oriented. It in-
FirstBit dicates the bit reference to apply the
control to (or the group initial refer-
ence if the control relates to a group)

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Active if the type of control is single-bit
LastBit orientated. Indicates the last bit of the
group to apply the control to

Determines if the object can move or

Lock not

Determines the authorization level re-
quired to be able to edit the field (see
PasswordLevel chap. 5, “Password configuration”
page 184). This property is ignored if
the field is Read Only
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Table 26: Properties of the Dynamic Text

Properties Description

Tablndex

Makes it possible to control the focus
movement when using movement keys
of the cursor within a page. It also con-
trols the order in which data is intro-
duced in several fields when the
automatic setting of the next field of
the page is enabled (see chap. 5,
“General” page 124)

TextListld

Defines the text list from which the
string to be displayed will be selected
in Runtime. Using the appropriate keys
you can create a new list or edit an ex-
isting one (see chap. 5, “Text list”
page 196)

TextMaxLen

Indicates the maximum length of the
text

TextTranslateDisable

Determines whether the translation of
the Label text must be disabled

TypeOfMovement

Identifies the movement associated to
the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement

Associates a Tag to the Direct move-
ment

TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Dynamic Text Events

Table 27: Dynamic Text Events

Event Description

OnAbortinput

Activated when data input operation is
ended
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Table 27: Dynamic Text Events

Event Description

Activated when data input using the
keyboard starts

OnBeginlnput

Activated when the value of the Field is

OnvalueChange changed using the keyboard

ASCII Field

An ASCII field can be introduced into a page by clicking on the
icon 44 or using the Main Menu (Fields->Create->Value
Fields->ASCII field). After clicking on the icon, use the mouse
to indicate the area in the page where POLYMATH should draw
the Field.

ASCII fields tell the operator the updated value of a particular
String variable. These fields can also be edited thereby be-
coming value changing fields.

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to an ASCII Field. In POLYMATH, the value of an
ASCII field is represented by a series of dollar symbols ($)
that can be substituted by the effective value in Runtime.

T‘ Note: An alternative method of creating an ASCII Fieldistodrag a
string variable from the Project Explorer directly onto the destina-
tion page in the work area.

Properties of the ASCII Field

Table 28: Properties of the ASCII Field

Properties Description

Identifying name of the ASCII field.
Name Must be unique among the graphic el-
ements
Comment Identifying comment within POLYMATH
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Table 28: Properties of the ASCII Field

Properties Description

Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension
Determines the color of the ASCII
field, which can be selected using the
AreaColor RGB code or color palette. The value

can be associated with Tag or it can be
managed with thresholds

AreaVisibility

Determines whether the Sector has a
background area or should be trans-
parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Border3D

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderBlink

Determines the flashing of the Border,
which can be No blinking, Slow blinking
or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderColor

Determines the color of the Border us-
ing the RGB code or color palette. The
value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

BorderVisibility

Determines whether there will be a
Border to the ASCII field or not; a
Boolean variable can be assigned to
this value

BorderSize

Determines the size of the Border
which must be a number to which a
whole variable can be assigned, if
wished, or it can be managed with
thresholds
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Table 28: Properties of the ASCII Field

Properties Description

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Font related to the text shown in the
field; by clicking on ' you can edit
multilanguage Fonts (see chap. 5,
“Languages” page 152)

FontField

Enabling this option allows you to se-

Keyboardld lect the keyboard to use for editing

Reference variable for the value to be
displayed. This is a numerical variable.
Tagld Using the appropriate keys you can
create a new variable or edit an exist-
ing one

Determines the flashing of the text;
the possibilities are No Blinking, Slow
TextBlink blinking or Rapid Blinking. The value
can be associated with Tag or it can be
managed with thresholds

Determines the color of the Field text,
which can be selected using the RGB

TextColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

Determines the type of horizontal
alignment of the text; this can be Cen-
TextHAlign ter, Left or Right. The value can be as-
sociated with Tag or it can be managed
with thresholds

Determines the type of horizontal
alignment of the text; this can be Cen-
TextVAlign ter, Top or Bottom. The value can be
associated with Tag or it can be man-
aged with thresholds

Indicates whether the field should be
disabled. The value can be associated
with Tag or it can be managed with
thresholds

Disable
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Table 28: Properties of the ASCII Field

Properties Description

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Determines if the object can move or

Lock not

Determines the authorization level re-
quired to be able to edit the field (see
PasswordLevel chap. 5, “Password configuration”
page 184). This property is ignored if
the field is Read Only

Makes it possible to control the focus
movement when using movement keys
of the cursor within a page. It also con-
trols the order in which data is intro-

Tabindex duced in several fields when the
automatic setting of the next field of
the page is enabled (see chap. 5,
“General” page 124)

AsciilLen Determines the maximum length of

the string represented in the Field

Allows you to use a general numerical
field and view, during insertion of its
data, the character attributed to the
"Password Character" property. For
PasswordChar example, if you attribute the "*" cha-
racter to the "Password Character"
property, a line of asterisks "*****"
will appear when inserting the data
(e.g. "12345").

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

. A iat Tag to the Direct move-
TagDirectMovement ssociates a lag to the ec ove

ment
TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
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Table 28: Properties of the ASCII Field

Properties Description

FinalX Horizontal co-ordinate

FinalY Vertical co-ordinate

ASCII Field events

Table 29: ASCII Field events

Events Properties

Activated when data input operation is
ended

OnAbortlnput

Activated when data input using the

OnBeginlnput keyboard starts

Activated when the value of the Field is

OnvalueChange changed using the keyboard

Symbol Field

A Symbol field can be introduced into a page by clicking on the
icon or using the Main Menu (Fields->Create->Value
fields->Symbol field). After clicking on the icon, use the
mouse to indicate the area in the page where POLYMATH
should draw the Field.

The Symbol field serves to indicate to the operator a given im-
age according to the value of a related variable; depending on
the value of the variable, an image contained in a list of imag-
es is displayed (see chap. 5, “Image list” page 197). For ex-
ample, the image of a led that may be ON or OFF can be
shown, according to the Boolean variable.

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a Symbol field. In POLYMATH, the Symbol field
value is represented by the first image in the image list will be
replaced by the correct image in Runtime.

ESAPOLYMATH - User Manual - rev. 2.1



Chapter6 | 317

Properties Editor

Properties of the Symbol Field

Table 30: Properties of the Symbol Field

Properties Description

Identifying name of the Symbol field.

Name Must be unique among the graphic el-
ements

Comment Identifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

Determines the color of the Symbol
Field, which can be selected using the
AreaColor RGB code or color palette. The value
can be assigned to a whole variable or
it can be managed with thresholds

Determines whether the Sector has a
background area or should be trans-
AreaVisibility parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds
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Table 30: Properties of the Symbol Field

Properties Description

Determines the flashing of the Border,
which can be No blinking, Slow blinking
BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines whether there will be a

Border to the Symbol Field or not; a
Boolean variable can be assigned to
this value

BorderVisibility

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Reference variable for the value to be
displayed. This is a numerical variable.
Tagld Using the appropriate keys you can
create a new variable or edit an exist-
ing one

Active if the type of control is value-
oriented; it is necessary to indicate the
values on which to apply the strings in
the list. By clicking on you access
the mask for associating values with
elements in the list of images

Value

Indicates the type of control to exer-
cise over the control variable; this can
be value-oriented, single-bit orientat-
ed or bit-group-oriented.

ControlType
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Table 30: Properties of the Symbol Field

Properties Description

Indicates whether the field should be
disabled. The value can be associated
with Tag or it can be managed with
thresholds

Disable

Active if the type of control is single-bit
orientated or bit-group-oriented. It in-
FirstBit dicates the bit reference to apply the
control to (or the group initial refer-
ence if the control relates to a group)

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Active if the control is bit-group orient-
LastBit ed. Indicates the last bit of the group
to which the control is applied

Determines if the object can move or

Lock
not

Determines the authorization level re-
quired to be able to edit the field (see
PasswordLevel chap. 5, “Password configuration”
page 184). This property is ignored if
the field is Read Only

Makes it possible to control the focus
movement when using movement keys
of the cursor within a page. It also con-
trols the order in which data is intro-
duced in several fields when the
automatic setting of the next field of
the page is enabled (see chap. 5,
“General” page 124)

Tablndex

Indicates whether the image should
ImageAutoSize automatically sized to fit the dimen-
sions of the Field

Indicates the type of horizontal align-
ImageHAIlign ment of the image within the Field,
which can be Center, Left or Right

Indicates whether the image should
maintain the proportions of the source
image

ImageKeepAspect
Ratio
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Table 30: Properties of the Symbol Field

Properties Description

ImagelListld

Indicates the list of images from which
a Runtime selection of the image to be
displayed is made. Using the appropri-
ate keys a new list can be created or an
existing one edited (see chap. 5, “Im-
age list” page 197)

ImageTransColor

Indicates the color, selectable using
the RGB code or the color palette, for
which the transparency filter should be
applied

Indicates whether a transparency filter

1 T . h
mageTransparent should be applied to the image
Indicates the type of vertical alignment
ImageVAlign of the image within the Field, which
can be Center, Top or Bottom
Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,

Vertical and Horizontal And Vertical

TagDirectMovement

Associates a Tag to the Direct move-
ment

TagX Horizontal movement tag
TagY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Symbol Field events

Table 31: Symbol Field events

Event Description

OnAbortinput

Activated when data input operation is
ended

OnBeginlnput

Activated when data input using the
keyboard starts

OnValueChange

Activated when the value of the field is
changed using the keyboard
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DateTime field

A DateTime field can be introduced into a page by clicking on
the icon or using the Main Menu (Fields->Create->Value
fields->DateTime field). After clicking on the icon, use the
mouse to indicate the area in the page where POLYMATH
should draw the Field.

The DateTime field serves to indicate to the operator the cur-
rent date and/or time while a project is running. A variable can
be associated to the field, like Long or UnsignedLong (e.g. to
use the data set in the device) or the system variable
SYS_DateAndTime that shows the time of the operating sys-
tem of the panel (see chap.“Appendix A - System Variables”
page 693). To express the day or the month in letters rather
than in numbers, the corresponding translations must be giv-
en in appropriate text lists (see chap. 5, “Text list” page 196).
The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a DateTime field. In POLYMATH, the value of
the DateTime field is represented by the DateTime of the op-
erating system of the machine the programmer is using.

Properties of the DateTime field

Table 32: Properties of the DateTimefield

Properties Description

Identifying name of the Date-Time
Name field. Must be unique among the
graphic elements
Comment Identifying comment within POLYMATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension
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Table 32: Properties of the DateTime field

Properties Description

Determines the color of the Date/Time
field, which can be selected using the
AreaColor RGB code or color palette. The value
can be assigned to a whole variable or
it can be managed with thresholds

Determines whether the Field has a
background area or should be trans-
AreaVisibility parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the flashing of the Border,
which can be No blinking, Slow blinking
BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines whether there will be a
Border to the Date/Time field or not; a
Boolean variable can be assigned to
this value

BorderVisibility

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle
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Table 32: Properties of the DateTime field

Properties Description

Font related to the text shown in the
field; by clicking on . you can edit

FontField multilanguage Fonts (see chap. 5,
“Languages” page 152)
Keyboardld Enabling this option allows you to se-

lect the keyboard to use for editing

Reference variable for the data value
to be displayed. The variable selected
Tagld can be Long or Unsigned Long. Using
the appropriate keys you can create a
new variable or edit an existing one

Determines the flashing of the text;
the possibilities are No Blinking, Slow
TextBlink blinking or Rapid Blinking. The value
can be associated with Tag or it can be
managed with thresholds

Determines the color of the Text field,
which can be selected using the RGB

TextColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

Determines the type of horizontal
alignment of the text; this can be Cen-
TextHAlign ter, Left or Right. The value can be as-
sociated with Tag or it can be managed
with thresholds

Determines the type of horizontal
alignment of the text; this can be Cen-
TextVAlign ter, Top or Bottom. The value can be
associated with Tag or it can be man-
aged with thresholds

Indicates whether the field should be
disabled. The value can be associated
with Tag or it can be managed with
thresholds

Disable

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

ESAPOLYMATH - User Manual - rev. 2.1



324 | Chapter 6

Properties Editor

Table 32: Properties of the DateTime field

Properties Description

Determines if the object can move or
not

Lock

Determines the authorization level re-
quired to be able to edit the field (see
PasswordLevel chap. 5, “Password configuration”
page 184). This property is ignored if
the field is Read Only

Makes it possible to control the active
focus using cursor keys within a page.
It also controls the order in which data
Tablndex is introduced in several fields when the
automatic setting of the next field of
the page is enabled (see chap. 5,
“General” page 124)

Indicates the position of the Date with-
DatePosition in the field: this may be centered, left-
ward or rightward

Indicates the format of the date to be
shown; the order and the layout of the
day, month and year can be selected.
You can choose whether or not to as-
sign a text list to the value of the
month so as to display the string relat-
ed to the current month (see chap. 5,
“Text list” page 196)

DateRepresentation

Indicates the position of the Time with-
TimePosition in the field: this may be centered, left-
ward or rightward

Indicates the format of the date to be
shown; you can indicate whether or
not to insert the seconds and whether
to create an AM/PM type of display

TimeRepresentation

Indicates the display related to the day
of the week; it is possible not to dis-
play anything, to show an ordinal num-
TypeOfDayOfWeek ber (Sunday being O, etc.) or to assign
a text list to the number so as to view
(also in multilanguage) the current day
(see chap. 5, “Text list” page 196)
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Table 32: Properties of the DateTime field

Properties Description

Active if the TypeOfDayOfWeek is set
as a text list. This property indicates
the text list assigned to the day of the
week; a text list of 7 values must be
created (see chap. 5, “Text list”

page 196)

DayOfWeek

Indicates the position of the text relat-
ed to the Day (if desired) within the
field: this may be centered, leftward or
rightward

DayOfWeekPosition

Active if the DateRepresentation dis-
play is to be the full name of the
month. This property indicates the text
list assigned to the month; a text list of
12 values must be created (see chap.
5, “Text list” page 196)

Month

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

. A iat Tag to the Direct m -
TagDirectMovement ssociates a Tag to the Direct move

ment
TagX Horizontal movement tag
TagY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

DateTime field events

Table 33: DateTime field events

Event Description

Activated when data input operation is
ended

OnAbortinput

Activated when data input using the

OnBeginlnput keyboard starts
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Table 33: DateTime field events

Event Description

Activated when the value of the field is
changed using the keyboard

OnValueChange

Bar Field

A Bar field can be introduced into a page by clicking on the
icon §*fl or using the Main Menu (Fields->Create->Value
Fields->Bar field). After clicking on the icon, use the mouse to
indicate the area in the page where POLYMATH should draw
the Field.

The Bar field serves to give a graphic indication of the value
of a variable within a Scroll bar guided by a scale of values. If
the field is editable, the operator can change the value simply
by moving the pointer onto desired the Scale value.

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a Bar field.

Properties of the Bar field

Table 34: Properties of Bar field

Properties Description

ldentifying name of the Bar field. Must
Name . .

be unique among the graphic elements
Comment Identifying comment within POLYMATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension
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Table 34: Properties of Bar field

Properties Description

Determines the color of the Bar field,
which that can be selected using the
AreaColor RGB code or color palette. The value
can be assigned to a whole variable or
it can be managed with thresholds

Determines whether the Sector has a
background area or should be trans-
AreaVisibility parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the flashing of the Border,
which can be No blinking, Slow blinking
BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines whether there will be a
Border to the Bar Field or not; a Bool-
ean variable can be assigned to this
value

BorderVisibility

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds

Indicates the size of the character of
FontSize the values written above the numerical
division lines
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Table 34: Properties of Bar field

Properties Description

Indicates the number of subdivision
marks appearing between two numer-
ical divisions. These are shorter divi-
sion lines than the numerical ones,
giving greater precision to the repre-
sentation

ScaleNotches

Indicates the color ranges to be as-
signed to given value intervals within
the scale. By clicking on ' you enter
an editing window in which the value
intervals and their respective colors
can be defined; the window also allows
you only to specify the limits in relation
to the scale to be displayed

ScaleColorRanges

Indicates the number of notches on the
scale of values. You will also see the fi-
ScaleSectors gure for the value above the notch
(calculated based on the number of
notches)

Reference variable corresponding to
the position of the indicator. Using the
appropriate keys you can create a new
variable or editor an existing one

Tagld

AlignBarColorToScale | Allows to align, or not, the color of the
Color bar to the color of the scale

Allows you to assign a color to the bar
background. The value can be associ-
ated with Tag or it can be managed
with thresholds

BarBackgroundColor

Indicates the direction of the Bar:

Direction whether vertical or horizontal
Indicates whether the field should be
. disabled. The value can be associated
Disable

with Tag or it can be managed with
thresholds

Determines the color of the filling of
the bar through code or RGB color pa-
lette. The value can be associated with
integer variable.

FillBarColorRanges
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Table 34: Properties of Bar field

Properties Description

Hide

Determines whether the object is ini-
tially visible. You can also assign a
Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

PasswordLevel

Determines the authorization level re-
quired to be able to edit the field (see
chap. 5, “Password configuration”
page 184). This property is ignored if
the field is Read Only

Tablndex

Makes it possible to control the focus
movement when using movement keys
of the cursor within a page. It also con-
trols the order in which data is intro-
duced in several fields when the
automatic setting of the next field of
the page is enabled (see chap. 5,
“General” page 124)

BarOrigin

Indicates from which value the Bar val-
ue count should start

ScaleValueColor

Color of the values (figures) related to
the numerical subdivisions of the
scale. This can be selected using the
RGB code or the color palette

ScalePosition

Indicates where the scale of values
should be positioned in relation to the
Bar. If the Bar is vertical, the scale can
be positioned to the left or the right; if
it is horizontal, the scale can be above
or below

TypeOfMovement

Identifies the movement associated to
the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement

Associates a Tag to the Direct move-
ment

TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
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Table 34: Properties of Bar field

Properties Description

FinalY Vertical co-ordinate

Bar field events

Table 35: Bar field events

Event Description

Activated when the value of the Field is
changed using the touch screen

OnValueChange

Indicator

An Indicator can be introduced into a page by clicking on the
icon or using the Main Menu (Fields->Create->Value
fields->Pointer). After clicking on the icon, use the mouse to
define the area in the page where POLYMATH should draw the
Indicator.

The Indicator gives a graphic representation of the value of a
variable within a given scale of values. Unlike the Bar, the In-
dicator cannot be edited and has a different graphic form.
The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to an Indicator.
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Properties of the Indicator

Table 36: Properties of the Indicator

Properties Description

ldentifying name of the Indicator. Must

Name be unique among the graphic elements
Comment Identifying comment within POLYMATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension

Determines the color of the Indicator
AreaColor area, which can be selected using the

RGB code or color palette. The value
can be assigned to a whole variable

AreaVisibility

Determines whether the Sector has a
background area or should be trans-
parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,

Bordersb Bump or Etched. The value can be as-
signed to a whole variable
Determines the flashing of the Border,

BorderBlink which can be No blinking, Slow blinking

or Rapid blinking. The value can be as-
signed to a whole variable

BorderColor

Determines the color of the Border us-
ing the RGB code or color palette. The
value can be assigned to a whole vari-
able

BorderVisibility

Determines whether there will be a
Border to the Indicator or not; a Bool-
ean variable can be assigned to this
value

BorderSize

Determines the size of the Border
which must be a number to which a
whole variable can be assigned, if
wished
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Table 36: Properties of the Indicator

Properties Description

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Indicates the size of the character of
FontSize the values written above the numerical
division lines

Determines the color of the Indicator
IndicatorColor (hand) using the RGB code or the color
palette

Indicates the number of subdivision
marks appearing between two numer-
ical divisions. These are shorter divi-
sion lines than the numerical ones,
giving greater precision to the repre-
sentation

ScaleNotches

Indicates the color ranges to be as-
signed to given value intervals within
the scale. By clicking on ' you enter
an editing window in which the value
intervals and their respective colors
can be defined; the window also allows
you only to specify the limits in relation
to the scale to be displayed

ScaleColorRanges

Indicates the number of divisions on
the scale of values. The number relat-
ScaleSectors ing to the value above the division is
also displayed (calculated according to
the number of divisions)

Reference variable corresponding to
the position of the indicator. Using the
appropriate keys you can create a new
variable or edit an existing one

Tagld

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Determines if the object can move or

Lock
not
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Table 36: Properties of the Indicator

Properties Description

Determines the Indicator start position
(given as an angle)

StartAngle

Determines the angle (in degrees) of

SweepAngle the aperture of the Indicator

Color of the values (figures) related to
the numerical subdivisions of the
scale. This can be selected using the
RGB code or the color palette

ScaleValueColor

Determines the color of the Indicator
(hand) using the RGB code or color
palette. The value can be assigned to a
whole variable

TipColor

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement Associates a Tag to the Direct move-

ment
TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Simple Controls  Simple Controls are objects that can be inserted into a page
to show the operator the value of an item of data (variable)
and/or edit it. In this section we will analyze each Simple Con-
trol, identifying their functional characteristics, their proper-
ties (configurable using the Properties Editor) and their
associated events (Events Editor).

Touch Button

A Touch Button can be introduced into a page by clicking on
the icon or using the Main Menu (Fields->Create->Simple
controls->TouchButton). After clicking on the icon, use the
mouse to indicate the area in the page where POLYMATH
should draw the button.

Touch Buttons are useful as they allow the operator to assign
a given function or script user with a single click. For further
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details regarding scripts and predefined functions, the reader
is advised to consult the relevant section of this manual (see
chap.“Appendix B - Predefined functions” page 701 and see

chap. 9, “Scripts” page 509).

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a button.

change

Properties of the Touch button

Table 37: Properties of the Touch button

Properties Description

Identifying name of the Touch button.

Name Must be unique among the graphic el-
ements

Comment ldentifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

Determines the color of the Area of the
button (when depressed), which can
be selected using the RGB code or col-
or palette. The value can be assigned
to a whole variable or it can be man-
aged with thresholds

AreaColorPressed
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Table 37: Properties of the Touch button

Properties Description

Determines the color of the Area of the
button (when released), which can be
selected using the RGB code or color
palette. The value can be assigned to a
whole variable or it can be managed
with thresholds

AreaColorReleased

Determines whether the Button has a
background area or should be trans-
AreaVisibility parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines the flashing of the Border,
which can be No blinking, Slow blinking
BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the color of the Border
(when the button is depressed) using
BorderColorPressed the RGB code or color palette. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

Determines the color of the Border
(when the button is released) using
BorderColorReleased the RGB code or color palette. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

Determines whether there will be a
BorderVisibility Border to the button or not; a Boolean
variable can be assigned to this value

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds

Determines whether the button is in
3D. The value can be associated with
Tag or it can be managed with thresh-
olds

Button3D

Indicates the choice of image to apply
Bitmap to the button: No image, a single im-
age or list of images

ESAPOLYMATH - User Manual - rev. 2.1



336 | Chapter6

Properties Editor

Table 37: Properties of the Touch button

Properties Description

Active only if Bitmap set on Image;
with this you can indicate which of the
images in the project to apply to the
button

Image

Indicates the type of inscription to dis-
Caption play on the button: None, Label or Text
list

Active only if Caption is set for Label;
makes it possible to indicate the text to
be applied to the button. Inside a mul-
tilanguage project, click on to edit
texts in any language (see ciiap. 5,
“Languages” page 152)

Text

Font related to the text shown in the
field; by clicking on (@ you can edit
multilanguage Fonts (see chap. 5,
“Languages” page 152)

FontField

Determines the flashing of the text;
the possibilities are No Blinking, Slow
TextBlink blinking or Rapid Blinking. The value
can be assigned to a whole variable or
it can be managed with thresholds

Determines the color of the text of the
button, which can be selected using
TextColor the RGB code or color palette. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

Allows you to specify the horizontal
centering of the text within the Label.
TextHAlign The value can be assigned to a whole
variable or it can be managed with
thresholds

Allows you to specify the vertical cen-
tering of the text within the Label. The
TextVAlign value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Indicates whether the field should be
disabled. The value can be associated
with Tag or it can be managed with
thresholds

Disable
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Table 37: Properties of the Touch button

Properties Description

Determines whether the object is ini-
tially visible. You can also assign a

Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds
Determines if the object can move or

Lock

not

Determines the authorization level re-
quired to access the button functions
(see chap. 5, “Password configuration”
page 184)

PasswordLevel

Makes it possible to control the focus
movement when using cursor keys
within a page. It also controls the or-
Tablndex der in which data is introduced in sev-
eral fields when the automatic setting
of the next field of the page is enabled
(see chap. 5, “General” page 124)

Determines the maximum value in re-

TextMaxLen lation to the length of the text string

Determines whether the Label text can

TextMultiLine .
start a new line

Determines whether the translation of

TextTranslateDisable the Button text must be disabled

Active if TextListType is value-orient-
ed; it is necessary to indicate the val-
ues on which to apply the list strings.
By clicking on . you can access the

mask for associating values and text

list elements

TextListValue

Indicates which type of check to per-
form on the control variable: can be
value-oriented, single-bit or bit-group-
oriented

TextListType

Active only if Caption is a Text List
TextListld type. Determines the reference text
list (see chap. 5, “Text list” page 196)
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Table 37: Properties of the Touch button

Properties Description

TextTagld

Active only if Caption is a Text List
type. Determines the variable to
choose from the text list (see chap. 5,
“Text list” page 196)

TextListFirstBit

Active if TextListType is single-bit or

bit-group-oriented. Indicates the ref-
erence bit to be checked (or the group
initial reference if the control relates to

a group)

TextListLastBit

Active if TextListType is bit-group-ori-
ented, indicates the last bit of the
group to which the control is applied.

ImageAutoSize

Indicates whether the image should
automatically sized to fit the dimen-
sions of the Field

ImageKeepAspect
Ratio

Indicates whether the image should
maintain the proportions of the source
image

ImageListValue

Active if ImagelListType is value-ori-
ented. Indicate the values correspond-
ing to the Strings in the list. By clicking
on ‘ you access the mask for associ-
ating values and text list elements

ImagelListType

Indicates which type of check to per-
form on the variable: value-oriented,
single-bit or bit-group-oriented

ImagelListld

Active only if the Bitmap is an Image
List. Determines the reference text list
(see chap. 5, “Image list” page 197)

ImageTagld

Active only if the Bitmap is an Image
List. Determines which text list vari-
able to choose (see chap. 5, “Image
list” page 197)

ImageTransparent

Indicates whether a transparency filter
should be applied to the image

ImageHAIlign

Allows you to specify the horizontal
centering of the image within the but-
ton. The value can be assigned to a
whole variable or it can be managed
with thresholds
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Table 37: Properties of the Touch button

Properties Description

Allows you to specify the vertical cen-
tering of the image within the button.
ImageVAlign The value can be assigned to a whole
variable or it can be managed with
thresholds

Active if the ImageListType is single-
bit orientated or bit-group-oriented. It
ImagelListFirstBit indicates the bit reference to apply the
control to (or the group initial refer-
ence if the control relates to a group)

Active if ImagelListType is bit-group-
ImagelListLastBit oriented. Indicates the last bit of the
group to which the check is applied

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

. A iat Tag to the Direct m -
TagDirectMovement ssociates a Tag to the Direct move

ment
TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Touch button events

Table 38: Touch button events

Event Description

Activated whenever the button is
pressed

OnPressed

Activated whenever the button is re-

OnReleased leased after being pressed
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Touch Area

A touch-sensitive area can be introduced into a page by click-
ing on the icon or using the Main Menu (Fields->Create-
>Simple controls->Touch area). After clicking on the icon, use
the mouse to indicate the area in the page where POLYMATH
should draw the item.

The Touch Area is useful when you want to assign an entire
screen area to a given function or user script (for example a
part of an image to create a ‘map’). The area in question can
contain other graphic objects or elements.

&,

Note: If a Touch area is superimposed on other objects, only the
function relating to the Touch area is performed in Runtime. In gen-
eral, the operation relating to the object positioned on the surfaceis
performed while those relating to the objects underneath areig-
nored.

¢

For further details regarding the script and predefined func-
tions, the reader is advised to consult the relevant section of
this manual (see chap.““Appendix B - Predefined functions”
page 701 and see chap. 9, “Scripts” page 509).

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a Touch area.

Properties of the Touch Area

Table 39: Properties of the Touch Area

Properties Description

Identifying name of the Touch area.
Name Must be unique among the graphic el-
ements
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Table 39: Properties of the Touch Area

Properties Description

Comment

Identifying comment within POLYMATH

Top

Vertical position coordinate

Left

Horizontal position coordinate

Width

Width dimension

Height

Height dimension

Disable

Indicates whether the field should be
disabled. The value can be associated
with Tag or it can be managed with
thresholds

Lock

Determines if the object can move or
not

PasswordLevel

Determines the authorization level re-
quired to access the Area functions
(see chap. 5, “Password configuration”
page 184)

Tablndex

Makes it possible to control the focus
movement when using movement keys
of the cursor within a page. It also con-
trols the order in which data is intro-
duced in several fields when the
automatic setting of the next field of
the page is enabled (see chap. 5,
“General” page 124)

TypeOfMovement

Identifies the movement associated to
the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement

Associates a Tag to the Direct move-
ment

TagX Horizontal movement tag
TagY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate
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Touch Area events

Table 40: Touch Area events

Event Description

Activated whenever the button is
OnPressed
pressed
Activated whenever the button is re-
OnReleased ;
leased after being pressed

Touch Keyboard Button

A "Touch Keyboard Button" can be inserted inside the key-
board.

Double-click one of the keyboard types on Polymath default in
the "Keyboards" sub-menu of the "Explore Project” :

S@Gaooa

|Progetto\ITl05T(SPl,SPZ,ETHL)\SWConﬁguratmn ~
[ Progstta
1k HWConfiguration
=1 | ITLOST{SF1,5F2,ETHL,}
& swconfiguration
?; Tags
) Languages and fants
] Pages
PopUp pages

T Frames
Alarmms
R Recipe types
fa Users and passwards
B Data archive
{ } soripts
{8} Global script
[7] uists
‘n Images
B i Advanced
?_‘i Pipelines
é_'é Reports
[ Remote notification
= ',':, Keyboards

7

Bk_Ascii_Low_4_5_7_10

fw Bk_Ascii_Up_4_5

W Bk_Ext_Low_7_10_Hor
(W Bk_Ext_Up_7_10_Har

B weekly tasks

The following image will appear :
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Click on the icon or the "Main Menu" (Fields->Create-
>Simple controls->Touch Keyboard Button.

The "Touch Keyboard Button™ allows to insert a touch key for
the creation and configuration of a new keyboard.

After having clicked the icon, indicate the area in which POLY-
MATH must designate the button using the mouse inside of a
key.

The main property of the "Touch Keyboard Button" consists in
the possibility of associating the ASCII code of the symbol to
which the button is placed during the creation of the key-
board.

Slide potentiometer

A Slide Potentiometer can be introduced into a page by click-
ing on the icon W or using the Main Menu (Fields->Create-
=>Simple controls->SlidePotentiometer). After clicking on the
icon, use the mouse to indicate the area in the page where
POLYMATH should draw the Potentiometer.

A Slide Potentiometer is useful for introducing a direct check
on a variable. There is a continuous representation of the val-
ue of the reference variable and the operator can attribute any
value by just clicking on the indicator (slide control).

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a Potentiometer.
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Properties of the SlidePotentiometer

Table 41: Properties of the Slide Potentiometer

Properties Description

ldentifying name of the Potentiometer.

Name Must be unique among the graphic el-
ements

Comment ldentifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

Determines the color of the Potentiom-
eter, selectable using the RGB code or
AreaColor color palette. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines whether the Potentiometer
has a background area or should be
AreaVisibility transparent; a Boolean variable can be
assigned to this value or it can be man-
aged with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds
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Table 41: Properties of the Slide Potentiometer

Properties Description

Determines the flashing of the Border,
which can be No Blinking, Slow blink-
BorderBlink ing or Rapid blinking. The value can be
assigned to a whole variable or it can
be managed with thresholds

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines whether there will be a
Border to the Potentiometer or not; a
Boolean variable can be assigned to
this value

BorderVisibility

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds

Indicates the size of the character of
FontSize the values written above the numerical
division lines

Indicates the color of the precision in-
dicator of the Potentiometer; this is se-
lected using the RGB code or the color
palette

IndicatorColor

Indicates the number of subdivision
marks appearing between two numer-
ical divisions. These are shorter divi-
sion lines than the numerical ones,
giving greater precision to the repre-
sentation

ScaleNotches

Indicates the color ranges to be as-
signed to given value intervals within
the scale. By clicking on ' you enter
an editing window in which the value
intervals and their respective colors
can be defined; the window also allows
you only to specify the limits in relation
to the scale to be displayed

ScaleColorRanges
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Table 41: Properties of the Slide Potentiometer

Properties Description

Indicates the number of divisions on
the scale of values. The number relat-
ScaleSectors ing to the value above the division is
also displayed (calculated according to
the number of divisions)

Reference variable whose value is
checked. Using the appropriate keys
you can create a new variable or edit
an existing one

Tagld

Indicates the color of the whole cursor
CursorColor of the Potentiometer: this is selected
using the RGB code or the color palette

Indicates the direction of the scale:

Direction whether vertical or horizontal

Indicates whether the field should be
disabled. The value can be associated
with Tag or it can be managed with
thresholds

Disable

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Determines if the object can move or

Lock
not

Determines the authorization level re-
quired to be able to edit the potenti-
PasswordLevel ometer value (see chap. 5, “Password
configuration” page 184). This proper-
ty is ignored if the field is Read Only

Makes it possible to control the focus
movement when using cursor keys
within a page. It also controls the or-
Tablndex der in which data is introduced in vari-
ous fields when the automatic setting
of the next field of the page is enabled
(see chap. 5, “General” page 124)

Color of the values (figures) related to
the numerical subdivisions of the
scale. This can be selected using the
RGB code or the color palette

ScaleValueColor
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Table 41: Properties of the Slide Potentiometer

Properties Description

Indicates where the scale of values
should be positioned in relation to the
Potentiometer. If the Potentiometer is
vertical, the scale can be positioned to
the left or the right; if it is horizontal,
the scale can be above or below

ScalePosition

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement Associates a Tag to the Direct move-

ment
TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Slide Potentiometer events

Table 42: Slide Potentiometer events

Event Description

Activated when the value of the Poten-
OnValueChange tiometer is changed using the touch
screen

Slide Selector

A Slide Selector can be introduced into a page by clicking on
the icon or using the Main Menu (Fields->Create->Simple
controls->SlideSelector. After clicking on the icon, use the
mouse to indicate the area in the page where POLYMATH
should draw the Selector.

Slide Selectors are useful is useful for introducing a direct
check on a variable. There is a discrete representation of the
value of the reference variable and the operator can attribute
one of the available values by just clicking on the indicator
(slide control).
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The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a Slide Selector.

-

.5, /::' Note: It is advisable to use the SideSelector (rather than a Potenti-
ometer) if the number of choices that can be executed by the opera-
tor isrestricted, giving a limited range of options.

Properties of the SlideSelector

Table 43: Properties of the SlideSelector

Properties Description

ldentifying name of the Selector. Must

Name be uniqgue among the graphic elements
Comment ldentifying comment within POLYMATH
Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

Determines the color of the Potentiom-
eter, which can be selected using the
AreaColor RGB code or color palette. The value
can be assigned to a whole variable or
it can be managed with thresholds

Determines whether the Potentiometer
has a background area or should be
AreaVisibility transparent; a Boolean variable can be
assigned to this value or it can be man-
aged with thresholds
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Table 43: Properties of the SlideSelector

Properties Description

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the flashing of the Border,
which can be No blinking, Slow blinking
BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines whether there will be a
Border to the Selector or not; a Bool-
ean variable can be assigned to this
value

BorderVisibility

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds

Active if the value type is Text List.
Font related to the text shown in the
FontField field; by clicking on @ you can edit
multilanguage Fonts (see chap. 5,
“Languages” page 152)

FontSize Establishes the Font size

Indicates the color of the precision In-
dicator of the Potentiometer. This can
be selected using the RGB code or the
color palette

IndicatorColor

Reference variable whose value is
checked. Using the appropriate keys
you can create a new variable or edit
an existing one

Tagld
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Table 43: Properties of the SlideSelector

Properties Description

Indicates the color of the entire cursor
of the Potentiometer. This can be se-
lected using the RGB code or the color
palette

CursorColor

Indicates the direction of the scale:

Direction whether vertical or horizontal

Indicates whether the field should be
disabled. The value can be associated
with Tag or it can be managed with
thresholds

Disable

Determines whether the object is ini-
tially visible. You can also assign a
Boolean variable (for Runtime chang-
es)

Hide

Determines if the object can move or

Lock
not

Defines the values to be inserted into
the scale. By clicking on ' you enter
an editing window in which the value
NumValues intervals and their respective colors
can be defined; the window also allows
you only to specify the limits in relation
to the scale to be displayed

Determines the authorization level re-
quired to edit the potentiometer value
PasswordLevel (see chap. 5, “Password configuration”
page 184). This property is ignored if
the field is Read Only

Makes it possible to control the focus
movement when using cursor keys
within a page. It also controls the or-
Tablndex der in which data is introduced in sev-
eral fields when the automatic setting
of the next field of the page is enabled
(see chap. 5, “General” page 124)

Defines the type of display setting for
the scale: the display of values can be
maintained or a text list can be used
corresponding to the values

ValueType
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Table 43: Properties of the SlideSelector

Properties Description

Active if the value type is Text List. Al-
lows you to choose the text list associ-
ated with the values in question (see
chap. 5“Text list” page 196)

TextListld

Determines the color Color relating to
the scale of values. This can be select-
ed using the RGB code or the color pal-
ette

ScaleValueColor

Indicates where the scale of values
should be positioned in relation to the
Bar. If the Bar is vertical, the scale can
be positioned to the left or the right; if
it is horizontal, the scale can be above
or below

ScalePosition

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement Associates a Tag to the Direct move-

ment
TagX Horizontal movement tag
TagY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Slide Selector events

Table 44: Slide Selector events

Event Description

Activated when the value of the Selec-
tor is changed using the touch screen

OnValueChange
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Knob Potentiometer

A Knob Potentioeter can be introduced into a page by click-
ing on the icon or using the Main Menu (Fields->Create-
>Simple controls->KnobPotentiometer). After clicking on the
icon, use the mouse to indicate the area in the page where
POLYMATH should draw the potentiometer.

Knob potentiometers are useful for introducing a direct control
on a variable. A continuous representation of the value of the
reference variable is given and the operator can attribute any
value simply by clicking on the knob indicator.

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a potentiometer.

Properties of the Knob Potentiometer

Table 45: Properties of the Knob Potentiometer

Properties Description

ldentifying name of the Potentiometer.
Name Must be unique among the graphic el-
ements
Comment Identifying comment within POLYMATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension
Determines the color of the Potentiom-
eter, selectable using the RGB code or
AreaColor
color palette. The value can be as-
signed to a whole variable
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Table 45: Properties of the Knob Potentiometer

Properties Description

Determines whether the Potentiometer
has a background area or should be
AreaVisibility transparent; a Boolean variable can be
assigned to this value or it can be man-
aged with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,

Bordersb Bump or Etched. The value can be as-
signed to a whole variable
Determines the flashing of the Border,

BorderBlink which can be No blinking, Slow blinking

or Rapid blinking. The value can be as-
signed to a whole variable

Determines the color of the Border us-
ing the RGB code or color palette. The
value can be assigned to a whole vari-
able

BorderColor

Determines whether there will be a
Border to the Potentiometer or not; a
Boolean variable can be assigned to
this value

BorderVisibility

Determines the size of the Border
which must be a number to which a
whole variable can be assigned, if
wished

BorderSize

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Establishes the Font size for represent-

FontSize ing the text of the scale

Indicates the color of the precision in-
dicator of the Potentiometer. This is
selected using the RGB code or the col-
or palette

IndicatorColor

Determines the color of the Potentiom-
KnobColor eter knob, selectable using the RGB
code or color palette
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Table 45: Properties of the Knob Potentiometer

Properties Description

Indicates the number of subdivision
marks appearing between two numer-
ical divisions. These are shorter divi-
sion lines than the numerical ones,
giving greater precision to the repre-
sentation

ScaleNotches

Indicates the color ranges to be as-
signed to given value intervals within
the scale. By clicking on ° you enter
an editing window in which the value
intervals and their respective colors
can be defined; the window also allows
you simply to specify the limits in rela-
tion to the scale to be displayed

ScaleColorRanges

Indicates the number of divisions on
the scale of values. The number relat-
ScaleSectors ing to the value above the division is
also displayed (calculated according to
the number of divisions)

Reference variable whose value is
checked. Using the appropriate keys
you can create a new variable or edit-
ing an existing one

Tagld

Indicates whether the field should be
disabled. The value can be associated
with Tag or it can be managed with
thresholds

Disable

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Determines if the object can move or

Lock
not

Determines the authorization level re-
quired to edit the potentiometer value
PasswordLevel (see chap. 5, “Password configuration”
page 184). This property is ignored if
the field is Read Only

Determines the Knob starting position

StartAngle (given as an angle)
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Table 45: Properties of the Knob Potentiometer

Properties Description

SweepAngle

Determines the angle (in degrees) of
the aperture of the Knob

Tablndex

Makes it possible to control the focus

movement when using the cursor keys
within a page. It also controls the or-

der in which data is introduced in sev-
eral fields when the automatic setting
of the next field of the page is enabled
(see chap. 5, “General” page 124)

ScaleValueColor

Determines the color relating to the
scale of values. This can be selected
using the RGB code or the color palette

ScaleEnabled

Determines whether the scale of val-
ues is to be present or not

TypeOfMovement

Identifies the movement associated to
the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement

Associates a Tag to the Direct move-
ment

TagX Horizontal movement tag
TagY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Knob Potentiometer events

Table 46: Knob Potentiometer events

Event Description

OnValueChange

Activated when the Potentiometer val-
ue is changed using the touch screen
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Knob Selector

A Knob Selector can be introduced into a page by clicking on
the icon '@ or using the Main Menu (Fields->Create->Simple
controls->KnobSelector). After clicking on the icon, use the
mouse to indicate the area in the page where POLYMATH
should draw the selector.

Knob selectors are useful for introducing a direct control on a
given variable. A discrete representation of the value of the
reference variable is given and the operator can attribute one
of the values present simply by clicking on the knob.

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a Slide selector.

1]
P

Note: It is advisable to use the Knob selector (rather than a potenti-
ometer) if the number of choices the operator can make isto bere-
stricted, giving a limited range of options.

&

Properties of the Knob Selector

Table 47: Properties of the Knob Selector

Properties Description

Identifying name of the Selector. Must
Name . -

be unique among the graphic elements
Comment Identifying comment within POLYMATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension
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Table 47: Properties of the Knob Selector

Properties Description

Determines the color of the Selector,
which can be selected using the RGB
code or color palette. The value can be
assigned to a whole variable

AreaColor

Determines whether the Selector has a
background area or should be trans-
AreaVisibility parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,

Bordersb Bump or Etched. The value can be as-
signed to a whole variable
Determines the flashing of the Border,

BorderBlink which can be No blinking, Slow blinking

or Rapid blinking. The value can be as-
signed to a whole variable

Determines the color of the Border us-
ing the RGB code or color palette. The
value can be assigned to a whole vari-
able

BorderColor

Determines whether the Border of the
Selector should be present or not; a
Boolean variable can be assigned to
this value

BorderVisibility

Determines the size of the Border
which must be a number to which a
whole variable can be assigned, if so
desired

BorderSize

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Active if the value is a Text List value.
Font for the text shown in the field; by

FontField clicking on . you can edit multilan-
guage Fonts (see chap. 5, “Languages”
page 152)

FontSize Establishes the Font size
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Table 47: Properties of the Knob Selector

Properties Description

Defines the color of the indicator hand.
IndicatorColor This is selected using the RGB code or
the color palette

Determines the color of the Selector
KnobColor knob, which can be selected using the
RGB code or color palette.

Reference variable whose value is
checked. Using the appropriate keys
you can create a new variable or edit
an existing one

Tagld

Indicates whether the field should be
disabled. The value can be associated
with Tag or it can be managed with
thresholds

Disable

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Determines if the object can move or

Lock
not

Indicates the values to insert into the
scale. By clicking on . you enter an
editing window in which the value in-
NumValues tervals and their respective colors can
be defined; the window also allows you
only to specify the limits in relation to
the scale to be displayed

Determines the authorization level re-
quired to be able to edit the selector
PasswordLevel value (see chap. 5, “Password configu-
ration” page 184). This property is ig-
nored if the field is Read Only

Determines the Knob starting position

StartAngle (given as an angle)

Determines the angle (in degrees) of

SweepAngle the aperture of the Knob
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Table 47: Properties of the Knob Selector

Properties Description

Tablndex

Makes it possible to control the focus

movement when using the cursor keys
within a page. It also controls the or-

der in which data is introduced in sev-
eral fields when the automatic setting
of the next field of the page is enabled
(see chap. 5, “General” page 124)

ValueType

Indicates the display type for setting
the scale: the display of values can be
maintained or a text list corresponding
to the values can be used

TextListld

Active if the value is a Text List value.
Allows you to choose the text list asso-
ciated with the values in question
(see chap. 5“Text list” page 196)

ScaleValueColor

Determines the color of the scale of
values. This can be selected using the
RGB code or the color palette

TypeOfMovement

Identifies the movement associated to
the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement

Associates a Tag to the Direct move-
ment

TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Knob Selector events

Table 48: Knob Selector events

Event Description

OnValueChange

Activated when the Selector value is
changed using the touch screen
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Complex Complex Controls are objects that can be inserted into a page

Controls in order to show the operator the value of one or more data
items (or groups of data, like recipes, alarms, trends etc.)
and, if required, edit them. In this section we will analyze each
Complex Control, setting out its functional characteristics,
their respective properties (to be configured by the Properties
Editor) and associated events (Events Editor).

Monostable Button

A Monostable Button can be introduced into a page by clicking
on the icon a or using the Main Menu (Fields->Create-
>Complex controls->Monostable button). After clicking on the
icon, use the mouse to indicate the area in the page where
POLYMATH should draw the button. The Monostable Button
serves basically to trigger OnPressed and OnReleased events
to which the desired functions (or scripts) can be assigned.
For further details regarding predefined functions and user
scripts that can be assigned to the button, the reader is ad-
vised to consult the appropriate section in this manual (see
chap.“Appendix B - Predefined functions” page 701 and see
chap. 9, “Scripts” page 509).

The reader is advised to consult the following subsections to
learn about the details of the meaning of the properties that
can be assigned to a Monostable Button and how to edit them.

Note: No variable has to be assigned to a monostable button. When
you want the pressing of the monostable button to have an effect on
a variable, just assign the appropriate functions to the button’s
events.

&
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Table 49: Properties of the Monostable button

Properties Description

Identifying name of the Monostable

Name button. Must be unique among the
graphic elements

Comment ldentifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

AreaColorPressed

Determines the color of the area of the
button (when pressed), selectable us-
ing the RGB code or color palette. The
value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

PressedAreaVisibility

Determines whether the Button has a
background or if it must be transparent
when pressed; a Boolean variable can
be assigned to this value or it can be
managed with thresholds

AreaColorReleased

Determines the color of the area of the
button (when released), which can be
selected using the RGB code or color
palette. The value can be assigned to a
whole variable or it can be managed
with thresholds

ReleasedArea

Determines whether the button has a
background or if it must be transparent
when released; a Boolean variable can

Visibility be assigned to this value or it can be
managed with thresholds
Indicates whether the field should be
. disabled. The value can be associated
Disable

with Tag or it can be managed with
thresholds
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Table 49: Properties of the Monostable button

Properties Description

Hide

Determines whether the object is ini-
tially visible. You can also assign a
Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Lock

Determines if the object can move or
not

PasswordLevel

Determines the authorization level re-
quired to access the button utilities
(see chap. 5, “Password configuration”
page 184)

Tablndex

Makes it possible to control the focus

movement when using the cursor keys
within a page. It also controls the or-

der in which data is introduced in sev-
eral fields when the automatic setting
of the next field of the page is enabled
(see chap. 5, “General” page 124)

TypeOfMovement

Identifies the movement associated to
the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement

Associates a Tag to the Direct move-
ment

TagX Horizontal movement tag
TagY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Monostable button events

Table 50: Monostable button events

Event Description

OnPressed

Activated whenever the button is
pressed
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Table 50: Monostable button events

Event Description

Activated whenever the button is re-
leased after being pressed

OnReleased

Monostable button events

Once a monostable button is added to a page its form can be
edited but in OnPressed state and in OnReleased state. To edit
the button just double-click on it within the page; editing the
monostable button comprises three windows: Pressed, Re-
leased and General.

In the Pressed and Released masks the graphic appearance of
the button in its two states can be defined. Editing these win-
dows works like normal editing for project pages (see chap. 6,
“Managing a page” page 254).

Note: A monostable button differs from a touch button in its graphic
formwhich is completely editable. As described in this chapter, im-
ages or geometric forms can be applied to them. The library sup-
plied with POLYMATH contains a set of buttons ready for usein a
project (see chap. 7, “ POLYMATH Libraries’ page 441).

The General window can be used to set identifying properties
related to the button; the Name is a unique string within a set
of graphic objects, while the comment is a recognition text to
be used only within POLYMATH. You can also choose to over-
write the global grid dimensions to make positioning on the
surface of the button more (or less) precise.

Bistable button

A Bistable button can be introduced into a page by clicking on
the icon ﬂ or using the Main Menu (Fields->Create->Com-
plex controls->Bistable button). After clicking on the icon, use
the mouse to indicate the area in the page where POLYMATH
should draw the button.

A bistable button is useful when you need to change and
memorize the value of a variable by pressing it. Unlike a
monostable button, the bistable button must have two values
of a variable assigned to it (one for the ON-state and one for
the OFF-state) and pressing it changes the value variable.
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The library supplied with POLYMATH contains a set of buttons
ready for use within the project (see chap. 7, “POLYMATH Li-
braries” page 441).

The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a bistable button and how to edit it.

Properties of a Bistable button

Table 51: Properties of aBistable button

Properties Description

Identifying name of the Bistable but-

Name ton. Must be unique among the graphic
elements

Comment ldentifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

Determines the color of the area of the
Button (in OFF state), which can be se-
lected using the RGB code or color pal-
ette. The value can be assignhed to a
whole variable or it can be managed
with thresholds

OffStateAreaColor

Determines whether the Button has a
background or should be transparent
OffStateAreaVisibility | when it is OFF; a Boolean variable can
be assigned to this value or it can be
managed with thresholds

Determines the color of the area of the
button (in ON state), which can be se-
lected using the RGB code or color pal-
ette. The value can be assignhed to a
whole variable or it can be managed
with thresholds

OnStateAreaColor

Determines whether the Button has a
background or should be transparent
OnStateAreaVisibility | when it is ON; a Boolean variable can
be assigned to this value or it can be
managed with thresholds
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Table 51: Properties of a Bistable button

Properties Description

Reference variable whose value is
checked. Using the appropriate keys
you can create a new variable or edit
an existing one

Tagld

Indicates the value that the reference
variable must assume for the button to
ValueStateOff be OFF; if the button goes to OFF by
being pressed, the value of the vari-
able is updated to that value

Indicates the value that the reference
variable must assume for the button to
ValueStateOn be ON; if the button goes to ON by be-
ing pressed, the value of the variable is
updated to that value

Indicates whether the button should
be disabled. The value can be associat-
ed with Tag or it can be managed with
thresholds

Disable

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Determines if the object can move or

Lock not

Determines the authorization level re-
quired to access the button utilities
(see chap. 5, “Password configuration”
page 184)

PasswordLevel

Makes it possible to control the focus

movement when using the cursor keys
within a page. It also controls the or-

Tablndex der in which data is introduced in sev-
eral fields when the automatic setting
of the next field of the page is enabled
(see chap. 5, “General” page 124)

Identifies the movement associated to
TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

Associates a Tag to the Direct move-

TagDirectMovement
ment
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Table 51: Properties of a Bistable button

Properties Description

TagX Horizontal movement tag
TagyY Vertical movement tag
Steps Movement intervals
FinalX Horizontal co-ordinate
FinalY Vertical co-ordinate

Bistable button events

Table 52; Bistable button events

Event Properties

Activated when the Button is pressed
in position OFF

OnSwitchButtonOff

Activated when the Button is pressed

OnSwitchButtonOn in position ON

Editing the Bistable button

Once a Bistable button has been added to a page, its form can
be edited both for the ON state and the OFF state. To edit the
button just double-click on it within the page; editing a
Bistable button comprises three windows: OFF, ON and Gen-
eral.

The OFF and ON masks can be used to define the graphic ap-
pearance of the button in its two states. Editing these windows
works like normal editing for project pages (see chap. 6,
“Managing a page” page 254).

The General window is used to set identifying properties relat-
ing to the Button: the Name is a unique string within the set
of graphic objects while the comment is a recognition text to
be used only within POLYMATH. You can also choose to over-
write the global grid dimensions to make positioning within
the surface of the button more (or less) precise.

Frame Field

A Frame field can be introduced into a page by clicking on the
icon or using the Main Menu (Fields->Create->Complex
controls->Frame). After clicking on the icon, use the mouse to
indicate the area in the page where POLYMATH should add the
Frame.
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A Frame Field is simply an area for containing an actual
Frame. We have already described in the preceding chapter
how to create a Frame (see chap. 5, “Frames” page 163).
The reader is advised to consult the following subsections to
learn about the details of the properties and events that can
be assigned to a Frame Field.

Note: A Frame can also be added to a page simply by dragging the
framein question from Project Explorer to the desired page position
in the Work area. With this procedure POLYMATH automatically
creates a field to contain the dragged frame.

Properties of a Frame Field

Table 53: Properties of a Frame Field

Properties Description

Identifying name of the Frame Field.

Name Must be unique among the graphic el-
ements

Comment ldentifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Indicates the Frame to be contained by

Frameld the Frame Field being edited

Determines if the object can move or

Lock
not

Makes it possible to control the focus
movement using cursor keys within
the page. It also controls the order in
Tablndex which data is introduced in several
fields when the automatic setting of
the next field of the page is enabled
(see chap. 5, “General” page 124)

Trend View

A Trend View can be introduced into a page by clicking on the
icon or using the Main Menu (Fields->Create->Complex
controls->TrendView). After clicking on the icon, use the
mouse to indicate the area in the page where POLYMATH
should draw the TrendView.
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A Trend View is the field inside which you can see the contents
of the Trend Buffer, whose working was described in the pre-
ceding section (see chap. 5, “Trend Buffer” page 189).

The reader is advised to consult the following subsections to

learn about the details of the properties and events that can

be assigned to a TrendView and how it is edit.

034743 054751

Properties of a TrendView

Table 54: Properties of a TrendView

Properties Description

Identifying name of the TrendView.

Name Must be unique among the graphic el-
ements

Comment Identifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Width Width dimension

Height Height dimension

Determines the color of the display,
which can be selected using the RGB
AreaColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds
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Table 54: Properties of a TrendView

Properties Description

Determines whether the sector has a
background area or should be trans-
AreaVisibility parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the flashing of the Border,
which can be No blinking, Slow blinking
BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines whether there will be a
BorderVisibility Border to the display or not; a Boolean
variable can be assigned to this value

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Determines if the object can move or

Lock
not
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Editing a TrendView

After inserting a TrendView into a page, just double-click on it
to edit. The default object is a Trend Graph (see chap. 6,
“Properties of a Trend Graph” page 372) that can be accom-
panied, if the programmer wishes, by a series of control but-
tons for displaying the Trend. Editing is organized through two
masks, Fields and General.

g
E

CONGGG0E06E6LEE0660S

The Fields mask allows you to indicate which buttons have to
be present together with the table and position them in the ar-
ea. Each button has properties which can be edited in the
Properties Editor as happens with normal touch buttons (see
chap. 6, “Touch Button” page 333). To add or eliminate a but-
ton just click on the list of buttons present to the left of the
table. If an object is already present in the page it will appear
highlighted within the list (it will be visible in the Table Edit Ar-
ea). To move an element (button or table) just drag it to the
desired position. Insertable buttons are different and a non-
editable predefined function can be assigned to each of these:
= Move Left: The button has two functions depending on
whether the cursor is displayed or not: if the cursor is
invisible, pressing the key makes the graph move from
right to left. If, however, the cursor is visible, the button
moves it to the left and when it reaches the furthest
point, the graph moves from right to left by a unit de-
fined by the principal horizontal division of the grid.
= Move Right: The button has two functions depending on
whether the cursor is displayed or not: if the cursor is
invisible, pressing the key makes the graph move from
left to right. If, however, the cursor is visible the button
moves it to the right and when it reaches the furthest
point, the graph moves from left to right by a unit de-
fined by the principle horizontal division of the grid.
= Move Up: the button makes the graph move upwards by
a unit defined by the major vertical division of the grid.
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= Move Down: the button makes the graph move down-
wards by a unit defined by the major vertical division of
the grid.

« Principal: the button makes the graph move from right
to left until the oldest sample readings are positioned on
the left side of the graph.

= End: the button makes the graph move from right to left
until the most recent sample readings are positioned on
the right side of the graph.

e GoTo: the button makes a dialog window appear to ask
the user at what date and time the right side of the
graph should be put.

= IncreaseVerticalEnlargement: increases the vertical
scale factor

= ReduceVerticalEnlargement: decreases the vertical
scale factor

« IncreaseHorizontalEnlargement: increases the horizon-
tal scale factor

= ReduceHorizontalEnlargement: decreases the horizon-
tal scale factor

= "Zoom": Increases the total graphic display

= "Reduction": Decreases the total graphic display

= Reset Enlargement: restores the original scale factors
(no zoom)

e "User Button": Button to which the user can assign a
function/script.

= "HorizontalCursorPosition": it represents the sample ac-
quisition time (when it identifies at least one sample on
the graphics)

= "Selected Pendrive Value": field that indicates the pen-
drive currently selected

= ShowsScalePen: Determines the scale pen to be shown
via a pull-down menu

There are also two bistable buttons, a Date-Time Field and a
Numerical Field that can be edited as already described in this
chapter (see chap. 6, “Bistable button” page 363, see chap. 6,
“DateTime field” page 321 and see chap. 6, “Numerical Field”
page 302) each having its own function:

= CursorEnabled: allows the graphic cursor to be dis-
played or not

= Pause: shows whether or not the update of the graph is
enabled (does not disable the acquisition of samples).

= HorizontalCursorPosition: represents the time of the ac-
quisition of the sample (when it identifies at least one
sample on the graph)

= Pen Selected: field indicating that the Pen is currently
selected.
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As already described in this chapter, another customized label
can be added to the complex field (see chap. 6, “Complex la-
bel” page 278) or a dynamic field showing the value of the
Trend on the pen (see chap. 6, “Trend Pen” page 279).

Tdentification

Marme TrendWiewer

Cormrment

Editing

[ ©verride default grid size

Width 10 o
Height 10 o

The General mask can be used to insert a name and an iden-
tifying comment for the TrendView being edited. In addition,
you can overwrite the default dimensions of the editing grid of
the page (see chap. 5, “Main window” page 113) introducing
new measures in pixels valid only for editing the current field.

Properties of a Trend Graph

Table 55: Properties of a Trend Graph

Properties Description

Identifying name of the Trend Graph.

Name Must be unique among the graphic el-
ements

Comment Identifying comment within POLYMATH

Top Vertical position coordinate

Left Horizontal position coordinate

Width Dimension of the width

Height Dimension of the height

Determines the color of the Area,
which can be selected using the RGB
AreaColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds
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Table 55: Properties of a Trend Graph

Properties Description

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the flashing of the Border,
which can be No blinking, Slow blinking
BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines whether there will be a
BorderVisibility Border to the Table or not; a Boolean
variable can be assigned to this value

Determines the size of the Border
which must be a number to which a
whole variable can be assigned or it
can be managed with thresholds

BorderSize

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Determines if the object can move or

Lock
not

Indicates the pens to use in represent-
ing the trend. By clicking on the

key you can edit the types of pen (as
shown in the next subsection)

Pens

Indicates the refresh period of the

RefreshTime trend expressed in milliseconds

Indicates how the scroll movement of
ScrollType the table should operate: may be con-
tinuous, half screen or full screen

Determines the index that the object

TablIndex will occupy in the table order
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Table 55: Properties of a Trend Graph

Properties Description

Length of time periods expressed in
thousandths of a second. If the value

TimeSpan 10000 is entered, for example, at any
point the trend table will display the
values gathered in 10 seconds
Indicates the way the Trend display is

UpdateMode updated: automatically, with a change

of value or on command

ChartAreacColor

Indicates the color of the chart area,
which can be selected using the RGB
code or color palette

ChartAreaTop

Vertical coordinate position of the
chart

ChartArealLeft

Horizontal coordinate position of the
chart

ChartAreaWidth

Size of the width of the chart

ChartAreaHeight

Height dimension of the chart

ChartBorderColor

Determines the border color of the
chart which can be selected using the
RGB code or color palette

ChartBorderSize

Determines the border size of the chart

GridHorDivisionColor

Indicates the color of the divisions of
the horizontal grid, can be done using
the RGB code or the color palette

GridHorDivision
Number

Indicates the number of horizontal di-
visions in the grid

GridHorDivisionStyle

Indicates the style of the divisions of
the horizontal grid: may be Solid or
Broken line

GridHorMinDivision
Color

Determines the color of the horizontal
grid subdivisions, which can be select-
ed using the RGB code or color palette.

GridHorMinDivision
Number

Indicates the number of horizontal
subdivisions in the grid, that is, the
number of horizontal lines between
any two divisions
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Table 55: Properties of a Trend Graph

Properties Description

GridHorMinDivision
Style

Indicates the style of the subdivisions
of the horizontal grid: may be Solid or
Broken line

GridHorVisible

Indicates whether there should be a
horizontal grid

GridVerDivisionColor

Determines the color of the vertical
grid divisions, which can be selected
using the RGB code or color palette.

GridVerDivision
Number

Indicates the number of vertical divi-
sions in the grid

GridVerDivisionStyle

Indicates the style of the divisions in
the vertical grid: may be Solid or Bro-
ken line

GridVerMinDivision
Color

Determines the color of the vertical
subdivisions of the grid, which can be
selected using the RGB code or color
palette.

GridVerMinDivision
Number

Indicates the number of vertical subdi-
visions in the grid, that is, the number
of horizontal lines between any two di-
visions

GridVerMinDivision
Style

Indicates the style of the subdivisions
in the vertical grid: may be Solid or
Broken line

GridVerVisible

Indicates whether there needs to be a
vertical grid

HorScalelLabelColor

Indicates the color for the label texts of
the horizontal scale; these can be se-
lected using the RGB code or color pal-
ette

HorScalelLabelFont

Indicates the Font for the label texts of
the horizontal scale

HorScaleLabelSkip

Indicates the frequency with which the
horizontal scale labels should be in-
serted

HorScaleMinNotches
Len

Indicates the minimum length of the
notches on the horizontal scale of va-
lues

375
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Table 55: Properties of a Trend Graph

Properties Description

Indicates the way the scale should be
displayed. The Date alone, the Time
alone, both or tenths of seconds can be
represented

HorScaleMode

Indicates the length of the notches on

HorScaleNotchesLen the horizontal scale of values

Active if the type of scale envisages
HorScaleTimeFormat the Time and permits its format to be
specified

Active if the type of scale envisages
HorScaleDateFormat the Date and permits its format to be
specified

Indicates whether there needs to be a

HorScaleVisible .
horizontal scale

VerScalelLabel Number of decimal digits to show on
Decimal the vertical scale

Indicates the Font for the label texts of

VerScalelLabelFont .
the vertical scale

Indicates the frequency with which the

VverScalelabelSkip vertical scale labels should be inserted

VerScaleMinNotches Indicates the minimum length of the
Len notches on the vertical scale of values

Indicates the length of the notches on

VerScaleNotchesLen .
the vertical scale of values

Indicates whether there should be a

VerScaleVisible .
vertical scale

VerScaleVisible Number of digits to show on the verti-
Number cal scale

Editing Trend Pens

To be able to edit the Pens for writing Trends, you have to en-
ter the complex field edit function, TrendView, (double-click
on it in the page). After selecting the Trend Graph, use the ap-
propriate Properties Editor to click on the icon . in the Pens
option.
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The Pen edit window that is displayed is composed of three
sections. The left part has a list of pens created by the user
from which it is possible to create and eliminate elements. The
bottom part contains a preview of the pen currently being ed-
ited, while the middle part of the window contains the real ed-
iting area for the pen selected. This window is organized into
property masks, Intervals and Interval Colors that are dealt
with in the next subsections.

Properties

Properties

Narme

Trend buffer
Scale type
Min

Max

Pen style
Line style
Marker

Default color

[l Show pen icon

Ranges Colar range

English {United States) =| TrendPen

| (]
[Preset =]
(€ =
6" =
[Line analagic =]
Salid ~] size 1 E
ICross j
o -

First of all, it is possible to assign a Name to the Trend Pen and
assign a Trend Buffer, for which the Pen must be used.
A type must be indicated for the scale of values: this may be:

Programmed - it is necessary to indicate the maximum

and minimum values which can also be assigned to vari-

ables
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= Automatic - calculated in Runtime on the basis of the
values contained in the Buffer (but limits can also be in-
serted)

e Tag Limit related - the Buffer has to refer to a limited

variable (see chap. 5, “Limits” page 129)

* Client - maximum and minimum values must be defined
You can also choose the appearance of the penline, which can
be of the following: samples only, analog (continuous, with
oblique connections between the values) or digital (scaled,
with digital steps). Also the dimensions of the line, its color
and style (solid, broken or dotted) can be edited to suit the
user’s taste.

The pen marker can assume various different geometric forms
(pixel, circle, cross etc.) and you can choose not to show the
icon relating to the pen.

Each variation updates the preview at the bottom of the mask.

Intervals

Properties Caolar range

This mask is used to insert the values relating to the intervals
to which different representation colors can be attributed. The
scale of intervals must present values in increasing order.

Interval colors

Properfies Ranges [SRIRIEEnt
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This mask lets you assign a color to each of the value intervals
set out in the Interval mask. A color is applied when its value
read by the Buffer memory is within the corresponding inter-
val.

TrendXY

A "TrendXY" can be inserted inside of the page clicking on the
icon E or from the "Main Menu" (Fields->Create-=>Controls
Complexes->TrendXY). After having clicked the icon, indicate
the area in which POLYMATH must designate the "TrendXY"
using the mouse inside of the page.

The "TrendXY" is the field inside of which the content of the
TrendBufferXY is displayed, the functioning of which was de-
scribed in the previous paragraph.

Consult the next sub-paragraphs to know the details of the
properties that can be associated to a VistaTrendXY and its
editing modes.
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Properties of the TrendXY

Table 56: Properties of a TrendViewXY

Properties Description

Identifying name of the TrendView.
Name Must be unique among the graphic el-
ements
Comment ldentifying comment within POLYMATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
Height Height dimension
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Table 56: Properties of a TrendViewXY

Properties Description

Determines the color of the display,
which can be selected using the RGB
AreaColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

Determines whether the Trend View
has a background area or should be
AreaVisibility transparent; a Boolean variable can be
assigned to this value or it can be man-
aged with thresholds

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines whether there will be a
BorderVisibility Border to the display or not; a Boolean
variable can be assigned to this value

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if
wished, or it can be managed with
thresholds

Determines the flashing of the Border,
which can be No blinking, Slow blinking
BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds
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Table 56: Properties of a TrendViewXY

Properties Description

Determines whether the object is ini-
tially visible. You can also assign a
Hide Boolean variable (for Runtime chang-
es) or it can be managed with thresh-
olds

Determines if the object can move or

Lock not

Edit the TrendXY

After having inserted a "TrendXY" on a page, double-click it to
start its editing. A "TrendXY Graphic" will be present by de-
fault which, upon the programmer's choice, can be accompa-
nied by a range of control buttons to view the "TrendXY". The
editing is organised on two masks: "Fields" and "General".

From the "Fields" mask, the buttons which should be present
together with the table can be indicated and positioned inside
of the area. Each button has its relative properties which can
be edited in "Editor Properties" as for normal touch buttons
(see chapter 6). To insert or remove a button, click the list of
buttons at the left of the table. If an object is already present
on the page, it will be highlighted inside of the list (and it will
be visible inside of the drawing area). To move an element
(button or table) drag it to the desired position. There are se-
veral buttons that can be inserted and each one has a pre-de-
termined function associated to it (unchangeable) :
= “"Move to the Left": the button has two functions de-
pending on whether or not the cursor is viewed: if the
e cursor is invisible, the key pressure scrolls the graphic
from right to left. If the cursor is
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= visible, move the cursor to the left. When it reaches the
left edge, the graphic scrolls from the right

« to the left of a unit specified by the greater horizontal
division of the grid.

= "Move to the Right": the button has two functions de-
pending on whether or not the cursor is viewed: if the

= cursor is invisible, the key pressure scrolls the graphic
from left to right. If the cursor is

e visible, move the cursor to the left. When it reaches the
right edge, the graphic scrolls from the left

= to the right of a unit specified by the greater horizontal
division of the grid.

= "Move up": the button scrolls the graphic from the
bottom to the top of a unit specified by the

= greater vertical division of the grid.

= "Move down": the button scrolls the graphic from the
top to the bottom of a unit specified by the

= greater vertical division of the grid.

= "Initial page": the button scrolls the graphic from right
to left until the oldest samples are positioned

= on the left of the graphic.

= "End": the button scrolls the graphic from left to right
until the newest samples are positioned

= on the right of the graphic.

= "Go to": the button displays a dialogue box to ask the
user which time and date must be

= placed at the right of the graphic.

= "Vertical Size Increase": increases the vertical scale

factor

e "Vertical Size Decrease": decreases the vertical scale
factor

e "Horizontal Size Increase": increases the horizontal sca-
le factor

= "Horizontal Size Decrease": decreases the horizontal
scale factor
= "Zoom": Increases the total graphic display
= "Reduction": Decreases the total graphic display
= "Reset zoom": restores the original scale factors (no
zoom).
= "User Button": Button to which the user can assign a
function/script.
= "Show Pen Scale": determines the Scale pen to be
shown by means of the pull-down menu
Also present: three "Bistable Buttons", a "Time Date field" and
two "Numerical Fields" which can be edited as described in this
chapter (see chap. 6, “Bistable button” page 363, see chap. 6,
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“DateTime field” page 321 e see chap. 6, “Numerical Field”
page 302) Each one of them has a particular function :

= "Cursor Enabled": allows the graphic cursor to be di-

splayed or not.

= "Break": represents if the graphic update is enabled or
not (it does not disable

= sample acquisition).

= "Pen Enabled": Displays or hides the selected pen.

= "Time Date Field": Displays the sample instant.

= "Numerical Field" 1: "X" value.

= "Numerical Field" 2: "Y" value.

As already described in this chapter, a further customised la-
bel can be inserted on the complex field (see chap. 6, “Com-
plex label” page 278) or go and insert a dynamic field which
shows the Trend value on the pen (see chap. 6, “Trend Pen”

page 279).

Tdentification

Mame

Cormment

Editing

Wiidth

Height

10
10

TrendWiewer

[ override default grid size

==
==|

An identification name and comment for the "Trend" that is
being edited can be inserted on the "General” mask. The page
editing grid default dimensions can be overwritten as well
(see chap. 5, “Main window” page 113) introducing new mea-
surements in pixel, valid only for the current field editing.
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Properties of a Trend Graph XY

Table 57: Properties of a Trend Graph XY

Properties Description

Top Vertical position coordinate
Left Horizontal position coordinate
Width Dimension of the width
Height Dimension of the height

Determines the color of the Area,
which can be selected using the RGB
AreaColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

Determines whether the Graph has a
background area or should be trans-
AreaVisibility parent; a Boolean variable can be as-
signed to this value or it can be
managed with thresholds

Determines whether there will be a
BorderVisibility Border to the Table or not; a Boolean
variable can be assigned to this value

Determines the size of the Border
which must be a number to which a
BorderSize whole variable can be assigned, if so
desired or it can be managed with
thresholds

Determines the color of the Border us-
ing the RGB code or color palette. The
BorderColor value can be assigned to a whole vari-
able or it can be managed with thresh-
olds

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Border3D Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds
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Table 57: Properties of a Trend Graph XY

Properties Description

Determines the flashing of the Border,
which can be No blinking, Slow blinking

BorderBlink or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds
Indicates the way the Trend display is

UpdateMode updated: automatically, with a change

of value or on command

RefreshTime

Indicates the refresh period of the
trend expressed in milliseconds

HorScaleVisible

Indicates whether there needs to be a
horizontal scale

HorScaleMode

Indicates the way the scale should be
displayed. The Date alone, the Time
alone, both or tenths of seconds can be
represented

HorScaleDateFormat

Active if the type of scale envisages
the Date and permits its format to be
specified

HorScaleTimeFormat

Active if the type of scale envisages
the Time and permits its format to be
specified

HorScalelLabelFont

Indicates the Font for the label texts of
the horizontal scale

HorScalelLabelColor

Indicates the color for the label texts of
the horizontal scale; these can be se-

lected using the RGB code or color pal-
ette

HorScaleLabelSkip

Indicates the frequency with which the
horizontal scale labels should be in-
serted

VerScaleVisible

Indicates whether there should be a
vertical scale

VerScaleVisible
Number

Number of digits to show on the verti-
cal scale

VerScalelLabel
Decimal

Number of decimal digits to show on
the vertical scale

385

ESAPOLYMATH - User Manual - rev. 2.1



386

Chapter 6

Properties Editor

Table 57: Properties of a Trend Graph XY

Properties Description

Indicates how the scroll movement of

ScrollType the table should operate: may be con-
tinuous, half screen or full screen
Length of time periods expressed in
thousandths of a second. If the value

TimeSpan 10000 is entered, for example, at any

point the trend table will display the
values gathered in 10 seconds

GridHorVisible

Indicates whether there should be a
horizontal grid

GridHorDivision
Number

Indicates the number of horizontal di-
visions in the grid

GridHorMinDivision
Number

Indicates the number of horizontal
subdivisions in the grid, that is, the
number of horizontal lines between
any two divisions

GridHorDivisionStyle

Indicates the style of the divisions of
the horizontal grid: may be Solid or
Broken line

GridHorMinDivision
Style

Indicates the style of the subdivisions
of the horizontal grid: may be Solid or
Broken line

GridHorDivisionColor

Indicates the color of the divisions of
the horizontal grid, can be done using
the RGB code or the color palette

GridHorMinDivision
Color

Determines the color of the horizontal
grid subdivisions, which can be select-
ed using the RGB code or color palette.

GridVerVisible

Indicates whether there needs to be a
vertical grid

GridVerDivision
Number

Indicates the number of vertical divi-
sions in the grid

GridVerMinDivision
Number

Indicates the number of vertical subdi-
visions in the grid, that is, the number
of horizontal lines between any two di-
visions
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Table 57: Properties of a Trend Graph XY

Properties Description

Indicates the style of the divisions in
GridVerDivisionStyle the vertical grid: may be Solid or Bro-
ken line

Indicates the style of the subdivisions
in the vertical grid: may be Solid or
Broken line

GridVerMinDivision
Style

Determines the color of the vertical
GridVerDivisionColor grid divisions, which can be selected
using the RGB code or color palette.

Determines the color of the vertical

GridVerMinDivision subdivisions of the grid, which can be
Color selected using the RGB code or color
palette.

Indicates the pens to use in represent-
ing the trend. By clicking on the '
key you can edit the types of pen (as
shown in the next subsection)

Pens

Editing of the Trend Pens

To access the "TrendXY" writing pens editing, enter the Tren-
dXY" complex field editing (double-click it on the page). After
having selected the "TrendXY Graphic", click on the icon . in
the "Pens" voice in the relative "Editor Properties".

niz

Fari defned

0 L B L B el B 14 @

The displayed pens editing window is made up of three sec-
tions. On the left, there is a list of pens created by the user
from which to create and eliminate elements. At the bottom

ESAPOLYMATH - User Manual - rev. 2.1



388 | Chapter 6

Properties Editor

there is a preview of the pen currently being edited. At the
centre of the window there is the actual editing area for the
selected pen. This window is divided in "Properties”, "Inter-
vals" and "Interval Colours" masks. They will be described in
the following sub-paragraphs.

Properties

FA Ranges Color range

Mame Ttalian (Italy) =] Trendrenxy

Trend buffer XY [TrendBufferr e |
Scale type ¥ [Freset Bl
Min % @D El
Max % @mn E
Scale type T [Preset |
Min ¢ @n E
Max ¥ @mn E
Cem syl [Line Analogic =l
Lina style ST L =|
Marker [Gross o
Default color .n ,0,0

[ Show pen icon

First of all, a "Name" and a "Trend bufferXY", for which the
"Pen" must be used, can be associated to the Trend Pen.
Indicate a value "Scale type" that can be :

= "Programmed": the Max and Min values that can also be
associated to variables must be indicated

e "Automatic": calculated by Runtime, based on the va-
lues contained in the Buffer (but the limits can also be
inserted)

= "By the tag limits": the Buffer must refer to a limited va-
riable (see chap. 5, “Limiti” page 134)

= "Client": the Max and Min values must be indicated

From a graphical point of view, the aspect of the "Pen" can be
established. It can be "Signal only", have an "Analogue" dash
(continuous, with oblique connections between the values) or
"Digital” (scaled, with digital steps). Even the dimensions of
the line, the colour and the style ("Solid", "Dash", "Dot",
"Dash Dot", "Dash Dot Dot™) can be edited at will.

The pen marker can assume different geometrical shapes
("Pixel", "Cross", "Plus, "Cross and plus" and "circle") and one
can choose to not show the icon relative to the pen.

Every variation will update the preview at the back of the
mask.
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Intervals

Properties [BEhblE Color range

From this mask, insert the values relative to the intervals to
which different representation colours can be attributed. The
interval scale must present values in increasing order.

Interval Colours

In this mask, a colour can be associated to each of the value
intervals described in the Interval mask. The colour is applied
when the value read by Buffer is contained in the relative in-
terval.

Active Alarm View

Active Alarm View is a predefined element in POLYMATH, one
that can be inserted into the project pages. It allows the op-
erator to access the alarm list and perform the principal oper-
ations with a simple click. To insert an Active Alarm table into
a page, click on the icon or, alternatively, use the main
menu: Fields->Create-=>=Complex Controls->ActiveAlarm-
View. After clicking draw just its outline in the page and the
table appears automatically.

389
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Group

Acknowledge Ackncad

User Define

Once the table has been inserted into the page and been se-
lected, a series of properties contained in the Properties Editor
can be attributed to it; the meanings of these properties are
identical to those of TrendView properties (see chap. 6, “Prop-
erties of a TrendView” page 368).

By double-clicking on the table, you access its editing page
which comprises two masks: Fields and General.

The default contents of the Fields mask include the Alarm Grid
table, whose properties will be dealt with in the next subsec-
tions (see chap. 6, “Properties of the Active Alarm Grid”
page 392). Using this mask you can proceed to indicate which
buttons should be present with the table and position them
within the area. To insert or remove a button just click on the
list of buttons to the left of the table; if an object is already
present in the page, it will appear highlighted within the list
(and will be visible in the Table Edit Area). To move an ele-
ment (button or table) just drag it to the desired position. The
buttons that can be inserted are different and each has a pre-
defined (non editable) function assigned to it:
= Page Up: allows the operator to go up the pages of the
table
= Page Down: allows the operator to go down the pages
of the table
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= Page Left: allows the operator to move left within the
page
= Page Right: allows the operator to move right within the
page
e Line Up: select the line above the current one
« Line Down: select the line below the current one
= Cursor Left: move the table cursor leftwards
= Cursor Right: move the table cursor rightwards
= User button: this button can have a user-chosen func-
tion or a script assigned to it (see chap."“Appendix B -
Predefined functions” page 701 and see chap. 9,
“Scripts” page 509)
= Show Page: displays the page assigned to the alarm
(see chap. 5, “Properties” page 175)
= Acknowledgement: acquires the selected alarm
« Global Acknowledgement: allows the operator to per-
form a global (cumulative) acquisition of all the alarms
present in the table, if this option has been enabled for
the alarm in question (see chap. 5, “Properties”
page 175)
= Group Acknowledgement: allows the operator to per-
form a global (cumulative) acquisition of all the alarms
in the table that belong to the same group as the one
selected, if this option has been enabled for the alarm
in question (see chap. 5, “Properties” page 175)
= Show History: shows the page containing the Alarm His-
tory. Enter the appropriate Events Editor and indicate
the name of the page to go to after pressing this key
In addition, Dynamic fields can be assigned to the system
variables related to the alarms, each of which has properties
that can be edited using the Properties Editor (see chap. 6,
“Label” page 275). These fields are:
= Total of active alarms: shows the total number of active
alarms (not yet acknowledged or not yet terminated)
« Total of active alarms not acknowledged: shows the to-
tal number of alarms not acknowledged
= Total of alarms not returned: shows the total number of
alarms not terminated (still present in the device)
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The General mask can be used to insert a name and an iden-
tifying comment for the Alarm table being edited. In addition,
you can overwrite the default dimensions of the editing grid of
the page (see chap. 5, “Main window” page 113) introducing
new measures in pixels valid only for editing the current field
The graphic properties (fonts and colors) of the Active Alarm
View grid can be configured by using together the Fields and
the Priorities mask of the Alarms (see chap. 5, “Fields”

page 155 and see chap. 5, “Priorities” page 171).

Properties of the Active Alarm Grid

Table 58: Properties of the Active Alarm Grid

Properties Description

Top Vertical position coordinate
Left Horizontal position coordinate
Width Dimension of the width
Height Dimension of the height

This field allows the operator to deter-
mine which columns to put in the table
and define their respective properties.
To edit the columns click on the icon
Columns . . In the window which appears enter
the details relating to their width, to
the font and to the dimension and for-
mat of the titles of each column in the
table.
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Table 58: Properties of the Active Alarm Grid

Properties Description

Determines height in pixels of each

RowHeight

row

Determines whether the object can
Lock

move or not
Tablndex Determines the index that the object

will occupy in the table order

Indicates whether table scrolling

AutoScrollEnabled should be enabled automatically.

Active if autoscroll is enabled. Sets the
AutoScrollinterval number of lines for the autoscroll inter-
val.

This field allows the operator to insert
filtering parameters for the alarms to
be displayed within the table. To apply
these filters click on the icon ° In
Runtime only the alarm instances re-
specting the conditions indicated in the
Filters window will be shown. If more
than one filter is set, only the alarm in-
stances respecting the limits (AND
conditions) will be shown in runtime.

Filters

Indicates whether the horizontal scroll

HScrollBarVisible bar should be visible in Runtime.

Indicates whether the tables should

LetterHeadVisibility have titles

Allows the operator to decide whether
or not to display the index numbers of
the alarm (in the columns to the left of
the table)

RibbonVisibility

Indicates the chronological order in
which to arrange the alarms in the
grid; may choose to show the most re-
cent ones first, or the oldest ones

TimeStampOrder

Indicates whether the vertical scroll

VScrollBarvisible bar should be visible in Runtime.
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Alarm History View

The Alarm History table is a predefined element in POLYMATH,
one that can be inserted into the project pages. It allows the
operator to access the active alarm list and perform the prin-
cipal operations with a simple click. To insert an Alarm History
View table into a page, click on the icon E% or, alternatively,
use the main menu: Fields->Create-=>=Complex Controls-
>Alarm History. This table contains only those alarms whose
configuration explicitly says that they are to be saved in the
terminal’s Alarm History (see chap. 5, “Properties” page 175).
After clicking on the table draw just its outline in the page and
the table will appear automatically.

[fFH Genersl Help psge FKevs

o Dusergtn [ Dota | Ak Dote [ TamOne |_ste

Page Up | Page down ‘
Page left Page right
Line Up | Line down ‘
Cursor left Cursor right

Once the table has been inserted into the page and been se-
lected, a series of properties can be attributed using the Prop-
erties Editor; the meanings of these properties are identical to
those of the properties in TrendView (see chap. 6, “Properties
of a TrendView” page 368).

By double-clicking on the table itself you access its editing
page which comprises two masks: Fields and General.

Paga Lp

Page left

Line Lp

Cursor loft

The default contents of the Fields mask include the Alarm Grid
table, whose properties will be dealt with in the next subsec-
tions (see chap. 6, “Properties of the Active Alarm Grid”
page 392). Using this mask you can proceed to indicate which
buttons should be present with the table and position them
within the area. To insert or remove a button just click on the
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list of buttons to the left of the table; if an object is already
present in the page, it will appear highlighted within the list
(and will be visible in the Table Edit Area). To move an ele-
ment (button or table) just drag it to the desired position. The
buttons that can be inserted are different and each has a pre-
defined (non editable) function assigned to it:
= Page Up: allows the operator to go up the pages of the
table
= Page Down: allows the operator to go down the pages
of the table
= Page Left: allows the operator to move left within the
page
= Page Right: allows the operator to move right within the
page
= Line Up: select the line above the current one
« Line Down: select the line below the current one
* Cursor Left: move the table cursor leftwards
= Cursor Right: move the table cursor rightwards
= User button: this button can have a user-chosen func-
tion or a script assigned to it (see chap.“Appendix B -
Predefined functions” page 701 and see chap. 9,
“Scripts” page 509)
= Show Page: displays the page assigned to the alarm
(see chap. 5, “Properties” page 175)

Fields [

Identification

MName HistoricallournalViewer

Comment

Editing
[ Owerride default grid size
Width 10 |
Height 10 =

The General mask can be used to insert a name and an iden-
tifying comment for the Alarm History table being edited. In

addition, you can overwrite the default dimensions of the ed-
iting grid of the page (see chap. 5, “Main window” page 113)
introducing new measures in pixels valid only for editing the

current field.

The graphic properties (fonts and colors) of the Active Alarm
View grid can be configured using together the Fields and Pri-
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orities masks of the Alarm (see chap. 5, “Fields” page 155 and
see chap. 5, “Priorities” page 171).

Properties of the Alarm History Grid

The properties of the Alarm History Grid coincide with those of
the Active Alarm Grid (see chap. 6, “Properties of the Active
Alarm Grid” page 392).

User List Table

The User List table (see chap. 5, “Password configuration”
page 184) is a predefined element in POLYMATH, one that can
be inserted into the project pages. It allows the operator to
access the user list (respecting the limits of its level of protec-
tion) and perform the principal operations with a simple click.
To insert a User List table into a page, click on the icon or,
alternatively, use the main menu: Fields->Create->Complex
Controls->User list.

After clicking draw just the outline of the table and it will ap-
pear automatically.

[l General Help page F Keys

Add User

Delete User |

Change ‘
Password

Once the table has been inserted into the page and been se-
lected, a series of properties contained in the Properties Editor
can be attributed to it; the meanings of these properties are
identical to those of the properties in TrendView (see chap. 6,
“Properties of a TrendView” page 368).

By double-clicking on the table itself you access its editing
page which comprises two masks: Fields and General.
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Add Utser

Delete User

Charge
Passwinrd

The default contents of the Fields mask include the Alarm Grid
table, whose properties will be dealt with in the next subsec-
tions (see chap. 6, “Properties of the Active Alarm Grid”
page 392). Using this mask you can proceed to indicate which
buttons should be present with the table and position them
within the area. To insert or remove a button just click on the
list of buttons to the left of the table; if an object is already
present in the page, it will appear highlighted within the list
(and will be visible in the Table Edit Area). To move an ele-
ment (button or table) just drag it to the desired position. The
buttons that can be inserted are different and each has a pre-
defined (non editable) function assigned to it:
= Add User: allows the operator to add a new user
= Delete User: allows the operator to remove the user se-
lected
= Change Password: allows the operator to change the
password relating to the user selected

Identification

Mame UserDirectory

Comment

Editing
O override default grid size
ridth 10 =
Height 10 E

The General mask can be used to insert a name and an iden-
tifying comment for the User table being edited. In addition,
you can overwrite the default dimensions of the editing grid of
the page (see chap. 5, “Main window” page 113) introducing
new measures in pixels valid only for editing the current field
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The graphic properties (fonts and colors) of the User List can
be configured using together the Fields mask and Password el-
ement (see chap. 5, “Fields grid” page 188).

L ) Note: After inserting a new user in Runtime, you will have to change
o his/her password by selecting the corresponding row in the table
and then by clicking on ‘ Change Password’. Just insert the new
password in the ensuing mask, leaving blank the field relating to the
old password (since the new user does not possess any assigned

password).

Properties of the Password Grid

Table 59: Properties of the Password Grid

Properties Description

Top Vertical position coordinate
Left Horizontal position coordinate
Width Dimension of the width
Height Dimension of height

This field allows the operator to edit
the appearance of the table. To edit
the columns click on the icon ° In
Columns the window which appears enter the
details relating to their width, to the
font and to the dimension and format
of the titles of each column in the table

Determines height in pixels of each

RowHeight

row

Determines whether the object can
Lock

move or not
Tablndex Determines the index that the object

will occupy in the table order

Indicates whether the horizontal scroll

HScrollBarVisible bar should be visible in Runtime.

Indicates whether the vertical scroll

VScrollBarvisible bar should be visible in Runtime.
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Recipe List Table

The Recipe List table is a predefined element in POLYMATH,
one that can be inserted into the project pages. It allows the
operator to access the Recipe list in the terminal (see chap. 5,
“Recipes Types” page 178). To insert a Recipe List table into
a page, click on the icon or, alternatively, use the main
menu: Fields->Create->Complex Controls->Recipe list.
After clicking draw just the outline of the table and it will ap-
pear automatically.

EEIEE General Help page F Keys

Typs Mas Poiipt Mot

Delete

__ose |
Download

Once the table has been inserted into the page and been se-
lected, a series of properties contained in the Properties Editor
can be attributed to it; the meanings of these properties are
identical to those occurring in TrendView (see chap. 6, “Prop-
erties of a TrendView” page 368).

By double-clicking on the table, you access its editing page
which comprises two masks: Fields and General.

[ enersl ]

Besgerr
Eraas down

Type tame_|_Fedpe Hame .
Eeagetan Dotz
e i

Euireun Crownload |
Buire down

& cursorieft

@ cursor right
Boeiew
Boepon
eeortal

[ [

| @ povntons

B import Recipes
B urarbuston

d Recpe types

The default contents of the Fields mask include the Alarm Grid
table, whose properties will be dealt with in the next subsec-
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tions (see chap. 6, “Properties of the Active Alarm Grid”
page 392). Using this mask you can proceed to indicate which
buttons should be present with the table and position them
within the area. To insert or remove a button just click on the
list of buttons to the left of the table; if an object is already
present in the page, it will appear highlighted within the list
(and will be visible in the Table Edit Area). To move an ele-
ment (button or table) just drag it to the desired position. The
buttons that can be inserted are different and each has a pre-
defined (non editable) function assigned to it:

= Delete: deletes the Recipe selected

= Export: exports the Recipe selected into a .csv file

= Export all Recipes: exports all the Recipes in the table

into a .csv or .xml file
= Transfer (download): downloads the Recipe selected
onto a device

= Import Recipes: imports the Recipes from a .csv file
In addition, a Dynamic field can be inserted, which contains
the Recipe type list in a pull-down menu which allows the op-
erator to filter the display for a specific type of Recipe. The
properties relating to position and dimension can be inserted
into the Properties Editor of this field, and it is also possible to
indicate which type of Recipe to display as default when the
page opens.

Identification
Mame RecipeDirectary

Comment

Editing
[ override default grid size
idth 10 =
Height 10 =

The General mask can be used to insert a name and an iden-
tifying comment for the Recipe table being edited. In addition,
you can overwrite the default dimensions of the editing grid of
the page (see chap. 5, “Main window” page 113) introducing
new measures in pixels valid only for editing the current field.
The graphic properties (fonts and colors) of the Recipe list can
be configured using the Fields mask of the Recipes element
(see chap. 5, “Fields” page 155).
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Properties of the RecipeGrid

Table 60: Properties of the Recipe Grid

Properties Description

Top Vertical position coordinate
Left Horizontal position coordinate
Width Dimension of the width
Height Dimension of the height

This field allows the operator to deter-
mine which columns to put in the table
and define their respective properties.
To edit the columns click on the icon

Columns ° In the window which appears enter
the details relating to their width, to

the font and to the dimension and for-
mat of the titles of each column in the

table
RowHeight Determines height in pixels of each
row
Determines whether the object can
Lock
move or not
Tablndex Determines the index that the object

will occupy in the table order

Indicates whether the horizontal scroll
bar should be present in Runtime when
the dimensions of the instances allow
for it

HScrollBarVisible

Indicates whether the tables should

LetterHeadVisiblity have titles

Indicates the way the instances should
be ordered within the table; the order
can be alphabetical, chronological or-
der of editing and Recipe ID order

OrderMode

Indicates whether the vertical scroll
VScrollBarVisible bar should be present in Runtime when
the number of instances allow for it

Recipe Editing Table

The Recipe Editing table is a predefined element in POLY-
MATH, one that can be inserted into the project pages. It al-
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lows the operator to access the Recipe editor in the terminal
(see chap. 5, “Recipes Types” page 178). To insert a Recipe
Editing table into a page, click on the icon or, alternatively,
use the main menu: Fields->Create->Complex Controls-
>RecipeEditing.

After clicking draw just the outline of the table in the page and
it will appear automatically.

Load Clear Buffer

Download Buffer | Upload Buffer

Once the table has been inserted into the page and been se-
lected, a series of properties contained in the Properties Editor
can be attributed to it; the meanings of these properties are
identical to those of TrendView (see chap. 6, “Properties of a
TrendView” page 368).

By double-clicking on the table, you access its editing page
which comprises two masks: Fields and General.

Load Clear Buffar

Download Buffer|  Updoad Buffer

The default contents of the Fields mask include the Alarm Grid
table, whose properties will be dealt with in the next subsec-
tions (see chap. 6, “Properties of the Active Alarm Grid”
page 392). Using this mask you can proceed to indicate which
buttons should be present with the table and position them
within the area. To insert or remove a button just click on the
list of buttons to the left of the table; if an object is already
present in the page, it will appear highlighted within the list
(and will be visible in the Table Edit Area). To move an ele-
ment (button or table) just drag it to the desired position. The
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buttons that can be inserted are different and each has a pre-
defined (non editable) function assigned to it:
= Save: saves the Recipe in the terminal memory (if nec-
essary, overwriting the one being edited)
= Save as: saves the Recipe open in any case the inser-
tion window of the name
= Load: loads the Recipe selected into the video buffer
= Delete Buffer: empty the buffer
= Transfer to Buffer (upload): transfers the Recipe from
the device to the video buffer
« Transfer from Buffer (download): transfers the data of
the Recipe present from the video buffer to the device
In addition, dynamic fields can be inserted which contain a
Recipe list and the name of the uploaded Recipe which has
same properties as the Label objects (see chap. 6, “Label”
page 275) that can be edited using the Properties Editor.

Identification

Marme RecipeEditing

Comment

Editing
[ owverride default grid size
Wiidth 10 (!
Height 10 =

The General mask can be used to insert a name and an iden-
tifying comment for the Recipe table being edited. In addition,
you can overwrite the default dimensions of the editing grid of
the page (see chap. 5, “Main window” page 113) introducing
new measures in pixels valid only for editing the current field.
The graphic properties (fonts and colors) of the Recipe list can
be configured using the Fields mask of the Recipes element
(see chap. 5, “Fields” page 155).

Operations for transferring Recipes

The following summary gives an overview of all the operations
that can be performed on transfers of Recipes using VTs and
devices. It is important to note that transfer operations see

the interaction of 3 elements: the physical memory of the VT
(where the Recipes are saved), the VT video buffer (contain-
ing the data of just one Recipe, the one being displayed on the
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panel) and the device (in whose memory the Recipe data re-
ally resides).

Import lT Export

Video Buffer “—L VT Memory
D%t:&:k \ Upload A\!m
Device

When you decide to manage the transfer of Recipes in syn-
chronized mode constitutes a special case.

In this case, before transferring the data the terminal asks for
the status of the device, waiting for an authorization. The syn-
chronization procedure happens by means of the write/read of
certain exchange areas (see chap.“Appendix C - Status area”
page 715 and see chap.“Appendix D - Command area”

page 719).

A synchronized transfer is defined at the moment the function
is attributed (or the script instruction, see chap. 9, “Scripts”
page 509)

Let us give a practical example. Supposing we are performing
a synchronized download and are using a Recipe type in non-
compatible mode (see chap. 5, “Modes of compatibility”
page 180), then, at the request for a transfer of data, the de-
vices will behave as follows:

« the VT will send the data transfer request to the PLC
(WORDO.BIT1 of the Status Area)

= the PLC responds, enabling the transfer using bit 4 of
WORDO of the Command Area

= At this point, the data transfer will begin (WORDO.BITO
of the Status Area)

« At the end of the transfer, the VT will signal to the PLC
(WORDO.BIT3 of the Status Area) that the download
has terminated

= the PLC will respond confirming the reception
(WORDO.BITO of the Command Area)

If during the data transfer the handshake times are not re-
spected, the VT puts at 1 in the Status Area the Error In Trans-
ferring bit (bit 14 = download, bit 15 = upload).
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Chronothermostat

A "Chronothermostat" can be inserted inside of the page by
clicking on the icon or from the "Main Menu" (Fields->Cre-
ate->Complex Controls->Chronothermostat). After having
clicked the icon, indicate the area in which POLYMATH must
designate the "Chronothermostat" using the mouse inside of
the page.

A "Chronothermostat" represents a Polymath object that al-
lows to detect a temperature and edit the behaviour of the sy-
stem in "Manual” or "Automatic" mode at will. Scheduling
allows to program the temperature trend weekly.

The "Chronothermostat" is the field inside of which the con-
tent of the TaskSettimanali (WeeklyTasks) is displayed, the
functioning of which was described in the last previous para-
graph (see chapter 7 "TaskSettimanali" on page

Consult the next sub-paragraphs to know the details of the
properties that can be associated to a "Chronothermostat"
and its editing modes.

Properties of the Chronothermostat Grid

Table 61: Properties of the Chronothermostat Grid

Properties Description

Identification name of the Chronother-
Name mostat View. It must be unique among
the graphic elements

Identification comment inside of POLY-
Comment

MATH
Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension
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Table 61: Properties of the Chronothermostat Grid

Properties Description

Height Height dimension

Determines the color of the Area,
which can be selected using the RGB
AreaColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

Determines whether the Chronother-
mostat has the background area or if it
AreaVisibility must be transparent. A Boolean varia-
ble can be associated to this value or it
can be managed with thresholds

Determines the 3D effect of the Bor-
der. It can be Flat, Relief, Rec-essed,
Border3D Bump or Etched. The value can be as-
sociated to a whole variable or it can
be managed with thresholds

Determines the style of the Border. It
can be Solid or Dashed. The value can
be associated to a whole variable or it
can be managed with thresholds

BorderStyle

Determines the Border colour by me-
ans of the RGB code or the colour pa-
BorderColor lette. The value can be associated to a
whole variable or it can be managed
with thresholds

Determines whether the Viewer border
BorderVisibility is present or not. A Boolean variable
can be associated to this value

Determines the dimension of the Bor-
der. It must be a number to which a
BorderSize whole variable can be associated op-
tionally, or it can be managed with
thresholds

Determines the flashing of the Border.
It can be No Flash, Slow Flash or Fast
BorderBlink Flash. The value can be associated to a
whole variable or it can be managed
with thresholds
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Table 61: Properties of the Chronothermostat Grid

Properties Description

Determines whether the object is visi-
ble initially. It can also be associated to
Hide a Boolean variable (for Runtime modi-
fications) or it can be managed with
thresholds

Determines whether the object can

Lock
move or not

Edit the Chronothermostat

After having inserted a "Chronothermostat” on a page, dou-
ble-click it to start its editing. A "graphic" will be present by
default which, upon the programmer's choice, can be accom-
panied by a range of control buttons to view the "Chronother-
mostat". The editing is organised on two masks: "Campi" e
"Generale" (Fields and General)

Fields

i

{

S | W )|

s | [ | [ |

From the "Fields" mask, the buttons which should be present
together with the table can be indicated and positioned inside
of the area. Each button has its relative properties which can
be edited in "Editor Proprieta" (Properties Editor) as for nor-
mal touch-sensitive buttons. To insert or remove a button, cli-
ck the list of buttons at the left of the table. If an object is
already present on the page it will be highlighted inside of the
list (and it will be visible inside of the drawing area). To move
an element (button or table) drag it to the desired position.
Several buttons can be inserted and each one has a pre-de-
termined function associated to it (unchangeable) :
= "Copy": the button copies the daily trend of the tempe-
rature in order to overwrite it on another day at will.
This is useful when it is necessary to have the same dai-

ESAPOLYMATH - User Manual - rev. 2.1



408 | Chapter 6

Properties Editor

ly schedule on different days. Functions by pressing the
button and then selecting the days where the modifica-
tion is to be applied. To conclude, re-select the "Copia"
(Copy) key

"Change state": the button allows to pass from heating
mode to cooling mode and vice versa. This function
must be activated in the "Script"” della "WeeklyTask"
"Script" screen used. It is only active if the selection of
"Type of Chronothermostat™ corresponds to "Riscalda-
mento e Raffreddamento” (Heating and Cooling)
"Save": the button memorises and saves the modifica-
tions made to this function

"Automatic": allows to start "Chronothermostat" sche-
duling. The system reads the previously-set cycle va-
lues and behaves according to the same

"Manual”: the system leaves "Automatic” mode and fol-
lows a variable temperature value at will at any time
from the panel

"Default": pass to a pre-established temperature value
(Default) in the design phase. The "Automatic" function
is deactivated

"Perform": activates "Chronothermostat" functioning
"Off": exists the "Chronothermostat" functioning mode
"User Button": identifies a new button that can be cu-
stomised freely by the user

General

Identification

Mame Chronothermiiewer

Cormment

Editing
[ override default grid size

Width 10 [
==

Height 10

An identification name and comment for the "Chronothermo-
stat” that is being edited can be inserted on the "General”
mask. Moreover, it is possible to overwrite the default dimen-
sions of the page editing grid introducing new measurements
in pixel valid only for editing the current field.
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Properties of the Chronothermostat Grid

Table 62: Properties of the Chronothermostat Grid

Properties Description

Identification name of the Chronother-

Name mostat View. It must be unique among
the graphic elements

Comment Identification comment inside of POLY-
MATH

Top Vertical position coordinate

Left Horizontal position coordinate

width Width dimension

Height Height dimension
Determines the color of the Area,
which can be selected using the RGB

AreaColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds
Determines the 3D effect of the Bor-
der. It can be Flat, Relief, Rec-essed,

Border3D Bump or Etched. The value can be as-

sociated to a whole variable or it can
be managed with thresholds

BorderColor

Determines the Border colour by me-
ans of the RGB code or the colour pa-
lette. The value can be associated to a
whole variable or it can be managed
with thresholds

BorderVisibility

Determines whether the Viewer border
is present or not. A Boolean variable
can be associated to this value

BorderSize

Determines the dimension of the Bor-
der. It must be a number to which a
whole variable can be associated op-
tionally, or it can be managed with
thresholds

BorderBlink

Determines the flashing of the Border.
It can be No Flash, Slow Flash or Fast
Flash. The value can be associated to a
whole variable or it can be managed
with thresholds

409
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Table 62: Properties of the Chronothermostat Grid

Properties Description

Determines the type of use of the
WeeklyType Chronothermostat. It can be None,
Days or Week

Determines if the grid has reference li-

ridLineVisibl .
GridLinevisible nes or if it must be transparent

Determines the Visible Grid Line colour
by means of the RGB code or the co-
lour palette. The value can be associa-
ted to a whole variable

GridLineColor

It determines the colour of the cells
not used in the Grid by means of the
GridUnusedCellColor RGB code or the colour palette. The
value can be associated to a whole va-
riable

Determines the text to display in the
OffLabel grid in the intersection point of the
graphical lines

Determines the selection between
WeekTask TaskSettimanali present for program-
ming

Allows to use the ° button to access
the configuration window of the co-
lours relative to the graphic tempera-
ture intervals

GrdiColors

Determines whether the object can

Lock
move or not

Determines the index that the object

TablIndex will occupy in the table order

Determines the presence or not of a

BackgrimageEnabled background image in the grid

Determines the background image

BackgroundlmagelD used in the program

Determines the presence or not of the

HorScalevisible horizontal scale in the graphics

Determines the Font to use for the la-

HorScaleLabelFont bels of the horizontal scale
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Table 62: Properties of the Chronothermostat Grid

Properties Description

It determines the colour of the labels in
HorScalelLabelColor the horizontal scale by means of the
RGB code or the colour palette

Determines the presence or not of the

VerScaleVisible vertical scale in the graphics

Determines the Font to use for the la-

VverScaleLabelFont bels of the vertical scale

It determines the colour of the labels in
the vertical scale by means of the RGB
VerScalelLabelColor code or the colour palette The value
can be associated with Tag or it can be
managed with thresholds

Scheduler View

"Scheduler View" is the "Scheduler" function graphical repre-
sentation inside of the page (see chap. 5, “Schedulers”

page 222).

A “Scheduler View” can be inserted inside of a page by clicking
on the icon or from the “Main Menu” (Fields->Create-
>Controls Complexes->Scheduler View). After having clicked
the icon, indicate the area in which POLYMATH must draw the
“new Scheduler View” inside of the page using the mouse :
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Before creating a new "Scheduler view" it is necessary (but
not indispensable) to have created a "Scheduler" to which as-
sociate it. It is also possible to create scheduler after having
created scheduler view by editing the "Scheduler" property di-
rectly from property editor under the "Advanced" item :

'EInvaIid

[ERROR:The Scheduler doesnt exist,

= Advanced

l Scheduler IScheduIer VI%

After having inserted "Scheduler”, the "Vista Scheduler” ima-
ge automatically becomes the following :

It is certainly possible to customise "Scheduler View" using
the days of the week or the "Week" and "Week-end" keys.
(see chap. 5, “Fields” page 155).
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Scheduler View Properties

Table 63: Scheduler View Properties

Properties Description

Identifying name of the Scheduler

Name View. Must be unique among the
graphic elements

Comment Identification comment inside of POLY-
MATH

Top Vertical position coordinate

Left Horizontal position coordinate

width Width dimension

Height Height dimension
Determines the color of the Area,
which can be selected using the RGB

AreaColor code or color palette. The value can be

assigned to a whole variable or it can
be managed with thresholds

AreaVisibility

Determines whether the Scheduler
View should have a background or if it
must be transparent; a Boolean vari-
able can be assigned to this value or it
can be managed with thresholds

Border3D

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderBlink

Determines the flashing of the Border,
which can be No blinking, Slow blinking
or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderColor

Determines the color of the Border,
which can be selected using the RGB
code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds
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Table 63: Scheduler View Properties

Properties Description

Determines whether there will be a
Border to the Rectangle or not; a Bool-
ean variable can be assigned to this
value

BorderVisibility

Determines the size of the Border,
which must be a number to which a
BorderSize whole variable could be assigned if de-
sired or it can be managed with thresh-
olds

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Determines whether the object is ini-
tially visible. It is also possible to as-

Hide sign a Boolean variable (for changes in
Runtime) or it can be managed with
thresholds
Determines if the object can move or

Lock

not

Allows associating and modifying a

Scheduler new "Scheduler” to "Scheduler View"

Editing Scheduler View

After having inserted a “Scheduler View” on a page, double-
click it to start its editing. A graphic will be present by default
which, upon the user's choice, can be accompanied by a range
of control buttons to view the “Scheduler View”. The editing is
organised on two masks: “Fields” and “General”.
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Fields

EEILEY General

| = |
[C ER
Bauto Tuesday
+ +

et 11:34 wed
[C BT
aCOW Thursday
B userbutton

Friday

— 11:34 — Saturday
Sunday

From the “Fields” mask, the buttons which should be present
together with the table can be indicated and positioned inside
of the area. Each button has its relative properties which can
be edited in “Editor Properties” as for normal touch buttons.
(see chap. 6, “Touch Button” page 333). To insert or remove
a button, click the list of buttons at the left of the table. If an
object is already present on the page, it will be highlighted in-
side of the list (and it will be visible inside of the drawing
area). To move an element (button or table) drag it to the de-
sired position. There are several buttons that can be inserted
and each one has a pre-determined function associated to it
(unchangeable) :

= "Save": the button saves and stores the changes made.

= "Automatic": allows scheduling to start The system rea-
ds previously set values and behaves based on them. By
pressing once the "Automatic" button the system
switches to "Manual" and Scheduler is disabled.

= “Run”: activates set function in events.

= "Stop": stops Scheduler execution.

= "Copy": the button copies Scheduler daily trend to then
overwrite it into a different day at will. It is useful when
the same daily scheduling is needed on different days.
It functions by pressing the button and subsequently
selecting days the change is to be applied to; finish by
selecting the "Copy" key again

= “User Button”: identifies a new button that can freely be
customised by user
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General

WGETEY General |

|1dentification

Name Schedulerviewer

Comment

|Editing
O override default grid sizs
Width 10 [==|
Height in E

An identification name and comment for the “Scheduler” that
is being edited can be inserted on the "General" mask. The pa-
ge editing grid default dimensions can be overwritten as well
introducing new measurements in pixel, valid only for the cur-
rent field editing (see chap. 5, “Main window” page 113).

Holiday Groups View

"Holiday group view" is the "Holiday group" function graphical
representation inside of the page (see chap. 5, “Holiday
Group” page 230).

A “Holiday Group View” can be inserted inside of a page by cli-
cking on the icon or from the “Main Menu” (Fields->Create-
>Controls Complexes->View "Holiday Group"). After having
clicked the icon, indicate the area in which POLYMATH must
draw the new “Holiday group view” inside of the page using
the mouse: :
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Holiday Group View Properties

Table 64: Holiday Groups View Properties

Properties Description

Identifying name of the Holiday

Name Groups Viewer. Must be unique among
the graphic elements

Comment Identification comment inside of POLY-
MATH

Top Vertical position coordinate

Left Horizontal position coordinate

width Width dimension

Height Height dimension
Determines the color of the Area,
which can be selected using the RGB

AreaColor code or color palette. The value can be

assigned to a whole variable or it can
be managed with thresholds

AreaVisibility

Determines whether the Holiday
Groups Viewer should have a back-
ground or if it must be transparent; a
Boolean variable can be assigned to
this value or it can be managed with
thresholds

Border3D

Determines a 3D effect for the Border,
which can be Flat, Relief, Recessed,
Bump or Etched. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderBlink

Determines the flashing of the Border,
which can be No blinking, Slow blinking
or Rapid blinking. The value can be as-
signed to a whole variable or it can be
managed with thresholds

BorderColor

Determines the color of the Border,
which can be selected using the RGB
code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds

417
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Table 64: Holiday Groups View Properties

Properties Description

Determines whether there will be a
Border to the Rectangle or not; a Bool-
ean variable can be assigned to this
value

BorderVisibility

Determines the size of the Border,
which must be a number to which a
BorderSize whole variable could be assigned if de-
sired or it can be managed with thresh-
olds

Determines the style of the Border,
which can be Solid or Broken. The val-
ue can be assigned to a whole variable
or it can be managed with thresholds

BorderStyle

Determines whether the object is ini-
tially visible. It is also possible to as-

Hide sign a Boolean variable (for changes in
Runtime) or it can be managed with
thresholds
Determines if the object can move or

Lock

not

Properties of the Holiday Groups Viewer grid

Table 65: Properties of the Holiday Groups Viewer Grid

Properties Description

Top Vertical position coordinate
Left Horizontal position coordinate
Width Width dimension

Height Height dimension

Determines the color of the Area,
which can be selected using the RGB
AreaColor code or color palette. The value can be
assigned to a whole variable or it can
be managed with thresholds
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Table 65: Properties of the Holiday Groups Viewer Grid

Properties Description

Border3D

Determines the 3D effect of the Bor-
der. It can be Flat, Relief, Rec-essed,
Bump or Etched. The value can be as-
sociated to a whole variable or it can
be managed with thresholds

BorderBlink

Determines the flashing of the Border.
It can be No Flash, Slow Flash or Fast
Flash. The value can be associated to a
whole variable or it can be managed
with thresholds

BorderColor

Determines the Border colour by me-
ans of the RGB code or the colour pa-
lette. The value can be associated to a
whole variable or it can be managed
with thresholds

BorderVisibility

Determines whether the Viewer border
is present or not. A Boolean variable
can be associated to this value

BorderSize

Determines the dimension of the Bor-
der. It must be a number to which a
whole variable can be associated op-
tionally, or it can be managed with
thresholds

FontGridCell

Determines the font used to display
text in grid cell

FontHeaders

Determines the font used to display
text grid headers

TextColorDisableCell

Determines the RGB color used for the
text in disable cell

TextColorEnablecCell

Determines the RGB color used for the
text in enable cell

TextColorSelectedCell

Determines the RGB color used for the
text in selected cell

TextColorWeek

Determines the RGB color used for the
text in week headers

TextColorWeekend

Determines the RGB color used for the
text in weekend headers
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Table 65: Properties of the Holiday Groups Viewer Grid

Properties Description

Determina se I'oggetto é inizialmente
visibile; & anche possibile associare
Hide una variabile di tipo Boolean (per mo-
difiche a Runtime) oppure puo essere
gestito a soglie.

Determina se I'oggetto si puo spostare

Lock
0 no
Permette di controllare il movimento
del focus quando si utilizzano i tasti di
movimento del cursore all’interno di
una pagina; inoltre controlla I'ordine di
Tablndex pag

inserimento dati su piu campi quando
la Impostazione automatica del campo
successivo della pagina € abilitato (see
chap. 5, “Generale” page 161)

Allows assigning an image to selected

ImageSelectedCell
cell

Allows assigning an image to unse-

ImageUnselectedCell lected cell

Allows assigning an image to "current

ImageCurrentCell day" cell

Allows assigning an image to not ena-
ImageDisableCell bled cell (or cells) (days not included in
current month)

Determines which holiday group to

HolidayGroup show

Determines texts list used for week

DayOfWeek days

Edit Holiday Group View

After having inserted a “Holiday Group” on a page, double-cli-
ck it to start its editing. A default graphic is present accompa-
nied by a "Save" button.

The editing is organised on two masks: “Fields” and “General”.
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Fields

General

Save

[ oy Torday Ve Thosdsy ™ Frdvy Swdiy Sonday

From the "Fields" mask it is possible to edit grid keys cha-
racteristics. Each button has its relative properties which can
be edited in “Editor Properties” as for normal touch buttons
(see chap. 6, “Touch Button” page 333). To insert the "Save"
button simply click on it, while dragging it to the desired po-
sition will move it. A pre-determined function (unchangeable)
is associated to the "Save" button.

You can have the following buttons along with the grid (which
can also be edited) :

= Month: views configured month
e Month increase button

e Month decrease button

= Year: views configured year

e Year increase button

e Year decrease button

Only in Runtime it is possible to select the days where the
scheduler does not need to operate (holidays) :

ESAPOLYMATH - User Manual - rev. 2.1



422 | Chapter 6

Properties Editor

ESA RunTime Simulation

February ->

<

< | 2011 >

Mondsy Tussdsy Wiednezday Thursday Friday Saturday Sunday
) 1 2 3 4 5
7 8 9 " i
14 15 15 17 18 19 -
) ) 23‘ i -
25 1 2 3 4 5 &
7 E 9 10 11

)
&~ Note: Current day is selected by default in blue.

General

Fields

|1dentification

Mame HolidayGroupViewer

Caomrment

|Editing

[ owerride default grid size
fidth
Height

An identification name and comment for the “Holiday group”
that is being edited can be inserted on the "General" mask.
The page editing grid default dimensions can be overwritten
as well introducing new measurements in pixel, valid only for
the current field editing (see chap. 5, “Finestra Principale”

page 117).
Movement A movement property can be associated to every object pre-
properties of sent in the creation of the POLYMATH project.

the objects
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This is used to determine the behaviour of this object associa-
ted to a "Tag".

The commands useful for introduction of a movement are pre-
sent in the object "Editor Proprieta” (Properties Editor) :

Table 66: Movement properties of the objects

Properties Description

Identifies the movement associated to

TypeOfMovement the object: None, Direct, Horizontal,
Vertical and Horizontal And Vertical

TagDirectMovement Associates a Tag to the Direct move-
ment

TagX Horizontal movement tag

TagyY Vertical movement tag

Steps Movement intervals

FinalX Horizontal co-ordinate

FinalY Vertical co-ordinate

Once an object has been selected, by clicking the button,

the movement associated to it can be displayed graphically.

Shift the object to the desired position.
Direct Movement

The image shifts to the pre-established point.
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Horizontal Movement

LI RN Il R

The image follows the established horizontal movement (Tag
X).

Vertical Movement

LIy

118

The image follows the established vertical movement (Tag Y).
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Horizontal and Vertical Movement

The image follows the established horizontal and vertical mo-
vements (X and Y Tags).

For all the graphic elements described in this chapter it is pos-
sible to perform a series of useful operations aimed at further
improving the graphic presentation of the project.

In this section we will give a complete description of practical
examples relating to standard operations, like grouping, align-
ment and distribution.

Grouping of two or more graphic elements

The grouping function is useful whenever you want to deal
with a group of graphic elements as a single block so as to be
able to perform cumulative operations on all the elements. To
group two or more elements select them simultaneously (us-
ing the mouse to construct an area to enclose them) and click
on the icon of the toolbar (or Layout->Group using the
Main menu).

For example, let us insert into a page a Regular 5-sided poly-
gon and then a touch button.

425
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d

Change Page

Let us suppose that after individually defining the properties
of the single objects (as shown in the previous sections), we
want the button to be over the Polygon and want this structure
to be a single structure, so that we can move, resize or dupli-
cate them together as a group. First of all we will move the
button (selecting it and dragging it to the desired position).

Change Page

Now we have to select the two objects collectively. We just
click on the icon and draw a selection area inside the page
big enough to contain the outlines of both objects as shown in
the following figure:
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Change

at this point release the button and both elements will be se-
lected,

oChangg Pa
1 -

and the Group key on the toolbar will become activated E
(Layout->Group). By clicking on this icon the elements be-
come grouped and the Polygon-button ensemble becomes us-
able as a single element. The type of object created is Group
Field and, when selected, the Properties Editor can be used to
attribute the properties relating to dimensions and position
besides the name and identifying comment in the context of
POLYMATH. Once a Group Field is created it is possible to edit
the position of the objects within it (or delete and add objects)
after double-clicking on the group itself. In this way you ac-
cess the Group editor in which it is also possible to set the
Group’s general properties and dimensions.
This operation can of course be performed on all the types of
graphic element described in this chapter. Moreover, the ele-
ments of a group can be disaggregated later by clicking on the
key (Layout->Separate), active only when a group of ob-

427
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jects is selected. After their division the elements return to be-
ing separately editable.

Depth order of objects

When there is an overlapping of more than one object in a
page, the operator can establish display priority policy for the
overlapping objects. By selecting one of the objects it is pos-
sible to determine at what depth level to position it by press-
ing one of the four keys also to be found in the Main menu
Layout->Level.

B Bring ko fronk
B Send to back
=

.

p

Down

To understand the way the four options work let us take the
*- example given in the previous section, but adding to the poly-

gon and the touch button a third element, a Sector.

We will apply the Level commands to the touch button, then

select it (click on n and then on the button). Now by clicking

on (Layout->Level->Move to First Level) the button is

brought to the top level above all the other objects.

When, instead, we click on the icon (Layout->Level-
>Move to Lowest Level), the button selected is taken to the
bottom level, that is, below all the other objects. See figure:
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Now, if we click on the icon (Layout->Level-=>Up), the but-
ton is moved one level towards the top, that is, it rises only
above the object that was immediately above it at that mo-
ment (in our example, the polygon).

Naturally, with each click of this icon, the object selected ap-
pears at a different level. _

Similarly, by clicking on the icon (Layout->Level->Down)
the button is moved down by one level, that is, it drops only
below the object that was immediately below it at that mo-
ment (in our example, the polygon).
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Alignment of objects

When there are two or more objects in a page the operator
can use the tools supplied by POLYMATH to obtain their auto-
matic alignment; these tools can be accessed directly via the
Main menu (Layout->Align) or via the respective icons of the
toolbar, as described below.

*" To describe the various behaviors of the Alignment function,
we will use the same example we utilized in the last subsec-
tion: three elements in a page, namely a touch button, a poly-
gon and a Sector.

First of all we enable the icon relating to alignment by clicking
on the icon , then we draw in the page a selection area big
enough to contain the outlines of both objects. See figure:

Once the mouse key is released the objects become selected
and the alignment icons become clickable.
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There are six icons in the Alignment Menu, each of which be-
haves differently, as shown below:

Top
Bottam
Mliddle
Left

Cenker

ool =)o) 3R] S

Right

By clicking on (Layout-=>Align->Top), the top edges of all
the figures selected are aligned with one another at the level
of the top edge of the highest positioned object (in our exam-
ple, the button). See figure:

By clicking on h (Layout-=>Align->Bottom) the lowest edges
of all the figures selected are aligned with one another at the
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level of the bottom edge of the lowest positioned object (in our
example, the button). See figure:

By clicking on (Layout->Align->Mid-point) the (vertical)
mid-points of all the figures selected are aligned with one an-
other at the level of the (vertical) mid-point of the lowest po-
sitioned object (in our example, the button). See figure:

€=

By clicking on i@ (Layout->Align->Left) the left edges all the
figures selected are aligned with one another at the level of

the left edge of the leftmost object (in our example, the but-
ton). See figure:
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By clicking on E (Layout-=>Align-=>Center) the (horizontal)
mid-points of all the figures selected are aligned with one an-
other at the level of the (horizontal) mid-point of the lowest
positioned object (in our example, the button). See figure:

By clicking on EI (Layout->Align->Right) the right edges all
the figures selected are aligned with one another at the level
of the right edge of the rightmost object (in our example, the
button). See figure:
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Arrangement of objects

When there are at least three objects in a page the operator
can use the tools supplied by POLYMATH to obtain their auto-
matic arrangement; these tools can be accessed directly via
the Main menu (Layout->Arrange) or via the respective icons
of the toolbar, as described below.

Objects are arranged within a page by taking as a point of ref-
erence the distance between the first two objects in the page.
(For vertical arrangements, the reference is the distance be-
tween the first two objects encountered scrolling the page
from top to bottom; for horizontal arrangements, the refer-
ence is the distance between the first two objects encountered
scrolling the page from left to right).

The following subsections offer simple examples which take
into consideration only three touch buttons of different dimen-
sions but more complex configurations are dealt with in the
same way.

Horizontal arrangement

*‘ Using our example, let us add three different colored buttons
to the page. See below:

After drawing the three buttons, let us click on the q icon of
the toolbar and draw a selection area that includes all the ob-
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jects. This activates the arrangement options of the toolbar or
Main menu: Layout->Arrange.

In the examples in this subsection, our starting point to illus-
trate how the arrangement operation works will always be this
same initial situation. For horizontal arrangements, POLY-
MATH takes as its reference the distance between buttons 1
and 2 (being the first two from the left).

To operate a simple horizontal arrangement, just click on the
icon of the toolbar or Main menu (Layout->Arrange->Hor-
izontally).

POLYMATH will arrange all the objects selected such that the
distance between the left side of one object and the right side
of the object preceding it is always equal to the distance be-
tween the left side of the second object and the right side of
the first object (reference objects calculated according to their
order when scrolling the page from the left). If the reference
distance is less than zero, POLYMATH takes it automatically to
0.

In our example, the result obtained will be the one represent-
ed in the next figure:

To operate a rightward arrangement, just click on icon of
the toolbar or Main menu (Layout->Arrange->Right).
POLYMATH will arrange all the objects selected such that the
distance between the right sides of consecutive objects is al-
ways equal to the distance between the right sides of the first
two objects (reference objects calculated according to their
order when scrolling the page from the left). If the reference
distance is less than zero, POLYMATH takes it automatically to
0, thereby aligning to the right.

In our example, the result obtained will be the one represent-
ed in the next figure:
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To arrange to the center, just click on icon ’m of the toolbar
or the Main menu (Layout->Arrange->Center).

POLYMATH will arrange all the objects selected such that the
distance between the central vertical axes of consecutive ob-
jects is always equal to the distance between the central ver-
tical axes of the first two objects (reference objects calculated
according to the order when scrolling the page from the left).
If the reference distance is less than zero, POLYMATH takes it
automatically to 0, thereby aligning to the center.

In our example, the result obtained will be the one represent-
ed in the next figure:

.: e

e

To operate a leftward arrangement, just click on the icon
of the toolbar or Main menu (Layout->Arrange-=>Left).
POLYMATH will arrange all the objects selected such that the
distance between the left sides of consecutive objects is al-
ways equal to the distance between the left sides of the first
two objects (reference objects calculated according to their
order when scrolling the page from the left). If the reference
distance is less than zero, POLYMATH takes it automatically to
0, thereby aligning to the right.

In our example, the result obtained will be the one represent-
ed in the next figure:
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|

Vertical arrangement

Using our example, let us add three different colored buttons
to the page as indicated in the next figure:

After drawing the three buttons, let us click on icon of the
toolbar and draw a selection area that includes all the objects.
This activates the arrangement options of the toolbar or Main
menu: Layout-=>Arrange.

In the examples in this subsection, our starting point to illus-
trate how the arrangement operation works will always be this
same initial situation. For vertical arrangements, POLYMATH
takes as its reference the distance between buttons 1 and 2
(being the first two from the top).

To operate a simple vertical arrangement, just click on the
icon of the toolbar or Main menu (Layout->Arrange->Ver-
tically).

POLYMATH will arrange all the objects selected such that the
distance between the top side of one object and the bottom
side of the object preceding it is always equal to the distance
between the bottom side of the first object and the top side of
the second object (reference objects calculated according to
their order when scrolling the page from the top). If the ref-
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erence distance is less than zero, POLYMATH takes it automat-
ically to O.

In our example, the result obtained will be the one represent-
ed in the next figure:

For a top-line arrangement, just click on icon of the toolbar
or the Main menu (Layout->Arrange->Top).

POLYMATH will arrange all the objects selected such that the
distance between the top sides of consecutive objects is al-
ways equal to the distance between the top sides of the first
two objects (reference objects calculated according to their
order when scrolling the page from the top).

In our example, the result obtained will be the one represent-
ed in the next figure:

For a mid-point arrangement, just click on the icon of the
toolbar or the Main menu (Layout->Arrange->Mid-point).
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POLYMATH will arrange all the objects selected such that the
distance between the central horizontal axes of consecutive
objects is always equal to the distance between the central
horizontal axes of consecutive objects (reference objects cal-
culated according to their order when scrolling the page from
the top). If the reference distance is less than zero, POLY-
MATH takes it automatically to O (thus making the alignment
in the center).

In our example, the result obtained will be the one represent-
ed in the next figure:

For a bottom-line arrangement, just click on the icon of the
toolbar or the Main menu (Layout->Arrange->Bottom).
POLYMATH will arrange all the objects selected such that the
distance between the lowest sides of consecutive objects is al-
ways equal to the distance between the lowest sides of the
first two objects (reference objects calculated according to
their order when scrolling the page from the top). If the ref-
erence distance is less than zero, POLYMATH takes it automat-
ically to 0 (thus making the alignment at the bottom).

In our example, the result obtained will be the one represent-
ed in the next figure:
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7. Other anchorable windows

In the last chapters we dealt with the workings of the three
main anchorable windows: Project Explorer, Properties Editor
and Events Editor.

But POLYMATH contains other anchorable windows, each of
which has its particular purposes and functions as we shall
now see: Library Explorer, Error Viewer and Complirer Output.

POLYMATH POLYMATH has a structure saving tool that also functions out-

Libraries side the context of the project being edited: the Library.
This too is useful as it makes it possible to store, save and re-
use portions of a project; each individual element or set of el-
ements - indeed, even a whole project - can be put in a library
to be easily re-usable in new projects. A classic example of
the use of the Library is when you want to maintain a uniform
style in different projects without having to redefine them
each time. For example, you need simply create a frame with
the colors, the size and the style required and save it in a Li-
brary to conserve it and make it available to be inserted in all
the other projects.
With POLYMATH an unlimited number of libraries can be man-
aged. The libraries are managed using the Explorer Library
window which is an anchorable window and thus can be cus-
tomized at will (see chap.3, “Anchorable windows” page 80).
This chapter describes POLYMATH's standard libraries and
how to insert objects of the various categories of library in a
page of the project.

Library Explorer

Library Explorer is the window that shows the contents of the
libraries being worked on and allows them to be managed.

Image of the Explore Libraries in "Double click" mode :
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Select "Explore Libraries" at the bottom of "Explore Resour-
ces" :
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Image of the Explore Libraries in "Extended" mode :
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Images
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Temporary objects

Project Explorer®, Library Explorer,

The “Library” comprises the following categories

= “Buttons”

= “Swicthes”

- “Lights”

= “Pipes and Valves”
e “Tanks”

= “Motors”

= “Machinery”

= “Images List”

e “Images”

e “Flags and Icons”
- “Various”

= “Keyboards”

= “User Objects”

= “Temporary Objects”

of objects :
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Butkons

switches

Lights

Pipes and Yalves

Tanks

Motars

Machinery

Image lists

Images

Flags and Icons

Various

Keyboards

Uset objects

Temporary objects

The library allows you to use objects immediately by dragging
them with the mouse onto the page :

TN G Cemadien Tan b Camnesoms Pamtators mouse (900, 284) [umera

f

i
[Poes nd Voo
tarks
Hoters

=rE=

Drum  Hesew Meterl  Materd

w o e

etan dne; Dynamis fan

This window appears after you have dragged an object onto
the page. You can now edit the various properties of the object

as you like :
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valare 1
v
Rotazione: ® o Ooen (O ia0 O 270
e Riflesso: [ orizzontale O verticale
Background (255,255,255) Sempre
Background 1 (255,255,255) Sempre
Fan 0 (255,255,255)  visibile
Fan 45 (255,255,255)  Non visibile
Fan 135 (255,255,255)  Non visibile
Fan 225 (255,255,255)  Non visibile
Fan 315 (255,255,255)  Non visibile
Grid (255,255,255) Sempre
Sfonde |Trasparente v
[]

“DOUBLE CLICK” mode

“Double click” an object :

Pantatore mouse (416.277)
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This window appears. You can define all the parameters of the
variables associated with the object :

dit Dynamiclmage

Il Userinterface

Identification

Name DynamicImage

Comment

O Lock

Data

Tag id

[Tags ~|[Tag v

[walue

Contral type

First bit
Last bit
Disable

Hide [%

ImageKeepAspectRatio
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Takes you back to the previous page where you can edit the
properties of the object.

In the same way, it's possible to import a button on the page,
choosing among the several ones available in the library, edi-
ting its properties from the popup windows after double-cli-
cking on the object. For example, let's import the button
“Access 27 :

SEIEEY General Help page Keys Events Page Properties

After double-clicking on it, the following window appears al-
lowing to configure all the parameters of the "Released" but-
ton :
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Preview

Released
area color 255 , 255, 255 v
Area visibility

By twice clicking on the Preview key it is possible to :

= Change the Background colour

= Change the “Symbol” internal colour
= Edit the Background colour

= Change the rotation (default=0)

= Change the Mirror

In the “released” page it is possible to change both the featu-
res of the released button: :

e Area Colour
= Area Visibility
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Ratation: lé') 0 Oeo Cwo Oz
Flip: L Horizantal [ Vertical
Background (0003 Always
Symibol (25%,256,255) Always
Background | Transparenl w

The following window will appear, where it's possible to confi-
gure all the "Pressed” button parameters :

= Edit PushButton

Released Il General Behaviour

Preview

Pressed

Area color ol 3

Area Visibility 7

The following window will appear, where it's possible to confi-
gure all the "General” button parameters :
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Released Pressed Behaviour Events
Name PushButten
Comment
O Lock

[Editing

O override default arid size

Width

alv| 4y

Height

The following window will appear, where it's possible to confi-
gure all the "functioning” button parameters :

= Edit PushButton

Released Pressed General |23 I Events
Bchaviour
Disable
Hide
password level 10
Tab index o

The following window will appear, where it's possible to confi-
gure all the "Events” button parameters :
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= Edit PushButton

Released Pressed General Behaviour |3

Events

OnReleased

OnPressed

“EXTENDED” mode

Select the object with a single click of the mouse. The "Pro-
perties Editor" window appears to the right of the POLYMATH
where you can define all the parameters of the variables as-
sociated with the object :

Foust pomter (bhd,144) aa

5 \Properties Editer / Events Edtor

Double-clicking the object opens the window below where you
can edit the properties of the object :
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s valore |1
e |V P
ey Aggiungi Cancella
Retazione: mo Qoo Ois0 O 270
T Riflesso: [ orizzantale O Verticale
Wisibilita
Background (255,255,255) sempre
Background 1 (255,255,255) Sempre
Fan 0 (255,255,255)  visibile —
= . 2 T
Fan 45 (255,255,255)  Hon visibile —
Fan 135 (255,255,255)  Hon visibile n
Fan 225 (255,255,255)  Hon visibile
Fan 315 (255,255,255)  Hon visibile ! \)
Grid (255,255,255) Sempre L"e" "’...l
o \—/o
Sfonde |Trasparente v

Libraries management

To manage libraries click on the appropriate "Libraries man-
agement” icon in "Libraries explorer” :

Manage Libraries
Switches

Lights

Pipes and Valves
Tanks

Maotors

Machinery

Image lists

Irnrnagini

Flags and Icons

‘Warious

Keyboards
UkenteiFolder

Iy Library
TEMP

ESAPOLYMATH - User Manual - rev. 2.1



&

Chapter 7

Other anchorable windows

This screen opens :

E Libraries management =ioi:

Jraries

Buttons

Switches

Lights

Pipes and Valves
Tanks

Matars
Machinery
Image lists
Images

Flags and Icans
Warious
Keyboards

User

Selecting the "Visible" column boxes makes it possible to de-
termine which libraries need to be visible in "Libraries Explo-
rer".

Note: To choose a library click twice on "check-box", the first time
isto select a library and the second time is to make the selection ef-
fective.

Clicking on the "Create" key adds a library named "My Library"
by default :

Libraries management i (=]

Jraries

le |Mame

Switches

Lights

Pipes and Valves
Tanks

Matars
Machinery
Image lists
Images

Flags and Icans
Various
Keyboards
User

K KRR &R EERE R RS

My Library I
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If you want to delete a library, click on the corresponding
"check box" to select it, then click on the "Delete" key :

Libraties management B [=] ]

araries

Switches

Lights

Pipes and Valves
Tanks

Motors
Hachinery
Trage lists
Images

Flags and Toons
Various
Keyboards

User

KRl k)RR R R RN R R R E

Hy Library

TN GETNS GETNS

To confirm click on "Yes" :

zl

Do you want to delete My Library ?

4

Clicking on the "Import" key makes it possible to import pre-
determined libraries from the hard disk, while clicking
"Export", after having select it, makes it possible to export the
"User" library and save it onto the hard disk.

Creating a subfolder

User can add subfolders to the "USER" and "TEMP" folders by
clicking on the "Create Folder" icon :

8 BE

L
_|B”tt°”5 Create Folder|

Switches

The new folder appears under library :
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User

o

Folder

Right clicking makes it possible to perform the following ope-
rations on the just created folder :

* Rename

= Change icon
e Delete

|User

o

Folde Rename...

Change icon

Delete. ..

Select the "Rename" option to open this window :

5|

Insert the new name for Folder

Type the desired name then click OK to confirm.

Selecting the "Change Icon" option makes it possible to modi-
fy the default icon.

Selecting the "Delete Folder" option makes it possible to eli-
minate selected folder :
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Do you want to delete BOILER 7

_

Saving objects

It is possible to save edited objects in the USER OBJECTS fol-
der in the same Library.

Objects saved in the USER OBJECTS folder can also be used
for other projects.

There is a folder in the Library Explore called “TEMPORARY
OBJECTS” where saved objects are only available for the cur-
rent project.

Open the “USER Objects” folder :

Library Explorer

Buttons

Switches

Lights

Pipes and Yalves
Tanks

Motors

Machinery

Image lists

Irmages

Flags and Icons

‘Warious

Keyboards

User objects %
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Select the object you wish to save, press CTRL+Shift and drag
it into the "USER OBJECTS" library

This operation can take a few seconds.

aerties

Mouse pointer: (750 4807

Buttons
Switches
Lights
Fipes and Walves
Tanks
Motors
Machinery
Imadge lists
Immagini
Flags and Icons
Warious
Tastiere
User objects

P

o<y

It is possible to save an entire page of a project in the library
by simply selecting it in Explore Project and dragging it into
the "User Objects" library. The operation can take a few se-

conds :

Buttons

Switches

Lights

Pipes and Yalves

Tarks

Motors

Machinery

Image lists

Images

Flags and Icons

Yarious

Keyboards

User objects

5 ot
[ I
Ini

rretever
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A Warning: If an element isdragged fromthe project to alibrary and
this object refersto a variable (e.g. Numeric field), POLYMATH
does not automatically import the variable into the Library, this op-
eration must be done manually. When a variableisimported into a
Library, its reference to the memory addressis lost.

Dragging is also the way an object moves from the library to
a project: just take an element from the Library Explorer to
the Project Explorer so that it is included in the project.

A Warning: Wheninserting an element fromthe Library to the Project
pay special attention to the nomenclature of the objects. When the
object inserted has the same name as an element already present in
the project, POLYMATH will replace the element with the one
present in the library

Errors Viewer "Error Viewer" is an anchorable window (see , " Le Finestre an-
corabili" (Anchorable Windows on page 47" chapter) that sup-
plies information regarding the errors present in the project.

e value must be included the min and the max walues,

The tag used doesn't exist.

The number of the page is incorrect, The same number is used in another Page. The number of the page must be unique.

Errors Viewer (3)/ Warnings Viewer (1) 4 Compiler Qutput

The "Error Viewer" window lists, in real time, any errors asso-
ciated with the project you are editing and validating; errors
are highlighted in red. Double-clicking the description of a
problem focuses the application on the source of the error,
opening a window ("Properties Editor", window in the work
area, etc.) where you can make the necessary corrections. Er-
rors disappear as soon as they are corrected in the associated
area.

ESAPOLYMATH - User Manual - rev. 2.1



Warning
Viewer

Compiler
Output

Chapter 7

Other anchorable windows

1ing: 1

iNo Tag is associated to the fisld.

Errors Viewer (3::\Warnings Viewer (ly Compiler Output

The "Warning Viewer" window lists, in real time, any warnings
associated with the project you are editing and validating;
warnings are highlighted in orange.

Double-clicking the description of a problem focuses the appli-
cation on the source of the error, opening a window ("Proper-
ties Editor", window in the work area, etc.) where you can
make the necessary corrections. Errors disappear as soon as
they are corrected in the associated area.

"Compiler Output" is an anchorable window where the log in-
formation relative to the last compilation (if already carried
out during the actual session) of the project currently being
edited is reported. During the compilation phase, the log in
this window is updated in real time, showing the object and
the compiled file on which it is working. The errors and war-
nings are signalled as in the "Error Viewer" mask and a double
click on them causes movement of the focus onto the area of
application from where it is possible to solve the problem.
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Deleting files.....
Files deleted

Compiling .0bj file ...
Compiling line ports ...

Compiling device addresses ...

Compiling tags ...

Compiling tag groups ...

Compiling tay group: 57 300,400§7Progetto)ITL0ST(SP1,5P2, ETHL) \PagesPage ZICUPDATEISTLY
Compiling tay group: 57 300,400§7FrogettolIT105T(SF1,5P2 ETHL)\PagesiInizia_17CUPDATE? 5717
Compiling tay group: 57 300,400§7Progetto)ITL0ST(SP1,5P2,ETHL) \Pages)nizial CUPDATEIST1Y
Compiling tay group: 57 300,400§7FrogettolIT105T(SP1,5P2 ETHL)\PagesiPage?CUPDATE? 5717
Compiling tag group: 37 300,400§7Progetto}IT105T(3P1,3Pe, ETH1)\Pages)Page_17CUPDATE?ST17
Compiling protocol frames ...

Compiling pointer header of datsbase ...

Compiling final CRC value of text datahase ...

Compiling .EXT file

Compiling .INT fila ...

Compiling .5YS file ...

Euilding configurarion filss: succeedsd

EPMCEV4TRTCOMPTILER

Building Ceot_xml. ... __ .
Building Ceot.xml: Succesded

Euilding Idx_Tags.xml._ .......
Building Idx_Tags.xzul: Succeeded

Building Seripting.sml.........
Building Scripting.xml: Succeeded

Building Tags.xml....._...
Building Tags.xml: Succeedsd

Euilding Messaging.xml_ ........
Building Messaging.xml: Succeeded

Building Recipients.xml.........
Building Recipients.xml: Succeeded

Fiailcdimer b1armes Wanmamar ol

Errors Viewer (8} 4 Warnings Viewer & Compiler Qutput
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Compiling, Downloading and
Runtime

The preceding sections have provided all the necessary
concepts for creating and editing a project by describing all
the utilities offered by POLYMATH. Once the editing phase is
over, the work done needs to be downloaded onto the ESA
panel.

First of all it is necessary to check that there are no problems
in the project that might prevent it behaving properly in
runtime. To detect any errors there needs to be a validation
operation which analyzes all the objects created and checks
that the properties are complete and coherent without,
however, creating any transfer files.

Transfer files are created, though, when compiling, which,
therefore, is the more complex operation. Once the compiled
files have been created, they can be downloaded onto the
panel using the appropriate POLYMATH function.

This chapter will supply the details of the operations of
validation, compilation and download, illustrating at the end
another very useful function of POLYMATH, the download of
the image of the operating system onto a Windows® CE
terminal.

Validation

Validation is the operation that checks the coherence of the
objects added to the project. Any errors or warnings are
shown in the Errors Viewer window (see chap. 7, “Errors
Viewer” page 458).

POLYMATH offers wither a global validation of the project or
the validation of only the object currently being edited: a
project can be globally validated by clicking on the icon of
the Toolbar (or main menu, using File->Validates Project)
while partial validation requires a click on (File->Validates
Current).

There is also a choice as to whether to let POLYMATH perform
a validation in real-time (signals problems as they are edited)
or whether validation should be carried out only when
requested by the appropriate commands. This function can be
configured using the main menu by clicking on Tools-
>QOptions.

The Errors mask contains a report in real time of the errors
and warnings relating to the project being validated. The
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errors appear in red while the warnings appear in orange. If
we double-click on the description of the problem, POLYMATH
will focus the application on the origin of the error, that is, on
the mask (Properties Editor, work area mask, etc.) where a

correction can be made. As soon as they are corrected in the
appropriate area, the errors disappear.

Compilation

Compilation is the operation whereby a project created with
POLYMATH is transformed into files ready to be sent to the
panel to be then interpreted by the VT’s firmware.

To start off the compilation of a project click on the icon in
the Toolbar (or use the main menu File->Compile). Any errors
or warnings detected in the process of compilation are
signalled in the Errors Viewer window (see chap. 7, “Errors
Viewer” page 458). Errors appear in red while Warnings
appear in orange.

A Warning: Itisalwaysadvisableto correct errors(inred) signalled
by the compiler before downloading the project onto the panel, as
failureto do so could cause runtime mal functioning. By contrast, the
warnings relate to incomplete parts of the project that it would be
advisable to correct although their runtime impact is less grave.

Compiler Output

Building Sip_0003.xml. ... ..... A
Puilding Sip 0003.xul: Succesdsd

Building Sip 0004.xml.........
Euilding $ip_0004.sml: Zucceeded

Euilding Datalog.mml. .. ...._.
Euilding Datalog.zml: Succeeded

Building TEXT_O0L.TEN.........
Building TEXT_O0L.TRN: Succesded

Building APPMSG_O0L.TEN.........
Building APPMSG_O0L.TEN: Succeeded

Building SYSMSGC_ENG.TEN. . ... ...
Building SYSMSG_ENG.TEN: Succeeded

Building NerworkTags. zml: Succesded

When the compilation has finished the project is ready to be
downloaded onto the panel. When there is an attempt to
download a project that has not been compiled (or that
contains changes compared with the last compilation),
POLYMATH will advise the user and ask whether to go ahead
with the compilation again before beginning to transfer.
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Run time simulator

The project can be simulated directly on the PC without being
transferred to the terminal; all device variables and the
project's accurate execution can be verified without the device
actually being connected.

List of menu items

File

Menu Path Function

Imports .csv files of following
elements:
= Watch list
list of variables
selected by check
mark
= Tag values
value of variables
= Simulations
type of simulation
associated with single
variables

File -> Import

Exports .csv files of following
elements:
= Watch list
list of variables
selected by check
File -> Export mark
= Tag values
value of variables
= Simulations
type of simulation
associated with single

File -> Print Prints
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Tags

Menu path Function description

Tags -> Edit value

Edits the value of the selected
variable

Tags -> Reset all
values

Resets the values of all
variables

Tags -> Add to
watch list

Adds the selected variable to
the "Watch List"

Tags -> Remove
from watch list

Removes the selected variable
from the "Watch List"

Tags -> Reset
watch list

Removes all variables from the
"Watch List"

Tags -=>Show
watch list

Shows list of variables included
in the "Watch list"

Tags -=> Show
complete list

Shows list of all variables
included in the project

Simulation

Simulation -> Play

Carries out all simulations

Simulation ->
Pause

Pauses the simulations

Simulation -> Stop

Stops the simulations

Simulation -> Add
new simulation

Adds a new simulation

Simulation -> Edit
simulation

Edits the selected simulation

Simulation ->
Remove
simulation

Removes the selected
simulation

Simulation ->
Enable simulation

Enables the selected simulation

Simulation ->
Disable simulation

Disables the selected simulation
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Simulation -> Removes all simulations
Remove all
simulation

Simulation -> Enables all simulations
Enable all
simulation

Simulation -> Disables all simulations
Disable all
simulation

List of buttons in the tags

"Device simulation" tag
List of configured simulations

e Add: adds a simulation to a selected variable
« Edit: edits the selected simulation
e Remove: removes the selected simulation

"Project Tags" Tag
List of all the variables in the project

e Edit Value: Edits the value of the selected variable.

= Watch List: shows only the variables in the Watch List,
selected by check mark.

e Reset List: Reset List: unchecks all variables, removing
them from the watch list.

A 11T WARNING !!'! When quitting the simulator, all the values of the
variables, the watch list and the simulations are lost. To save them
for further use, use the file menu to export Watch lists, Tag values
and Simulations.

Downloading a Preparing Windows® CE panels for the first download
project

To ensure that projects created with POLYMATH are correctly
run on Windows® CE panels, 2 files to be found on the
installation CD need to be copied onto the memory (Hard
Disk) of the panel:
= Esa.cfg - this file is different for every model of panel in
that it contains hardware information and goes under
the root directory, Hard Disk\ .
= Startup.esa - this file must be copied into the directory
Hard Disk\Esa\Startup. It allows the ESA Downloader
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application to start and therefore enables
communication to take place in the project download
phase. In addition, the addition of this file leads to the
project being started automatically when the panel is
switched on.
After copying these two files the terminal’s operating system
starts; after successive start-ups the ESA Downloader
application will start automatically without any additional
operation being necessary.

Downloading a project

When a project is compiled it is ready to be transferred to the
terminal by invoking the Download function (if Esa
Downloader has been properly configured in accordance with
the indications in the preceding subsection). To start the
transfer just click on the H icon of the toolbar (or use main
menu File->=Download). If there are files compiled for the
version of the project currently being edited, POLYMATH will
show the window relating to the hardware configuration of the
PC-terminal connection. If, on the other hand, no files have
been compiled for the project yet, POLYMATH will ask the
programmer whether it should start compiling.

=101

Operater panel propect ta downisad

ITALOT (5P1, 5FZ, ETHL, ETI)

Connestion type

Part

Batare clicking on ‘Connect’, check that the cable connectians are right.
ESAPOLYMATH will reco: anize the commun cation parameters

Fassward

Password:

The download window allows the operator first to select the

terminal to which the project file is sent and the parameters
for the type of connection to be used. The types of connection
catered for are :

e “Standard serial”
e “Ethernet - TCP/IP”

e “Local”
e “USB”
- “http”
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The serial connection is the most common type and it is
achieved by connecting the ports of the PC on which
POLYMATH has been installed and those of the terminal with
the appropriate cable (see chap. 5, “Communication ports”
page 112). The type of port to be used for the PC-terminal
connection must be specified.

In the EsaPolymath 2.1 version a second Download protocol
was added, called “UDP” (User Data Protocol) :

= ESAPOLYMATH Downloader =10

Parametri comunicazione

Tipo connessione Ethernet - TCP/IP v

Indirizzo dispositiva 192 188.100.1
Porta 4036

Pratocalla & TP O uoe

Fassword

Password:

Note: With Polymath 2.0 and earlier versions, if a project is
download using the Ethernet port it is necessary to select the UDP
protocol in the operator panel downloader configurator menu.

If an Ethernet TCP/IP connection is required, it is necessary to
specify the parameters for making the connection: the IP
address and communication port (see chap. 8, “Establishing
an Ethernet connection” page 480). A remote connection (out
of those set on the PC being used) can be used when the
project download starts; in this case user credentials for
authenticating access rights (username and password) also
need to be given.
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If the connection is Local (that is, the files are sent to a server
present on the same PC), just define the port through which
POLYMATH and the application will communicate.

Once the type of connection has been selected, just click on
‘Connect’ to activate the connection (which can be aborted by
clicking on ‘Cancel’.

Preparation of IT panels before download

The IT panels do not require any particular preparation if
choosing a USB connection. If an ethernet connection is
chosen, the panel must be connected to the network and the
network parameters must be configured as indicated in the
hardware manual “Video terminal 1Txxx/Control Panel/
Network”. Finally, configure the connection gate on the
"Service page/configuration download" page of the terminal
(See hardware manual “Video terminal ITxxx/Downloader
Configuration™)

Perform the project Download on the IT terminal

When a project is compiled it can be transferred on to the
terminal by means of the Download function; to start transfer,
click on the icon l:IJ of the instruments bar (or on the main
menu File->Download). If there are compiled files for the
current project version edited, POLYMATH will display a
window relating to the configuration of the hardware
connection machine-terminal. If however, no files are
compiled with respect the project, POLYMATH will ask the
programmer to perform compilation.
In the window relating to download, it is possible to select the
terminal to send the project files and the relative parameters
to the type of connection to use; types foreseen for the IT
terminal are:

- “Standard Serial”

= “Ethernet - TCP/IP”

e “Local”
e “USB”
- “http”

The USB connection is carried out by connecting, using a
suitable cable, the gates of the machine with POLYMATH
installed and those of the terminal (see chap. 5,
“Communication ports” page 112).
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Connaction type Etharnet - TCR/ID =

Dnvice address 123.456.78.50

Fort 9aTE

Password:

If an Ethernet TCP/IP connection is chosen, specify the
parameters in order to carry out the connection as IP address
and communication gate that must be configured before the
terminal (see chap. 8, “Preparation of IT panels before
download” page 468).

Once the connection has been selected, click on 'Connect’ to
start the connection whilst clicking on 'Cancel’, cancels the
operation.

Preparation of the PCs or PC terminals based on the first
download

If an ethernet connection is chosen, connect the PC to the
network and configure the network parameters (refer to the
windows guide or consult the network administrator).
PCUSB ADAPTER

If a SERIAL CAN or PROFIBUS connection is chosen, the ESA
"PCUSBxxxxxxx" product must be used.

The "PCUSBxxxxxxx" product is essential to establish
communication between PC/XS and the PLC provided with a
CAN/DP or SERIAL port.

ESA puts the following order codes at disposal :

PCUSBADPOSP2 (RS232/485 serial communication board)
PCUSBADPOCAN (CAN-BUS communication board)
PCUSBADPODP (PROFIBUS-DP communication board)

In order to perform a project transfer, it is necessary to install
on the PC where the runtime is located, a program called
ESAPOLYMATH Downloader available on installation CD of the
POLYMATH. To install the downloader, follow the simple
instructions provided by the installation guide. At the end of
installation, the program asks if it must always be started with
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the start of Windows. If the answer is “no” it must be manually
activated each time a transfer is to be carried out or runtime
launched.

After having installed the program, the icon is added
automatically inside "Control panel”

“RCS_ADAPTER CONTROL PANEL” :

o

RCS_Adapker
Contral Panel

During installation of the "ESAPOLYMATH Downloader"
application, the drivers necessary for connecting the "PCUSB"
are installed as well.

The drivers are requested the first time the "PCUSBXxXxxxxx"
is connected to the PC/XS and are found skimming through
the path :

C\PROGRAM FILES\ESAELETTRONICA SPA\ESAPOLYMATH
DOWNLOADER\DRIVER RCS_ADAPTER.

Once the driver path requested by the application is inserted,
we connect the USB port used in our project (for example
USB1) with the COM to which the "PCUSB" is associated.
This connection is carried out double-clicking the
"RCS_ADAPTER CONTROL PANEL" icon previously described.
The following image will appear :

Miw ESA - RCS Adapter v.1.2 - Settings 1[

ADAPTER PROJECT PORT

{l}l Use2
# El
Apply | Cloze |
At this point, click "APPLY" to save the settings.
If there are problems during the connection, temporarily

deactivate firewall and the antivirus installed on the PC/XS, if
there is one.

Clicking the icon near the system clock in the traybar with the
right key of the mouse, one accesses the program functions :
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Info

Connection Settings
Start ESA system
Stop ESa& systemn
Exit Downloader

About

471

= "Start Up": clicking the new option opens a window that
allows you to select which project to start up. You can
also check a box for starting up the project in automatic

mode.

ESA Elettronica - Start Up

Active Project
Praject

Praoject
Project(2

I~ Automatic Start

Activate

= Select the required project and press "Activate"

Active Project
Project1

I Automatic Start

Project

Froject02

Activate [:

Cancel
OF

e Press OK to confirm.
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[~ Automatic Start

Activate

ESA Elettronica - Start Up

Active Project
Froject

Froject

Project02

Cancel

"Info": displays the version of the DataModel supported
by the current Runtime

“Connection Setting”: allows you to configure the
connection parameters by selecting between the serial
or Ethernet port (port 4096), If the serial transfer is
chosen, a CVCOM41102 cable must be used. If the
direct ETHERNET transfer is chosen, a CVNET11002
cable (crossed type) must be used. If passing through a
HUB or a SWITCH, a standard network cable must be

used
X

Conne on Se Nos
Serial Connection

" Serial oK
Port number:

Cancel

Baud rate:

" Eth TCP Ethermet connection

& EthUDP Part number: 4036

" Http

Start ESA system: start runtime (the project starts after
it has been transferred onto XS/PC)

Stop ESA system: stop runtime

Exit Downloader: close downloader

About: shows information of the downloader versions

PCMACHINEBASE

The whole system regarding Runtime on the PC/XS working
with "ESAPOLYMATH DOWNLOADER" application described
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until now, will automatically close after 20 minutes if the USB
Hardware key has not been inserted.

Inserting the "PCMACHINEBASE" key in the XS/PC terminal,
the system could request to insert the drivers to acknowledge
the key. These drivers are found skimming through the
following path :

C\PROGRAM FILES\EUTRONSEC\SMARTKEY DRIVERS

Carry out project Download on the PC or PC terminal based

When a project is compiled it can be transferred on to the
terminal by means of the Download function; to start transfer,
click on the icon E of the instruments bar (or on the main
menu File->Download). If there are compiled files for the
current project version edited, POLYMATH will display a
window relating to the configuration of the hardware
connection machine-terminal. If however, no files are
compiled with respect the project, POLYMATH will ask the
programmer to perform compilation.

In the window relating to download, it is possible to select the
relative parameter connection types to be used; the
envisioned connection types for the PC platforms are:

e “Standard Serial”
e “Ethernet - TCP/IP”

e “Local”
e “USB”
- “http”

The serial connection is carried out by connecting, using a
suitable cable, the gates of the machine with POLYMATH
installed and those of the terminal/PC (see chap. 5,
“Communication ports” page 112).

Communication parameters

Connection type Ltharnet - TCR/AP =

Device address 123.456.70.90

Part 76

Fagsmerd

If an Ethernet TCP/IP connection is chosen, specify the
parameters in order to carry out the connection as IP address

ESAPOLYMATH - User Manual - rev. 2.1



474 | Chapter 8

Compiling, Downloading and
Runtime

and communication gate that must be configured before the
PC (see chap. 8, “Preparation of the PCs or PC terminals based
on the first download” page 469).

Once the connection has been selected, click on 'Connect’ to

start the connection whilst clicking on 'Cancel’, cancels the
operation.

Transferring data

After setting all the connection variables and activated the
connection, POLYMATH checks the status of the terminal. In
particular, there is a check of the space available in the
terminal’s memory (relative to the needs of the current
project) and status of the project’s components.

Panel

Connection Type: Ethernet TCP/IP - 192.168.100.1 : 4096
Selectzd panel: IT_TFT

Model: YT4T (SP1, ETH1)
Model panel connected: YTaT

The upper part of the download mask is used to indicate
whether the project being sent is consistent with the type of
terminal being used to receive the transfer. If it is not, the
mask shows an error message.

Hemory avadability: DK, the comes gan be

Following this the details regarding the memory required for
the project and that available on the terminal’s supports is
shown: the operator can see if there is enough space on the
panel to hold the project files and, if there are problems, an
error message is shown.

Project companents status

Dus

Configuratior S1kb S1kh Hard Disk

{2 Update &l (%) Updste oldest only
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Finally, in the lower part there is a list of project components,
the more recent of which (compared with those residing in the
terminal) are highlighted in pink. The support and the path
used for saving the files of the related section can be shown
or the operator can decide to let POLYMATH automatically
allocate the component on the physical supports available on
the panel.

At this point, all the elements on the panel (firmware, project
and all the other components) can be updated or, to save
time, only those elements requiring updating because the
currently used version is more recent than that of the
elements in the terminal.

Conbguratior S1kE B1Kb Hard sk cunbgh,

= Runtime: transfer of firmware files in the currently used
version of POLYMATH.

= Pages: files containing information about the pages
created in the project

= Help: files containing information about the help pages
created in the project

= Images: the project images are simply copied into this
folder

= Configuration: files containing information useful for
running the project properly (.xml component files).
The Scripts added by the user and the password files
can be found here, too.

= Recipes: files (.rec) containing information on the
recipes saved in the memory of the VT

= Translation: files containing translations of multilingual
project texts and system messages

= Log: log files used by the application; this folder, for
example, contains the log files of the login/logout
operations, the alarm history and trend buffer logs.

= Font: files containing relative information to fonts used
in the project

= Report: files containing the relative information to the
project reports

= Documents: empty directory ready to accommodate the
reports in pdf
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Project: OPC files useful for managing the project’s

communica

tions

VTWinPro: contains general project information (.xml

files)

Font: font files installed and used by the project

After the file download is launched (whether it is partial or total
update) a log window for transfer operations being performed
by POLYMATH is opened :

|Up|oad

Connection Type: Ethernet

UDP - 192.163.100.1 : 4096

Cownloading files - Time left: 29 sec

Show details O

(

]

By enabling the "Show details" check box, the file names cur-

rently being transferred are displayed :

\Upload

Connection Type: Ethernet UDP - 192,166,100.1 ; 4096

Downloading files - Time left: 18 sec

Show details [

[

]

Downloading: Runtime file
Downloaded: Runtime file:

Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime file:
Downloaded: Runtime fils:

Downloaded: Runtime file:
Downloading: Runtime file

Downloading: Runtime file:
Downloading: Runtime file:
Downloading: Runtime file:
Downloading: Runtime file:
Downlaading: Runtime fils:
Downlaading: Runtime fils:
Downloading: Runtime fils:
Downloading: Runtime fils:
Downloading: Runtime file:
Downloading: Runtime file:
Downloading: Runtime file:
Downloading: Runtime file:
Downloading: Runtime file:

Downloading: Runtime file:

: W4IExchareas.dll
W4IExchareas dll
vaIPageManager.dll
w4IPageManager.dll
vaIRecipeManager.di|
w4IRecipeManager.dll
valalarmManager.dil
w4lalarmManager.dll
walalarmobserver.dll
w4ldlarmoObserver.dll
WallserObserver.dll
W4llserobserver.dil
VaAIRecipeObserver.dil
wd4IRecipeObserverdil
W4IPIcTag.dll
w41PIcTag.dll
W4ITimer,ocx
WaITimer.ocx
W4ITrendManager.dll
wa4ITrendManager.dil
W4ITrendObserver dll
W4ITrendObserver.dil
W41 dil
WATIM.dII
W4IPDFWiriter.dil
WAIPDFWriter.dll
W4ISMPPLIb.dIl
W4ISMPPLib.dIl
W4IMessaging. dil
W IMassaging.dil
:+ W4IChronoObserver.dil

IS GED

~

-

Next to the download bar the remaining process completion ti-
me is displayed.
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During panel transfer a message indicating download status is
displayed; after its completion the project execution is laun-
ched.

Polymath provides the possibility to set a password on the

panel, necessary then (if configured), to transfer the project.

In order to configure the Main Menu, click on Instruments-
>Utility downloader->Change Password Downloader CE.

= [SAPOLTMATH Domminader I

parator panel profct b damnlond

Etherrat

Conneetion trpe ) -

Passward:

At this point, the type of connection with which to
communicate to the panel will be requested and once chosen
the password can be changed.

To remove the password carry out again the procedure listed
above leaving the fields empty.

Execution runtime on XP

Once download is complete, runtime is automatically carried
out.

By means of the “ESAPOLYMATH Downloader” functions,
runtime can be stopped and restarted:

Start Up

Info

Connection Settings
Start ESA system
Stop ESa& systemn
Exit Downloader

About

With regards runtime of Polymath on windows XP, a USB pen
drive is required that acts as a license without which runtime
will not execute. In order to create a project for the PC or any
other platform terminal PC based, no hardware drive is
required. The advanced polymath version with license is

477
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A

Download the
IT OPERATING
SYSTEM image

Set up an
Ethernet
connection

sufficient. The same project can be used on a limited number
of PCs as long as each PC has a hardware drive.

Attention: if the drive is withdrawn from the USB gatein which it is
inserted, a message will appear ontheterminal: “ The USB must be
connected while Esaruntime is running retry key check or close
runtime” . At this point, re insert the drive in the gate and click on
the retry runtime to execute or cancel to close.

In POLYMATH, it is possible to transfer the whole image of the
Windows Operating System® CE on the terminal. This
operation is reachable from the main menu clicking on
Instruments->Utility downloader->Update Boot Windows CE
for IT.

It is necessary to set the connection mode as in the case of
project download (see chap. 8, “Transferring data” page 474).
The loaded images on the panel will overwrite the existing one
for which backup should be carried out before performing this
operation.

To update the Boot between the PC and the IT panel, a
crossed ethernet cable is necessary (only possible method),
successively, it is necessary to set on the PC a local network
with the IT panel, setting as IP address : 192.168.100.2 and
as Subnet Mask : 255.255.255.0

Internet Protocol {TCP/IP) Properties ﬂﬂ
General I

You can get [P seftings assigned automatically if vour netwark. supports
this capability. Otherwise, you need to ask your netvork administrator for
the appropriate IP settings.

¢ Obtain an IP addiess automatically

—(% Use the following IP addess:

I address: 192168100, 2
Subnet mask: 250,200,200, 0
Detault gateway: . .

€ Obtain DHE server addiess automatically

—f= lse the following DNS server addresses:

Frefermed DNS server. . .
Alternate DNS server

Advanced |
Cancel
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From the Main Menu, click on Instruments->Utility
downloader->Update Boot Windows CE for IT to start the
procedure and follow the instructions.

POLYMATH will ask for the previously explained IP address to
be set and to select the file source from which the program will
read the Boot to be transferred.

During the installation of POLYMATH, a file is created on the
PC where the images for the operating systems of various ESA
panel models are copied ready to be downloaded on to the
terminal; generally the image files are found in the main
directory of the POLYMATH in the path \xmI\OSImages\IT1xx
(for example for a IT105T, if the installation path has not be
modified, the image is in C:\Program Files\ESA
Elettronica\ESAPOLYMATH\xmNOSImages\IT105
TFT\NK.bin).

%Bootloader Windows CE for IT o =] |

Parameters

File name image to send:
CiyPragram Files\ESA elettronicatESAPOLYMATH 1 (@

After selecting the source from the Boot File to transfer, press
the NEXT button and switch on the IT panel so that transfer
can begin.

l%le:ll:ll:lal:h:r Windows CE for IT o ] S|

send File

Windows CE irnage transfer completed

Once transfer of the file is terminated, the IT panel should be
left on until the initial page is displayed.

479
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Downloading
the image of
the Operating
System for VT
CE

Establishing an
Ethernet
connection

= =101 x|

==Bootloader Windows CE for IT
Wizard completed

Panel is loading the new Windows CE image, this action
rmay take between 10 and 20 minutes.

At this point, if the image is different to that already installed,
connect a Mause USB because the panel will lose calibration.
Two error Pop ups will display, click ok.

Entering in CONTROL PANEL->STYLUS, it will be necessary to
calibrate the touch screen again.

POLYMATH offers the possibility of transferring the entire
Windows® CE Operating System image to the terminal. This
can be done using the main menu by clicking on Tools-
>Update OS Image OS in panel.

The type of connection has to be defined as in the case of the
project download (see chap. 8, “Transferring data” page 474).
The image loaded onto the panel overwrites the existing one
(which should be backed up before running this operation).
While installing POLYMATH, the images of the operating
systems for the various models of ESA panels are copied onto
the PC ready to be downloaded onto the terminal. Generally
the image files are in the main directory of POLYMATH in the
path \xmN\OSImages\VTxxx. For example, if the installation
path has not been changed, the image for VT595 will be in
C:\Program Files\ESA
Elettronica\ESAPOLYMATH\xmN\OSImages\VT595\NK800.bin.

ESA panels with Windows® CE operating system allow a
connection to be made to an Ethernet network by means of
just a few simple steps. After connecting the terminal to the
network using the appropriate network cable, just define the
connection as set out below :
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From the initial page of the terminal, click on "Control
Panel" :

From the "Control Panel, click on the "Network" icon :

I 2 & e

| e

Stylus Date|Time Cvner Metwork
5 = @ (}\
Lamp Saver Backup Password FTF
& a
-
Reset Information

Use the next window to insert the details by which the
panel is to be recognised within the network.

Select the "Specify an IP address" option and insert an
IP address and a Subnet Mask address. These
parameters must be used in order to interact with the
terminal inside of the network (for example,
Downloading a project via Ethernet, see chapter,
"Download the project on the VTCE panels"” on page
290") :
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"SMSC11X Ethernet Driver...[J4

IP Address EsC | 7
4

An IP address can be automatically| +
assigned to this computer,

(") Obtain an IP address via DHCP | — 1

5! +ABC | TAB

IP Address: 169 .254 208 121

Subnet Mask: 255.255.0 .0

Default Gateway: |:|

cyiraltnlion

&~ Note: To check that the panel has been correctly set in the Ethernet
network, the operator is advised to performa“ Ping” operation
using a different terminal in the network. For example, using a
Windows PC, click on Start->Run->and write ‘ping
*rk kxk kxk kxk0 replacing the asterisks with the P address
assigned to the panel. A command window for checking the actual
connection and its speed will appear.

Naturally, to have a PC interact with the panel via Ethernet the
PC also needs to be configured to access the network with its
own IP address (the configuration is identical to that seen for
the terminal).

Sharing folders between panel and PC

It can sometimes prove useful to share folders in a network to
make them accessible to a Windows® CE panel in the same
network (after having first carried out the configuration
indicated in the preceding section).
*“ In this section we shall give an example of how to access a PC
folder with Windows® XP using a POLYMATH project.
= First of all create a new folder on your PC’s hard disk
(e.g. C:\); we will rename this folder
“Shared_Polymath” and then select it by clicking with
the right-hand mouse key as indicated below :
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Runtime

Open

Explore
Search. ..

Cuk
Copy

Create
Delete

Rename

Sharbcuk

Propert

ies

Now select the option ,,Sharing and Protection” from the
resulting menu. This takes you to the window for the

sharing settings.

Now move to the “Sharing” tab as shown in the figure

below:

Shared_Polymath Properties
General  Sharing ISecunt_uI Eustomlzel

— You can thare this folder with ot

falder

" Do not share this folder
1% Share this folder

network, To enable charing for thiz folder, click Share this

2=

her users on your

Share name: IShared_Ponmalh

Cornmnett: I

User limit: & Mauimum allowed

To configure settings for offline access,
Caching

7 Allowy this rumber of users

Tao zet peimigsions for ugers whao access this
falder over the network, click Permissiors

=

Pemiszions
Caching

click

with other computers on the network.

iew vour Windows Firewall settings

“windows Firewall iz configured to allow this folder to be shared

o]

Cancel | Apply |

We select the option “Share

this folder”; we then leave

the sharing name unchanged (leaving the default one
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corresponding to the name we chose for the folder, in
our case “Shared_Polymath”).

= Finally we click on the “Authorization” button to define
which users can have access to the folder (for details
regarding network users, consult your network
administrator) and which actions can be performed :

Permissions for Shared_Polymath EHES

Share Permissions I

Group or user names:

Add... Remove

Permizsions for Everyone Allaw Deny
Full Contral [m] [m]
Change [m] m|
Read [m]

oK I Cancel | Apply |

= Using the lower part of the window, we select all 3
options available. In this way outside users can read
and write the files contained in this folder.

* At this point we click on ‘Apply’ and ‘Ok’ in this window
and then on ‘Apply’ and ‘Ok’ in the window for assigning
the properties of the folder.

After making these settings, the folder C:\Shared_Polymath
will be accessible from any Windows® CE panel connected to
the same network. In particular, the folder can be reached by
the panel by digit ting the following path :
\\NOMEPC\c$\Shared_Polymath

where NOMEPC indicates the ID name of one’s personal
computer within the network (this name is given in the
System Properties of the PC under the option “Name of
Computer” or it must be requested from the network
administrator). The code c$ indicates the drive on which the
shared folder can be found.

A typical example of this function is when exporting recipes,
alarms or trend buffers directly to a PC so that they can be
dealt with more easily. To do this just carry out the export by
indicating the path \\NOMEPC\c$\Shared_Polymath\file.xml
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in the Scripts or when configuring the function predefined in
POLYMATH.

Exporting files to various supports

After configuring the panel for Ethernet access or for sharing
folders, this connection can be used for exporting data from
POLYMATH projects. And therefore it is possible to use the
function for exporting and importing recipes, alarms or trend
buffers to various devices.

For example, to export data to a physical support other than
the main disk (like a mass storage card or USB key), just
specify the name of the file including the complete path (e.g.
‘Hard Disk2\fileexportato.xml’) in the destination file path.

The function “Online tools” allows several operations between
PC and HMI. For example it's possible to up/download files
between the 2 devices.

The function “Online tools” is placed in the Main Menu by cli-
cking on Tools->Utility downloader->0Online Tools :

Tools | 2

mes . 3-Q@O0@

Utilities > o 3

Translatians »L—J AL SEALR% R L

Tags » J - J ;II

REE]ES ¥ lnizic %5715 (ETHL, ETHZ)

Alarms 3

Downloader Utilities » || online tools -

Dictianary » Backup/Restore "

) i Backup/Restore WTiool M

Backup/Restore WTiod with Modem
Bootloader for IT and XT
Bootloader for Y¥Tood in DIRECT mode
Bootloader for YTood in ASSISTED mode

4 ETHl ETHZ »
r‘ UsSBl USBZ ]

the following window will appear :

485
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= Connect panel @

Communication parameters

Connection type v
Port 4096
Protocal @ Tcp O uop

The runtime snviranment is on this PC, ESAPOLYMATH will use the
TCP/IP loopback connection.

[Passward

Passwaord:

Connect

After having choosing the kind of connection (USB, in our ca-
se), just click onto “Connect” to establish the connection
between PC and HMI. The following window will appear :

nline tools
Panel Tools Project Exit

onling tools:

Change downloader
Project parameters:

Panel:
®5715 (ETHL, ETH2) v
Compiling Date:

Mot compiled

Compils Project

From the previous window it's possible to execute the fol-
lowing operations :

= Transfer : it allows to transfer a project previously open
= Panel Explorer: it allows to view the files and the folders

in the HMI :
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VaIReg3vreEene
v IUtiley.dll
netISAF]al

iCetalegManager.dil
VdIDstaLogObserverdl
vdIFipelines
Vd1Ewehas

V1P

V4 ITrendManager.dil
VdITrenaonserver.dil
V411M B

3| V4IPDEWriter 41

Runtime

(ST

size Datetirme. ~

2H/D4/2011
2010472011
a2kb 200452011
102Kb 200452011
atkh 20/04/2011
a7kh 20/D4/2011 0305
338Kh 28/04/2011

Compare memory: throughout Polymath is possible to
compare the memory of the HMI with respect of the me-
mory used by the project (size of memory used and size

of memory free) :

Online tools

Panal Tosls Project Exit
Ceenpars mwmory
Panal memory
fras
1043 HB
used
4,90 MB.
W Free memory
W Used memary (Project)
W Used mermer ¥ {Srstem, others)

Project memary

fram
10,43 HB

4,90 HB

Compare files : It compares files of a PC-project with
the files stored on the HMI, by clicking on the key “Re-
port Print” is possible to print a list of the files :
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Online tools [9=]4]
Fanel Tools Frajec Exit

Compare fles

File maeme

Comparson resuk Paned date

Project date -
Idertseal 28/04/2011 17:00:

29/04/2008 09:14:35

Idenkical
Identical

2
270420

B MSE0APL
s A

B e ags.xmi
il PageHanagerkin
trcugh bin

ZO/D4/E011 17
20/04/2011 17

B B 105 1genscal =]

* 0 Panel only
B (M 1 oifferent =]

il 0 Progest only

Transfer files/Backup original project : The function has
2 sub-menus :

1- “Transfer files to the panel” : it allows to transfer files from
a HMI

2- “Download files from the panel”: it allows to transfer files
into a HMI

Wizard EoE

Select type of operation

O upload files to panel

O Download fles fram panel

By selecting the first option “Transfer files to the panel” (with
the open project) the following window will appear :
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= Wizard r_ ] 0 D_(]
Project backup

bl Create a back-up of the project sourcs files

Dnstinatinn directary: .
bl Compress project files in a zip file
Zip file name: FrogettaTLST 2ip
[ Protect 2 Ide with
Dimension: 97LKb
Remote device remaiming free space: 10686KDb / 15T01KD [68%]

In the window above you can see the following options :

= CREATING BACKUP OF THE PROJECT ->you can decide
to create a backup of the project on the panel.

 COMPRESSING THE PROJECT IN A ZIP FILE ->you can
zip the backup-file

* PROTECTING THE ZIP-FILE BY A PASSWORD ->you can
protect the zip-file by a password

By clicking on “Next” the following window will appear :

Adanonal fes

Dimensien: OB
Remots device remaining fres space: 10675 / 15701Kb [60%]

In the window above there are the following buttons :

e “Add file/s” ->Run the procedure again for new files to
add.

= “Remove row” -> select the row and delete it

= “Delete file/s” ->Remove files and folders in the panel.
It is useful to get part of the memory free.
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= “Modify the destination folder” ->just change the path

of the files.

By clicking on “Add File” you can choose the file to store into

the panel.

Once selecting the file to send, just choose the folder of desti-
nation. In the sample we've selected the folder “Hard Disk”.

Just click “OK” :

Choose destination directory

i Douments and Sattings
& 1 bin
L pages
3 help
3 E5A
o img
) weeifig
) revees
=1
5 g _bad
o Fortt

L) Docurmenl b
o Client

o by

My Minmmesss

The following image will appear :

By clicking on “Next” the download will start. At the end just

Dimension:  2891Kb
Remuobe devecn comawng fren space:  10686KD / 15701k [65%)]

press “End” :
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= Change the password downloader : it allows to change
the password downloader (blanked by default) :

= Online tools

Panel Tools Projec Exit
‘hange damnloader passward

Paspword:

Catfirm pasewnd:

= Compile project : it compiles the project.

By selecting the second option “Download files from the panel”
the following window will appear :
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|Download files from panel

File name

Edit destinat

In the window above there are the following buttons :

“Add file/s” -> Run the procedure again for new files to add.
“Remove file/s” -> Remove files and folders in the panel. It is
useful to get part of the memory free.

“Modify the destination folder” -> just change the path of the
files.

= File selection

Panel files:
) Metwark ~ Size Dateftime 4
=7 Hard Disk 13Kh 02/05/2011
) Documents and Settings s8Kh 11/05/2011
) bin netISAPL.dIl 3zKh 11/05/2011
&) pages W4IRCSApi.dil a6Kh 11/05/2011
&) help MSS0ARR dIl 24Kb 02/05/2011
) EsA MSS0APL.dIl 281Kh 02/05/2011
wIsc1o.dil 30Kh 02/05/2011
£ ima walzLib.dll 104Kh 11/05/2011
) config w4IESAaudio.dll 53Kb 11/05/2011
) recipes wdIScripting.dil 146Kh 11/05/2011
0 trn w41DataServer.dll 165Kh 11/05/2011
&) _log_bad ¥41DevMgrExternal dil 62Kh 11/05/2011
) Font w41DevMgrinternal dll askh 11/05/2011
| Reports ¥41Dataloghanager.dil 64Kb 11/05/2011
L A=k ¥41DatalogObserver.dil 32Kh 11/05/2011
= Documents wdlPipelines.dil 51Kh 11/05/2011
) Client walExchAreas.dil 63Kh 11/05/2011
o leg || wdIPageManager.dil 688Kh 11/05/2011
T AT i an oL P,
< > < >

By selecting a folder of the panel you can choose the files to
copy.
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Desktop
=] My Documents
= 4 My Computer
@ M 32 Floppy (a2
e WINPT i
< DATI (D)
b DVD/CD-RW Drive (E:)
22 Crs on Thldo3hgroups$' (M2)
Richieste_di_fattibilita on 'Tthidozhgroupssmktimkt' (N2

3

1

=]

2]

&

v

e

By clicking the button “Next” Polymath will copy the selected
files in the folder selected :

Ec &

ESACFG - “Hard Disk C:sDocumnents and Setting

Add fileds Remove file Edit destination directory
oo s
Backup / A different way to perform backup project is obtained from the
Restore terminal control panel.
Backup

From the initial page of the terminal, click on “Control Panel” :
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From the “Control Panel, click on the “Backup” icon :

g » 86 e

4
Skylus Date/Time QWnEr etwark
i g % (.j\
Lamp Saver Backup Password FTP
= J
-
Reset Information

This window opens :

‘IBackup & Restore

S @ Backup () Restore
/ ] Runi
e DProject ESC 7 8 9
DHistory
+ 4|5 |6
-|11]2]3
R Ready
+85C | TAB| O

As you can see from the previous figure, the user can carry
out "Backup" or "Restore"” (the latter option is discussed la-
ter), it is also possible to only backup the project, both the
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project and recipes (alarms, trends, variables), or to backup

any combination of the 3 options (Run Time, Project, History).

In our example the Backup will be performed enabling all 3
options :

i Backup & Restore m

S @ Backup () Restore

/ RunTime
Praoject
History {alarms, recipes, trends, variables)

Start Backup

Larnpy

R Ready

Pt =] [a) ~ -

After having enabled the desired option boxes, click on the
browse key E| to choose where to save the Backup file (in the
example the folder "My Documents" is chosen :

o <]

) Temp
o incowes

ﬁ] Save As
[3) My Device
= Hard Disk

y Documents
- Network
| |= Program Files

L 3

Marne: |

bl

Type: |Elac

| — - - ~ -

At this point we must name the file (123) :

-
ﬁ] Save As .
[3) \My Documents
S|
o
Lamp
Marne: |1234
o Type: |Elackups (*.ebk) E'

495
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Press the “Start Backup” key to save :

Larnpy

Ry

If everything has

S @ Backup () Restore

/ RunTime

‘|Backup & Restore m

[iwry Documentst 1236k

Praoject
History {alarms, recipes, trends, variables)

Start Backup

|Ready

been completed properly, the wording

“Backup Completed” appears :

Larnpy

Ry

i Backup & Restore m
|

S @ Backup () Restore

/ RunTime

Restore The “Restore” function is very useful when needing to load a
(Remote panel “RunTime” project and/or application on an "IT" terminal

[iwry Documentst 1236k El

Praoject
History {alarms, recipes, trends, variables)

|Backup Completed

update) without needing to use POLYMATH.

A practical example is when needing to send a project to a
remote customer that does not have the POLYMATH software

available.

First thin, the file to be sent must be created:

From POLYMATH, go top the main menu bar, specifically in

Tools/ Utilities Downloader / Backup-Restore:
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Tools | 2

i B— - ) - ][ LR

Utilities 3 [ p—

Translations 3 m d d @ l@ l:i! @ l‘-’ m q

Tags 3 U - hJ uj

Recipes 3

Alarms 3

Downloader Utilities  » Online tools

Dictionary 2 Backup/Restore Iy

RSN LS Uy Backup/Restare W T 4

Backup/Restore YT with Moderm
Bootloader for IT and XT
Bootloader for WTiodd in DIRECT mode
Bootloader for WTiued in ASSISTED mode

4 ETH1 ETEZ P
|—< USBEl USB2 »

Choose the terminal family (in our case the “IT” family) then
click on "Next" :

= Wizard ET®

Typa of pacal

Panel family
@ - po

Owr

In the following image, enable the “Panel Format Backup" op-
tion (only offline) and choose if the “Project” option, the “Run
Time” option or both at the same time are to be enabled then
click on “Next” :
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Wizard r: ] ,El
IT Backup Mestors-Optens

(=
O Backip
G Backup Panel Fermat {anly offiine}
3 Restare

ur
= Praject
B Runbene
O Recipes
O wags

In the next screen, choose the panel where the project is to
be saved and then enable the "Compile project” option. In the
second part of the screen, click on the "Browse" key to choose
where the project copy is to be saved, then click on "Next" :

Wizard

1T Backup Optens

OffLine
B offline

Parsl s icr crc B

Save
Fila Wama
DATemg\PROVA ebl

LloX

B Compile Project

The following image will appear, click on "Next" to save :
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Runtime

[SELT
Deefault paths
B vte dafmult paths
EESETS &8
At the end, click on “End” :
 Wizard EcE
Backup [ Rectore
> PageManager bin

At this point the file is ready to be sent to the "remote client”,

after receiving it they must copy it on a "USB drive" and insert
it in the USB drive present on the "IT" file.

From the initial page of the terminal,

click on “Control Panel” :
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From the “Control Panel, click on the “Backup” icon :

g » 86 e

4
Skylus Date/Time QWnEr etwark
i g % (.j\
Lamp Saver Backup Password FTP
= J
-
Reset Information

This window opens :

‘IBackup & Restore

: @ Backup () Restore

bl
|

/ ] Runi
e I:‘ Project] ESC 7 8 9
I:‘ Histary, + 4 5 6
R Ready — 1 2 3
+85C | TAB| O

Enable the “Restore” option and then click on the browse key
E| to locate the file containing the project to be loaded on the
panel :
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i Backup & Restore

1 (O Backup @R

Runtime

bl
|

I:‘ RunTime

I:‘ Project

Larnpy

R Ready

I:‘ History {alarms, recipes, trends, variables)

o 0 a

Locate the "Hard Disk2" folder :

[3) My Device

[[ommcic]
Sk

[==#Hard Disk

| == My Documents

|25 Pragrarm File
=5 Temp
122 windows

A | Metwork

L

| KT
[a
Iy esc | 7

Ry

[3) \Hard Disk2

[[omncic]
Sk

Larnpy

Ry

+lalel al ol

Choose options to be enabled (Run Time, Project or both) :
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(O Backup @) Restore
[irard Diskz\123. 2 El

RunTime
Praoject

I:‘ History {alarms, recipes, trends, variables)

|Rest0re Completed

X

— lmoutpanel

Click on "Start Restore", the following image is displayed whe-
re the user is warned that during "Restore™" all existing files in
directories involved in the process are replaced with the new
files, click "YES" to continue :

Starting restore process

warning: all the terrninal
directaries invalved in the
process will be cleared and
all the esisting files wil be
replaced by the backup.
Are you sure you want ta
proceed with the restore

process?

=1 ™y

Larnpy

i lra liral

DK

L

If everything has been completed properly, the wording “Re-
store Completed” appears :
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Click "OK" to go back to Control Panel, where the project just
loaded can be launched by clicking on "Start ESA Application :

SA Application

nfiguration

It's possible to execute backup/restore operations on both
HMI and PCs.

Such function is in Main Menu, Strumenti->Utilita downloa-
der->Backup\Restore :

Tools | 2

pucsm— -~ )] R

Utilities 3 7 3 3 2 3

Translations 3 Lﬁ ‘J ‘—J ‘d -d lﬁj Lj LJ ‘j b

Tage 3-a0

Recipes 3

Alarms 3

Downloader Utilites  » | Online tools

Dictionary 3 ‘ Backup/Restaore I

e =g sy Backup,/Restore Y Trxxi -

Backup/Restore YTiodd with Modem
Bootloader for IT and XT
Bootlnader for YTyt in DIRECT mode
Bootioader for ¥Txoaw in ASSISTED mode

4 ETHL ETHZ )
r< USEL USBZ b

By clicking on “Transferring files/Backup source project”, the
following image will appears :
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= Wizard =1 4]
Type of panal
Facel family
EHIT - P
Qv
- e

In the next window you can select the family of the panels: IT-

PC or VT :
Wizard EE El
Made
@ backup
) Dackup Banal Farmak [anly sMing)
O Bestore
& Project
(2 Ruskene
O Recipes
0 Legs
RS T

Now the user can choose either to download the files onto the
panel or viceversa (in our sample we download files PC--
=>HMI), if a project is open the following window will appear :
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Wizard

IT Backup Options

£ )0X

Gifine

O offee

Pansl 1 cempile Praject

Save
Filn Marme

DATempATEST 2ip

In the second part of the window, you can choose where to
store the project through the button “Browse”. Now click
"Next” :

= Wizard =g ]

Communication parameters

Connection tyee

I

Paggmord

In the first submask, the option “Connection Type” allows to
select the kind of communication (serial COMPORT, ethernet,
USB, ecc.) :
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= Wizard Elo&
.
By clicking “End” you end the procedure.
Panel Reset "Panel Reset" is an application of the terminal control panel
which allows to cancel all that has been transferred onto the

Hard Disk.

From the initial page of the terminal, click on "Control Panel" :

From the "Control Panel, click on the "Reset" icon :
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g » & e

=
Skylus Date/Time Cner Mebwork
Larmp Saver Backup Password FTP
L
-
Reset Infarrmation

The following image will appear :

Delete Project

rSelect reset operation

Delete

O Remove project and runtime
() Complete terminal disk reset

rProtection

| hange Password

From the image above, the user can choose between 2 op-
tions:

= “Remove project and runtime” -> choosing this option,
both the project and the runtime that have been tran-
sferred from Polymath onto the terminal will be cancel-
led.

= “Complete terminal disk reset” -> choosing this option,
the whole content of the "Hard Disk" folder will be can-
celled, with the exception of the files that are essential
for operating the terminal.

Choosing one of the two options described above and clicking
"Delete", the safety password will be requested, since impor-
tant information contained in the terminal is about to be can-
celled :
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Warning: the terminal disk
v l . content is about to be deleted.
=~ Enter password ko confirm

execution,

Password: I

Reset InFormak

The default password is "1234". If wanted, it can be changed.
After having typed in the password, confirm pressing "Send"
on the "Input Panel" keyboard.

ESAPOLYMATH - User Manual - rev. 2.1



Chapter 9
Scripts

Scripts

POLYMATH allows the programmer to add to the project whole
programmes or functions for managing and editing all the
application’s components (graphic objects, variables, recipes
etc.) in runtime. Thanks to this, users can complement the set
of predefined functions supplied by POLYMATH with those they
have created according to their needs. User scripts can be
called up in a project when a button is pressed, when an event
is triggered or in response to being called by other scripts.
Scripts can be inserted into a project using Project Explorer
(see chap. 5, “Scripts” page 194) and their code can be
written using simple programming/scripting languages like
VBScript.

For details concerning programming techniques (variable
declarations, operators, conditional structures and predefined
functions) the user is advised to consult specialist manuals
relating to the language to be used.

In this chapter we will give information relating to the
properties and methods that can be used in POLYMATH scripts
with relevant examples.

Editing codes

[l

Serept
Sub Seript(}

Dim n -
a=Hour (Now) —
£ (ave7 And a<lP] Then ESAILL.ESAPAGE ("Page”] .ESACNTRI
[a>=15 And &<1%) Ther ESANLL ESAPABE(~Faie”)  ESACHTI
[as=12 And @<14) Ther ESAHMI ESAPACE (Page") ESACHTI

[m3=19 indl ac0) Then ESAMMT.ESAPAGE ("Page"] . ESACHTRI
£ {av=0 And a<T?] Then BSAHMY.ESAPAGE {"Page") .ESACHTRL

11 ESAIGLL. ESAPAGE ("Fage”] ESACHTHL (“Label”) . UorderColor=
I ESANNL. ESAPAGE ("Fage”] ESACHTRL (“Lafel") . -

11 ESKMMT .ESAPAGE ("Page”| ESACHTRL (“Labe1") . =R

14 ESKHMT .ESAPAGE | } -ESRCHTRL {"Lane 1) .ClipX1=167

15  ESAHMI.ESAPAGE ("Pay SACHTRL (“Label"™) . TextBlink=2
£ ESAHMI.ESAPAGE ("Pay SACHTRL (“Label™) .ClipY1=467

17 ESANL. ESAPAGE ("Fage”] ESACHTRL (“Label™) .Draw()

In POLYMATH once a script has been inserted using Project
Explorer (see chap. 5, “Scripts” page 194) the editor page for
writing the code can be used.

The editor runs a real-time check of the syntax of the code,
immediately posting an on-screen warning should it detect
any imprecision in the formulation of the instructions.
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Errors Viewer

) Errors1) | ) Warnings(1)

WBScript error I@DE' line 0: Expected ')’

YESHript error 1006 line 0; Expected 'Y
ESAHMI.ESAPAGMGR. ClosedctivePoplp(l

As indicated in the figure above, a red circle is shown to
indicate the existence of an error. When the mouse cursor is
placed on it, a complete description of the problem is put on
screen. The errors and their related descriptions are also listed
the moment the project is validated and compiled.

1: ESAHMI.

GESAALARMMGR,  ia|
W EShABeep

% ESACOM

¥ ESADATALOGMGR

% ESAETH

i ESAFILE

i ESAGetUrl

% ESALPT

i ESAMsgBox

@ ESAPAGE hd

The editor facilities the drafting of the code, showing too the
list of objects and properties available for the object that has
been inserted (Intellisense mechanism). This list appears
whenever the user presses the separation point between the
objects or between an object and the method (or property) to
be called. When the code is edited, the objects are, in fact,
separated from their respective children or methods by the
insertion of a point ‘.” (dot). There follows a chart showing the
hierarchy of objects accessible by script.
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ESAHMI = ESATAG
- ESAPAGE = ESACNTEL
- ESAPAGEMGR
- ESAUSERMGR
- ESAATARMMGE.
- ESARECIPEMGR
- ESARECIPETYP
- ESARECIPEARC
- ESARECIPETRF
- ESA TIMER.
- ESAFRN
- ESABFEP
- ESACOM
= ESADATALOGMGR
= ESATILE
= ESAGETURL
- ESALPT
- ESAMSGBOX
- ESASLEFP
- ESAPIFEMGR
- ESATRENDMGR.
- ESAWAIT

Therefore, to indicate an element of the page, we use an
instruction of the type:
ESAHMI.ESAPAGE("Page").ESACNTRL("Label").ControlWid
th=67

Script
Sub Script()

1: a=ESAHMI.ESATAG.ReadValue
o
= Tag_1
= Tag_2

In the case of those objects that require a passage of the
name of the reference object (for example, ESAPAGE,
ESACNTRL, etc.), after the opening of the brackets just press
the ‘?’ key of the keyboard to obtain the list of objects that can
be inserted.

The following sections of this chapter will deal with the various
objects accessible by Script and set out their properties and
functions, giving where necessary practical examples of their
use.
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A Note: Some properties mentioned in the following paragraphs are
described as being in read-only mode when using Scripts; for many
of these properties, however, there is no physical protection, so
thereisthe possibility that the script will overwrite their value. This
overwrite operation is, in any case, not advised. It is thus the
programmer’ s responsibility to avoid the properties indicated as
being read-only (R) being edited by the scripts.

Key to types of variable and syntactical premises

The following sections will refer to properties and methods
characteristic of objects. The table below gives a rapid key to
the abbreviations that will be used.

Table 1: Key to Abbreviations

Variable Abbreviatio
n

Whole Int

String Str

Boolean Bool

Long Long
Double Dbl

RGB (color, RGB

returned by the
RGB function)

Variant Var

Read, read-
R

only
RW Read&Write,

read and write

If a subroutine (method returning no value) requires an input
parameter, the passage can be achieved by using brackets or
by leaving them out:

ESAHMI.ESAMSGBOX “Text”
ESAHMI.ESAMSGBOX(“Text”)

When a subroutine requires more than one input parameter,
these parameters must be written consecutively and
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separated by a comma (without brackets) as shown in the
following example:
ESAHMI.ESAPAGEMGR.ShowPageByNumber 32,0

If a function (a method returning a value) requires one of
more input parameters, a passage must be made using
brackets, as follows:
a=ESAHMI.ESATAG("Tag_Array").GetTagBitValue(1)
a=ESAHMI.ESAPAGEMGR.GetTAGBuffer
(“RecipeType“,”RecipeName”)

Use of functions and subroutines

It is possible to insert into one’s projects functions and

subroutines (the former return a value while the latter do not)
that can be called by a script at any moment. The definition of
these functions happens as with normal scripts, only that it is
necessary to specify the type of input and output parameters.

Identification

Mame addzero

Comment

Return value type: |Vm—.ant

T ———

Valus Humber Tag that shows the value

T add

Duplicate

After creating the script using Project Explorer, enter in the
General mask the type of output value (‘None’ if it is a
subroutine) and enter the type in question in the list of input
parameters.

ESAMSGBOX Method

The ESAMSGBOX method serves to make a message window
appear on the terminal with the value provided.

X

This is a Message Box!

oK
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This method is useful for debugging the script as it allows the
user to view, for example, the value of a variable at a given
moment of its execution.

According to the simplest syntax for invoking that method, the
passage of a value (whether constant or variable) is as set out
in the following example:

ESAHMI.ESAMSGBOX(“Message Text")

which in Runtime makes the window containing the message
“Message Text” appear. If, on the other hand, we use the
following syntax:

ESAHMI.ESAMSGBOX(VariableName)

in Runtime a window containing the current value of the
variable ‘VariableName’) appears.

Alternatively the method can be invoked with the passage of
two values; in this case the first parameter indicates the string
to be displayed while the second parameter must be a string
that then appears in the title bar of the window. See example
below:

ESAHMI.ESAMSGBOX “Message Text“,”Message Title”

will make a window containing the message ‘Message Text’
appear, while the title appearing in the bar above this window
will be ‘Message Title’.

& Warning: The ESAMSGBOX method is advised only for debugging

the script, or rather during its testing. For the final project, when
messages ar e to be presented on screen for the operator, we strongly
advise the use of pop-up pages (whose appearance can be controlled
using Scripts).

& Warning: To execute scripts relating to a variable the continuous

update option must be enabled during the setting of the variable in
POLYMATH (seechap. 5, “ Device” page 128). In addition, tagscan
only use the methods and properties relating to thresholds if these
have already been assigned.
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Methods of the ESATAG objects accessible from
SCriptESAUSERMGR

Table 2: Methods of the ESATAG objects accessible from Script

Method Description ouT I\
Returns the IC variable Long String
Getld code inserted under string
form
Gets the code type of the Integ | String
GetDataType value corresponding to the | er
type of tag
Gets the code type of the Integ | String
GetRawDataT "rough" value (value inside | er
ype the device) from the
variable
Isinvalid Checks_ if the tag value is Bool String
not valid ean
1sOffline Checks if the t-ag is Bool String
correctly Off Line ena
1sOffscan Checks if the tag is Bool String
correctly Off Scan ean
Checks if the tag value had | Bool String
IsForced been forced whilst in Off ean
Scan
Checks if the threshold of Bool String
IsInhibit the tag is forbidden ean
Set the tag to the Off Scan - String(tag
status name)
SetOffscan Boolean(0
ffscan)
Set the threshold of the - String(Tag
SetInhibit tag to the forbidden status name)
Boolean(l
nhibit)
GetStringLen Gets the It'ength_ configured Long | String
of the tag's string
- Gets the filling assigned to Integ | String
GetFillingType the code of the tag's string | er
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Table 2: Methods of the ESATAG objects accessible from Script

Method Description ouT I\
GetFillingChar Gets the flllllng_s character Integ | String
of the tag's string er
Changes the fillings - String(Tag
SetFillingChar chgracter of the tag's name) _
string Integer(Fil
Ichar)
GetlnputValue | Gets the lower limit of the Doub | String
LowerLimitGe operations in entry of a le
tTagThrsDevR numerical tag
eference
Getlnputvalue Gets the up_per limit of the Dbl String
o operations in entry of a
UpperLimit .
numerical tag
GetlnputRaw Gets the lower limit of the Dbl String
ValueLowerlLi operations in exit of a
mit numerical tag
GetlnputRaw Gets the upper limit of the Dbl String
ValueUpperLi operations in exit of a
mit numerical tag
GetConversion | Gets the conversion type Integ | String
Type code of a numerical tag er
Gets the parameter of the Dbl String
GetConversion | mathematical conversion
X1Par of the value of a numerical
tag
Gets the parameter of the Dbl String
GetConversion | mathematical conversion
Y1lPar of the value of a numerical
tag
Gets the parameter of the Dbl String
GetConversion | mathematical conversion
X2Par of the value of a numerical
tag
Gets the parameter of the Dbl String

GetConversion
Y2Par

mathematical conversion
of the value of a numerical
tag
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Table 2: Methods of the ESATAG objects accessible from Script

Method Description ouT I\
Setinputvalue Changes the onver limit of | - String(Tag
LowerLimit the operations in entry of a name)
numerical tag Dbl(Limit)
Changes the upper limit of - String(Tag
SetlnputValue | the operationsinentry ofa name)
UpperLimit numerical tag Double(Li
mit)
SetInputRaw Changes tr_1e I0\_Ner I|_m|t of | - String(Tag
the operations in exit of a name)
ValueLower - .
P numerical tag Double(Li
Limit K
mit)
SetInputRaw Changes tk_le up_per I|_m|t of - String(tag
the operations in exit of a name)
ValueUpper - .
P numerical tag Double(Li
Limit K
mit)
Changes the parameter of - String(Tag
. the mathematical name)
SetConversion .
conversion of the value of Double(Co
X1Par .
a numerical tag nvPatamet
er)
Changes the parameter of - String(Tag
. the mathematical name)
SetConversion .
conversion of the value of Double(Co
Y1Par .
a numerical tag nvPatamet
er)
Changes the parameter of - String(Tag
the mathematical name)
SetConversion | conversion of the value of Double(Co
X2Par a numerical tag nvPatamet
er)
Changes the parameter of - String(Tag
the mathematical name)
SetConversion | conversion of the value of Double(Co
X2Par a numerical tag nvPatamet
er)
GetCurrent Reads the current value Varia | String
Value saved in the tag nt

517

ESAPOLYMATH - User Manual - rev. 2.1



518

Chapter 9
Scripts

Table 2: Methods of the ESATAG objects accessible from Script

Method Description ouT I\
GetCurrent Read the curr_en_t rough Varia | String
RawValue value (value inside the nt
device) saved in the tag
ReadValue Read the valt_Je of the tag Varia | String
from the device nt
Writes a new value of the - String(Tag
. tag in the device name)
WriteValue Variant(Va
lue)
Reads from the device the Var